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Preface

Intended Audience
Welcome to Release 12.2 of the Oracle Process Manufacturing Product Development User's 
Guide.

This guide assumes that you have working knowledge of your business area's 
processes, tools, principles, and customary practices. It also assumes that you are 
familiar with Oracle Process Manufacturing. If you have never used Oracle Process 
Manufacturing, we suggest you attend one or more of the Oracle Process 
Manufacturing training classes available through Oracle University.

See Related Information Sources on page xiii for more Oracle E-Business Suite product 
information. 

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit http://www.oracle.
com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=trs if you are hearing impaired. 

Structure
1  Understanding Product Development
This chapter introduces the fundamentals of Product Development like basic tasks, 

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
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responsibilities, and process flows required to develop and maintain a product. It 
provides a basic understanding of navigation, workbenches, the status approval 
workflow, version control and how to add and edit status codes.

2  Setting Up
Perform the following tasks to set up this application.

3  Formulas
This chapter includes a basic understanding of formula setup and shows you how to 
define the formulas that drive your manufacturing process. It shows how you can enter 
item technical data and use the Simulator for laboratory simulations. It discusses how to
set up formula information including how to use formula phantoms, methods available 
to scale formulas, and to find formulas. In addition to entering formula details, you can 
define and maintain formulas at the header and line levels. Also discussed are methods 
for determining where ingredients are used, the Indented Bill of Materials Report, and 
formula inquiry that help you locate formula information.

4  Operations
This chapter discusses how to define and maintain operations, activities, and resources. 
It explains how you can find an operation and view summaries of operations and 
operation headers that provide overviews. The processes to enter operation activity 
details, activity-resource details and how to display activity lines and edit a summary of
resource lines are also explained.

5  Routings
This chapter describes how to define and maintain routings. It explains how to find a 
routing and view summaries of routings and routing headers that provide overviews of
available routings. The processes of entering routing details and displaying the routing 
step line summary are discussed. Steps to edit routing step lines, and enter routing step 
dependencies as well as procedures for displaying and editing theoretical process loss 
are provided.

6  Recipes
This chapter describes how to define and maintain recipes. It shows you how to find 
recipes and display summaries of recipes and recipe headers. Procedures of how to 
enter recipe details, recipe organization details, and edit validity rules are explained to 
demonstrate the process flows for recipe development. Also discussed are processes to 
display and interpret recipe validity rules, recipe step and material association.

7  Tools
8  Least Cost Formulation
This chapter provides a basic understanding of least cost formulation. It includes 
information on using the formulation specification workbench, entering a new 
formulation specification, and a new requirement. Material, compositional, and 
technical requirements are discussed, and use of the formulation specification summary
is presented. You are shown how to generate and optimize a formula.

A  Navigator Paths
B  Oracle Process Manufacturing Product Development Responsibilities and Menu Access
C  Oracle Process Manufacturing Product Development Status Codes
D  Oracle E-Records Events in Oracle Process Manufacturing Product Development
Glossary
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Related Information Sources
Related Guides

Oracle Process Manufacturing shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other guides when you set 
up and use Oracle Process Manufacturing. You can read the guides online in the Oracle 
Help Center. Navigate to https://docs.oracle.com. Select On-Premises Applications, then
E-Business.

Guides Related to All Products

Oracle E-Business Suite User's Guide

This guide explains how to navigate, enter and query data, and run concurrent requests
using the user interface (UI) of Oracle E-Business Suite. It includes information on 
setting preferences and customizing the UI. In addition, this guide describes 
accessibility features and keyboard shortcuts for Oracle E-Business Suite.

Oracle Alert User's Guide

This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle E-Business Suite Concepts

This book is intended for all those planning to deploy Oracle E-Business Suite Release 
12.2, or contemplating significant changes to a configuration. After describing the 
Oracle E-Business Suite architecture and technology stack, it focuses on strategic topics, 
giving a broad outline of the actions needed to achieve a particular goal, plus the 
installation and configuration choices that may be available.

Oracle E-Business Suite Flexfields Guide

This guide provides flexfields planning, setup, and reference information for the Oracle 
Applications implementation team, as well as for users responsible for the ongoing 
maintenance of Oracle Applications product data. This guide also provides information 
on creating custom reports on flexfields data.

Oracle Application Framework Personalization Guide

This guide covers the design-time and run-time aspects of personalizing applications 
built with Oracle Application Framework.

Oracle E-Business Suite System Administrator's Guide Documentation Set

This documentation set provides planning and reference information for the Oracle 
Applications System Administrator. Oracle E-Business Suite System Administrator's 
Guide- Configuration contains information on system configuration steps, including 
defining concurrent programs and managers, enabling Oracle Applications Manager 
features, and setting up printers and online help. Oracle E-Business Suite Applications 
System Administrator's Guide - Maintenance provides information for frequent tasks such 
as monitoring your system with Oracle Applications Manager, managing concurrent 
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managers and reports, using diagnostic utilities, managing profile options, and using 
alerts. Oracle E-Business Suite Applications System Administrator's Guide - Security 
describes User Management, data security, function security, auditing, and security 
configurations.

Oracle e-Commerce Gateway User's Guide

This guide describes the functionality of Oracle e-Commerce Gateway and the 
necessary setup steps in order for Oracle Applications to conduct business with trading 
partners through Electronic Data Interchange (EDI). It also contains how to run extract 
programs for outbound transactions, import programs for inbound transactions, and 
the relevant reports.

Oracle e-Commerce Gateway Implementation Guide

This guide describes implementation details, highlights additional setups for trading 
partner, code conversion, and Oracle Applications as well as provides the architecture 
guidelines for transaction interface files. This guide also contains troubleshooting 
information and how to customize EDI transactions.

Oracle Report Manager User's Guide

Oracle Report Manager is an online report distribution system that provides a secure 
and centralized location to produce and manage point-in-time reports. Oracle Report 
Manager users can be either report producers or report consumers. Use this guide for 
information on setting up and using Oracle Report Manager.

Oracle iSetup User Guide

This guide describes how to use Oracle iSetup to migrate data between different 
instances of the Oracle E-Business Suite and generate reports. It also includes 
configuration information, instance mapping, and seeded templates used for data 
migration.

Oracle XML Gateway User's Guide

This guide describes Oracle XML Gateway functionality and each component of the 
Oracle XML Gateway architecture, including Message Designer, Oracle XML Gateway 
Setup, Execution Engine, Message Queues, and Oracle Transport Agent. The 
integrations with Oracle Workflow Business Event System and the Business-to-Business
transactions are also addressed in this guide.

Oracle XML Publisher Report Designer's Guide

Oracle XML Publisher is a template-based reporting solution that merges XML data 
with templates in RTF or PDF format to produce a variety of outputs to meet a variety 
of business needs. Using Microsoft Word or Adobe Acrobat as the design tool, you can 
create pixel-perfect reports from the Oracle E-Business Suite. Use this guide to design 
your report layouts.

Oracle XML Publisher Administration and Developer's Guide

Oracle XML Publisher is a template-based reporting solution that merges XML data 
with templates in RTF or PDF format to produce a variety of outputs to meet a variety 
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of business needs. Outputs include: PDF, HTML, Excel, RTF, and eText (for EDI and 
EFT transactions). Oracle XML Publisher can be used to generate reports based on 
existing E-Business Suite report data, or you can use Oracle XML Publisher's data 
extraction engine to build your own queries. Oracle XML Publisher also provides a 
robust set of APIs to manage delivery of your reports via e-mail, fax, secure FTP, 
printer, WebDav, and more. This guide describes how to set up and administer Oracle 
XML Publisher as well as how to use the Application Programming Interface to build 
custom solutions.

Guides Related to This Product

Oracle Process Manufacturing Cost Management User's Guide

The Oracle Process Manufacturing Cost Management application is used by cost 
accountants to capture and review the manufacturing costs incurred in their process 
manufacturing businesses. The guide describes how to set up and use this application.

Oracle Process Manufacturing Process Execution User's Guide

The Oracle Process Manufacturing Process Execution application lets you track firm 
planned orders and production batches from incoming materials through finished 
goods. Seamlessly integrated to the Product Development application, Process 
Execution lets you convert firm planned orders to single or multiple production 
batches, allocate ingredients, record actual ingredient usage, and then complete and 
close production batches. Production inquiries and preformatted reports help you 
optimize inventory costs while maintaining a high level of customer satisfaction with 
on-time delivery of high quality products. The Oracle Process Manufacturing Process 
Execution User's Guide presents overviews of the tasks and responsibilities for the 
Production Supervisor and the Production Operator. It provides prerequisite setup in 
other applications, and details the windows, features, and functionality of the 
application.

Oracle Process Manufacturing Quality Management User's Guide

The Oracle Process Manufacturing Quality Management application provides features 
to test material sampled from inventory, production, or receipts from external 
suppliers. The application lets you enter specifications and control their use throughout 
the enterprise. Customized workflows and electronic record keeping automate plans for
sampling, testing, and result processing. Compare specifications to assist in regrading 
items, and match customer specifications. Aggregate test results and print statistical 
assessments on quality certificates. Run stability testing with unrivaled ease. Several 
preformatted reports and inquiries help manage quality testing and reporting. The 
guide describes how to set up and use this application.

Oracle Process Manufacturing System Administration User's Guide

This guide provides information on the few tasks that are specific to Oracle Process 
Manufacturing. It offers information on performing Oracle Process Manufacturing file 
purge and archive, and maintaining such things as responsibilities, units of measure, 
and organizations.

Oracle Process Manufacturing Regulatory Management User's Guide
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Oracle Process Manufacturing Regulatory Management provides solutions for 
document management that help meet the FDA 21 CFR Part 11 and other international 
regulatory compliance requirements. Regulatory information management is facilitated 
by use of electronic signatures. Manage hazard communications by collaborating with 
Oracle partners to dispatch safety documents, attached printed documentation sets such
as the MSDS to shipments, and set up workflows to manage documentation revisions, 
approvals, and transmittals. The Oracle Process Manufacturing Regulatory Management 
User's Guide provides the information to set up and use the application.

Oracle Manufacturing Execution System for Process Manufacturing

Oracle Manufacturing Execution System (MES) for Process Manufacturing provides a 
seamless integration to product development and process execution applications for 
rapid deployment and tracking of procedures, work instruction tasks, and batch 
records. Set up and manage material dispensing operations and produce electronic 
batch records interactively with full electronic signature control, nonconformance 
management, and label printing routines. The Oracle Manufacturing Execution System for 
Process Manufacturing User's Guide delivers the information to set up and use the 
application.

Oracle Engineering User's Guide

This guide enables your engineers to utilize the features of Oracle Engineering to 
quickly introduce and manage new designs into production. Specifically, this guide 
details how to quickly and accurately define the resources, materials and processes 
necessary to implement changes in product design.

Oracle Inventory User's Guide

This guide describes how to define items and item information, perform receiving and 
inventory transactions, maintain cost control, plan items, perform cycle counting and 
physical inventories, and set up Oracle Inventory.

Oracle Bills of Material User's Guide

This guide describes how to create various bills of material to maximize efficiency, 
improve quality and lower cost for the most sophisticated manufacturing 
environments. By detailing integrated product structures and processes, flexible 
product and process definition, and configuration management, this guide enables you 
to manage product details within and across multiple manufacturing sites.

Oracle Work in Process User's Guide

This guide describes how Oracle Work in Process provides a complete production 
management system. Specifically this guide describes how discrete, repetitive, 
assemble–to–order, project, flow, and mixed manufacturing environments are 
supported.

Oracle Quality User's Guide

This guide describes how Oracle Quality can be used to meet your quality data 
collection and analysis needs. This guide also explains how Oracle Quality interfaces 
with other Oracle Manufacturing applications to provide a closed loop quality control 
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system.

Oracle Shipping Execution User's Guide

This guide describes how to set up Oracle Shipping to process and plan your trips, 
stops and deliveries, ship confirmation, query shipments, determine freight cost and 
charges to meet your business needs.

Oracle Purchasing User's Guide

This guide describes how to create and approve purchasing documents, including 
requisitions, different types of purchase orders, quotations, RFQs, and receipts. This 
guide also describes how to manage your supply base through agreements, sourcing 
rules and approved supplier lists. In addition, this guide explains how you can 
automatically create purchasing documents based on business rules through integration
with Oracle Workflow technology, which automates many of the key procurement 
processes.

Oracle interMedia User's Guide and Reference

This user guide and reference provides information about Oracle interMedia. This 
product enables Oracle9i to store, manage, and retrieve geographic location 
information, images, audio, video, or other heterogeneous media data in an integrated 
fashion with other enterprise information. Oracle Trading Community Architecture 
Data Quality Management uses interMedia indexes to facilitate search and matching.

Oracle Self–Service Web Applications Implementation Guide

This manual contains detailed information about the overview and architecture and 
setup of Oracle Self–Service Web Applications. It also contains an overview of and 
procedures for using the Web Applications Dictionary.

Installation and System Administration

Upgrading Oracle Applications

This guide describes the upgrade process and lists database and product-specific 
upgrade tasks.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to run
the AD utilities. This guide also provides information on maintaining the Oracle 
applications file system and database.

Oracle E-Business Suite Developer's Guide

This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components that
are needed to implement the Oracle Applications user interface described in the Oracle 
E-Business Suite User Interface Standards for Forms-Based Products. This manual also 
provides information to help you build your custom Oracle Forms Developer forms so 
that the forms integrate with Oracle Applications.



xviii

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications products
and how to apply this UI to the design of an application built by using Oracle Forms.

Other Implementation Documentation

Oracle Workflow Administrator's Guide

This guide explains how to complete the setup steps necessary for any product that 
includes workflow-enabled processes. It also describes how to manage workflow 
processes and business events using Oracle Applications Manager, how to monitor the 
progress of runtime workflow processes, and how to administer notifications sent to 
workflow users.

Oracle Workflow Developer's Guide

This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how to 
define and customize business events and event subscriptions.

Oracle Workflow User's Guide

This guide describes how users can view and respond to workflow notifications and 
monitor the progress of their workflow processes.

Oracle Workflow API Reference

This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a detailed 
description of database tables, forms, reports, and programs for a specific Oracle 
Applications product. This information helps you convert data from your existing 
applications, integrate Oracle Applications data with non-Oracle applications, and write
custom reports for Oracle Applications products. Oracle eTRM is available on My 
Oracle Support.

Integration Repository
 The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

 The Oracle Integration Repository is shipped as part of the Oracle E-Business Suite. As 
your instance is patched, the repository is automatically updated with content 
appropriate for the precise revisions of interfaces in your environment. 
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Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Understanding Product Development

This chapter introduces the fundamentals of Product Development like basic tasks, 
responsibilities, and process flows required to develop and maintain a product. It 
provides a basic understanding of navigation, workbenches, the status approval 
workflow, version control and how to add and edit status codes.

This chapter covers the following topics:

• About This Guide

• About Product Development

• Tasks and Responsibilities

• Understanding Navigation

• Understanding Workbenches

• Understanding the Status Approval Workflow

• Adding and Editing Status Codes

• Entering Status Details

• Finding a Status Code

• Understanding Version Control

About This Guide
This guide provides the following information for users of the Oracle Process 
Manufacturing (OPM) Product Development application:

• Overviews of tasks, responsibilities, and processes that comprise the Product 
Development application.

• Overviews of navigation, workbenches, status approval workflow, and version 
control.
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• Prerequisite setup in other applications.

• Setup required in the Product Development application, including parameters, 
profile options, security profiles, window security, and API security. Setup is also 
provided for formula classes, process operation classes, process routing classes, 
activities, laboratory organizations, technical parameters, and technical parameter 
sequences. Entry of technical data, technical classes, and technical subclasses is 
illustrated with specific examples.

• Procedures for formula management, including: setting up formula information, 
using formula phantoms, scaling formulas, defining and maintaining formulas and 
displaying summaries of formulas, products, byproducts and ingredients. Several 
windows let you display and edit formula components. Discussions of the 
Simulator and Optimizer provide details and examples of how to use computer-
aided formulation. Procedures are also provided for use of the Indented Bill of 
Materials report, the Formula Inquiry, and Formula Analysis options.

• Procedures for process operation management, including: defining and maintaining
process operations, activities, and resources, finding an operation, displaying 
process operation summaries, entering operation activity details and activity 
resource details, displaying operation activity lines, and, editing resource lines.

• Procedures for routing management, including: defining and maintaining routings, 
finding a routing, using routing summaries, entering routing details, displaying 
routing step line summaries, editing routing step lines, entering routing step 
dependencies and, displaying and editing theoretical process loss.

• Procedures for recipe management, including: defining and maintaining recipes, 
finding a recipe, displaying recipe summaries, understanding step quantity 
calculations, entering recipe details, entering recipe organization details, entering 
multi-record validity rules, editing validity rules, and displaying the recipe step 
and material association. Procedures are also provided for using the Recipe 
Designer.

• Procedures for mass search and replace, including: understanding search and 
replace, mass search and replace security, performing a search and replace, and 
using the Replace Results window. Additional procedures are provided for item 
substitutions.

• Procedures for least cost formulation, including entering a formulation specification
with requirements for material, composition, and technical aspects of a the 
formulation. Use of least cost formulation is illustrated with examples that outline 
the procedure to generate and optimize a formula.

Depending on your system security profile, it is possible you do not have access to all of
the windows and functions described in this guide. If you do not see a menu option 
described, and you need to access it, contact your system administrator.
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About Product Development
Reducing time to market is one of the most important objectives in developing a 
successful product. Research shows that one of the strongest drivers for on time 
product delivery is the use of a cross-functional, dedicated, and accountable team. To be
successful, the team needs a strong leader and top management support. Oracle Process
Manufacturing Product Development delivers a seamless, development environment 
that helps your team:

• Reduce time to market by using a solid framework that manages recipes from 
concept through production.

• Expand the enterprise by strengthening relationships with vendors and customers.

• Share project information and collaborate globally using the Internet.

• Manage quality processes proactively.

• Streamline production efficiencies.

Product Development enhances product consistency and reduces the costs associated 
with creating and modifying formulas by letting you adapt to different research and 
development environments. You can manage many laboratory organizations and 
support varying product lines throughout the organization. You can characterize and 
simulate the technical properties of ingredients and their effects on formulas. You can 
optimize formulations before beginning expensive laboratory test batches. Product 
Development coordinates each development function and enables a rapid, enterprise-
wide implementation of new products in your plants.

By managing a recipe from its inception through production you can reduce the overall 
product development life cycle time. Recipes account not only for ingredient usage, but 
also for quality characteristics of those ingredients, costing implications of any alternate 
materials or processes, specific requirements of customers, corporate manufacturing 
standards, and regulatory compliance issues. Product Development offers a single, 
integrated, secure formulation environment. Formulators and Process Engineers can 
collaborate in the development and maintenance of new and existing products using a 
workbench. The workbench is a job specific role that enables rapid definition and easier 
maintenance of recipe components. Workbenches increase formula usage flexibility to 
streamline the overall production process.

Tasks and Responsibilities
One of the most challenging aspects of Product Development is effective information 
transfer. Each job role must collaborate at various points throughout the product 
development cycle.

The following is representative of the work breakdown structure required to develop a 
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new product. It lists most of the key tasks and the job titles responsible for those tasks:

• Define product requirements.

• Product Development Manager

• Marketing Manager

• Customer

• Search for or copy a formula.

• Formulator

• Define ingredient parameters.

• Formulator

• Prototype the formula.

• Formulator

• Determine production feasibility of the prototype formula.

• Formulator

• Purchasing

• Determine formula reproducibility using laboratory scale batches.

• Formulator

• Tester

• Determine formula stability.

• Formulator

• Packaging Engineer

• Evaluate quality control specifications.

• Formulator

• Tester

• Create a routing.

• Packaging Engineer



Understanding Product Development    1-5

• Process Engineer

• Run pilot plant batches.

• Process Engineer

• Select the optimal recipe.

• Marketing Manager

• Customer

• Obtain field approvals.

• Plant Manager

• Process Engineer

• Assign effective date use.

• Formulator

• Process Engineer

Understanding Navigation

Navigating the Product Development Application
In addition to the standard menu and toolbar, a navigator tree provides a hierarchical 
display of the objects in a treelike framework.

• Node and Leaf

The higher level nodes in the navigator tree include forms and database objects. All 
other nodes, and the objects they contain, are indented to indicate that they belong 
to these higher level nodes. The terminal node is a leaf. The Product Development 
application uses Data Organizer tabs to group various objects such as recipes, 
formulas, routing and operations. Refer to Identifying Nodes and Tabs on the 
Navigator for specific nodes and tabs that are used in the Product Development 
application.

• Menu and Toolbar

Menu and toolbar components let you access all globally available functions.

• Data Organizer
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The Data Organizer groups objects on separate tabs. Each has a unique icon and its 
own tree hierarchy.

• Summary Views

Summary views display the highest level of business information. When you select 
any container on the Data Organizer navigator tree, the summary view can also list 
the contents of the container in a multi-record block.

• Detail Views

Detail views let you display and edit information.

For more information on navigation, see: Oracle E-Business Suite User's Guide

To navigate the Product Development application:
The following is a typical flow through the Product Development application Data 
Organizer navigator tree:

1. Open the appropriate Formulator or Process Engineer workbench. These are 
assigned by the System Administrator.

2. Click the region that contains the object type of interest. For example, the Process 
Engineer workbench includes these tabs:

• Formula

• Recipe

• Routing

• Operation

3. Select the appropriate View By field to sort and group records. View By fields for 
Formula include:

• Formula

• Class

• Status

• Owner

• Laboratory

• Product
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• Plant

• Status

4. Use one of the following methods to find the appropriate object:

• Expand or collapse entries in the hierarchical Data Organizer tree.

• Perform a Find operation from the View menu, choose the appropriate object 
from the results, and optionally, save the object in a Personal or Public folder. 
Optionally, use the right-click feature to perform a Find operation.

5. Use one of the following methods to show selected object Details:

• Select the object in the Summary view, and click Details.

• Select the top node of an expanded object on the navigator tree, and choose 
New from the File menu.

• Select the top node of an expanded object on the navigator tree, and right-click. 
Choose New from the right-click menu.

6. Double-click an expanded node in the Data Organizer until you reach the terminal 
or leaf object. When you click this object, it opens.

7. Perform actions on the selected object. Navigate from the Detail views to other 
related items of interest.

8. Use the right-click menu to copy objects from the navigator tree nodes and paste 
them into your personal shortcuts. You can retrieve these objects without the need 
to find them by methods previously described.

Identifying Nodes and Tabs on the Navigator Tree:
The following discussion and graphic identify and explain each of the nodes and tabs 
that display on the navigator tree.

• 1 is a Routing node. It identifies a Routing on the Navigator.

• 2 is the Routing tab. Click it to display all Routing available to your responsibility.

• 3 is an Operation node. It identifies an Operation on the Navigator.

• 4 is the Operation tab. Click it to display all Operations available to your 
responsibility

• 5 is an Activity node. It identifies an Activity on the Navigator.
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• 6 is a Resource node. It identifies a Resource on the Navigator.

• 7 is a Formula node. It identifies a Formula on the Navigator.

• 8 is the Formula tab. Click it to display all Formulas available to your responsibility.

• 9 is a Product node. It identifies a Product on the Navigator.

• 10 is a By-Product node. It identifies a By-Product on the Navigator.

• 11 is an Ingredient node. It identifies an Ingredient on the Navigator.

• 12 is a Recipe node. It identifies a Recipe on the Navigator.

• 13 is the Recipe tab. Click it to view all Recipes available to your responsibility.

• 14 is an Owner node. It identifies an Owner on the Navigator.

• 15 is a Class node. It identifies a Class on the Navigator.

• 16 is a Status node. It identifies a Status on the Navigator.

Understanding Workbenches
The workbench is a complete product, production, technical and cost profiling tool to 
model a new product to meet initial product specifications rapidly.

You can use the workbench to perform what if analyses to facilitate the overall 
formulation process. Since new products are developed in the laboratory, the list of 
ingredients and products are recorded in the laboratory formula. Once the development
is complete, production and cost formulas are required to manufacture and assign a 
cost to the product. With the Formulator Workbench, laboratory and production 
formulas are differentiated by a change in Status. Changing the status of an 
experimental formula for use by production, costing, or a Material Safety Data Sheet 
(MSDS) replaces the previous Formula upload and download functions with a new 
business process.



Understanding Product Development    1-9

You can simplify the entire process of initiating and monitoring the development of a 
new product by coupling the workbench capability to a Status Approval Workflow.

To display the Process Engineer Workbench:
1. Navigate to the Product Development Workbench.

2. Expand Routings to view a summary of routings available to your responsibility. 
Expand Operations, Formulas, and Recipes available to your responsibility as 
appropriate.

3. Expand Personal Shortcuts to view a summary of all of the personal shortcuts 
available to your responsibility.

4. Expand Public Shortcuts to view a summary of all public shortcuts available to your
responsibility.

To display the Formulator Workbench:
1. Navigate to the Formulator Workbench.

2. Expand Formulas to view a summary of formulas available to your responsibility. 
Expand Recipes, Routings, and Operations available to your responsibility as 
appropriate.

3. Expand Personal Shortcuts to view a summary of all of the personal shortcuts 
available to your responsibility.

4. Expand Public Shortcuts to view a summary of all public shortcuts available to your
responsibility.

Understanding the Status Approval Workflow
When the Status Approval Workflow is activated, recipes, formulas, routings, 
operations, and validity rules require a series of approvals that result in reassigning 
their statuses through a predefined approval process. Laboratory Approval is optional 
in this workflow.

Individual tasks are included in each topic to show you how to manage the approval 
workflow process.

Understanding Workflow Processes
Use Oracle Workflow to automate and continuously improve business processes by 
routing information according to a set of business rules. Transmit this information to 
individuals both inside and outside your enterprise as needed.



1-10    Oracle Process Manufacturing Product Development User's Guide

Setting Up Approvers
The Status Approval Workflow routes information to an approver. An approver is an 
individual or a group. Any individual associated with that approver can act on the 
notification. Each notification includes a message with information needed to make a 
decision. Some possible responses are also included. The Status Approval Workflow 
interprets each response and moves on to the next workflow activity.

Setting Up Workflow Processes
A workflow process starts when an application calls a set of Oracle Workflow Engine 
Application Program Interfaces (APIs). The workflow itself is depicted as a process 
diagram containing icons that represent activities. The process contains several 
workflow steps that include approvers, activities, and decision trees needed to complete
the workflow.

Delivering Electronic Notifications
Oracle Workflow notifies people of items awaiting their attention. This is done through 
e-mail, a browser link, or the Notification Summary window.

Setting Up the Status Approval Workflow
Set up the Status Approval Workflow. Contact your System Administrator if you are 
not sure that this is set up.

Your System Administrator must set up the following windows:

• Workflow Process Activation to define the approval processes that use the generic 
workflow process configuration framework. This window enables or disables the 
approval process in the database instance.

• Workflow Process Configuration Framework to define the configuration 
parameters for each approval process. These configuration parameters customize 
the approval process. For example, if a configuration parameter is specified as 
organization, the approval process for an organization could be enabled or 
disabled.

• Workflow Activity Approval Configuration Framework to define the 
configuration parameters for each approval process activity. These configuration 
parameters customize the behavior of an activity. For example, if the configuration 
parameter is specified as organization, then the approval process activity behavior 
could be customized for an organization.

• Workflow Process Configuration to customize the approval process behavior at a 
customer site. Approval can be required based on a business process requirement. 
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This window lets you enable or disable the approval process based on parameters 
defined in the Approval Process Configuration Framework.

• Workflow Activity Configuration to customize the approval process activities 
behavior based on configuration parameters defined in the Approval Process 
Activity Configuration Workflow. Enable or disable an activity and define an 
approver if the activity requires approval.

If the workflow does not start, the Workflow Activation window can be set to 
Deactivate. Contact your System Administrator to determine if this window and all 
appropriate triggers are set properly.

Note: Product Development Workflows do not function if seed data is 
changed.

Enabling the Status Approval Workflow
Enable the Status Approval Workflow. Once it is set up and operating, the workflow is 
activated by changing the Status of a recipe, formula, routing, operation, or validity rule
from a status of New to any of the other available status.

Adding and Editing Status Codes to the Status Approval Workflow
If you modify or delete any of the predefined status codes that are supplied with this 
application, then the Status Approval Workflow does not run as described in this 
documentation. You can add or edit status codes. See: Adding and Editing Status 
Codes, page 1-13

Running the Status Approval Workflow
When any status controlled entity is created, the workflow runs as follows:

1. Upon creation the default Status is assigned to the entity.

2. If you choose Change Status from the Actions menu and then select Approved for 
Laboratory Use, the workflow changes Status to Request Approval for Laboratory 
Use. Once approved, Status changes to Approved for Laboratory Use.

3. If you choose Change Status from the Actions menu and then select Approved for 
General Use, the workflow changes Status to Request Approval for General Use. 
Once approved, Status changes to Approved for General Use.

4. You can assign the Status Obsolete or Archived.

5. An Approved for Laboratory Use status can be assigned these statuses:
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• On Hold

• Obsolete or Archived

6. An Approved for General Use status can be assigned these statuses:

• On Hold

• Frozen

• Obsolete or Archived

7. A Pending Approval for Laboratory status or a Pending Approval for General Use 
status can be assigned a status of Obsolete or Archived.

8. Formulas, routings, operations, recipes, or validity rules that:

• Fail the approval of Pending Approval for Laboratory Use Status are assigned 
the Status Revise for Laboratory Use.

• Fail the approval of Request Approval for General Use Status are assigned the 
Status Revise for General Use.

See: Generating a Recipe and Validity Rule Automatically, page 6-33.

The following graphic depicts the previously described Status Approval Workflow:
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Disabling the Status Approval Workflow
The System Administrator must disable the Status Approval Workflow. If the workflow
is disabled, you can still change the Status of a recipe, formula, routing, operation, or 
validity rule. However, the Status change does not initiate the Status Approval 
Workflow.

Adding and Editing Status Codes
You can add to or edit the predefined status codes. Do not delete predefined status 
codes since this could result in unexpected behavior of the application.
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To add a new status code:
1. Navigate to the Status Codes window.

2. Choose New from the File menu. A new row appears for the new status code.

3. Enter a new Status Code number. The number entered is sorted into ascending 
order with the other status codes when you save and reopen this window. Codes 
entered between any two predefined codes, such as 101 to 199, or 201 to 299 are 
included in the workflow associated with the predefined status code with the same 
first digit. For example, if you enter the code 110, then it becomes part of the 
workflow associated to Code 100. If you enter a code number 699, then it becomes 
part of the workflow associated to Code 600. Predefined status codes are displayed 
in the table at the end of this topic. Required.

4. Enter a brief explanation of the new status code in the Description field. Required.

5. Enter Meaning as the information to display on the Status field. Required.

6. Select Enable Version if the status code entered is version controlled.

7. Save your work.

8. Optionally, click Details to enter status details as described in the "Entering Status 
Details" task.

The following are the required predefined status codes:

Code Meaning Description Version Enabled

100 New Formulation stage. 
Can make changes 
at any time, 
assuming security 
access.

Yes

200 Request Approval 
for Laboratory Use

Submitted for 
approval of use in 
Laboratory runs.

No

300 Revise for 
Laboratory

Approval has failed 
and rework is 
required.

No
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Code Meaning Description Version Enabled

400 Approved for 
Laboratory Use

Can be used in 
Laboratory batches 
and cost rollups for 
Laboratory.

Yes

500 Request Approval 
for General Use

Submitted for final 
approval.

No

600 Revise for General 
Use

Approval has failed 
and rework is 
required.

Yes

700 Approved for 
General Use

Can be used for 
production batches, 
cost rollups.

Yes

800 On Hold Object cannot be 
used until status is 
changed.

No

900 Frozen Prevents further 
changes to object 
and any dependent 
data. Object can still 
be used.

No

1000 Obsolete/Archived Object can no longer 
be used unless status
is changed.

No

To edit an existing status:
1. Navigate to the Status Codes window.

2. Edit Description to change the explanation of the status code.

3. Edit Meaning to change the information that displays on Status field.

4. Select Enable Version if the status code entered is version controlled. Otherwise, 
deselect this indicator.

5. Click Details. TheStatus Details window displays.
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6. Edit the following fields as required:

• Target Status to change the code that displays as the destination status on the 
Change Status window.

• Rework Status to change the destination for the listed status code when it is not 
accepted and must be reworked.

• Pending Status to change the destination of the listed status code when it enters
the approval workflow, and is pending approval.

Required.

7. Edit the Workflow Indicator by selecting:

• Enable or Disable Workflow to indicate the fields listed in the row enable or 
disable the workflow.

• Workflow Approval to indicate the fields listed in the row require workflow 
approval.

• No Workflow Approval to indicate the fields listed in the row do not require 
workflow approval. Required.

Required.

8. Click OK.

Entering Status Details
Use the Status Details window to enter a target status for a new status code. You can 
optionally enter rework status, pending status, and assign a workflow indicator.

To enter status details:
1. Navigate to the Status Details window.

2. Enter a Target Status for the new status code. This is the code that displays as the 
destination status on the Change Status window. You can enter several destinations
for each status code on separate lines. Required.

3. Enter a Rework Status for the new status code. This code defines the destination for 
the listed status code when it is not accepted and must be reworked.

4. Enter a Pending Status for the new status code. This code defines a destination of 
the listed status code when it enters the approval workflow and is pending 
approval.
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5. Select one of the following as Workflow Indicator:

• Enable or Disable Workflow to indicate that the fields listed in the row enable 
or disable the workflow.

• Workflow Approval to indicate that the fields listed in the row require 
workflow approval.

• No Workflow Approval to indicate that the fields listed in the row do not 
require workflow approval.

6. Click OK.

Finding a Status Code
Use the Find Status Codes window to find a status code by code number, description, 
version enabled, or mark for purge status.

To find a status code:
1. Navigate to the Find Status Codes window.

2. Enter one or more of the following fields to narrow your search:

• Status Code to find a specific status code number.

• Description to find a specific status code description.

• Version Enabled to find the status codes that enable version control when a 
modification is made to an operation, routing, formula, recipe, or validity rule.

• Mark For Deletion as Yes to find status codes marked for deletion. Enter No to 
bypass these status codes.

3. Click Find.

4. Click New to enter a new status code.

Understanding Version Control
Some businesses require version control to generate an audit trail. By monitoring 
version changes you define rules for modifying recipes, formulas, routings, operations, 
and quality specifications. The Product Development Version Control function lets you 
determine if an existing version can be modified, or if a new version must be created. 
Product Development lets you:
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• Force the creation of new versions so that transaction sources stay intact.

• Deliver a combination of forced version creation and no version control.

• Provide no version control.

These decisions are made at the organization level with proper assignment of user 
responsibilities. Changes to a formulas or routings creates new versions when the 
current status is checked for versioning.

Version control is called:

• If you add or change edit text data on any Product Development window.

• If you add or change data on any of the tab regions on the Recipe Organization 
Details window, with the exception of the Validity Rules tab.

Version control is not called:

• For status changes on any Product Development window.

• For mark for purge or undelete on any Product Development window.

• If you add or change validity rule related information on the Recipe Details 
window.

• If you add or change information on the Recipe Step Material Association window.

• If you add or change routing step dependency information on the Process Routing 
Details window.

Setting Up Version Control at the Organization and Responsibility Level
Set up version control in the Product Development Parameters window. You must be 
associated with valid organizations to create transactions and perform certain functions 
in Product Development. You must be linked to appropriate responsibilities to access 
specific workbenches and application functions. Here is an example of how to set up 
version control:

Users are defined as
• ABC for Formulator ABC

• JKL for Formulator JKL

• XYZ for Formulator XYZ

Organizations are
• OA for Oracle Applications
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• OPM for Oracle Process Manufacturing Company, consisting of:

• PLT1 for Plant1

• PLT2 for Plant2

• PLT3 for Plant3

Responsibilities are:
• Formulator for PLT1

• Formulator for PLT2

• Formulator for PLT3

Responsibility-Organization Access are:
• Formulator PLT1 for PLT1

• Formulator PLT2 for PLT2

• Formulator PLT3 for PLT3

User-Responsibility Associations are:
• ABC for Formulator PLT1

• JKL for Formulator PLT2

• XYZ for Formulator PLT3

Parameter Settings
Formula Version Control is set to Yes on the Product Development Parameters window 
for the responsibility of Formulator PLT1 in an appropriate context organization.

At logon, User ABC is presented with a list of responsibilities for Formulator PLT1. 
Menus and windows associated with the Formulator responsibility are accessible to 
User ABC, and they are configurable. Specific windows and functions can be enabled or
disabled within menus and responsibilities. The organization association for User ABC 
is limited to PLT1, and the Formula Version Control parameter is enabled for this 
responsibility. Any modifications made to a formula during the session for User ABC 
requires a new version of a formula for PLT1.

If User ABC changes to a responsibility where Version Control is set to No, then 
modifications to a formula in that session does not require a new formula version to be 
created.

If User ABC changes to a responsibility where Version Control was set to Optional, then
modifications to a formula in that session advises User ABC that Version Control is 
optional. Prior to saving a change, User ABC is asked whether or not to change the 
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existing formula version.

Setting Up Version Control at the Attributes Level
You can set up and enable version control attribute sets at the Formula, Operation, 
Routing, and Recipe levels. You can then use these version control attribute sets to 
create a new formula, operation, routing, and recipe, with a different version number 
when you modify any of the attributes that are configured to be version controlled in 
the Version Control Attributes user interface.

See: Setting Up Version Control Attribute Sets, page 2-39.
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2
Setting Up

Perform the following tasks to set up this application.

This chapter covers the following topics:

• Setting Up Other Applications

• Setting Up Parameters

• Finding Parameters

• Setting Up Profile Options

• Setting Up Security Profiles

• Setting Up Windows Security

• Setting Up Formula Classes

• Setting Up Process Operation Classes

• Setting Up Process Routing Classes

• Setting Up Activities

• Setting Up Laboratory Organizations

• Setting Up Technical Parameters

• Setting Up Technical Parameter Sequences

• Entering Item Technical Data

• Setting Up Technical Classes and Subclasses

• Setting Up Version Control Attribute Sets

Setting Up Other Applications
You will need to perform some required setup in other applications. Set up these 
prerequisites prior to running the application. Refer to the details of these setup 
requirements provided in the individual application user guides. Depending on your 
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requirements, there may be OPM related or additional setup required.

Setting Up in Oracle Inventory 
Set up the following in the Oracle Inventory application.

• Inventory Organizations*

• Organization Parameters*

• Subinventories*

• Locators*

• Unit of Measure Classes*

• Units of Measure*

• Unit of Measure Conversions

• Master Items

• Organization Items

Select the Recipe Enabled indicator on the Process Manufacturing tab to use 
organization items in formulas and recipes.

(*Required)

See: Oracle Inventory User's Guide

Setting Up in OPM Cost Management
Set up the following in the OPM Cost Management application.

• Cost analysis codes

• Cost calendar

See: Oracle Process Manufacturing Cost Management User's Guide

Setting Up in OPM Process Planning
Set up the following in the OPM Process Planning application.

• Resources

• Plant Resources

See:Oracle Process Manufacturing Process Planning User's Guide
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Setting Up in Oracle Applications System Administrator
Set up the following in the Oracle E-Business Suite System Administrator's application.

The Recipe Designer uses a Thin Client Framework (TCF) technology. Two profile 
options are set up during the implementation:

• TCF:HOST

• TCF:PORT

See:

Setting User Profiles,Oracle E-Business Suite Setup Guide.

Profile Categories, Oracle E-Business Suite Setup Guide.

Setting Up Parameters
Set up Oracle Process Manufacturing (OPM) Product Development parameters in the 
Product Development Security Manager responsibility. You can set up parameters for 
new organizations, or query and modify parameters for existing organizations. 
Parameter values can vary by organization. These parameters control various functions 
in the Product Development application. For example, if version control for formulas is 
enabled for organization PR1, then at the point of saving a formula, the application 
checks the formula organization to determine whether or not to apply version control 
rules. Organization PR2 can have a different setting for formula version control.

To enter OPM Product Development parameters:
1. Navigate to the Product Development Parameters window.

2. Enter Organization as the context inventory organization.

3. Organization Type is:

• Plant for a manufacturing facility.

• Laboratory for a research or lab facility.

Formula
4. Enter Allow Zero Ingredient Quantity as:

• No to specify you cannot enter ingredients with zero quantity. An error 
displays when a zero ingredient quantity is entered. Default.

• Yes to specify possible entry of a zero ingredient quantity.
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• Allow with warning to specify entry of a zero ingredient quantity with a 
warning message displayed. If you accept the warning, then you can proceed.

5. Enter Automatic Product Quantity Calculation as:

• No to specify that formula product quantities are entered manually. Default.

• Yes to specify that formula product quantities are calculated automatically 
based on the ingredients contributing to yield except for byproducts and 
distributed proportionally based on the product percentages. It can be changed 
at the formula level.

6. Enter Byproduct Active as:

• Yes to access the By-Products window. Default.

• No to restrict access the By-Products window.

7. Enter Default Consumption/Yield Type as:

• Automatic By Step for automatic consumption of ingredients and automatic 
yield of products and byproducts as each step is completed. Default.

• Manual for ingredients to default to manual consumption and inserted 
products and byproducts to default to manual yield.

• Incremental for inserted items to default to incremental consumption or 
incremental yield.

8. EnterDefault Formula Status as:

• New to make changes at any time, assuming you have security access. Default.

• Approved for Laboratory Use for use in laboratory batches and cost rollups for 
the laboratory.

• Approved for General Use for use in production batches.

• On Hold to specify the object cannot be used until the status is changed.

• Frozen to prevent any further changes to the object and any dependent data.

• Obsolete/Archived to specify the object can no longer be used unless the status 
is changed.

9. Enter Formula Security for Lot Genealogy as:
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• No to specify formula security rules are not enforced in lot genealogy. Default.

• Yes to specify formula security rules are enforced in lot genealogy.

10. Enter Mass UOM as:

• MASS to specify use of the mass unit of measure type when item quantities are 
converted to a common unit of measure for scaling, theoretical yield, and total 
output quantity. Default.

• Another valid unit of measure type for conversion purposes. Set up this unit of 
measure type.

11. Enter Material Release Type as:

• Automatic when ingredients quantities are consumed automatically. 

• Manual when ingredient quantities are consumed manually.

• Incremental when ingredient quantities are backflushed by incremental 
backflushing.

• Automatic by Step when ingredient quantities are consumed automatically as 
the step is released.

12. Enter Version Control as:

• No to specify version control is not active for formulas. Changes can be made to
an existing formula without the need to change its version. Default.

• Yes to specify full version control is active for formulas. Changes made to a 
formula require a new version. This excludes changes to formula status, mark 
for purge, and the Undelete functionality.

• Optional to specify version control is discretionary for formulas. You can create 
a new version when you update an existing version.

13. Enter Version Control Attribute Set as a version control attribute set you have 
created for Formula using the Version Control Attributes user interface. Note that 
the list of values will display only the corresponding list of version control attribute 
sets you created for the Formula entity. See: Setting Up Version Control Attribute 
Sets, page 2-39.

14. Enter Volume UOM as:

• VOL to specify use of the volume unit of measure type when item quantities are
converted to a common unit of measure for scaling, theoretical yield, and total 
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output quantity.

• Another valid unit of measure type for conversion purposes. Set up this unit of 
measure type.

15. Enter Yield UOM as:

• MASS to specify use of the mass unit of measure type when item quantities are 
converted to a common unit of measure for scaling, theoretical yield, and total 
output quantity. Default.

• VOL to specify use of the volume unit of measure type when item quantities are
converted to a common unit of measure for scaling, theoretical yield, and total 
output quantity.

• Another valid unit of measure type for conversion purposes. Set up this unit of 
measure type.

Operation
16. Enter Default Operation Status as:

• New to make changes at any time, assuming you have security access. Default.

• Approved for Laboratory Use for use in laboratory batches and cost rollups for 
the laboratory.

• Approved for General Use for use in production batches.

• On Hold to specify the object cannot be used until the status is changed.

• Frozen to prevent any further changes to the object and any dependent data.

• Obsolete/Archived to specify the object can no longer be used unless the status 
is changed.

17. Enter Version Control as:

• No to specify version control is not active for operations. Changes can be made 
to an existing operation without the need to change its version. Default.

• Yes to specify full version control is active for operations. Changes made to an 
operation require a new version. This excludes changes to operation status, 
mark for purge, and the Undelete functionality.

• Optional to specify version control is discretionary for operations. You can 
create a new version when you update an existing version.
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18. Enter Version Control Attribute Set as a version control attribute set you have 
created for Operation using the Version Control Attributes user interface. Note that 
the list of values will display only the corresponding list of version control attribute 
sets you created for the Operation entity. See: Setting Up Version Control Attribute 
Sets, page 2-39.

Routing
19. Enter Default Routing Status as:

• New to make changes at any time, assuming you have security access. Default.

• Approved for Laboratory Use for use in laboratory batches and cost rollups for 
the laboratory.

• Approved for General Usefor use in production batches.

• On Hold to specify the object cannot be used until the status is changed.

• Frozen to prevent any further changes to the object and any dependent data.

• Obsolete/Archived to specify the object can no longer be used unless the status 
is changed.

20. Enter Step Release Type as:

• Automatic to indicate that the step is automatically released or completed when
subsequent steps are released or completed.

• Manual to indicate that the step is released manually.

21. Enter Enforce Step Dependency as:

• No to specify step dependency is not enforced. Default.

• Yes to specify step dependency is enforced.

22. Enter Version Control as:

• No to specify version control is not active for routings. Changes can be made to 
an existing routing without the need to change its version. Default.

• Yes to specify full version control is active for routings. Changes made to the 
routing header or organization specific details require a new version.

• Optional to specify version control is discretionary for routings. You can create 
a new version when you update an existing version.
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23. Enter Version Control Attribute Set as a version control attribute set you have 
created for Routing using the Version Control Attributes user interface. Note that 
the list of values will display only the corresponding list of version control attribute 
sets you created for the Routing entity. See: Setting Up Version Control Attribute 
Sets, page 2-39.

Recipe
24. Enter Default Recipe Status and Default Validity Rule Status as follows:

• New to make changes at any time, assuming you have security access. Default.

• Approved for Laboratory Use for use in laboratory batches and cost rollups for 
the laboratory.

• Approved for General Use for use in production batches.

• On Hold to specify the object cannot be used until the status is changed.

• Frozen to prevent any further changes to the object and any dependent data.

• Obsolete/Archived to specify the object can no longer be used unless the status 
is changed.

25. Enter Process Instruction Paragraph as:

• NULL if the process instruction paragraph is not used. Default.

• A user-defined paragraph code to define process instruction entry using the 
standard Text Editor functionality. Process instructions entered in the Recipe 
Designer are stored against this paragraph code.

26. Enter Recipe Type as:

• Master to indicate that the default recipe type is process cell specific. Master 
recipes define exactly how a product is made in a specific process 
manufacturing cell.

• Site to indicate that the default recipe type is at the site level. There is one site 
recipe for each site that makes the product, or some portion of the product. A 
site recipe has the same structure as a general recipe, but may be modified for 
the local language and unit of measure. It may also be modified to take into 
account local material availability, or it may only define a part of the general 
recipe that is actually performed on the site. 

• General to indicate that the default recipe type is one general recipe for each 
specific product variation made by a company. It defines, in an equipment 
independent manner, the material and process dependencies required to make 
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a product. The general recipe is usually created during or after the pilot plant 
scaleup of a research and development recipe. 

27. Enter Version Control as:

• No to specify version control is not active for recipes. Changes can be made to 
an existing recipe without the need to change its version. Default.

• Yes to specify full version control is active for recipes. Changes made to the 
recipe header or organization specific details require a new version. This 
excludes changes to validity rules, step material association, recipe step 
quantities, customers, recipe status, mark for purge, and the Undelete 
functionality.

• Optional to specify version control is discretionary for recipes. You can create a 
new version when you update an existing version.

28. Enter Version Control Attribute Set as a version control attribute set you have 
created for Recipe using the Version Control Attributes user interface. Note that the 
list of values will display only the corresponding list of version control attribute sets
you created for the Recipe entity. See: Setting Up Version Control Attribute Sets, 
page 2-39.

Substitution
29. Enter Default Substitution Status as:

• New to make changes at any time, assuming you have security access. Default.

• Approved for Laboratory Use for use in laboratory batches and cost rollups for 
the laboratory.

• Approved for General Use for use in production batches.

• On Hold to specify the object cannot be used until the status is changed.

• Frozen to prevent any further changes to the object and any dependent data.

• Obsolete/Archived to specify the object can no longer be used unless the status 
is changed.

30. Enter Version Control as:

• No to specify version control is not active for recipes. Changes can be made to 
an existing substitution list without the need to change its version. Default.

• Yes to specify full version control is active for substitution lists. Changes made 
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to the item substitution list or organization specific details require a new 
version. This excludes changes to status, mark for purge, and the Undelete 
functionality.

• Optional to specify version control is discretionary for substitution lists. You 
can create a new version when you update an existing version.

Laboratory
31. Enter Costing Source Organization as the default organization for least-cost 

formulation. All process-enabled inventory organizations are available.

32. Enter Version Control as:

• No to specify version control is not active for formulation specifications. 
Changes can be made to an existing formula specification without the need to 
change its version. Default.

• Yes to specify full version control is active for formulation specifications. 
Changes made to the formula specification header or organization specific 
details require a new version.

• Optional to specify version control is discretionary for formulation 
specifications. You can create a new version when you update an existing 
version.

Finding Parameters
You can find Oracle Process Manufacturing (OPM) Product Development parameter set
for a local or global organization using the Find Default Configuration Parameters 
window.

To find Product Development parameters:
1. Navigate to the Find Product Development Parameters window.

2. Enter any of the following to narrow your search:

• Organization name.

• Description of the organization.

• Organization type as Plant or Laboratory.

3. Click Find.
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Setting Up Profile Options
The following table lists the profile options for Oracle Process Manufacturing Product 
Development:

Profile Option Description Default Options Recommended 
Level Change

GMD: 
Automatic 
Generation Of 
Step 
Dependency 
Attributes

This profile 
option 
determines 
whether step 
dependency 
attributes are 
generated 
automatically in 
the Routing 
Designer

No No

Yes

Site

GMD: 
Automatic Step 
Number 
Generation

This profile 
option 
determines 
whether to 
generate a step 
number 
automatically 
when adding a 
step in the 
Routing 
Designer 
window

No No

Yes

Site

GMD: Default 
Dependency 
Type

This profile 
option indicates 
the default 
dependency type
to use when step
dependency 
attributes are 
generated 
automatically

Lab A valid 
laboratory 
organization

Site
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GMD: Default 
Lab 
Organization

This profile 
option defines 
the default 
laboratory to be 
used in the OPM
Product 
Development 
application

Lab A valid 
laboratory 
organization

Site

GMD: Density This profile 
option sets the 
literal that 
displays for the 
Density technical
parameter. Do 
not change this 
profile option

Density None Site

GMD: Designer 
Category Set

This profile 
option sets the 
categories that 
appear in the 
Item Master list 
on the Recipe 
Designer 
window

Blank A valid category 
set

Site

GMD: Designer 
Display New 
Item Window

This profile 
option displays 
the New Item 
window to add a
new item to a 
formula. When it
is set to No, the 
New Item 
window does 
not display

Yes No

Yes

Site

GMD: Display 
Step Qty In 
Routing Graph

This profile 
option is used to 
display the 
transfer 
percentage in the
Routing Step 
Dependency 
graph

Yes No

Yes

Site
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GMD: Display 
Transfer Pct in 
Routing Graph

This profile 
option is used to 
display the 
transfer quantity
in the Routing 
Step 
Dependency 
graph

Yes No

Yes

Site

GMD: Display 
Transfer Qty in 
Routing Graph

This profile 
option is used to 
display the 
transfer quantity
in the Routing 
Step 
Dependency 
graph

Yes No

Yes

Site
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GMD: Sample 
Closed Batches

This profile lets 
you specify 
whether WIP 
samples can be 
taken against 
closed batches. 
The Batch list of 
values in the 
Item Samples 
window displays
WIP, Completed,
and Closed batch
statuses, if the 
Source is WIP, 
according to the 
value you select 
for this profile.

Select Yes to 
enable the 
creation of 
samples for WIP,
Completed, and 
Closed batch 
statuses.

Select No to 
enable the 
creation of 
samples for WIP 
and Completed, 
but not Closed 
batch statuses.

No No

Yes

Site
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GMD: Technical 
Parameter 
Category Set

This profile 
option lets you 
aggregate a 
group of 
technical 
parameters for 
an item and 
organization 
combination. 
When you enter 
a valid category 
set, it displays as
the default 
category on the 
Technical 
Parameter 
Sequences 
window.

Blank A valid category 
set

Site

GMD: User 
Name for ALL

This profile 
option is the user
name that 
represents all 
users when 
creating a 
product 
development 
security profile. 
The GMD: User 
Name for ALL 
profile option is 
controlled at the 
site level, 
because it is the 
value that 
formula security 
uses to indicate 
that all users for 
an organization 
are given a 
certain level of 
access to 
formulas

Null A valid Oracle 
Applications 
user

Site
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GMD: Workflow
Timeout (in 
Days)

This profile 
option is used to 
calculate the 
time interval for 
sending 
reminder 
notifications to 
an approver. The
value entered is 
divided by four 
to determine the 
time interval for 
the reminder 
notifications in 
days; only four 
notifications are 
sent. If this value
is null, then the 
application does 
not send a 
reminder 
notification to 
the approver. 
For example, if 
the value is set to
eight, then the 
approver gets a 
reminder 
notification at 
two-day 
intervals. After 
the fourth 
notification, the 
initiator is sent a 
notification that 
the approver is 
not responding.

None Positive whole 
number of 
calendar days for
the workflow 
timeout.

Site
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GMD: Update 
On-hand Status 
in All Locators

This profile 
option controls 
whether the final
sample group 
disposition can 
update the status
of on-hand lot 
inventory in all 
locators or only 
the locator 
specified at the 
time of sample 
creation. If set to 
the default 
value, Yes, this 
profile option 
allows the 
material status 
change across all
locators where 
on-hand 
inventory exists 
for the lot. If set 
to No, it will 
strict the 
material status 
change to the 
locator where 
the sample is 
created and on-
hand inventory 
exists for the lot.

Yes No

Yes

Site

Setting Up Security Profiles
Depending on your security profile, every function may not be available to you. Contact
your Product Development Security Manager or Product Development Security Profile 
Manager if you require access to this information.

See: Setting Up Windows Security, page 2-17

See: Oracle Process Manufacturing Product Development, Formula Security, Part No. E11065-
01.

Setting Up Windows Security
The System Administrator or Product Development Security Manager controls editing 
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privileges by assigning you to the owner organizations you need to access. Each of the 
windows listed below validates your access privileges. If you do not have access to the 
Owner Organization, then the data on the window is restricted to query only. 
Otherwise, data can be queried and edited.

Recipe editing privileges also restrict changes to existing step material associations. Edit
text associated to routings, operations, recipes, and recipe validity rules can be 
restricted so that the associated edit text is query only. You can only update global and 
local recipe validity rules when they are granted access to the recipe owning 
organization.

In addition to formula security, following are windows that validate your access 
privileges:

• Process Operation Details Activities (GMDOPRED.fmb)

• Operation-Activity Line (GMDOACLN.fmb)

• Operation Activity Resource Line (GMDORALN.fmb)

• Routing Details (GMDROTED.fmb)

• Routing Step Line (GMDRSTLN.fmb)

• Routing Step Dependencies (GMDSDPED.fmb)

• Recipe Step/Material Association (GMDRSAED.fmb)

• Recipe Details (GMDRCPED.fmb)

• Recipe Organization Details (GMDRCOED.fmb)

• Recipe Validity Rules (GMDRVRED.fmb and GMDRVRSM.fmb)

• Routing Designer (GMDRTDSG.fmb)

• Routing Properties (Routing Designer) (GMDRTDSG.fmb)

• Routing Preferences (Routing Designer)

• Recipe Designer (GMDRCDSG.fmb)

• Recipe Properties (Recipe Designer) (GMDRCDSG.fmb)

• Recipe Preferences (Recipe Designer)

• Step Properties (Routing Designer) (GMDRTDSG.fmb)

See: Setting Up Security Profiles, page 2-17
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See: Oracle Process Manufacturing Product Development, Formula Security, Part No. E11065-
01.

Setting Up Formula Classes
Formula Classes group formulas with similar characteristics and requirements for 
reporting purposes. For example, use a formula class to classify all formulas for 
ACRYLIC paints, or to classify all formulas for ORGANIC paints. Food seasoning 
formulas could be grouped under a SEASONINGS class. Specify the formula class in 
the Formula Details window. Defining formula classes is optional. Formula classes are 
set up using the Formulator responsibility.

Analyze all formulas for common properties that are used to classify them.

To set up formula classes:
1. Navigate to the Formula Classes window.

2. Enter the Class code that identifies formulas with similar characteristics or 
requirements. Required.

3. Enter a brief Description of the classification you are adding. Required.

Additional Information: Choose Find from the View menu to 
display the Find Formula Classes window. Enter appropriate fields 
to narrow your search, and click Find.

Setting Up Process Operation Classes
Group operations with similar characteristics and requirements for reporting purposes. 
For example, set up classes for MIXING, HEATING, DRYING, or GRINDING. Defining
process operation classes is optional.

Analyze all operations for common properties that are used to classify them.

To set up process operation classes:
1. Navigate to the Process Operation Classes window.

2. Enter the Class code that identifies operations with similar characteristics or 
requirements. Required.

3. Enter a brief Description of the classification you are adding. Required.

Additional Information: Choose Find from the View menu to 
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display the Find Process Operation Classes window. Enter 
appropriate fields to narrow your search, and click Find.

Setting Up Process Routing Classes
Routings are sequenced sets of operations performed in order to complete a production 
batch. It is useful to set up process routing classes to group process routings with 
similar characteristics and requirements for reporting purposes. Defining process 
routing classes is optional. UOM is required if the theoretical process loss is defined for 
the process routing class.

Analyze all process routings for common properties that are used to classify them.

To set up process routing classes:
1. Navigate to the Process Routing Classes window.

2. Enter the Class code that identifies routings with similar characteristics or 
requirements. Required.

3. Enter a Routing Class Description for the Class code entered. Required.

4. Enter the UOM for the Class code.

5. Click Process Loss to display the Process Loss window.

See:

Displaying Fixed Process Loss, page 5-18

Displaying Theoretical Process Loss, page 5-18

Setting Up Activities
Activities are actions performed during production. For example, mixing and cooling 
are activities. Set up activities to divide a manufacturing process into logical 
breakpoints. You can improve working methods and reduce time by analyzing and 
refining the granularity of activities, to complete activities performed in operations in 
the shortest possible time with the least effort to deliver the appropriate level of quality.

Cost analysis codes are assigned to activities so that proper cost calculations are 
computed. You need to set up cost analysis codes to define activities.

See: Defining Cost Analysis Codes, Oracle Process Manufacturing Cost Management User's
Guide.
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To set up activities:
1. Navigate to the Activities window.

2. Enter an Activity Code for the name of the activity. Activities are the components 
that make up an operation. Required.

3. Enter a brief Description of the activity. Required.

4. Enter the Cost Analysis Code. This code is set up in the OPM Cost Management 
application. Required.

Additional Information: Choose Find from the View menu to 
display the Find Activities window. Enter appropriate fields to 
narrow your search, and click Find.

Setting Up Laboratory Organizations
Most organizations manufacture a variety of similar products that are often grouped 
into product lines or families. The same technical parameters are likely to be relevant to 
the products within a product family, and to the ingredients used to manufacture those 
products. For example, viscosity is likely to be relevant to all lubricants, while opacity 
or contrast ratio is likely to be relevant to all paints.

Laboratory organizations are inventory organizations defined as laboratories in the 
Product Development parameters. Items defined in a formula are organization-specific, 
and laboratory organizations are used to group these items (ingredients) for product 
formulas. This enables you to view technical parameters linked from a laboratory to a 
batch, and perform organization-specific validations.

Although production batches are generated from a plant or a lab, you can view local 
technical parameters that are linked from a lab to a production batch produced in a 
plant. Items defined in a formula are organization-specific. Validations are performed in
product development to ensure that the formula items are enabled in production for 
organization-specific validity rules. This validation is performed when there is a 
validity rule status change. This validation is deferred for global validity rules.

To set up laboratory organizations:
1. Navigate to the Product Development Parameters window.

2. Select Find to navigate to the Find Product Development Parameters window.

3. Search for an existing Inventory organization using any of the following criteria:

• Organization
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• Description

• Organization Type

4. Select Find to display an applicable record. 

The selected record displays values in the Organization and Description fields. 

5. In the Organization Type region, enable the Laboratory check box. .

You can set the type as both a plant and a laboratory.

6. Laboratories are used to group technical parameters. Select the parameter 
applicable to your product type. 

For example, in the Formula tabbed region, set the Mass UOM type and the Volume
UOM type parameters for converting density in the Simulator calculations.

7. Save your work.

Setting Up Technical Parameters
Technical parameters are characteristics of items to measure and calculate. These 
parameters are either global or lab-specific attributes that are ultimately associated with
items in a formula. These are not item specific, however a laboratory organization is 
required to create them. There are several types of technical parameters. For example, a 
gravimetric technical parameter for percent solids by weight (w/w) is Weight%. 
Technical Parameters can function as expressions, numeric ranges, list values, character 
values, or link to quality tests. The Density technical parameter must be set up for every
item in a formula using the Item Technical Data window. Density is used to calculate 
weight and volume totals and percents.

Supported technical parameter types include:

• Weight Percent – entered as a percent for each ingredient. A total weighted percent 
is computed for the product.

• Volume Percent – entered as a percent for each ingredient. A total weighted percent
by volume is computed for the product. Density technical data is used to convert 
from weight to volume. 

• Specific gravity – entered as the relative density for a specific ingredient. Specific 
gravity is used to compute the specific gravity for the product.

• Cost – entered as a cost per unit for each ingredient or byproduct. Cost is used to 
compute the total unit cost for the product.

• Equivalent Weight – entered as the equivalent weight for the product. Equivalent 
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weight is calculated by setting up the technical parameter for an atomic weight and 
entering technical data for the total positive ionic valence to account for equivalent 
weight of a material.

• Quantity per Weight – entered as the quantity of the material required for the 
formula/batch divided by the weight in another unit of measure. 

• Expression or Product Expression – entered as a calculated technical parameter that
uses the supported mathematical functions or individual values from other 
technical parameters entered.

For each type of technical parameter, specify the constraints on the data for that 
parameter, such as the minimum and maximum values.

When using global technical parameters across multiple labs, technical parameters must
be independent of the lab organization. To create a global technical parameter, do not 
enter an organization. The Organization field displays the default organization defined 
in the profile GMD: Default Lab Organization. Technical parameters that belong to 
different labs are queried on this window. The record is protected if your current 
responsibility does not have access to the lab organization displayed.

Ensure you have completed the following prerequisites:

• Define a laboratory organization.

• Determine the hierarchy of technical parameters to set up. For example, density, 
gram percent, gram molecular weight, formula weight, and osmolality are 
developed to sequence in a hierarchy that can be rolled up to the product level.

To use expressions in technical parameters:

Symbol Meaning Example

+ Addition PARAM1+PARAM2

Adds PARAM1 to PARAM2

- Subtraction PARAM1-PARAM2

Subtracts PARAM2 from PARAM1

* Multiplication PARAM1*PARAM2

Multiplies PARAM1 and PARAM2

/ Division PARAM1/PARAM2

Divides PARAM1 by PARAM2
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Symbol Meaning Example

POWER Exponentiation POWER(PARAM1,2)

Raises PARAM1 to the power of 2

POWER(PARAM1,3)

Raises PARAM1 to the power of 3

SQRT Square Root SQRT(PARAM1)

The square root of PARAM1

LOG Common Logarithm LOG(PARAM1)

The common log of PARAM1

LN Natural Logarithm LN(PARAM1)

( ) Parentheses (PARAM1+PARAM2)/(PARAM3-
PARAM4)

Adds PARAM1 to PARAM2 and divides 
the result by the sum of PARAM3 minus 
PARAM4.

QTY$ Variable that represents 
the quantity of an 
ingredient or byproduct

QTY$*2

Multiplies the quantity of an ingredient or 
byproduct by 2.

VOL$ Variable that represents 
the volume of an 
ingredient or byproduct

VOL$*2

Multiplies the volume of an ingredient or 
byproduct by 2.

ISUM Sums the parameter or 
value for all ingredients

ISUM(PARAM1)

ISUM(QTY$)

ISUM(VOL$)

Sums all the ingredient quantities by 
weight and volume.
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Symbol Meaning Example

BSUM Sums the parameter or 
value for all byproducts

BSUM(PARAM1)

BSUM(QTY$)

BSUM(VOL$)

Sums all the byproduct quantities by 
weight and volume.

Important: Do not put spaces (blanks) in the name of a technical 
parameter that you use in an expression. (PARM 1)*(PARM 2) cannot 
be calculated because of extra spaces in the parameter name.

To use fixed expressions in technical parameters:

Certain technical parameters are fixed expressions that sum all ingredients in a formula 
(also called a formula rollup). Expressions are equations you define that use 
mathematical operators and previously defined technical parameters.

For example, you can define a technical parameter as a percent solvent (by weight), 
with each ingredient in a formula contributing a differing portion of its weight to a 
product as solvent. Use the Technical Parameters window to set up various quantitative
relationships between these individual parameters to find the weight of solvent 
contributed by each ingredient and calculate the sum of these contributions. After 
determining the total formula weight, the ratio of percent solvent for each product by 
its weight is calculated.

Calculations such as total weight and total volume are available for use in expressions. 
When a technical parameter is used within an expression, the product total value of the 
parameter may be required rather than individual ingredient values.

The Product Expression data type defines technical parameters to roll up to the product 
value. ISUM and BSUM are functions provided to indicate a total rollup sum to perform
on ingredients and byproducts, respectively. The variable QTY$ is the ingredient or 
byproduct quantity in the standard UOM defined by the UOM Mass type parameter. 
VOL$ is the ingredient or byproduct quantity in the standard UOM defined by the 
UOM Volume type parameter. Set up UOM conversions for mass and volume so that 
Simulator calculations are accurate.

In addition to the technical parameters that you define on the Technical Parameters 
window, OPM creates a technical parameter for density when you define a laboratory 
organization. The density technical parameter is used to convert from mass units of 
measure to and from volume units of measure. It does not use the item specific unit of 
measure conversions. It does, however, use the regular unit of measure conversions for 
formulas. Enter data for the DENSITY technical parameter for all items where you must
convert mass to volume or volume to mass.
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The GMD: Density profile option must be set to Density for the Simulator to calculate 
values correctly.

If a technical parameter is associated with a quality test, then the data type of the 
parameter defaults to the test data type. If the test data type is numeric, then you can 
change the data type to weight percent, volume percent, equivalent weight, or quantity 
per unit.

Following are typical expressions you can set up:

Parameter Type Description Example

Weight Percent The percent of the total 
weight for a specific 
parameter. It is often used to 
measure the total percent 
solids expressed in the 
primary inventory UOM.

Fat Percent is 1.2 g% = 1.2 
grams of fat per 100 grams of 
total material

Total Solids is 5 oz% = 5 
ounces of solids per 100 
ounces of total material

Volume Percent This is the percent of the total 
volume for a specific 
parameter. It is often used to 
measure the total percent by 
volume.

Ethanol percent is 40% by 
volume = 40 milliliters of 
ethanol per 100 milliliters of 
total volume

Specific Gravity The ratio of the mass of a 
solid or liquid to the mass of 
an equal volume of distilled 
water at 4 degrees C (39 
degrees F). Also called relative
density.

Specific gravity can be 
applied across any units. The 
density of pure water is 62.4 
pounds per cubic foot. If a 
sample of ethyl alcohol has a 
specific gravity of 0.785, then 
its density is 0.785 * 62.4 = 49 
pounds per cubit foot.

Cost The unit cost of an item. Use the standard or 
forecasted cost of an item.

Equivalent Weight The atomic weight of a 
compound divided by the 
total positive ionic valence.

Sulfuric acid has a gram 
molecular weight of 98 g. Its 
total positive ionic valence is 
+2. Therefore, the equivalent 
weight of sulfuric acid is 49.
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Parameter Type Description Example

Quantity per Unit Relative amount of material 
present based on the primary 
inventory unit of measure 
versus the unit of a mass 
assigned.

Assigned unit of mass is in 
grams, and inventory unit of 
measure is in pounds. 1 gram 
= 0.00220462262 pounds. 
Therefore, 1 kilogram is 
2.20462262 pounds. So the 
quantity per unit is 
2.20462262 pounds per 
kilogram.

Expression The algorithm entered using 
supported or defined 
variables for an ingredient or 
byproduct.

Set up an expression to adjust 
ingredient or byproduct 
factors. For example, to 
calculate dry material weight 
from a material with a 
reported 12% moisture 
content, set up 
PARAM2=QTY$-(QTY$*0.12).

Product Expression The algorithm entered using 
supported or defined 
variables for a product.

Set up a product expression to
adjust required factors for the 
product. For example, it is 
known that the packaging 
required is approximately 
40% of the weight of the 
finished product. Set up 
PARAM3=QTY$*1.4 to 
estimate the sum of the 
finished product and its 
packaging.

Derived Cost An alternate means of 
deriving cost using an 
external costing method.

See: To use the Derived Cost 
technical parameter.

To use the Derived Cost technical parameter:

Prior to using the Derived Cost technical parameter, set up inventory items and assign 
them to each laboratory organization where they are used. Create new least cost 
formulation item categories and category sets and assign the items to these category 
sets. Set up standard, actual, and lot costs for these items. The laboratory selected when 
you open the Technical Parameters window is used for the derivation of process costs. 
The Cost Type field is enabled when you select Process Cost as the cost source. The Cost
Type is validated against the cost methods master. If you select Cost Function as the 
external cost functionality, then the default seeded package GMD_LCF_UTIL.Get_Cost 
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is used. This package can be modified to fetch costs from external cost entities. The 
function has standard parameters of Item_Id, Organization_Id, Lot_Number, Qty, and 
UOM. You can select a cost parameter for one technical parameter in each laboratory. 
This parameter is used to calculate the least cost batch using the default laboratory 
profile value.

To set up technical parameters:
1. Navigate to the Technical Parameters window.

2. Enter the code for the Laboratory where you are defining a technical parameter. The
Laboratory Description displays. To define a global technical parameter, clear the 
field.

3. Enter the name of the technical Parameter. Required.

4. Enter a Description or statement about what the technical parameter represents. 
Required.

5. To link this technical parameter to a test in the OPM Quality Management 
application, enter the name of the Quality Test. The Test Description displays. 
Otherwise, leave this field blank.

6. Select the Data Type to associate with this technical parameter. Enter the 
information required in the appropriate tab. If a data type requires entry of a unit 
code, then the unit description displays.

• Character is the ASCII character data type:

• Enter Minimum as the lowest valid character string value based on the 
ASCII sort sequence.

• Enter Maximum as the highest valid character string value based on the 
ASCII sort sequence.

• Validation List is a valid list of criteria to meet for the technical parameter 
entered:

• Enter Unit Code as the unit of measure for the list.

• Enter each line as an alphanumeric character string that meets the criteria 
for the list named by the parameter.

• Boolean is a TRUE or FALSE validation:

• No entry is required on this field.

• When Boolean is defined as a technical parameter, it is validated as TRUE 
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or FALSE.

• Quantity Per Unit is a unit quantity technical parameter.

• Product Expression is a technical parameter for an expression to apply to a 
product.

• Expression is a technical parameter for a mathematical expression:

• Enter Unit Code as the unit of measure for the expression.

• Enter a valid mathematical or PL/SQL expression.

• Numeric is the numeric data type.

• Weight Percent is a parameter for weight per hundred weight units.

• Volume Percent is a parameter for volume per hundred volume units.

• Specific Gravity is a parameter for specific gravity.

• Cost is a parameter for cost calculation.

• Equivalent Weight is a parameter for equivalent weight calculation.

• Enter the Unit Code.

• Enter the Minimum value.

• Enter the Maximum value.

• Enter the Decimal Precision as the number of significant digits required.

• Derived Cost is the technical parameter used in least cost formulation.

• Enter Cost Source as Process Cost when the cost source is from an Oracle 
Process Manufacturing application, or enter it as External Source when the 
cost is derived from an outside application.

• Cost Type is the cost method used with its Description. Typically, this is a 
standard cost or actual cost.

• Enter Cost Function when you use an external cost functionality. If you use 
an external cost function, then you need to enter parameters.

• Select Default Cost Parameter to use the derived cost for a batch in the 
OPM Process Execution application. Validity rules display based on this 
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parameter value.

Additional Information: Choose Find from the View menu to 
display the Find Technical Parameters window. Enter 
appropriate fields to narrow your search, and click Find.

Setting Up Technical Parameter Sequences
Enter technical parameter sequences for the laboratory organizations and items that 
your responsibility can access. After entering the technical parameters for a laboratory 
organization, specify the order displayed as the technical parameter sequences.

The Technical Parameter Sequences window establishes which technical parameters to 
use for a simulation, and the order in which they display. All technical parameters 
defined locally for the laboratory organization are available, but can be deleted on an 
individual basis. Global technical parameters, as well as technical parameters grouped 
as item category sets, can be selected for the simulation from this window. There are 
three levels of flexibility in defining technical parameter sequences: Organization, 
Organization Item, and Organization Item Category.

When specifying a category, the category list displays all categories defined for the item
category set up in Oracle Inventory. The GMD: Technical Parameter Category Set 
profile option lets you aggregate a group of technical parameters for an item and 
organization combination. When you enter a valid category set for this profile option, it 
is displays as the default Category on the Technical Parameter Sequences window.

Expression type technical parameters that refer to other technical parameters must 
come after the technical parameters they reference in the sequence. For example, if 
PARM_3 is calculated by multiplying PARM_1 by PARM_2, PARM_3 must come after 
PARM_1 and PARM_2 in the technical parameter sequences. By default, the DENSITY 
technical parameter, or its equivalent is 1. Do not change this.

Keep in find the following prerequisites:

• Determine if two or more technical parameters are required in a calculation. If they 
are, verify their proper order prior to sequencing them in the Technical Parameter 
Sequences window. 

•  If they are, verify their proper order prior to sequencing them in the Technical 
Parameter Sequences window.

For example, if you want to determine a Brix-to-Acid ratio, first enter the Brix 
calculation, then the Acid calculation, and finally, the Brix/Acid calculation.
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To set up technical parameter sequences:
1. Navigate to theTechnical Parameter Sequences window.

2. Enter the code for the Laboratory where you are setting up technical parameter 
sequences. The Laboratory Description displays.

3. Enter the Item to display technical parameters associated with that item. The Item 
Description displays.

4. Enter Category to display technical parameters associated with the item class. The 
Category Description displays.

Parameter Sequence
5. Global is selected when a global parameter is entered.

6. Enter the code for a technical Parameter associated with the laboratory organization
entered. For example, enter GMW for gram molecular weight.

7. Enter a Sort number between 1 and 9999 to determine where to display this 
parameter in the complete list of technical parameters. When entering technical 
parameter data, the technical parameters are displayed in numerical order based on
the number entered in this field. You can enter numbers to accommodate future 
additions of technical parameters. For example, you can enter 10, 20, 30, to 
accommodate future addition of technical parameters between 10 and 20, 20 and 30,
and so forth.

8. When Quality Control is selected, the technical parameter links to a quality test.

9. Description displays the test description entered for quality linked technical 
parameters.

Additional Information: Choose Find from the View menu to 
display the Find Technical Parameter Sequences window. Enter 
appropriate fields to narrow your search, and click Find.

Entering Item Technical Data
Use the Item Technical Data window to assign one or a series of parameter values to a 
recipe enabled item, item and lot combination, batch, or formula. Items entered must be
recipe enabled. Use this window to derive item technical data from quality test results. 
Once you have specified a sequence for technical parameters, enter the technical 
parameter data. Changes made to item technical parameter values also change the 
properties of a simulation. The Batch and Formula fields in this window are mutually 
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exclusive. Batch fields are disabled if the formula option is selected. Formulas and 
batches must be accessible to your responsibility. Batches and lots are controlled by 
their respective inventory organizations.

You can define technical data for all lots derived from a parent lot when item lot control
is set to Full Control for the laboratory where you define the technical data.

If an organization and lot value are entered, then batch specific values are entered only 
for the batches that belong to the lot organization. Item technical data belonging to 
different laboratories can be queried on this window. The record is protected if your 
responsibility does not have access to the laboratory.

Entering Density for Raw Materials
The application uses the DENSITY technical parameter for unit of measure conversions.
Set up the GMD: Density profile option before entering item technical information. 
Enter values for this technical parameter for all your raw materials. If you set up item 
technical data, then a density value must be entered for items, and each lot of an item.

If you receive a unit of measure conversion error on the Simulator, then verify that you 
entered density information for all of your raw materials.

Enter density values as a ratio between the base unit of measure for the mass unit of 
measure type and the base unit of measure for the volume unit of measure type.

The base unit of measure for each UOM type is the first unit of measure set up for that 
UOM type. For example, if the base unit of measure for mass is kilograms and the base 
unit of measure for volume is liters, then enter the density in kilograms per liter rather 
than pounds per gallon.

You can determine the units of measure that are the base units for mass and volume. 
The units that display beneath the word Conversion are the base units used for mass 
and volume.

If you need to enter Item Technical Data for products, and you recalculate those 
technical parameter values on the Simulator, then data that you entered on the Item 
Technical Data window is overwritten if you use the Simulator to update the originally 
entered technical data.

Item Technical Data associates Technical Parameters at the item, formula, and lot levels.
Item Technical Data also associates technical parameters with batches.

Ensure you have completed the following prerequisites:

• Set up technical parameters.

• Set up technical parameter sequences.

To enter technical data for items:
1. Navigate to theItem Technical Data window.
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2. Enter the Laboratory where you are defining item technical data. The Laboratory 
Description displays. Enter data only for the technical parameters associated with 
this laboratory. Required. 

3. Enter the Item code to associate to technical data. The Item Description displays. 
Required.

4. If you enter technical data for a specific lot:

• Enter the inventory Organization that owns the lot.

• Enter the Lot number. The lot Description displays.

5. Select Formula or Batch to target a specific formula or batch for technical data entry:

• Enter the Formula and Version to enter formula-specific technical data.

• Enter the Plant and Batch number for entering batch-specific technical data.

Details
6. The name of each technical Parameter defined by the sort sequence for the 

laboratory organization displays. You cannot edit these fields.

7. Enter the Value for each technical parameter. You cannot enter or edit this field if 
the technical parameter value is calculated by the application.

For example, you cannot enter or edit this field if the Value is an Expression or if it 
is derived from a quality test. The value you enter must satisfy the validation 
parameters displayed at the bottom of the window if entering a numeric value. 
Otherwise, the value must be in the LOV if the Validation List method is selected as
the Data Type.

8. The following fields are display only:

• Unit is the unit of measure for the technical parameter.

• Quality Control indicator. If the indicator is selected, then the value for the 
technical parameter comes from an OPM Quality Management test or result

• Data Type is the technical parameter data type. You cannot edit this field.

• Decimal Precision is the number of significant figures assigned to the technical 
parameter.

• Calculate indicator. If the indicator is selected, then the technical parameter is 
calculated by the application.
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• Minimum Range is the minimum ranged assigned to the technical parameter.

• Maximum Range is the maximum range assigned to the technical parameter.

To find item technical data:
1. Navigate to the Find Item Technical Data window.

2. Enter any of the following to narrow your search:

• Organization to find item technical data for a specific organization. Make no 
entry here to search for global item technical data.

• Item to find item technical data for a specific item. The combination of 
organization and item refine this search to a specific item in a specific 
organization.

• Lot to find item technical data that is lot-specific.

• Formula to find item technical data associated to a specific formula and 
Version.

• Plant to find plant-specific item technical data.

• Batch to find batch-specific item technical data.

• Marked for Deletion to include only item technical data that is marked for 
purge.

Setting Up Technical Classes and Subclasses
The following procedures set up Technical Classes and Technical Subclasses for items. 
Access the Key Flexfield Segments window from the System Administrator 
responsibility. In formula analysis, view results for the contribution of Technical Class 
or Technical Subclass in either weight or volume.

To create key flexfields for technical class and technical subclass:
1. Navigate to the Key Flexfield Segments window.

2. Choose Find from the View menu to find all Key Flexfield Segments entered for the 
Oracle Inventory Item Categories Flexfield Title. Technical Class and Technical 
Subclass are Item Categories associated to the Oracle Inventory application. The 
Key Flexfield Segments window displays all flexfields defined for the Flexfield Title
of Item Categories.
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3. Insert a new row to create the Technical Class and Technical Subclass definition.

4. Enter the Code as TECH_CLASS_SUBCLASS. The Title defaults to the Code.

5. Enter the Titleand Description as Technical Class & Subclass.

6. Click Segments. The Segments Summary window displays for Technical Class & 
Subclass.

7. Enter two segments with the following values, and leave the Value Set blank:

• Technical Class, with a Window Prompt of Technical Class and a Column of 
SEGMENT1

• Technical Subclass, with a Window Prompt of Technical Subclass and a 
Column of SEGMENT2

8. Save your work.

9. Click Value Set. The Value Setswindow displays.

10. Enter the Value Set Name as TECHNICAL_CLASS.

11. Description displays Technical Class.

12. Enter a Maximum Size.

13. Choose Save and Proceed. The TECHNICAL_SUBCLASSValue Set Name displays.

14. Description displays Technical Subclass.

15. Enter a Maximum Size.

16. Save your work.

17. TheSegments Summary (Item Categories) - Technical Class & Subclass window 
displays the entries for Technical Class and Technical Subclass.

18. Find a Value Set of TECHNICAL_CLASS for Technical Class.

19. Find a Value Set of TECHNICAL_SUBCLASS for Technical Subclass.

20. Save your work.

21. Return to the Key Flexfield Segments window to freeze the flexfield definitions.

22. Select Freeze Flexfield Definition. A caution message displays to indicate that 
flexfields can be unfrozen, but that doing so can cause problems once you have 
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entered data in the flexfield.

23. Click OK.

24. Click Compile to establish the flexfield structure. The following message displays:

Compiling flexfield definition.

25. Click OK.

26. After compilation, a concurrent request is submitted to generate a flexfield view. 
The following message displays:

The flexfield was compiled successfully. Submitted request to generate flexfield 
view...

27. Click OK.

28. Check completion of the concurrent program by viewing submitted requests.

29. Define Technical Class & Subclass values.

To define technical class and subclass values:
1. Navigate to the Segment Values window.

2. Enter the following in the Find Key Flexfield Segments window:

• EnterOracle Inventory as Application.

• Enter Item Categories as Title.

• Enter Technical Class & Subclass as the Name of the structure created.

3. Click Find.

4. Query Technical Class as the Independent Segment.

5. Enter an appropriate Value, Translated Value, and Description for Technical Class. 
For example, enter:

• Binder as Value, Translated Value, and Description

• Solvents as Value, Translated Value, and Description

The values display as allowable values for the Technical Class LOV.

6. Select Enabled.
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7. Choose Save & Proceed.

8. Query Technical Subclass as the Independent Segment.

9. Enter an appropriate Value, TranslatedValue, and Description for Technical 
Subclass. For example, enter:

• Acrylic as Value, Translated Value, and Description

• Alkyd as Value, Translated Value, and Description

• Epoxy as Value, Translated Value, and Description

• Organic as Value, Translated Value, and Description

The values display as allowable values for the Technical Subclass LOV.

10. Select Enabled.

To define categories:
1. Navigate to the Codes window. The Find Categories window displays.

2. Click New.

3. Enter Technical Class & Subclass.

4. Enter each Category multisegment flexfield structure to assign meaning to each 
segment. For example, enter:

• Binder.Acrylic for an acrylic binder

• Binder.Alkyd for an alkyd binder

• Binder.Epoxy for an epoxy binder

5. Enter an appropriate Value for each Segment.

6. Click OK. Return to the Categories window.

7. Enter a unique Description for each Category. For example, Binder.Acrylic could 
have the Description Binder/Acrylic.

To define category sets:
1. Navigate to the Category Sets window.

2. Select the appropriate Inventory Organization.
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3. Click OK.

4. Enter a unique Name and Description for the Category Set. For example, enter:

• Technical Classification as Name

• Component Technical Classification as Description

5. Enter the Flex Structurecreated. For example, enter Technical Class & Subclass.

6. Verify that the Category Set is controlled at theMaster Level. You can assign the 
same Category Value in all organizations where it is assigned.

7. Enter the Default Category. For example, enter Binder.Acrylic. The default is used 
when assigning an item to the Category Set.

8. Determine if you want to Enforce a List of Valid Categories:

• Select this indicator if you want to assign items only to Categories defined as 
valid for the current Category Set. Enter each of the Valid Categories.

• Clear this indicator if you want to assign an item to any Category that has the 
same flexfield structure as the current Category Set.

9. Click Assign. The Item Assignments (OPM) Technical Classification, Master Level 
window displays.

10. Query the Item to assign to the Category Set.

11. Select the Category and enter the Segments.

12. Repeat steps 9 and 10 for each additional Item to assign.

13. Click Accept.

See: Oracle Inventory User's Guide.

To assign category sets to a process manufacturing class:
1. Navigate to the OPM Category Sets window.

2. Select the Category Set for the appropriate Process Manufacturing Class. Enter 
TechnicalClassification as Category Set.

See:Oracle Inventory User's Guide.
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Setting Up Version Control Attribute Sets
You can create and use version control attribute sets to set up version control at the 
following entity levels:

• Formula - The following table lists and describes the version control attributes at 
the formula entity level:

Formula Attribute Description

Description Brief description of the formula

Comments Remarks or notes entered for the formula

Class Classification assigned to the formula

Organization Organization that owns the formula

Owner Owner of the formula

Scaling Allowed Whether the formula allows scaling or not

Packing Whether the formula is a packaging type 
formula or not 

Calculate product quantity Automatically calculate the quantity for 
products with the scale type, proportional

Quantity The quantity of ingredients, products and 
by-products

UOM Unit of measure for ingredients, products 
and by-products

Scale Type Type of scaling for ingredients, products, 
and by-products

Scale Multiple Scaling increment for the ingredient

Scale Rounding Variance Percent variance allowed for rounding 
when scale type is integer
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Rounding Direction Acceptable rounding direction when scale 
type is integer

Yield Type Type of yield for products and by-products

Cost Allocation Cost Allocation for financial rollup

By-Product Type Type of by-product

Consumption Type Type of ingredient consumption

Contribute to Yield Whether the ingredient contributes to yield 
or not

Contribute to Step Qty Whether the ingredient quantity contributes
to step quantity or not 

Phantom Type Phantom type of ingredients

Buffer Buffer indicator of ingredients

Scrap Factor Scrap factor as a percentage for ingredients

Add or Delete Material Addition or deletion of ingredients or 
products or by-products

Process Instructions Process instructions for an ingredient or 
product or by-product of a formula

• Operation - The following table lists and describes the version control attributes at 
the operation entity level:

Operation Attribute Description

Description Brief description of the operation

Class Classification assigned to the operation

Valid From Date from which operation is valid
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To Expiration date of the operation

Owner Organization Owner organization for the operation

Minimum Transfer Quantity Minimum quantity to be produced before 
the next operation begins

Process Qty UOM Process quantity unit of measure of the 
operation

Yield% Operation level planned yield percentage

Activity Factor Number of times activity is performed

Sequence Dependency Sequence dependency indicative of the 
activity

Offset Interval Offset interval between activity start and 
resource start

Breakable Whether the activity can be broken or not

Max Break Maximum duration of the break

Material Scheduled Whether material consumption is scheduled
for the activity or not

Process Quantity Process quantity for the resource

Usage Usage of the resource

UOM Resource usage unit of measure

Component Class Component class for resource

Cost Analysis Code Cost Analysis code for resource

Plan Type Plan type of the resource

Count Number or quantity of the resource used

Offset Interval for Resource Offset interval before start of the resource
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Scale Type Scale type of the resource

Target Target value for the process parameter

Minimum Minimum value for the process parameter

Maximum Maximum value for the process parameter

Add or Delete Activity Addition or deletion of activity of an 
operation

Add or Delete Resource Addition or deletion of a resource of an 
activity 

Add or Delete Process Parameter Addition or deletion of a process 
parameter of a resource

Process Instructions Process instructions at an operation level

• Routing - The following table lists and describes the version control attributes at the
routing entity level:

Routing Attribute Description

Routing Description Brief description of the routing

Class Classification assigned to the routing

Valid From Date from which routing is valid

To Expiration date of the routing

Owner Organization Owner organization for the routing

Quantity Process quantity for the routing

Quantity UOM Process quantity unit of measure for the 
routing

Process Loss Planned loss of material for the routing
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Enforce Step Dependency Whether routing enforces step dependency 
or not 

Contiguous Whether the routing is run in contiguous or 
not

Owner Owner of the routing

Fixed Loss Fixed process loss of the routing

Fixed Loss UOM Fixed process loss unit of measure of the 
routing

Step Quantity Quantity of material associated to the step

Yield% Planned yield percentage of the step

Minimum Transfer Quantity Minimum quantity to be produced before 
the next operation begins

Release Type Release type of the step

Step dependencies Dependencies between steps in the routing

Process Instructions Process instructions at an operation level in 
the routing

• Recipe - The following table lists and describes the version control attributes at the 
recipe entity level:

Recipe Attribute Description

Description Brief description of the recipe

Owner Organization Owner organization for the recipe

Planned Loss Planned loss of material defined as a 
percentage for the recipe

Calculate Step Quantity Automatically calculate step quantity
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Owner Owner of the recipe

Contiguous Whether routings in the recipe are run in 
contiguous or not

Recipe Type Type of the recipe

Fixed Loss Fixed process loss for the recipe

Fixed Loss UOM Fixed process loss unit of measure for the 
recipe

Enhanced Process Instructions Enhanced process instructions indicator

Plant/Laboratory Organization specific details of the recipe

Customer Customer details

Step Quantity Quantity of material associated to the step

Yield% Planned yield percentage of the step

Step/Material Association Material association to the steps

When you create and assign a attribute set for an entity, enable it for the organization, 
or set the Version Control parameter in the Product Development Parameters form to 
Yes for an entity, the application creates a new formula, operation, routing, and recipe.

For example, you can create a version control attribute set for Operation, enable it for 
the organization using the Assign Version Control Set page or use the Operation tab in 
the Product Development Parameters form to set the Version Control parameter to Yes, 
and assign the version control attribute set to the Operation entity. This ensures that 
when updating fields in the Process Operation Details Activities window that are 
included in the attribute set you created and assigned, you will be able to create a new 
version of the operation with the same entity names but with a different version 
number.

Note: Version controlling is not enabled for entities with the status 
New.

You can use the Version Control Attribute Set page to search for existing attribute sets, 
create a new attribute set, and assign an attribute set to one or more organizations. You 
can also use this page to delete existing version control attribute sets.
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Note: If you have not created and associated any attribute sets with 
organization parameters, the basic functionality of version controlling 
continues. To use version control at the attribute level, create a version 
control attribute set for an attribute, and enable it for use in the 
organization.

To search for a version control attribute set:
1. Navigate to the Version Control Attribute Set page.

 (N) Product Development Security Manager > Version Control Attributes

2. Use one or both of the following fields in the Simple Search region to search for 
attribute sets:

• Set Name: Enter the version control attribute set name.

• Version Controlled Entity: Select from the following types of entities:

• Formula

• Operation

• Routing

• Recipe

3. Click Go.

The Attribute table displays the attribute sets applicable to your search criteria.

To create a version control attribute set:
1. Navigate to the Version Control Attribute Set page.

2. Click Create.

3. Use the Create Version Control Attribute Set page, to provide information for the 
following fields:

• Set Name: Enter a name for the attribute set. It is recommended that you enter a
name of up to 32 characters.

• Set Description: Enter a description for the attribute set.

• Version controlling Entity: Select from the following list of values to indicate 
the entity that you are creating this version control attribute set for:
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• Formula

• Operation

• Routing

• Recipe

4. Click Go.

5. Based on the version controlling entity that you select in this field, the 
corresponding list of attributes appear in the Attribute Table.

To enable version control for your selected attributes, select the corresponding 
Enabled check box.

6. If you do not want to save and create the version control attribute set, click Cancel.

7. If you want to save and create the version control attribute set, but also create 
another new attribute set, click Apply and Create Another. A confirmation message 
displays and you can continue to create a new version control attribute set on the 
Create Version Control Attribute Set page.

8. If you want to save and create this version control attribute set, click Apply. A 
confirmation message displays and you can see the new version control attribute set
in the Version Control Attribute Set page.

To update a version control attribute set:
1. Navigate to the Version Control Attribute Set page.

Use the fields in the Simple Search region to search for the attribute set you would 
like to update.

2. Click Go.

3. The Attribute table displays the attribute sets applicable to your search criteria.

Click the Update icon for the version control attribute set you want to update.

4. Use the Update Version Control Attribute Set page to select or clear the 
corresponding Enabled check boxes for the attributes that display for the version 
control attribute set.

5. If you do not want to save your updates, click Cancel and return to the Version 
Control Attribute Set page.

6. To save your updates, click Apply. A confirmation message displays.
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7. To return to the Version Control Attribute Set page, click the Return to Version 
Control Attribute Set link.

To delete a version control attribute set:
1. Navigate to the Version Control Attribute Set page.

Use the fields in the Simple Search region to search for the version control attribute 
set you would like to delete.

2. Click Go.

3. The Attribute table displays the attribute sets applicable to your search criteria.

Click the Delete icon for the version control attribute set you want to remove.

4. A message displays to ask if you want to delete the selected attribute set. Click Yes 
to delete the set. Click No to retain the set.

To assign a version controlling attribute set:
You will need to assign the version control attribute set you created for the entity, be it 
formula, operation, routing, or recipe, to one or more organizations.

To assign a specific version control attribute set to the version controlling entity, you 
can use the Assign Version Control Set page to assign an attribute set to multiple 
organizations at one time, or the Product Development Parameters windows to assign 
an attribute set to a single organization.

Assigning Version Control Attribute Sets Using Assign Version Control Set page
1. Navigate to the Assign Version Control Set page.

 (N) Product Development Security Manager > Version Control Attribute Set page.

2. Use the fields in the Simple Search region to search for the version control attribute 
set you would like to assign to organizations

3. Click Go.

4. The Attribute table displays the attribute sets applicable to your search criteria.

Click the Assign icon for the attribute set you would like to assign to one or more 
organizations.

5. In the Assign Version Control Set page, select the Enabled check box for the 
organizations you would like to assign to the version control attribute set.

Note: The organizations that display are organizations with no 
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version control attribute set assigned or which have been assigned 
the same set you have queried. Organizations assigned to a 
different version control attribute set do not display. 

You can also use this page to remove organization assignments. Clear the Enabled 
check box for the organization you do not want to assign to the version control set.

6. Click Cancel, to return to the Version Control Attribute Set page without saving 
your changes.

7. Click Apply to save your changes.

8. To return to the Version Control Attribute Set page, click the Return to Version 
Control Attribute Set link.

Assigning Version Control Attribute Sets the Using Product Development 
Parameters window
1. Navigate to the Product Development Parameters window.

(N) Product Development Security Manager > Organization Parameters.

2. Use the Product Development Parameters window to enter the context inventory 
organization in the Organization field.

3. Select from the following tabs for the version controlled entity to which you want to
assign a attribute set:

• Formula

• Operation

• Routing

• Recipe

4. For the Version Control parameter, select from the following list of values in the 
Parameter Value:

• Yes: Select Yes to use version control at the attribute level.

• No: Select No if you do not want to use version control at the attribute level. If 
the value for Version control is set to No, you cannot use version controlling 
attribute sets, even if you select an attribute set.

• Optional: Select Optional to be prompted by the application with the option to 
select Yes to create a new version, or select No to save changes in the current 
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version. You will also be able to select Cancel to discard the changes.

5. In the Version Control Attribute Set, use the Parameter Value list of values to select 
an attribute set you have created. Note that the list of values will display only the 
corresponding list of attribute sets you created for the version controlling entity.

6. Click Save.

For more information on the Product Development Parameters window, see Setting
Up Parameters, page 2-3.
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3
Formulas

This chapter includes a basic understanding of formula setup and shows you how to 
define the formulas that drive your manufacturing process. It shows how you can enter 
item technical data and use the Simulator for laboratory simulations. It discusses how to
set up formula information including how to use formula phantoms, methods available 
to scale formulas, and to find formulas. In addition to entering formula details, you can 
define and maintain formulas at the header and line levels. Also discussed are methods 
for determining where ingredients are used, the Indented Bill of Materials Report, and 
formula inquiry that help you locate formula information.

This chapter covers the following topics:

• Requirements

• Understanding Formula Setup

• Setting Up Formula Information

• Using Formula Phantoms

• Scaling Formulas

• Defining and Maintaining Formulas

• Finding a Formula

• Displaying the Formula Summary

• Displaying the Formula Header Summary

• Entering Formula Details

• Copying a Formula

• Scaling a Formula

• Displaying Ingredient Technical Parameters

• Using the View Menu to Find a Formula

• Displaying the Formula Product Summary

• Displaying the Formula Byproduct Summary
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• Displaying the Formula Ingredient Summary

• Displaying a Summary of Formula Product Lines

• Editing Formula Product Lines

• Displaying a Summary of Formula Byproduct Lines

• Editing Formula Byproduct Lines

• Editing a Formula Byproduct Line

• Displaying a Summary of Formula Ingredient Lines

• Editing Formula Ingredient Lines

• Editing a Formula Ingredient Line

• Using Computer-Aided Formulation

• Setting Up for Computer-Aided Formulation

• Loading Formulas and Batches into the Simulator

• Using the Simulator

• Updating Formulas Using the Simulator

• Updating Batches Using the Simulator

• Blending Batches Using the Simulator

• Adding Lot Information

• Adding Lot Information to a Batch

• Displaying Parameters on the Simulator

• Displaying Calculation Errors

• Saving a Simulation

• Finding a Saved Simulation

• Using the Optimizer

• Using the Workpad

• Optimizing Lot Quantities

• Optimizing Formulas and Batches

• Optimizing Ingredient Quantities Based on Other Items

• Recalculating Quantities and Physical Properties

• Optimizing Lot Quantities While Maintaining Output Yield

• Ingredient Distribution Rules Used in Optimization

• Using the Buffer Indicator

• Running the Indented Bill of Materials Report
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• Using Formula Inquiry

• Interpreting a Formula Inquiry

• Displaying Details from a Formula Inquiry

• Displaying an Intermediate Formula

• Analyzing a Formula

• Displaying Formula Analysis Results

• Finding a Formula Analysis

• Overriding Default Explosion Rules

Requirements
Following are some requirements that customers have for formulas in Product 
Development.

Can multiple versions be managed at the same time?
Yes. Depending on how version control is implemented, a version number can be 
assigned to multiple versions of a formula.

Manage Multiple Versions of a Formula

If Version Control is enabled, then a change to any formula component requires a new 
formula to be created consisting of the same formula name with a different version 
number. This is not required for status changes, Mark for Purge, or Undelete 
operations. If Version Control is off, then changes to a formula can be made without 
requiring a new version. Version Control helps manage multiple versions of a formula.

Can you enable version control at the Formula attributes level?
Yes. The Formulas user interface supports version control for attributes, provided you 
create version control attribute sets at the Formula entity level to include attributes you 
could like to modify and drive version control and assign them to the organization.

Support for Version Controlled Attributes for Formula

Use the Version Control Attributes user interface provided under Product Development
Security Manager to create version control attribute sets at the Formula entity level. 
Select and enable attributes you would like to modify and enable version control for at 
the Formula level. Ensure you assign the version control attribute set to the 
organization using the Assign Version Control Set page or the Product Development 
Parameters window. This will enable you to modify attributes for existing formulas and
create new versions of the formula. See: Setting Up Version Control Attribute Sets, page
2-39.
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Can the formula approval process be managed efficiently?
Yes. Use the formula Status field to manage formula approvals quickly and efficiently. 
By activating the Status Approval Workflow, the application manages each step of the 
approval process with a minimal requirement for intervention.

You can configure e-records and e-signatures as a part of the formula management 
process.

Let Formula Status Indicate Formula Approval

Use the Status field in each formula to determine where the formula is in an approval 
cycle. Activate the Status Approval Workflow to control the approval process. 
Workflow presents each Approver with an electronic notification so that action can be 
taken immediately.

Oracle Process Manufacturing (OPM) Product Development supports e-signatures and 
e-records. When a status change is requested, required signatures are captured online 
while the event is happening in the window. Any users responsible for additional 
required signatures receive workflow notifications informing them that their e-
signature must be entered before the status of the formula is changed to the requested 
status. This expedites the overall approval process.

Is there multilingual support for formulas?
Yes. Use Description and Comments fields to enter translations for each of the installed 
languages.

Use the Description and Comments Text Fields for Multilingual Support for 
Formulas

Two descriptive text fields in the header of a formula allow entry of a formula 
Description and Comments for each of the installed languages. Text displays in the 
session specific language.

Can both standard and packaging formulas be created?
Yes. Use the Formula Details window to create both standard and packaging formulas. 
The window has a Packaging indicator that identifies a formula as a packaging formula.

Use the Formula Details Window to Create Both Standard Formulas and Packaging 
Formulas

The Formula Details window allows entry of the formula header and all its products, 
ingredients, and byproducts. To set up a packaging formula, enter the packaged item 
itself as product. Then enter the bulk item, packaging container, and package label as 
ingredients.
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Can formulas from third party applications be imported into the Product Development 
application?

Yes. Use Formula APIs to create new formula headers and details from applications not 
developed by Oracle. For existing Oracle applications, migration scripts are supplied.

Bridge Collaborative Environments with Formula APIs

To bridge collaborative formulation environments, an integrated set of Applications 
Programming Interfaces (APIs) such as legacy systems, spreadsheets, or third party 
systems. These Formula APIs create, reconcile or update formulas, their components, 
and their validity rules.

Can formulas be modeled and created based on the technical properties of its 
components?

Yes. Using Computer-Aided Formulation, model and create formulas based on any 
number of characteristics associated with ingredients. 

Use Computer-Aided Formulation to Model and Create Formulas

Process manufacturing industries produce products composed of chemical and physical
properties that can be predicted using algorithms. With the correct algorithms, you can 
alter the amount of one or more raw materials and the application calculates the 
ultimate effect on the product. Alternately, by selecting target finished good properties 
such as a prescribed value for Volatile Organic Compound (VOC), or a desired cost, the 
quantities of raw materials in a formula can be altered to produce the target product 
values. The availability of modeling features in an environment that is separate from 
the working formula allows formulators to simulate changes without affecting current 
production.

Can a laboratory be set up for many product lines with different technical 
characteristics?

Yes. Use technical parameters that are specific to an organization to set up individual 
product lines with differing technical characteristics.

Define Technical Parameters for Rapid Calculations

Product Development allows setup of technical parameters as quality control tests. You 
can use quality results in the calculations. This can be done on an organization specific 
basis or globally across all organizations. After establishing a formula for laboratory 
use, and entering its technical data for all appropriate ingredients, the application 
displays technical parameters within the laboratory formula to see how to roll it up into 
a recipe. It also enables use of engineering items for evaluation or testing purposes, and 
the recording of all information and text as detailed notes or comments.
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Is it possible to predict the characteristics of a product based on ingredient 
composition?

Yes. Use the Simulator to model new formulas and predict formula composition based 
on individual components added.

Simulate Formulas and Analyze Their Components

The Simulator provides what-if scenario testing, enables simulation of the quantity and 
technical parameter values for all formula components, and calculates product technical
parameters automatically. Formulators can rearrange and adjust quantities of the 
ingredients and byproducts. Save formula variations as possible new products. 

Formula analysis explodes the ingredients and reports on contributing components of a 
formula. You can simulate the contribution of formula components in a product by 
weight or by volume. This flexibility enables testing of different scenarios during 
reformulation and provides a rapid evaluation of the results.

Deliver Complete Standard Operating Procedures (SOPs)

Product Development enables formulators and process engineers to link SOPs created 
through Oracle Tutor to transactions and records using Oracle E-Records, or the Oracle 
Applications Help System. This eliminates the need to transfer information manually. It
improves product quality and consistency. Procedures are defined in one or more 
languages at various levels of the organization to meet quality requirements. This 
information supports compliance to ISO 9000.

Is it possible to model catalysts and starter cultures, or any other item that does not 
change batch size?

Yes. Formula ingredients can be scaled using rules that specify whether or not an 
ingredient contributes to yield.

Provide Comprehensive Formula and Ingredient Scalability

Product Development delivers full manufacturing scalability. The amounts of material 
produced or used by a formula can be scaled using methods that fix or vary each 
ingredient. Scalability provides production cycle flexibility and virtually eliminates the 
need to recalculate ingredient amounts manually.

Can SOPs be linked to a transaction or record?
Yes. SOPs created using Oracle Tutor can be linked to any Oracle Applications 
transaction or record using Oracle E-Records. Refer to the Oracle Tutor product 
documentation for details.

Deliver Complete Standard Operating Procedures (SOPs)

Product Development enables formulators and process engineers to link SOPs created 
through Oracle Tutor to transactions and records using Oracle E-Records, or the Oracle 



Formulas    3-7

Applications Help System. This eliminates the need to transfer information manually. It
improves product quality and consistency. Procedures are defined in one or more 
languages at various levels of the organization to meet quality requirements. This 
information supports compliance to ISO 9000.

Can product quantities be automatically calculated in formulas?
Yes. The Auto Calculate Product Quantity parameter lets you calculate single or 
multiple product quantities based on the ingredients, UOM, Scale Type, Percentage, 
Contribute to Yield Indicator, and byproduct quantities entered in the formula.

Automatic Calculation of Formula Product Quantity 

Formulators can account for all material quantities based on a proportional or fixed 
scaling relationship among ingredients, byproducts, products and coproducts and 
using the automatic calculation of formula product quantity feature.

Does the Formulas user interface support serial controlled items?
Yes. The Formulas user interface supports serial controlled items, provided you ensure 
that you create the formula for serial controlled ingredients.

Support for Serial Controlled Items

Use the Formula Details page to select and define formulas for serial controlled items as
products, by-products, and ingredients. Note that OPM Product Development 
functionality is applicable to both serial and non-serial controlled items, with the 
exception that when defining serial controlled items as ingredients, you must ensure 
that the Scale Type you select is Integer.

Once you define formulas and once the recipes including serial controlled items are 
approved for general use, the production batches inherit the serial-controlled items. 

Understanding Formula Setup
You can define, create, and save formulas that drive your manufacturing process. 
Formulas are lists of ingredients and products with their associated quantities and 
processing instructions. In some cases, you can refer to a formula as a process 
manufacturing parts list. Production batches are based on formulas defined in Product 
Development. Formulas are also used for planning, managing costs, and scheduling.

Formulas are depicted hierarchically in the following diagram that shows the:

• Routing composed of a series of Operations organized in Steps.

• Operations composed of Activities containing Resources.

• Formula composed of Ingredient, Product, and possibly Byproduct.
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• Recipe linking the Routing and Formula together with Processing Instructions.

Requirements for a new product are usually assigned to a formulator in research and 
development. They also originate from sales and marketing, customer requests, or are 
required by regulatory agencies.

New materials are analyzed to determine their chemical, physical, or mechanical 
properties. Engineering items are created for these unapproved materials. Engineering 
items are entered into experimental formulas. They do not require additional details to 
enter other than the item technical properties. Engineering items do not have to 
undergo the usual new item introduction process. Therefore, these items cannot be 
viewed by or used in approved production formulas.

After producing test batches with the laboratory formula, their test results are 
submitted for review. If the formula produces the expected yields, and meets other 
criteria for cost and safety, then it can be sent for approval for general use in 
production. At this point, the formula is validated to determine that engineering items 
are not included. All ingredients must be fully defined and approved for use in a 
production run.

Formulators design new formulas. Existing formulas can be used as a starting point. 
These formulas are modified to meet a new product specification. The Simulator and 
Optimizer windows are used to design and optimize a formula using criteria such as 
cost, potency, color, or other key technical parameters. Ingredients and their properties 
are loaded into these tools by selecting formula name and version. With the entry of 
output quantity and product targets, relevant materials are recalculated to meet a 
product specification. An optimized formulation is selected and a request is made to 
approve the formula for laboratory use.
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Setting Up Formula Information

Setting Up Header Information
To create a new formula, enter formula header information including formula name, 
version, and product on the Formula Details window. Formula header information 
applies to the entire formula. The Formula Header Summary window lists all formula 
header information entered.

Process formulas are compliant with the S88.01 standard for recipe management. 
Control formulas at a global level to maintain your corporate standard, and permit 
certain manufacturing plants within your organization to maintain their own version of 
the formula to meet their local requirements. Maintaining global or local recipes ensures
that a formula can be created in one inventory organization, and then copied, modified, 
and maintained by another inventory organization.

Formulas can also be created using the Recipe Designer.

See: Creating a Formula in the Recipe Designer, page 6-55

Setting Up Product and Coproduct Information
Use the Formula Product Lines window to enter each product or coproduct component.
For example, skim milk is a coproduct in the production of cream. Products and 
coproducts must be recipe-enabled.

Setting Up Ingredient Item Information
Use the Formula Ingredient Lines window to enter each ingredient component in a 
formula. Items are selected from the item master. The key flexfield segment feature lets 
you name items logically for purposes customized retrieval during the building of a 
formula. Formula items are organization specific. This ensures that the items used to 
formulate are also accessible from the manufacturing plants where formulas are used. 
Each formula item must be recipe-enabled. This includes ingredients, byproducts, and 
products. If you obsolete a formula item, then disable the recipe-enabled feature and 
continue to use the item in batches. However, you cannot use this same item to build 
new formulas.

Note: Line items available for formula definition are restricted to those 
items owned by the formula owning organization. Only use items that 
are marked as recipe-enabled in the owning organization. Each item is 
validated for availability in the inventory organization.
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Using Engineering Items
Define engineering items and assign engineering item attribute details as you do for 
manufacturing items. You can perform many of the functions with an engineering item 
that you do for an production-approved item. This includes revision control, inventory 
tracking, and cost rollups. However, you cannot use engineering items in formulas that 
are approved for general use. To share engineering items across several laboratory 
organizations, use the Engineering Master Item window, and assign the item to specific 
laboratory organizations.

Transfer an engineering item to production prior to using the item in a production 
formula. Transferring and copying an engineering item is organization specific. You can
only transfer or copy an engineering item to manufacturing within the same 
organization.

Transfer or copy an engineering item using the Engineering Transfer function. See: 
Oracle Engineering User's Guide.

Setting Up Byproduct Information
Byproducts differ from products in that you do not plan production to make 
byproducts, but they must be accounted for in the formula. For example, applesauce 
production generates apple peels as a byproduct. Peels are not something you plan to 
manufacture as a product. You would never schedule a batch in order to produce apple 
peels. Depending on the facility, these peels can have no monetary value and can 
require disposal, or they can be sold as raw material for apple cider vinegar. In either 
case, enter apple peels as a byproduct of your applesauce formula.

Oracle Process Manufacturing (OPM) does not calculate the cost of production of 
byproducts. Any items produced by formulas that you want to calculate costs for must 
be entered as products. They must not be entered as byproducts. Byproducts must be 
recipe-enabled.

Set up the byproduct type as:

• Rework if the material generated requires rework.

• Sample if the material generated is used as a sample for quality inspection. See:
Oracle Process Manufacturing Quality Management User's Guide.

• Waste if the material is a waste product.

• Yield if the byproduct is material that is yielded for use in another process.

Specifying the Set of Technical Parameters to Use
When you enter an item that is a product of one or more laboratory formulas, you can 
specify the appropriate formula containing the Item Technical Data. Since the item is a 
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product in formulas, its technical parameter values are calculated from specific 
formulas. Calculated values can be different in each formula.

For example, your company makes orange juice using either of two valid formulas. 
Each formula uses a different orange juice concentrate. If you use orange juice to make 
an orange drink, then verify that the technical parameter values are selected for the 
formula you decide to use, since calculated technical parameter values can be different 
in each formula. Assign formula technical parameters from the Formula Details 
window.

Adding Text to a Formula
Add text to a formula by selecting Edit Text from the Actions menu. Do this at the 
header or line level. Text that is associated with a formula is copied to batches that are 
based on the formula if Copy Formula Text is selected on the Process Execution 
Parameters window in the Oracle Process Manufacturing Process Execution 
application.

Setting Up Formula Ownership
Each formula has an owning organization. Depending on the size and complexity of 
your company, develop and maintain formulas within a research and development 
laboratory, and allow a manufacturing plant to use the formula rather than maintain it. 
When a formula is created, the default organization is the context organization selected.

Using Formula Phantoms
Phantoms are intermediate formulas that are not manufactured as products. Phantoms 
are sometimes referred to as transient subassemblies. Phantom functionality is a fixed 
method of multibatch management. Once several batches are linked by a production 
order number and phantom type dependence, you can manage them as a single 
production event. Two fundamental tasks are associated to using phantoms are:

• Identify one or more ingredients in a formula as phantoms. Use the Phantom Type 
field to indicate that an item is a phantom.

• Build a formula for each phantom. The method for building a formula that 
generates a phantom is the same method used to build a formula for a regular 
batch. The formula ingredient must be defined as a phantom.

There are two types of phantoms:

• Automatic Generation creates phantom batches automatically. When you use this 
function with automatic document numbering, the application automatically 
creates a dependent phantom batch, and then generates a production identification 
number to associate all related batches.
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• Manual Generation requires manual intervention to create phantom batches. When 
you use manual generation, explode each phantom ingredient by selecting the 
Phantom. 

Phantoms You Make
Use a basic bread dough for a number of kinds of bread. You do not sell it or keep it in 
inventory, however you need to track its ingredients. Your formulas for bread contain 
#BASICBREAD plus whatever other ingredients are needed to turn plain white bread 
into other kinds of bread such as rye, whole wheat, and pumpernickel.

In this case, you need only one version of the #BASICBREAD formula.

Phantoms You Never Actually Make
You make a number of products that use apples. Each product has a different formula, 
but all of them use apples. And, there are many varieties of apples. Flavor, texture, and 
sugar content vary significantly among these apple varieties. Price and availability can 
vary depending on season or other factors. Therefore, you decide to use an intermediate
called #APPLEBLEND that is made up of two or more apple varieties. You do not 
actually make #APPLEBLEND. However, you use its ingredients in a batch.

Scaling Formulas
You can scale formulas up or down by input or by output:

• If the formula input ingredients are scaled, a specific scaling factor is applied to all 
scalable ingredients. A calculated output scale factor is applied to all scalable 
outputs.

• If the formula outputs are scaled, a factor is applied to all scalable outputs. A 
calculated input scale factor is applied to all scalable ingredients.

In order for this approach to be successful, specify whether the quantities of each item 
in the formula are fixed or scalable.

Proportional scaling is the least complex scaling type since the given and calculated 
factors are applied appropriately to the scalable item inputs or outputs. In order to scale
formulas properly, specify whether the ingredients need to increase using fixed or 
proportional scaling.

Scale Type Definitions
The quantities of items which are fixed scale are not altered when a formula is scaled. 
For example, if a formula has a fixed scale ingredient with a quantity of 10 kg and the 
formula is scaled by a factor of two, then the quantity remains fixed at 10 kg.
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Items that are proportionally scaled have their quantities changed when a formula is 
scaled up or down. With proportional scaling, the scaling is continuous in that the 
scaled quantities can contain decimals. Proportionally scaled items may or may not 
contribute to yield.

While proportional scaling makes sense for many items in process industries, it does 
not make sense for all items.

Following are the types of formula scaling available in Product Development: 

• Fixed scaling

• Proportional scaling.

• Integer scaling.

Following are the Contribute to Yield types available in Product Development:

• Yes indicates that an ingredient contributes to yield.

• No indicates that an ingredient does not contribute to yield.

Understanding Scale Type Rules
The following summarizes the business rules in effect for scale types:

• The Contribute to Yield type for ingredients can be set to Yes or No.

• Products and byproducts cannot have an Integer scale type.

• Ingredients are assigned a scale type of Fixed, Proportional, or Integer.

• If an ingredient is assigned a scale type of Integer, then it must also be assigned a:

• Scale Multiple, to specify the multiple in which the ingredient is used in a 
formula. For example, a Scale Multiple of 30 indicates the ingredient is used in 
quantities of 30, 60, or 90, and so forth.

• Rounding Direction, to specify whether the quantity of material is rounded up 
to the next higher scale multiple of material, down to the next lowest scale 
multiple of material, or if the material can be rounded up or down. If the 
material can be rounded up or down, then it is rounded to the nearest multiple.

Fixed Scale
To scale a formula with fixed scale items, the application converts the quantities of 
ingredients, products, and byproducts to a common unit of measure. The unit of 
measure used for this calculation is the base unit of measure specified by the parameter 
Yield UOM type. This is usually mass. All items in the formula that contribute to yield 
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must be convertible to this unit of measure. 

If the formula contains fixed quantity ingredients that contribute to yield, then the 
scalable ingredients are scaled by an amount necessary to produce the new product 
quantity, not by the percent entered as the scale factor. If all products are set to fixed 
quantity, then quantities in the formula are not changed.

Fixed Scale With Yield Contribution
The quantities of items for this scale type are not altered when a formula or batch step is
scaled. If a formula has a fixed scale ingredient with a quantity of 2000 kg and the 
formula output is scaled by a factor of 2, then the quantity remains fixed at 2000 kg.

These quantities are taken into account when calculating the factor to apply to the 
scalable ingredients so that the yield ratio is preserved. In the example that follows, the 
ratio is 115:120 before scaling and 230:240 after scaling the output by a factor of 2.

Item Formula Quantity Quantity After Scaling

Product A 11500 kg 23000 kg

Ingredient A, Proportional 
Scaling

5000 kg 11000 kg

Ingredient B, Proportional 
Scaling

5000 kg 11000 kg

Ingredient C, Fixed and 
Contributing

2000 kg 2000 kg

Fixed Scale Without Yield Contribution
The quantities of items for this scale type are also not altered when a formula is scaled. 
This is the same as the previous example, however the item quantities are not 
considered when scaling the remaining ingredients. These quantities have no effect on 
scaling. For example, in the following, formula Ingredient C is fixed scale without yield 
contribution. If the product is scaled by a factor of 2, then the quantities after scaling 
appear as if ingredient C were not included.

Item Formula Quantity Quantity After Scaling

Product A 10000 kg 20000 kg
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Item Formula Quantity Quantity After Scaling

Ingredient A, Proportional 
Scaling

5000 kg 10000 kg

Ingredient B, Proportional 
Scaling

5000 kg 10000 kg

Ingredient C, Fixed and 
Noncontributing

2000 kg 2000 kg

Proportional Scale
If the formula contains proportionally scalable ingredients, then the scalable ingredients
are increased in a direct ratio to produce the new product quantity. In the following 
example, Product A is proportionally scaled from 10000 kg to 20000 kg.

Item Formula Quantity Quantity After Scaling

Product A 10000 kg 20000 kg

Ingredient A, Proportional 
Scaling

5000 kg 10000 kg

Ingredient B, Proportional 
Scaling

5000 kg 10000 kg

With proportional scaling, Ingredient A and Ingredient B are multiplied by a factor of 2.

Examples of Single and Mixed Scale Types
The following discussion compares different scale types:

Single Type Scaling
If a formula consists solely of proportionally scalable items, then scaling the output or 
the input scales everything in the same ratio. It is also possible to construct a formula 
from items that are all fixed scale. This formula is ineligible for scaling.

Mixed Type Scaling: Fixed and Proportional With Yield Contribution
If a formula contains both fixed and proportionally scaled items, then the factor applied 
to the scalable quantities is not the same as the overall scaling factor. Consider a 
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formula that yields 3000 kg of scalable product by converting 1000 kg of fixed scale 
Ingredient 1 and 2000 kg of scalable Ingredient 2. If the product is scaled by a factor of 2
to produce 6000 kg, then 5000 kg of Ingredient 2 is required, not 4000 kg. The factor 
applied to the Ingredient 2 quantity is therefore 2.5 rather than 2. If the inputs are scaled
by a factor of 2, then the output is 5000 kg, or 2 times 2000 kg of Ingredient 2 plus 1000 
kg of Ingredient 1. The yield of the product is scaled by a factor of 1.667 rather than by a
factor of 2, as shown in the following:

Item Formula Quantity Quantity After Scaling

Product B 3000 kg 6000 kg

Ingredient 1 Fixed and 
Contributing

1000 kg 1000 kg

Ingredient 2 Proportional 
Scaling

2000 kg 5000 kg

Mixed Type Scaling: Proportional With Yield Contribution and Fixed Without Yield Contribution
If the fixed quantity of an ingredient has no effect on yield, then the yield contribution 
field must indicate this. When a fixed quantity item that does not contribute to yield is 
encountered by the scaling algorithms, the item quantity is not scaled, and is ignored 
when deriving the scale factor to apply to the remaining items. The formula is treated as
consisting only of the remaining items.

If a formula is scaled so that 2000 kg of scalable product is made by converting 2000 kg 
of scalable Ingredient 1 in the presence of 1000 kg of fixed scale Ingredient 2 that does 
not contribute to the yield, then the output doubles. Scaling the inputs by a factor of 2 
doubles the output quantity, since the fixed scale ingredient quantity is not to be 
changed. It does not matter if 100 kg of Ingredient 2 is used. The same is true when 
outputs are scaled.

Item Formula Quantity Quantity After Scaling

Product C 2000 kg 4000 kg

Ingredient 1 Proportional 
Scaling

2000 kg 4000 kg

Ingredient 2 Fixed and 
Noncontributing

1000 kg 1000 kg
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Understanding Integer Scaling
Some material in process industries is picked from inventory in eaches, such as a 30 
pound bag of defoamant or a box of antistatic sheets. If an item is issued in 30 pound 
bags, then it is supplied in full bags and managed on the production floor 
appropriately. If the UOM used in the formula is the bag, then you must scale in whole 
integer increments. If you want to express the ingredient in pounds, then integer scaling
is not sufficient. You need a way to specify that the ingredient must only be scaled in 
multiples of 30 pounds.

When materials are scaled by a multiple, a scaling direction value must be specified so 
that the scaled quantity is rounded properly. Scaling by a multiple results in ingredients
being rounded up or down to the next whole multiple specified for the item in the 
formula. It is possible that the formula ingredient is not scaled as a result of not meeting
the criteria to round up or down. Rounding Variance is required for integer scaling. If 
you do not use rounding variance, then scaling type defaults to proportional scaling.

Examples of Integer Scaling
When the Integer scale type is selected, specify the Scale Multiple, Rounding Variance, 
and Rounding Direction. In the following example, Product C is scaled up by 60 
percent.

Simple Integer Scaling
The following is a simple example of using the Integer scale type with directional 
rounding:

Item Formula Quantity Quantity After Scaling

Product Pkg1 1000 kg 2500 kg

Ingredient 1 Proportional 
Scaling

1000 kg 2500 kg

Ingredient 2 Integer 1 pallet 3 pallets

Ingredient 2 has a Formula Quantity of 1 pallet with the following specifications:

• Scale Multiple = 1

• Rounding Variance = 100 percent

• Rounding Direction = Either

It is not possible to use 2.5 pallets, therefore the Integer scale type rounds the 
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requirement up to 3 pallets.

Complex Integer Scaling
The following example is a more complex example of using the Integer scale type with 
directional rounding:

Item Formula Quantity Quantity After Scaling

Product C 2000 kg 3200 kg

Ingredient 1 Proportional 
Scaling

2000 kg 3200 kg

Ingredient 2 Integer 25 kg 40 kg

Ingredient 2 has a Formula Quantity of 25 kg with the following specifications:

• Scale Multiple = 25 kg

• Rounding Variance = 30 percent of the Formula Quantity After Scaling. This is 0.3 of
40 kg, or up to 12 kg

• Rounding Direction = Down

The decision is whether to use 25 kg or 50 kg of material to produce Product C, since 
Ingredient 3 is only dispensed in multiples of 25 kg. The differences between the 
required Formula Quantity and the Integer is 10 kg for the Up Rounding Direction, and 
15 kg for the Down Rounding Direction. The Down Rounding Direction is calculated as 
follows:

• Lower Scale Multiple - Quality After Scaling

= 25 - 40

= -15 kg for the Down Rounding Direction

Take the absolute value of any negative Rounding Direction. In this case, the lower 
Rounding Direction has an absolute value of 15 kg.

The acceptable Rounding Variance is up to 12 kg. The Rounding Direction is Down, and
the calculated absolute value for the down Rounding Direction is 15 kg, representing 3 
kg more than the acceptable Rounding Variance. It is not acceptable to round down to 
25 kg, so 40 kg of Ingredient 3 must be used in the formula.

If the Rounding Direction were Up, then it is acceptable to use 50 kg of Ingredient 3, 
since a 10 kg difference is less than the acceptable Rounding Variance of 12 kg. The Up 
Rounding Direction is calculated as follows:
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• Upper Scale Multiple - Quantity After Scaling

= 50 - 40

= 10 kg for the Up Rounding Direction.

Limitations for Repeated Scaling of an Integer Scaled Item
Scaling issues occur when an item with an Integer scale type is scaled more than once 
during the production cycle. Repeated scaling items by the integer scale type is a 
process production issue.

See: Oracle Process Manufacturing Process Execution User's Guide

Disabling the Scaling of a Previously Scaled Formula
This advice applies to the Formula Details window.

If you clear Scaling Allowed so that scaling is not allowed on a formula, then the 
following message displays:

Unchecking 'Scaling Allowed' for this formula will change the scale type for all material
lines to fixed. The minimum, maximum, and standard quantities for any existing 
validity rules will be changed to the product quantity in the formula.

Do you wish to Continue?

If you click OK, then the associated validity rule quantities are updated and disabled, 
and all material line scale types are set to Fixed. If validity rules exist with a status of 
Pending, Frozen, or On Hold, then the formula cannot be updated, and an appropriate 
message displays:

Validity Rules exist which require update due to the change in this formula's scale type.
However, they can not be updated because of their current status. Please update VR 
status in order to save this record.

If you do not continue after clearing Scaling Allowed, then the formula is set back to 
allow scaling, and all material detail line scale types remain unchanged and enabled.

Changing the Scale Type of a Product Line to the Fixed Scale Type
This advice applies to the following windows:

• Formula Details

• Formula Product Lines

• Formula Product Line Edit

If you change the Scale Type of a product line to the Fixed scale type, then the following
message displays:
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The minimum, maximum, and standard quantities of any existing validity rules will be 
changed to the product quantity in the formula. Do you wish to continue?

If you click OK, then the associated validity rule quantities are updated and disabled, 
and all material line scale types are set to Fixed. If validity rules exist with a status of 
Pending, Frozen, or On Hold, then the formula cannot be updated, and an appropriate 
message displays:

Validity Rules exist which require update due to the change in this formula's scale type.
However, they can not be updated because of their current status. Please update VR 
status in order to save this record.

This advice applies to the following windows:

• Recipe Validity Rules

• Recipe Organization Details

When you display these windows after an associated formula header had its scaling set 
to Fixed, then all quantities are disabled. If the associated formula header allowed 
scaling, but the product line did not, then the associated validity rules for that product 
are disabled.

If you create a new record from any of these windows, and either the associated 
formula header or product record is set to fixed scaling, then the quantities are set equal
to the product quantity and unit of measure of the formula. Quantities are disabled 
after entry if formula header or product are set to fixed scaling.

Defining and Maintaining Formulas
Formulas are statements of ingredient requirements. A formula can include processing 
instructions and ingredient sequencing directions. The formula can also specify the 
quantities of each item.

Creating a New Formula
Use the Formula Details window to create and define new formulas. Specify formula 
header information and each of the products, ingredients, and byproducts included in 
the formula. You can access the following windows using the Formula Details window:

• Formula Product Lines

• Formula Product Line Edit

• Formula By-Product Lines

• Formula Ingredient Lines
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Maintaining Formulas at the Formula Header Level
Use the following windows to maintain formulas at the header level:

• Formula Summary By to display a list of defined formulas with their individual 
version numbers and descriptions. These display Class, Status, Owner, Laboratory, 
Product, or Plant. Display the Formula Details window from the Formula Summary
By window.

• Formula Header Summary to display important descriptive information on a 
specific formula. Display the following windows from the Formula Header 
Summary window:

• Formula Details

• Formula Product Lines

• Formula By-Product Lines

• Formula Ingredient Lines

• Formula Product Summary to display a summary of all formula products. Display 
the following windows from the Formula Product Summary window:

• Formula Product Lines

• Formula Product Line Edit

• Formula Product Lines to display individual formula product lines. Display the 
Formula Product Line Edit window from the Formula Product Lines window.

• Formula By-Product Summary to display a summary of all formula byproducts. 
Display the following windows from the Formula By-Product Summary window:

• Formula By-Product Lines

• Formula By-Product Line Edit

• Formula By-Product Lines to display individual formula byproduct lines. Display 
the Formula By-Product Line Edit window from the Formula By-Product Lines 
window.

• Formula Ingredient Summary to display a summary of all formula ingredients. 
Display the following windows from the Formula Ingredient Summary window:

• Formula Ingredient Lines
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• Formula Ingredient Line Edit

• Formula Ingredient Lines to display individual formula ingredient lines. Display 
the Formula Ingredient Line Edit window from the Formula Ingredient Lines 
window.

The following graphic depicts the previously described formula navigation flow from 
the Formulas node and from the Products, By-Products and Ingredients nodes:

Maintaining Formulas at the Line Level
Use the following windows to maintain formulas at product, byproduct, and ingredient
line level:

• Formula Product Line Summary to display a summary of the individual formula 
product lines, with an item number and unit of measure associated with each line. 
Display the Formula Product Line Edit from the Formula Product Line Summary 
window.

• Formula Product Line Edit to edit individual lines in the Formula Product Line 
Summary.

• Formula By-Product Line Summary to display a summary of the individual 
formula byproduct lines, with an item number and unit of measure associated with 
each line. Display the Formula By-Product Line Edit window from the Formula By-
Product Line Summary window:

• Formula By-Product Line Edit to edit individual lines in the Formula By-Product 
Line Summary.
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• Formula Ingredient Line Summary to display a summary of the individual formula 
ingredient lines, with an item number and unit of measure associated with each 
line. Display the Formula Ingredient Line Edit window from the Formula 
Ingredient Line Summary window.

• Formula Ingredient Line Edit to edit individual lines in the Formula Ingredient Line
Summary.

The following graphic depicts the previously described formula navigation flow from 
an individual product node (PROD 1), byproduct node (BY-PROD1), and ingredient 
node (INGR1).

Creating a Packaging Formula
In addition to defining the way bulk items are produced, formulas are used to define 
the way items are packaged. To set up a packaging formula, enter the packaged item 
itself as product. Then enter the bulk item, packaging container, and package label as 
ingredients. Select the Packaging indicator in the formula header.

Calculating Formula Product Quantities
The Automatic Calculation of Product Quantity determines single or multiple product 
quantities based on the ingredients, UOM, Scale Type, Percentage, Contribute to Yield 
Indicator, and byproduct quantities entered in the formula.

The formula product quantity is automatically calculated as the sum of the ingredients 
contributing to yield minus sum of the byproduct quantities. The resultant product 
quantity is divided among the products proportionally based on the individual 
percentages entered.
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Formula Product Quantity = [(Sum of Contributing Ingredients Quantities)
? (Sum of Byproduct Quantities)] * [(Percentage Entered for Product) / 
100]

In the following example, Ingredient A is mixed with Ingredients B and C to yield 
Products X and Y and Byproduct Z. Ingredient C is a catalyst and does not contribute to
the product yield. With automatic product quantity calculation, the formula product 
quantities are calculated as follows:

Formula 
Line

Quantity Entered Percentage Contribute To Yield Quantity 
Calculated

Ingredient A 40 LB N/A Yes N/A

Ingredient B 60 LB N/A Yes N/A

Ingredient C 20 LB N/A No N/A

Byproduct Z 10 LB N/A N/A N/A

Product X N/A 60 N/A 54 LB

Product Y N/A 40 N/A 36 LB

The product quantity for Product X is calculated as (40 LB + 60 LB ? 10 
LB) * 60/100 = 54 LB
The product quantity for Product Y is calculated as (40 LB + 60 LB ? 10 
LB) * 40/100 = 36 LB

Creating Version Control Attribute Sets for Formulas
You can set up version control at the Formula attribute level. You can create a version 
control attribute set for Formula and assign it to the organization. This ensures that 
when modifying attributes in the Formula Details window that are included in the 
attribute set, you will be able to create a new version of the formula with the same 
entity names but with a different version number. Should you not want to create a new 
version, you can select to cancel and continue with the existing formula.

To set up version controlling attribute sets at the Formula entity level, see: Setting Up 
Version Control Attribute Sets, page 2-39.

Finding a Formula
The Find Formulas window enables you to find a specific formula. You can find 
formulas that you have entered and saved and display summary windows from the 
workbench.
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To find a formula:
1. Navigate to the Find Formulas window.

2. Enter as many parameters as needed to complete the search:

• Enter search parameters in the Standard region for Formula, Version, 
Description, Class, Product, or Ingredient.

• Enter search parameters in the Advanced region to enter a specific: Item, 
Condition, or Value.

3. Click Find.

4. Review the results of the search.

Displaying the Formula Summary
The Formula Summary window presents a list of formulas associated with the View By 
option selected. The window displays individual versions and a brief description of the 
formula, and can be viewed by Class, Status, Owner, Laboratory, Product, or Plant.

To display a list of all defined formulas:
1. Navigate to the Formula Summary By window.

2. Use the View By list to select how you want to view the summary of formulas.

3. Select one of the following views:

• Class to display the list by formula class

• Status to display the list by formula status

• Owner to display the list by formula owner

• Laboratory to display the list by laboratory

• Product to display the list by primary product

• Plant to display the list by plant

4. The following fields are display only:

• Formula is the code assigned to the formula.

• Version is the version of the formula.
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• Description is a brief explanation of the formula.

• Product is the primary product associated with the formula.

• Quantity is the amount of material associated with the formula.

• UOM is the primary unit of measure for the material associated with the 
formula.

5. Click Details to display the Formula Details window.

Displaying the Formula Header Summary
The Formula Header Summary window displays important descriptive header 
information on a specific formula.

To display a summary of formula headers:
1. Navigate to the Formula Header Summary window.

2. Select the appropriate Formula.

3. The following fields are display only:

• Status is the status of the formula.

• Formula is the code assigned to the formula.

• Version is the version of the formula.

• Description is a brief explanation of the formula.

• Comments are the remarks or notes entered for the formula.

• Class is an optional classification assigned to the formula.

• Class Description is an optional classification description assigned to the 
formula.

• Main Product is the end item for the listed formula.

• Product Description is a description the main product produced by the formula.

• Owner is a code for the owner of the formula.

• Owner Name is the complete name of the formula owner.
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• Scaling Allowed indicates whether the formula allows scaling. If selected, then 
scaling is allowed. See: Scaling Formulas, page 3-12.

• Packaging Formula indicates whether the formula is a packaging type formula. 
If selected, then the formula is a packaging formula.

• Organization is the formula owning organization.

4. Click Products to display the Formula Product Line Summary window.

5. Click By-products to display the Formula By-Product Line Summary window.

6. Click Ingredients to display the Formula Ingredient Line Summary window.

7. Click Details to display the Formula Details window.

Entering Formula Details
Use the Formula Details window to enter details for a specific formula. When creating a
new formula on the Formula Details window, the LOV for the Formula field lets you 
select or query the product from the Item Master. When you select a product name to 
use as a formula name, the formula Description field has the item description entered 
automatically. The product UOM and product description continue to be entered 
automatically. For automatic product and description entry, select a valid item. If the 
item description changes subsequently, then the formula description does not change, 
and it must be updated manually. When you modify formula details, you cannot delete 
the last remaining product or ingredient in a formula. Select a context organization 
prior to entering formula details.

You can also use the Formula Details page, to enter serial control enabled items as 
products, by-products, and ingredients. While the same steps are used to define 
formulas for non-serial and serial controlled items, when defining a serial controlled 
item as an ingredient, you must select the Scale Type as Integer.

Note: You can enter engineering items in a formula that is approved for
laboratory use. Remove engineering items from a formula and replace 
them with production approved items prior to requesting approval for 
general use.

Important:  The item substitution functionality modifies formula item 
usage. See: Managing Item Substitutions in Formulas, page 7-9.

You can also create a version control attribute set at the Formula entity level and assign 
it to the organization. This will enable you to modify the selected Formula attributes 
included in the set and create new versions of the Formula. See: Setting Up Version 
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Control Attribute Sets, page 2-39.

There may be an e-signature event associated with this window. See: Appendix D 
Oracle E-Records Events in Product Development, page D-1.

To use the Formula Details window ensure that you

• Set up the ingredients, products, and byproducts with UOM conversions based on 
the Yield UOM, Mass UOM, and Volume UOM parameters.

• Optionally, enter and save formula classes.

• Optionally, set the parameter for automatic product quantity calculation.

To enter formula details:
1. Navigate to the Formula Details window.

2. Enter the code for the Formula. Required.

3. Enter the Formula Version. Required.

4. Return to this window to change status by selecting Change Status from the Actions
menu after entering all relevant information and saving the formula with the 
default Status of New. Depending on whether workflow is enabled, a different set 
of statuses is available. See: Appendix C Oracle Process Manufacturing Product 
Development Status Codes, page C-1.

5. Enter a Description that briefly explains the formula. Required.

6. Enter Comments that need to accompany this formula. For example, enter 
CUSTOM PROPRIETARY FORMULA. DO NOT COPY. This field also allows 
multilingual entries.

7. Enter a Class for the formula to identify how it is categorized. The Class Description
assigned to the formula displays.

8. Organization displays the name of the organization responsible for the formula. 
The Organization Description assigned to the organization displays.

9. Enter the Owner of the formula. The Owner Description displays.

10. Select Scaling Allowed to indicate the formula allows scaling.

11. Select Packaging when the formula is a packaging formula.

12. Select Calculate Product Quantity to indicate the formula automatically calculates 
the quantity for products with the Proportional scale type.
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Products
13. The Line number for each product listed displays. These fields cannot be edited.

14. Enter the Product code for each item produced by this formula. If the formula code 
entered is the same as an item code, then that item code displays as the default for 
the first product line. A minimum of one product is required for a formula. 
Required.

15. Enter the Revision, or leave this blank if there is no revision.

16. Enter Quantity of the product that this formula yields. The product quantity 
defaults if Calculate Product Quantity checkbox is selected. The quantity entered in 
this field is the default standard quantity used for the recipe. Required.

17. Enter Percentage for each product in the formula.

18. Enter Percentage as the ratio of product quantity compared to the total output 
quantity for all products in the formula expressed as a percentage. Percentage is 
used to calculate the quantity for each product by distributing the contributing 
ingredients without byproducts proportionally across the multiple products that 
are scalable.

19. The Description of the product entered displays. This defaults from the Item Master
table.

20. Enter Quantity of the product that this formula yields. The quantity entered in this 
field is the default standard quantity used for the recipe. Required.

21. Enter the UOM for the quantity entered. The inventory unit of measure for the item 
is the default. If you enter a different unit of measure, then set up a unit of measure 
conversion between the default and the unit of measure you decide to enter. 
Conversions between units of measure of the same unit of measure type are defined
in Oracle Inventory. Required.

22. Select the Scale Type as:

• Fixed if the product is not scalable.

• Proportional if the product is scalable.

23. Select the Yield Type to indicate the type of product yield as:

• Automatic when products are yielded automatically when the batch is 
completed.

• Manual when products are yielded manually.
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• Incremental when product is yielded by incremental backflushing.

• Automatic by Step when products are yielded automatically as the step is 
completed.

Required.

24. Cost Allocation indicates how the cost of this item is allocated for financial rollup 
purposes.

By-Products
25. The Line number for each byproduct listed displays. These fields cannot be edited.

26. Enter the By-Product code for byproduct items produced by this formula. 
Byproducts are not required for a formula.

27. The Description of the byproduct entered displays. This defaults from the Item 
Master table.

28. Enter the Quantity of the byproduct that this formula yields. The quantity entered 
in this field is the default standard quantity used for the recipe. It can be changed at
the recipe level.

Required if you enter one or more byproducts for the formula.

29. Enter the UOM for the quantity entered. The inventory unit of measure for the item 
is the default. If you enter a different unit of measure, then set up a unit of measure 
conversion between the default and the unit of measure you decide to enter. 
Conversions between units of measure of the same unit of measure type are defined
in Oracle Inventory. Required.

30. Select the Scale Type as:

• Fixed if the byproduct is not scalable.

• Proportional if the byproduct is scalable.

Required.

31. Select the Yield Type to indicate the type of byproduct yield as:

• Automatic when byproducts are yielded automatically when the batch is 
completed.

• Manual when byproducts are yielded manually.

• Incremental when byproduct is yielded by incremental backflushing.



Formulas    3-31

• Automatic by Step when byproducts are yielded automatically as the step is 
completed.

Required.

32. Enter the following By-product Type:

• Rework if the material generated requires rework.

• Sample if the material generated is used as a sample for quality inspection.

• Waste if the material is a waste product.

• Yield if the byproduct is material that is yielded for use in another process.

Ingredients
33. The Line number for each ingredient listed displays. These fields cannot be edited.

34. Enter the Ingredient code for each item required by this formula. A minimum of 
one ingredient is required for a formula. Required.

35. Enter the Revision number.

36. The Description of the ingredient entered displays. This defaults from the Item 
Master table.

37. Enter Quantity of the ingredient that this formula requires. The quantity entered in 
this field is the default standard quantity used for the recipe. It can be changed at 
the recipe level. Required.

38. Enter the UOM for the Quantity entered. The inventory unit of measure for the Item
is the default. Conversions between units of measure of the same unit of measure 
type are defined in Oracle Inventory. Required.

39. Select the Scale Type as:

• Fixed if the ingredient is not scalable.

• Proportional if the ingredient is scalable.

• Integer if the ingredient is scalable by multiples.

• Integer if the ingredient is a serial controlled item.

40. Enter the Scale Multiple as the scaling increment for the ingredient.

41. Enter the optional Scale Rounding Variance if the integer scale type is selected. 
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Enter this value as the percent variance allowable for rounding when the Scale Type
is Integer.

42. Enter the optional Rounding Direction if the integer scale type is selected as:

• Down if the acceptable rounding direction is down to the nearest multiple.

• Either if the acceptable rounding direction is up or down to the nearest 
multiple.

• Up if the acceptable rounding direction is up to the nearest multiple.

43. Select the Consumption Type to indicate the type of ingredient consumption as:

• Automatic when ingredients are consumed automatically when the batch is 
completed.

• Manual when ingredients are consumed manually.

• Incremental when ingredient consumption is calculated by incremental 
backflushing.

• Automatic by Step when ingredients are consumed automatically as the step is 
completed.

Required.

44. Select Contribute to Yield as Yes or No to indicate whether the material contributes 
to the yield. Required.

45. Select Contribute to Step Qty as Yes or No to indicate whether the material 
contributes to the to the step quantity. Required.

46. Select the Phantom Type:

• Not a Phantom indicates the ingredient is not a phantom item.

• Automatic Generation indicates the ingredient is a phantom item that is 
exploded automatically.

• Manual Generation indicates that the ingredient is a phantom item that requires
manual explosion.

Required.

47. Buffer specifies those ingredients that are used to maintain the target quantity while
working with a formula or batch on the Simulator. The Calculate indicator on the 
Optimizer window is the default for all the ingredients selected as buffer in the 
formula.
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48. Enter Scrap Factor as the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the scrap factor is 10 
percent, then an additional 10 percent of material is added to accommodate for this 
loss. Required.

49. Required Qty displays the result of multiplying the formula quantity by the 
quantity one plus the scrap factor expressed as a percent. For example, if the scrap 
factor is 10 percent and the formula quantity is 100 pounds, then the required 
quantity is 110 pounds. It represents the planned quantity plus the scrap.

50. Save your work.

Note: If you create and assign a version control attribute set for the 
Formula entity and if you modify any of the attributes included in 
that set, you will be prompted to create a new version of the 
formula when you save your work. See: Setting Up Version Control
Attribute Sets, page 2-39.

51. Click Edit Line to display the Formula Product Line Edit window.

52. Click Products to display the Formula Product Lines window.

53. Click By-Products to display the Formula By-Product Lines window.

54. ClickIngredients to display the Formula Ingredient Lines window.

To scale the formula:
1. Choose Scale from the Actions menu. The Scale Formula window displays.

2. Select one of the following:

• Percent to scale by a percentage. Enter the value in the Factor field.

• Item Quantity to scale by a specific quantity. Enter the New Quantity.

3. Click OK to display the scaled formula.

4. Optionally, save the scaled formula.

To mark the formula for deletion:
1. Choose Mark for Purge from the Actions menu. The record is marked for deletion.

2. Save your work.
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To change the formula status:
1. Choose Change Status from the Actions menu.

2. Change the Current Status displayed by selecting a different status from the 
Change Status To list.

3. Click OK. The Formula Details window displays the revised Status for the Formula.

To edit the formula text:
1. Choose Edit Text from the Actions menu.

2. Make the appropriate edits to formula text.

3. Save your work.

To access the Samples Summary window:
1. Choose Samples from the Actions menu. The Samples Summary window displays.

2. Evaluate production samples.

To display the Specifications window:
1. Choose Specifications from the Actions menu. The Specifications window displays.

2. Evaluate specifications.

To select technical data:
1. Select an intermediate ingredient line with technical parameters.

2. Choose Technical Data Selection from the Actions menu. The Technical Data 
Selection window displays.

3. Evaluate technical data.

To display process instructions:
1. Select the product, byproduct, or ingredient line associated to the process 

instructions set.

2. Choose Process Instructions from the Actions menu. The appropriate Instruction 
Set window displays.
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To display product technical parameters:
1. Select the Line to display technical parameters.

2. Choose Product Technical Parameters from the Actions menu. The Product 
Technical Parameters window displays.

3. Evaluate the technical parameters.

To list engineering items:
1. Choose List Engineering Items from the Actions menu. The List Engineering Items 

window displays.

2. Evaluate the list for the Formula and Version . The Material, Line, and a brief 
Engineering Item Description display for each component in the list.

To display theoretical yield:
1. Choose Calculate Theoretical Yield from the Actions menu. The Theoretical Yield 

window displays.

2. Evaluate the Yield Percent.

To duplicate a record:
1. Retrieve the Formula Details record to duplicate.

2. Choose New from the File menu.

3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Formula name and Version number.

5. Save your work.

Copying a Formula
Use the Copy Formula window to copy a preexisting formula into another organization.
You can assign a new formula name and version to the copied formula. The 
organization must have access to the items defined in the formula. Use the copy 
formula function to create customized formulas for use in general, site, master, and 
control recipe types.

You can create a single formula in the research and development laboratory during the 
pilot phase of product development. This Formula functions as the master formula for 
different site-specific formulas. You can copy a master formula to child organizations. 
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The master formula is stored with the formulas created from copying function.

To copy a formula:
1. Navigate to the Copy Formula window.

2. The following fields are display only:

• Organization is the name of the organization that owns the formula.

• Formula is the name of the formula to copy and its Version number in the 
organization.

3. Enter the Organization, Formula name, and Version that you want this formula 
copied to.

4. Click Copy.

Scaling a Formula
Use the Scale Formula window to scale a formula by a percent or by an item quantity.

Using a Percent to Scale a Formula:

Enter a percentage to scale any scalable ingredient up or down by a percent of the 
displayed quantity. For example, if you enter 100 percent, then the quantity of the 
selected item is scaled up by 100 percent, or doubled, and the other quantities are 
increased accordingly. If you enter -50, or negative fifty percent, the item quantity is 
decreased by half.

Using an Item Quantity to Scale a Formula:

This is the simplest method to scale any scalable ingredients. Enter a new quantity of 
material.

To scale a formula by a percentage:
1. Select the material Line to scale. For example, select a product.

2. Choose Scale from the Actions menu. The Scale Formula window displays.

3. Click Percent.

4. Enter a percentage for the scaling Factor. For example, to double the material, enter 
100.

5. Click OK to display the scaled formula.

6. Optionally, save the scaled formula.
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To scale a formula by entering a new quantity:
1. Choose Scale from the Actions menu. The Scale Formula window displays.

2. Click Item Quantity.

3. The following fields are display only:

• Line displays the line number of the material on the Formula Details window.

• Item displays the item code listed on the Formula Details window.

• Description displays a brief description of the item.

• Old Quantity displays the quantity to rescale with its UOM.

4. Enter a New Quantity for the material.

5. Click OK to display the scaled formula.

6. Optionally, save the scaled formula.

Displaying Ingredient Technical Parameters
Use the Ingredient Technical Parameters window to display and evaluate technical 
parameters for selected ingredients.

To display ingredient technical parameters:
1. Choose Ingredient Technical Parameters from the Actions menu. The Ingredient 

Technical Parameters window displays.

2. Evaluate technical parameters for selected ingredients and make necessary changes.

Using the View Menu to Find a Formula
Use the Find selection from the View menu to find a formula.

To find a formula from the View menu:
1. Choose Find from the View menu.

2. Enter as many parameters as needed to complete the search:

• Status
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• Formula

• Version

• Description

• Product

• Formula Class

• Owner

• Organization

• Scaling Allowed

• Marked for Deletion

3. Click Find.

4. Review the results of the search.

Displaying the Formula Product Summary
The Formula Product Summary window enables you to display a summary of products
listed in a formula. 

To display the formula product summary:
1. Navigate to the Formula Product Summary window.

2. The following fields are display only:

• Line determines the line sequence for products listed in the Formula.

• Item No determines the item code for products listed in the Formula.

• Quantity determines the amount for products listed in the Formula.

• Description determines a brief explanation of the product entered. This defaults
from the Item Master table.

• UOM determines the unit of measure for products listed in the Formula.

• Yield Type to indicate the type of product yield as:

• Automatic if the product is yielded when the batch is completed.
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• Manual if the product is yielded manually.

• Incremental if the product is yielded by incremental backflushing.

• Automatic by Step when products are yielded automatically as the step is 
completed.

• Required Qty displays planned quantity plus the scrap.

• Scale Type displays whether the scaling is Fixed or Proportional. See: Scaling 
Formulas, page 3-12.

• Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

3. Click Edit Line to display the Formula Product Line Edit window.

Displaying the Formula Byproduct Summary
Use the Formula By-Product Summary window to display a summary of byproducts 
listed in a formula.

To display the formula byproduct summary:
1. Navigate to the Formula By-Product Summary window.

2. The following fields are display only:

• Line determines the line sequence for byproducts listed in the Formula.

• Item No determines the item code for byproducts listed in the Formula.

• Quantity determines the amount for byproducts listed in the Formula.

• Description determines a brief explanation of the byproduct entered. This 
defaults from the Item Master table.

• UOM determines the unit of measure for byproducts listed in the Formula.

• Select the Yield Type to indicate the type of byproduct yield as:

• Automatic when byproducts are yielded automatically when the batch is 
completed.

• Manual when byproducts are yielded manually.
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• Incremental when byproducts are yielded by incremental backflushing.

• Automatic by Step when byproducts are yielded automatically as the step 
is completed.

• Scale Type displays whether the scaling is Fixed or Proportional. See: Scaling 
Formulas, page 3-12.

• By-product Type displays whether the byproduct is Rework, Sample, Waste, or 
Yield. See: Setting Up Formula Information, page 3-9.

3. Optionally, click Edit Line to display the Formula By-Product Line Edit window.

Displaying the Formula Ingredient Summary
Use the Formula Ingredient Summary window to display a summary of ingredients 
listed in a formula.

To display the formula ingredient summary:
1. Navigate to the Formula Ingredient Summary window.

2. The following fields are display only:

• Line determines the line sequence for ingredients listed in the Formula.

• Item No determines the item code for ingredients listed in the Formula.

• Quantity determines the amount for ingredients listed in the Formula.

• Description determines a brief explanation of the ingredient entered. This 
defaults from the Item Master table.

• UOM determines the unit of measure for ingredients listed in the Formula.

• Consumption Type indicates the type of ingredient consumption as:

• Automatic if the ingredient line is automatically consumed when a 
subsequent line is released.

• Manual if the ingredient line is released and completed manually.

• Incremental if the line is consumed by incremental backflushing.

• Automatic by Step when ingredients are consumed automatically as the 
step is completed.
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• Contributes to Step Qty indicates whether the line contributes to step quantity.

• Scrap Factor displays the anticipated amount of ingredient loss during 
manufacturing as a percentage. For example, if the Scrap Factor is 10 percent, 
an additional 10 percent of material is added to accommodate for this loss.

• Required Qty displays the planned quantity plus the scrap.

• Scale Type displays whether the scaling is Fixed, Proportional, or Integer. See: 
Scaling Formulas, page 3-12.

• Phantom Type determines whether the ingredient is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom.

3. Click Details to display the Formula Ingredient Line Edit window.

Displaying a Summary of Formula Product Lines
Use the Formula Product Line Summary window to display formula product lines. 
Ensure that you:

• Set up the Allow Zero Ingredient Quantity parameter.

• Enter and save formulas.

To display the formula product line summary:
1. Navigate to the Formula Product Line Summary window.

2. The following fields are display only:

• Line determines the line sequence for each product listed in the Formula.

• Item determines the item code for each product listed in the Formula.

• Description displays a brief explanation of the product entered. This defaults 
from the Item Master table.

• Quantity determines the amount for each product listed in the Formula.

• UOM determines the unit of measure for quantities of product listed in the 
Formula.

• Yield Type to indicate the type of product yield as:

• Automatic if the product is yielded when the batch is completed.
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• Manual if the product is yielded manually.

• Incremental if the product is yielded by incremental backflushing.

• Automatic by Step when products are yielded automatically as the step is 
completed.

• Scale Type displays whether the scaling is Fixed or Proportional. See: Scaling 
Formulas, page 3-12.

• Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

3. Click Details to display the Formula Product Line Edit window.

4. Close the window.

Editing Formula Product Lines
Use the Formula Product Lines window to edit formula product lines.

You cannot delete the last remaining product or ingredient in a formula. You cannot 
delete a product from a formula that has a validity rule saved for the formula and 
product combination.

To edit the formula product lines:
1. Navigate to the Formula Product Lines window.

2. Line displays the line sequence for each product listed in the formula.

3. Enter the Item No as the item code for each product listed in the formula. Required.

4. Enter the Quantity as the amount for each product listed in the formula. Required.

5. Description displays a brief explanation of the product entered. This defaults from 
the Item Master table.

6. Enter the UOM as the unit of measure for the quantity. Required.

7. Select the Yield Type to indicate the type of product yield as:

• Automatic if the line is automatically released or completed when subsequent 
steps are released or completed.

• Manual if the line is released and completed manually.
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• Incremental if the line is released by incremental backflushing.

• Automatic by Step when products are yielded automatically as the step is 
completed.

Required.

8. Enter the Scale Type to indicate whether the scaling is Fixed, Proportional, or 
Integer. See: Scaling Formulas, page 3-12.

9. Cost Allocation indicates how the cost of this item is allocated for financial rollup 
purposes.

Displaying a Summary of Formula Byproduct Lines
Use the Formula By-Product Line Summary window to display a summary of formula 
byproduct lines.

To display a summary of formula byproducts:
1. Navigate to the Formula By-Product Line Summary window.

2. The following fields are display only:

• Line determines the line sequence for each byproduct listed in the formula.

• Item determines the item code for each byproduct listed in the formula.

• Description determines a brief explanation of the byproduct entered. This 
defaults from the Item Master table.

• Quantity determines the amount for each byproduct listed in the formula.

• UOM determines the unit of measure for the quantity.

• Select the Yield Type to indicate the type of byproduct yield as:

• Automatic when byproducts are yielded automatically when the batch is 
completed.

• Manual when byproducts are yielded manually.

• Incremental when byproduct is yielded by incremental backflushing.

• Automatic by Step when byproducts are yielded automatically as the step 
is completed.
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• Scale Type displays whether the scaling is Fixed, Proportional, or Integer. 
Required. See: Scaling Formulas, page 3-12.

• By-product Type displays whether the byproduct is Rework, Sample, Waste, or 
Yield. See: Setting Up Formula Information, page 3-9.

3. Optionally, click Details to display the Formula By-Product Line Edit window.

Editing Formula Byproduct Lines
Use the Formula By-Product Lines window to edit formula byproduct lines.

To edit the formula byproduct lines:
1. Navigate to the Formula By-Product Lines window.

2. Line displays the line sequence for each byproduct listed in the formula.

3. Enter the Item No as the item code for each byproduct listed in the formula. 
Required.

4. Enter the Quantity as the amount for each byproduct listed in the formula. 
Required.

5. Description displays a brief explanation of the byproduct entered. This defaults 
from the Item Master table.

6. Enter the UOM as the unit of measure for the quantity. Required.

7. Select the Yield Type to indicate the type of byproduct yield as:

• Automatic when byproducts are yielded automatically when the batch is 
completed.

• Manual when byproducts are yielded manually.

• Incremental when byproducts are yielded by incremental backflushing.

• Automatic by Step when byproducts are yielded automatically as the step is 
completed.

Required.

8. Select the By-product Type as:

• Rework when the byproduct requires rework.
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• Waste when the byproduct is a waste material.

• Sample when the byproduct is a sample for quality testing.

• Yield when the byproduct generated is yielded to another process or step.

Required.

9. Enter the Scale Type to indicate whether the scaling is Fixed or Proportional. See: 
Scaling Formulas, page 3-12.

10. Save your work.

11. Optionally, click Edit Line to edit a selected Line Number. The Formula By-Product 
Line Edit window displays.

Editing a Formula Byproduct Line
Use the Formula By-Product Line Edit window to edit formula byproduct lines.

To edit a formula byproduct line:
1. Navigate to the Formula By-Product Line Edit window.

2. The following fields are display only:

• Line is the line sequence for each byproduct listed in the formula.

• Item is the item code for each byproduct listed in the formula.

• Description is a brief explanation of the byproduct entered. This defaults from 
the Item Master table.

3. Enter the Quantity for the byproduct Line listed in the formula. Required.

4. Enter the UOM for the quantity. Required.

5. Select the Yield Type to indicate the type of byproduct yield as:

• Automatic when byproducts are yielded automatically when the batch is 
completed.

• Manual when byproducts are yielded manually.

• Incremental when byproducts are yielded by incremental backflushing.

• Automatic by Step when byproducts are yielded automatically as the step is 
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completed.

Required.

6. Enter the Scale Type as Fixed or Proportional. Required. See: Scaling Formulas, 
page 3-12.

7. Enter the By-product Type as Rework, Sample, Waste, or Yield. See: Setting Up 
Formula Information, page 3-9.

Displaying a Summary of Formula Ingredient Lines
Use the Formula Ingredient Line Summary window to display a summary of formula 
ingredient lines.

To display a summary of formula ingredients:
1. Navigate to the Formula Ingredient Line Summary window.

2. The following fields are display only:

• Line is the line sequence for each ingredient listed in the formula.

• Item is the item code for each ingredient listed in the formula. 

• Description is a brief explanation of the ingredient entered. This defaults from 
the Item Master table.

• Quantity is the amount for each ingredient listed in the formula.

• UOM is the unit of measure for the quantity.

• Select the Consumption Type to indicate the type of ingredient consumption as:

• Automatic when ingredients are consumed automatically when the batch is
completed.

• Manual when ingredients are consumed manually.

• Incremental when ingredient consumption is calculated by incremental 
backflushing.

• Automatic by Step when ingredients are consumed automatically as the 
step is completed.

• Scale Type indicates whether the scaling is Fixed, Proportional, or Integer. See: 
Scaling Formulas, page 3-12.
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• Phantom Type indicates whether the ingredient is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom.

• Contributes to Step Qty indicates whether the ingredient contributes to the step 
quantity.

• Scrap Factor is the anticipated amount of ingredient lost in the manufacturing 
process as a percentage. For example, if the scrap factor is 10 percent, then an 
additional 10 percent of material is added to accommodate for this loss.

• Required Quantity is the result of multiplying the formula quantity by the 
quantity one plus the scrap factor expressed as a percent. For example, if the 
scrap factor is 10 percent and the formula quantity is 100 pounds, then the 
required quantity is 110 pounds.

3. Optionally, click Details to display the Formula Ingredient Line Edit window.

Editing Formula Ingredient Lines
Use the Formula Ingredient Lines window to edit formula ingredient lines. You cannot 
delete the last remaining product or ingredient in a formula.

To edit the formula ingredient lines:
1. Navigate to the Formula Ingredient Lines window.

2. Line displays the line sequence for each ingredient listed in the formula.

3. Enter the Item No as the item code for the ingredient listed in the formula. 
Required.

4. Enter the Quantity as the amount for each ingredient listed in the formula. 
Required.

5. Description displays a brief explanation of the ingredient listed in the formula. 

6. Enter the UOM as the unit of measure for the quantity. Required.

7. Select the Consumption Type as:

• Automatic when ingredients are consumed automatically when the batch is 
released.

• Manual when ingredients are consumed manually.

• Incremental when ingredients are consumed by incremental backflushing.
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• Automatic by Step when ingredients associated to the step are consumed 
automatically as the step is released.

Required.

8. Select Yes if the ingredient Contributes To Step Qty. Required

9. Select Yes if the ingredient Contributes to Yield.

10. Enter Scrap Factor as the anticipated amount of ingredient lost in the 
manufacturing process expressed as a percentage. For example, if the Scrap Factor 
is 10 percent, then an additional 10 percent of material is added to accommodate for
this loss. Required.

11. Required Qty displays the result of multiplying the formula quantity by the 
quantity one plus the scrap factor expressed as a percent. For example, if the scrap 
factor is 10 percent and the formula quantity is 100 pounds, then the required 
quantity is 110 pounds. It represents the planned quantity plus the scrap.

12. Enter the Scale Type displays whether the scaling is Fixed, Proportional, or Integer. 
See: Scaling Formulas, page 3-12.

13. Enter the Phantom Type to indicate whether the ingredient is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom. Required.

To find a formula line:
1. Choose Find from the View menu. The Find Formula Line window displays.

2. Enter one or more of the following to narrow your search:

• Formula No as the formula code number.

• Formula Version as the formula version number.

• Line Type as Automatic, Manual, or Incremental release.

3. Click Find.

4. Review the results of your search.

5. Optionally, click New to enter a new formula line.

Editing a Formula Ingredient Line
Use the Formula Ingredient Line Edit window to edit formula ingredient lines.
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To edit a formula ingredient line:
1. Navigate to the Formula Ingredient Line Edit window.

2. The following fields are display only:

• Line determines the line sequence for each ingredient listed in the formula.

• Item determines the item code for each ingredient listed in the formula.

• Description determines a brief explanation of the ingredient entered. This 
defaults from the Item Master table.

3. Enter the Quantity for the ingredient line listed in the formula. Required.

4. Enter the UOM for the quantity. Required.

5. Select the Consumption Type to indicate the type of ingredient consumption as:

• Automatic when ingredients are consumed automatically when the batch is 
completed.

• Manual when ingredients are consumed manually.

• Incremental when ingredient consumption is calculated by incremental 
backflushing.

• Automatic by Step when ingredients are consumed automatically as the step is 
completed.

Required.

6. Enter the Scale Type as Fixed, Proportional, or Integer. See:Scaling Formulas, page 
3-12.

7. Enter the Phantom Type to indicate that this line is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom. Required.

8. Select Contributes To Step Qty if the line contributes to step quantity.

9. Enter the Scrap Factor as the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the scrap factor is 10 
percent, then an additional 10 percent of material is added to accommodate for this 
loss. Required.

10. Required Quantity displays the result of multiplying the formula quantity by the 
quantity one plus the scrap factor expressed as a percent. For example, if the scrap 
factor is 10 percent and the formula quantity is 100 pounds, then the required 
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quantity is 110 pounds.

11. Cost Allocation indicates how the cost of this item is allocated for financial rollup 
purposes.

Using Computer-Aided Formulation
Research and development laboratories and production facilities use simulations to test 
theoretical product formulation scenarios. This saves the time and cost of using actual 
materials and equipment. Alternate items and lots can be inserted to achieve the best 
material blend. Product targets can be specified for ingredient optimization. In-process 
production can be fine tuned for available inventory or for changes in the 
manufacturing conditions. Security and business rules are enforced to provide a 
controlled yet flexible working environment to use these simulation tools for increased 
productivity and cost savings.

Process manufacturing industries make products that have chemical and physical 
properties that can be predicted by algorithms. These step-by-step problem-solving 
procedures use recursive computational procedures to predict formulations in a finite 
number of steps. With the proper algorithms, you can alter the amount of raw 
materials, and the application calculates the effect on the product. Alternatively, by 
selecting target finished good properties, such as a prescribed value for Volatile Organic
Compound (VOC), or a desired cost, the application can alter the quantities of raw 
materials in a formula to produce the target product values. The availability of 
modeling features in an environment which is separate from the production formula 
lets formulators simulate changes without affecting current formulas and recipes.

Computer-Aided Formulation provides these benefits:

• Get products to market more quickly.

• Scope out ideas without need for expensive and time-consuming experimentation 
and testing.

• Provide researchers with a workbench to pursue creative ideas.

• Redirect research efforts early to minimize losses when results do not meet 
expectations.

• Simplify installations and integrations by eliminating multiple applications in use 
for advanced formulation.

Following are stages for using Computer-Aided Formulation:

• Setting Up for Computer-Aided Formulation

• Using the Simulator
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• Optimizing Formulas and Batches

Setting Up for Computer-Aided Formulation
Following are the setup steps for using computer-aided formulation:

Step 1: Define a laboratory organization.

Laboratories are used to group technical parameters. Common technical parameters are 
loaded to the Simulator and Optimizer windows through the laboratory organization. 
This organization must be marked as a Laboratory on the Product Development 
Parameters window to use it as a context organization in the Simulator.

See: Setting Up Laboratory Organizations, page 2-21.

If you intend to use quality data for a formula simulation or laboratory batch, then 
create quality data that is owned by the laboratory you define. As an optional step, if 
quality data is already defined for production batch items at the plant level, then the 
simulation uses quality data for that plant.

Step 2: Set profile options and Product Development Parameters.

• Profile option for GMD: Density

• Parameter for Yield UOM

• Parameter for Mass UOM

• Parameter for Volume UOM

The above parameters are required for converting density values in the Simulator 
window.

• Parameter for Automatic Product Quantity Calculation

Step 3: Define technical parameters for the laboratory organization.

Technical parameters are those characteristics of items to measure, optimize, or 
rebalance for a formula or batch. You can use quality tests as technical parameters. This 
can be done on an organization specific basis or globally across all organizations. See: 
Setting Up Technical Parameters, page 2-22. If a quality test is numeric or numeric 
range with display labels, then the data type on the Technical Parameters window can 
remain numeric, or changed to weight%, volume%, equivalent weight, or quantity per 
unit. This applies to numeric quality tests, and you cannot change other quality tests.

Step 4: Sequence technical parameters.

The Technical Parameter Sequences window establishes which technical parameters to 
use for a simulation, and the order in which they display on the Simulator. If you do not
sequence the parameters, then the technical parameters do not appear on the Simulator 
or Optimizer windows. If you do not want a parameter to display on a simulation, then 



3-52    Oracle Process Manufacturing Product Development User's Guide

remove the sequence number.

Technical parameter sequences can be organized using sort orders or groupings as 
follows:

1. Organization + Product

2. Organization + Category

3. Organization

You can sequence using multiple groups within the same laboratory.

See: Setting Up Technical Parameters, page 2-22.

Step 5: Define item technical data.

If you assign specific parameter values at the item, batch, or formula levels, then define 
item technical data. Changing specific item parameter values changes the properties of 
a simulation. Items that have a parameter value appear on the Contributing tab on the 
Optimizer window. Items without a parameter value appear on the Non Contributing 
tab on the Optimizer window. Changes to these specific item parameter values change 
the properties of the optimization or rebalancing calculations.

Step 6: Load the formula or batch in the Simulator.

Use the Load Simulator window to load formulas and batches in the Simulator. You can
update a formula or batch from the Simulator window, or from a saved simulation.

Step 7: Load the formula or batch in the Optimizer.

Use the Optimizer window to maximize material usage and fulfill product 
specifications. After you load a formula or batch in the Simulator, click Optimizer to 
load the formula or batch data in the Optimizer.

Loading Formulas and Batches into the Simulator
Use the Load Simulator window to enter a formula and its version, a batch, or a saved 
simulation. Use Query by Example from the View menu to load a formula, batch, and 
saved simulation.

The header region in the Simulator window is query only. Search for a formula, batch, 
or a saved simulation using the query enter mode or by choosing Find from the View 
menu to open the Load Simulator window. The context organization appears in 
parentheses next to the window title. The Organization field displayed on the window 
is the owning organization for the formula or batch. Technical data loaded is based on 
the item, lot, and organization combination. When loaded from a saved batch 
simulation, the Organization field displays the plant organization code. Technical data 
displays based on this organization. Formula details display after appropriate entry of 
formula header information.

The intermediate formula is selected with a defined hierarchy to obtain the proper 
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formula for intermediates. Simulator business rules use the following hierarchy: 

• If a technical formula is at the ingredient level, then it is used to get the appropriate 
technical parameter value.

• If a technical formula is not at the ingredient level, but a validity rule with a Status 
of Approved for Laboratory Use is defined for the ingredient, then the formula 
entered at the validity rule is used to get the appropriate technical parameter value.

• If a validity rule with a Status of Approved for General Use is defined for the 
ingredient, then it is used to get the technical parameter value. Item technical 
parameter values defined at the item level for the intermediate are used.

In the Details region, add new simulation lines or delete existing simulation lines, and 
expand the material lines to view all the associated lots and their corresponding values.

Column details display:

• The Ingredient type displays the Item, Revision and Lot, Quantity, UOM and 
technical parameters for formula ingredients.

• The By-Product type displays the Item, Revision and Lot, Quantity, UOM and 
technical parameters for formula byproducts.

Each item entered must be recipe-enabled for the organization displayed in the header. 
Lot transactions are marked with the Transactions indicator. You can use engineering 
items in laboratory formulas and laboratory batches. However, you cannot use 
engineering items in production batches.

You can work with item technical data for the ingredient lots by loading a batch into the
Simulator. You can predict the properties of a specific batch based on the exact lot 
properties and quantities of the ingredients making up the batch. When you load the 
Simulator from a batch, the item must be production-enabled for the organization 
displayed in the header.

To load formulas and batches to the Simulator, ensure that you:

• Set up formulas, recipes, and validity rules.

• Set up or verify that quality data exists.

• Create required production batches.

• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.
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To load a formula into the Simulator:
1. Navigate to the Simulator window.

2. Enter the context Organization.

3. Choose Find from the View menu.

4. Enter a Formula name, or select a formula from the LOV.

5. Optionally, enter a Version for the formula.

6. Click Find.

To load a batch into the Simulator:
1. Navigate to the Simulator window.

2. Enter the context Organization.

3. Choose Find from the View menu.

4. Enter a Batch number, or select a batch from the LOV.

5. Click Find.

Using the Simulator
The Simulator window displays each ingredient, product, and byproduct in a formula 
with the quantity and technical parameter values for each. The Simulator manages 
ingredients and byproducts, and the quantities and technical parameter values for each 
ingredient and byproduct. Technical parameter values for the product are only 
calculated for the first product in a formula. When working with a formula in the 
Simulator, select ingredients by item, or item and lot. Item technical parameters for the 
selected lot are loaded into the Simulator.

Use the Simulator to display and edit formulas and the technical parameter values of 
the items in the formula, and to display the effects that changes to ingredient values 
have on the product values. You can update formulas and batches on the Simulator.

The Quality Source menu item in the Actions menu allows you to access Result, Spec, or
Composite Result form to display relative data for the selected item. If there are no 
sample results but specifications exist for the selected item, the Spec form is displayed 
instead of the Result form, however, if there is neither sample results nor specifications, 
then clicking on Quality Source from the Actions menu does not display anything.
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Updating Formulas Using the Simulator
When you use the Simulator to update a formula, the application does not 
automatically update the formula stored in the database. If you make changes to items 
or item quantities on the Simulator, and later retrieve the formula using the Formula 
Details window, then you do not see the changes made even if you saved the 
simulation. This prevents you from accidentally making permanent changes to a 
laboratory formula based on scenarios you investigate with the Simulator. Choose 
Update Formula from the Actions menu to save a simulation to the stored formula.

Calculated values for a product are not saved in the Item Technical Data table until you 
recall the formula displayed on the Simulator window and choose Update Technical 
Parameters from the Actions menu. The technical data is stored for that specific item 
and formula combination. If the product is an ingredient in other formulas, then values 
you update are not available for use in other formulas.

To update formulas in the Simulator, you need to:

• Set up formulas, recipes, and validity rules.

• Optionally, set up or verify that quality data exists.

• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.

To update formulas in the Simulator:
1. Navigate to the Simulator window.

2. Enter the context Organization.

3. Choose Find from the View menu to load the formula. 

4. The current formula owning Organization displays. You cannot edit this field. 
Formula, Version, and Description fields are display only.

Details
5. The following fields are display only:

• Type displays the formula line type as ingredient or byproduct.

• Item/Lot displays the item number or lot number for each ingredient or 
byproduct.
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• Columns labeled with names for each technical parameter display. The 
technical parameter values display for each item. Click the + that precedes the 
Rollup indicator to display the item lots and their technical parameter values if 
they exist. 

6. Update Quantity, UOM, and Technical Parameter for any ingredient or byproduct 
in the formula.

7. Click Recalculate to assess the effect on each of the listed ingredients, byproducts, 
and product. The formula product quantity and technical parameter values are 
updated in the product fields.

Note:  The automatic calculation of the product quantity based on 
product percentages may be set on the Formula Details window. It 
is applicable only to the first product in a formula, and the 
remaining products are updated when you save the formula. It is 
not applicable to a batch or a simulation loaded into the Simulator.

See: Entering Formula Details, page 3-27.

Updating Batches Using the Simulator
Work with all of the item technical parameters for the ingredient lots by loading a batch
into the Simulator. If there are no batch steps, then the ingredient items sort according 
to their order on the formula.

Like formulas, quantities can be adjusted until you are satisfied with the results. If you 
decide that the allocation and ingredient changes can be used to update the batch, then 
the Update Batch option is available for pending and WIP batches. Using Process 
Execution APIs, the Simulator updates the batch. If e-records and e-signatures are 
enabled, then standard signature windows display requesting an approval e-signature.

To update batches in the Simulator, you need to:

• Set up formulas, recipes, and validity rules.

• Optionally, set up or verify that quality data exists.

• Create required production batches.

• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.
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To update a batch using the Simulator:
1. Navigate to the Simulator window.

2. Enter the context Organization.

3. Choose Find from the View menu to load the batch.

4. Update each Ingredient and Qty. 

5. Click Recalculate to assess the effect on each of the listed ingredient technical 
parameters. Repeat this step until you are satisfied with the values displayed.

See: Updating Formulas Using the Simulator, page 3-55.

6. Choose Update Batch from the Actions menu. 

Do you want to update the batch? displays if the batch has a status of Pending or 
WIP.

7. Click Yes to update the batch.

Batch has been updated displays.

Note: Query the batch in the Oracle Process Manufacturing Process
Execution application to verify that changes were made.

Blending Batches Using the Simulator
Several business rules assist in the blending of batches using the Simulator:

• The Plant field on the Simulator displays process quality results for samples that 
were created in a plant different from that of the batch. This field is read only and 
cannot be edited.

• The Simulator defaults the lot density from the item, as entered on the Item 
Technical Data window. The item density serves as a default value for item lots. 
You can edit this value.

• You can update the secondary quantity field on the Simulator. Use this field to 
recalculate quantities in cases where the primary quantity is not a physical quantity.
For example, if the primary quantity represents the percent active ingredient that is 
used for costing purposes, and the secondary quantity represents the actual 
volumetric quantity used in the formulation, then use the secondary quantity to 
explore what-if scenarios on the Simulator.

• You can use sample results in the Simulator regardless of the result acceptability. 
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Results with a status of Accept or Accept with Variance are found first. If results are
not found, then the application searches for results that are not yet accepted. If it 
does not find them, then it displays the target values from the item specification if 
the item specification has a specification validity rule that is approved for general 
use.

When you choose Select Available Inventory from the Actions menu on the Simulator, 
the window displays all available lots for the item. You can select lots that have 
available inventory even if the material status is not available for production. Enter the 
Selected Reservation Qty from the quantity available, and click Done to select the lot.

Adding Lot Information
Use the Add Lot - Formula window to add additional lot information to the existing lots
that display on the Simulator. This window displays only those lots owned by the 
formula owning organization.

To add lot information using the Simulator:

• Define lot, or lot values.

• Assign technical parameters.

To add lot information:
1. Navigate to the Simulator window.

2. Enter the context Organization.

3. Open a simulation.

4. Choose Add Lot from the Actions menu. The Add Lot - Formula window displays.

5. Item displays the item lot.

6. Select a Lot code from the list of values. Required.

7. Enter the allocated Quantity. The Secondary Qty displays.Required.

8. Click OK to add the lot.

Adding Lot Information to a Batch
When a simulation is loaded from a batch, new lots can be added to the existing 
displayed lots on the Simulator by accessing the Add Lots option from the Actions 
menu. This is enabled for line items where lot control is set to Full Control for the lot 
displayed.
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The Add Lot - Formula window lets you add additional lot information to the existing 
lots that display on the Simulator. This window displays only those lots owned by the 
formula owning organization. 

To add a lot from a batch, ensure that you:

• Define lot values.

• Assign technical parameters.

• Create a batch.

To add a lot from a batch:
1. Select an organization and navigate to the Simulator window.

2. Load a batch on the Simulator using Find from the View menu, or query on batches.

3. Choose Add Lot from the Actions menu. The Add Lot - Formula window appears.

4. Enter a Lot code. 

5. Subinventory defaults to the supply subinventory for the item defined in the 
organization.

6. Locator displays if the subinventory is locator controlled.

7. Enter a Secondary Qty.

8. Select OK.

Displaying Parameters on the Simulator
Use the drill-down functionality in the Simulator window to view all technical 
parameters for a particular material line. This is a query-only window that displays all 
material lines and corresponding technical parameters which contribute to the product 
rollup value.

Displaying Calculation Errors
You can display calculation errors for a product, ingredient, or byproduct using the 
Simulator window. To display calculation errors, you need to:

• Set up formulas, recipes, and validity rules.

• Optionally, set up or verify that quality data exists.
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• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.

To display calculation errors:
1. Navigate to the Simulator window.

2. Enter Organization as the context inventory organization.

3. Choose Calculation Errors from the Actions menu.

4. Select one of the following:

• Product to display product calculation errors.

• Ingredient to display ingredient calculation errors.

• By-product to display byproduct calculation errors.

5. The following fields are display only:

• Type determines whether the error displayed is for the product, ingredient, or 
byproduct.

• Item/Lot determines whether the technical parameter calculation error is for a 
product, ingredient, or byproduct.

• Technical Parameter displays the code of the technical parameter where an 
error occurred.

• Error Message determines a description for the calculation error.

• Expression determines the location where the error occurred. A carat (^) points 
to the approximate location where the error occurred.

Saving a Simulation
Use the Save Simulation window to save a simulation for comparison purposes. To save
a simulation, you need to:

• Set up formulas, recipes, and validity rules.

• Optionally, set up or verify that quality data exists.
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• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.

To save a simulation in the Simulator:
1. Choose Save Simulation from the Actions menu, or choose Save from the File menu.

2. Enter a Name for the simulation to save.

3. Click OK to save.

Finding a Saved Simulation
You can find a saved simulation using Query by Example from the View menu, or from
the Load Simulator window. To find a saved simulation:

• Set up formulas, recipes, and validity rules.

• Optionally, set up or verify that quality data exists.

• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.

• Define a simulation.

To find a saved simulation:
1. Navigate to the Simulator window.

2. Choose Find from the View menu.

3. Select a Simulation from the LOV.

4. Click OK from the Simulations window.

5. Click Find from the Load Simulator window.

Using the Optimizer
Formula and batch optimization methods are necessary for using raw materials 
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efficiently while meeting product specifications.

The fundamental requirement of formula optimization is the same across industries, 
although different businesses implement optimization differently. For example, paint 
manufacturers typically optimize formulas, not batches. Specific grades of raw 
materials are ordered from an approved list of vendors and the lots they receive are 
usually stable. Therefore, the batch does not usually require optimization at the lot 
level. Laboratory batches are an exception to this and can be optimized while the 
formula is in the experimental phase.

Alternatively, raw materials used in the dairy industry vary from lot to lot, and 
properties such as percent butterfat must be balanced with other ingredients to yield a 
specific quantity with the appropriate properties. The food and beverage industries are 
sensitive to the characteristics of materials and require a consistent product with a 
specified shelf life.

Pharmaceutical and biotech companies must yield products with consistent technical 
characteristics. It is important that each raw material lot be tested for potency and other 
factors, and that each finished product meet specifications. The U.S. Food and Drug 
Administration (FDA) influences these industries, and the high cost associated with 
materials make profitability an important element for requiring formula and batch 
optimization. The ability to optimize batches using lot specific data in a simulated 
environment provides time and cost savings.

Using the Workpad
The Workpad window displays a hierarchical view of all ingredients and lots selected 
for optimization. You can use the Workpad to view and select ingredients and lots for 
calculating in the Optimizer window. The Workpad window contains two navigator 
panes. The Calculate pane displays ingredients and corresponding lots selected for 
optimization. The Fixed pane displays all ingredients and lots with fixed quantities. Use
the left and right arrows to add or remove selected nodes to or from the Calculate pane. 
You can expand, expand all, collapse, collapse all, and find nodes in each navigator 
pane. Click OK to apply changes and updates in the Optimizer window. Click Cancel to
roll back all changes that were entered on the Workpad window.

To access information in the Workpad window

• Set up formulas, recipes, and validity rules.

• Set up or verify that quality data exists.

• Create required production batches.

• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.
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• Load a formula or batch to the Simulator.

To access the Workpad:
1. Navigate to the Simulator window.

2. Load a formula or batch to the Simulator choosing Find from the View menu.

3. Click Optimizer.

4. Click Workpad.

5. Click left (<<) and right (>>) arrows to move nodes between the Calculate and Fixed 
panes for optimization.

6. Click OK to return to the Optimizer window.

Optimizing Lot Quantities
If the Optimizer is loaded from a batch, then use the Allocations window to adjust lot 
quantities and parameter values associated with the batch. Lot quantity optimization is 
available only when the simulation is associated with a batch. To optimize lot 
quantities:

• Set up formulas, recipes, and validity rules.

• Create required production batches.

• Define technical parameters.

• Define technical parameter sequences.

• Define item technical data values.

• Load a batch to the Simulator.

To adjust lot quantities and parameter values:
1. Navigate to the Simulator window.

2. Enter Organization as the context inventory organization.

3. Load a batch to the Simulator using Find from the View menu.

4. Click Optimizer.

5. Click Allocations to display available lots for a batch.
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6. Select the Calculate indicator. If selected, then the application calculates the 
quantity for the ingredient lot. If this field is not selected for any ingredient, then 
the optimization uses the lot level values for calculating the parameter values.

7. Enter Qty for the lot.

8. Enter a Lot Parameter Value.

9. Click OK to calculate lot quantities, and return to the Simulator window.

Optimizing Formulas and Batches
Use formula and batch optimization to maximize material usage and fulfill product 
specifications. Optimize formulas and batches from the Simulator window based on 
technical parameter values associated with material lines. After calculating the 
optimized quantities, update the formula with the optimized results.

Optimization calculates ingredient quantities based on the following constraints:

• Subset of ingredient quantities

• Technical parameter values

• Output quantity

Load an in-process batch into the Simulator to refine or change the final batch output. A
batch may require adjustment once the properties of the raw materials are determined. 
For industries that process raw materials, quantities of certain ingredients vary 
depending on the quality of the other raw materials present. A work in process batch 
can be loaded into the Simulator with the actual or available inventory and its 
properties. View the technical properties for each ingredient, or ingredient lot, and their
individual affect on product properties. By designating various quantities for the 
available lots, the Production Engineer determines the best inventory to use for a batch. 
The Production Engineer can add ingredients and view the effect of the new material on
the final product. Use the Optimizer to modify these quantities using any of the 
technical parameters for the product. When both the input and output quantities are 
finalized, the batch is uploaded into production with its allocated inventory lots.

Following are steps for optimizing formulas and batches:

1. Load the formula or batch into the Simulator.

Use the Load Simulator window or choose Query by Example from the View menu 
to load formulas or batches into the Simulator.

2. Click Optimizer on the Simulator window to open the Optimizer window. The 
Optimizer window displays a formula, batch, or saved simulation. The header 
displays product, quantity, and unit of measure information.
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The Product Parameters region displays the following parameter types:

• Weight%

• Volume%

• Equivalent Weight

• Quantity Per Unit

Product parameter values are set in the Product Parameters region and can be 
optimized for Range or Value.

Ingredient Lines display ingredient information. Items that have a parameter value 
display on the Contributing tab. Items without parameter values display on the 
Non Contributing tab. Changes to ingredient quantities or ingredient parameter 
values are made in the Ingredient Lines detail region.

3. Use the Wordpad to view all ingredients and associated lots selected for the 
optimization.

The Workpad displays ingredients and lot allocations selected for calculation and 
rebalancing.

4. Adjust lot quantities and associated parameters.

If you load a batch on the Simulator, then you can adjust lot quantities and the 
associated parameters on the Allocations window.

5. Calculate ingredient quantities.

Click Calculate on the Optmizer window to calculate the required ingredient 
quantities based on the defined constraints. Results display on the Optimizer. 
Accept or discard the changes. If you click Apply, then changes are applied to the 
Simulator.

Set up the following example as an exercise to calculate ingredient quantities
6. Select Organization as the context inventory organization before opening Simulator.

7. Grant this organization to the Formulator responsibility.

8. Define the following ingredient items for a formula:

• RCM (Attributes = Lot Only) - RCM is Raw Chilled Milk

• SMP (Attributes = Lot Only) - SMP is Skim Milk Powder

• CREAM (Attributes = Lot Only)
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9. Define the following product item for a formula:

STD MILK (Attributes = None)

10. Define a formula for Product STD MILK.

11. In the Formula Details window, enter ingredients and quantities as follows:

• RCM qty = 94 kg

• CREAM qty = 3.75 kg

• SMP qty = 2.25 kg

The Buffer indicator displays on the Ingredients tab and is selected for 
ingredients RCM and SMP.

12. Change formula status to Approved for General Use.

13. Define a recipe to use for a production batch.

14. Define recipe validity rules for the plant and laboratory. 

15. Create either Pending or WIP batches from the recipe.

16. Define the following technical parameters;

• FAT - Weight% (data type = Weight%)

• SNF - Solids Non Fat(data type = Weight%)

Define these parameters globally or for a specific organization. See: Setting Up 
Technical Parameters, page 2-22.

17. Define technical parameter sequences.

18. Define item technical data at the item, lot, and batch levels.

Optimizing Ingredient Quantities Based on Other Items
Batch rebalancing lets you optimize a dependent ingredient in a formula by 
recalculating quantities of other ingredients required to adjust it to achieve a target 
component value in the production batch.

In the following example, a product parameter value changes. Appropriate ingredients 
quantities are adjusted to account for the change, while the main ingredient quantity 
remains the same.
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To optimize ingredient quantities after changing an ingredient property 
while maintaining output yield:
1. Create a formula for this example containing the following ingredients and 

quantities:

Ingredient Formula Quantity

RCM 94.00

CREAM 3.75

SMP 2.25

2. Parameter sequences exist for the following parameters:

• DENSITY = 1

• FAT = 2

• SNF = 3

Parameters without a sort sequence do not display on the Simulator.

3. Assign the following item technical data values:

Ingredient FAT Value SNF Value

CREAM 20 25

SMP Null Null

RCM 4 8

Items that have a parameter value display on the Contributing tab of the Optimizer.
Items without a parameter value display on the Non Contributing tab.

4. Load the formula into the Simulator.

5. Click Optimizer in the Simulator window. The Optimizer displays. The optimize 
values in the Product Parameters region default to None for both rows. FAT has a 
value of 4.51, and SNF has a value of 8.46. When you open the Optimizer window, 
the cursor is located in the upper region of the window, and the following 
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ingredients and values display on the Contributing tab:

Items Qty FAT Values

RCM 94 4

CREAM 3.75 20

6. The Non Contributing tab displays the following ingredient values:

Item Qty FAT Value

SMP 2.25 NULL

7. From the Optimizer window, click Workpad to open the Workpad window and 
select the ingredients for calculation. The Workpad displays a hierarchical view of 
all ingredients and associated lots selected for optimization.

8. Select CREAM in the Fixed navigator and click the left arrow to move the item to 
the Calculate navigator. Repeat this procedure for the item SMP and click OK. 
CREAM and SMP are now selected for calculation.

The Optimizer window displays, and the Calculate indicator for CREAM on the 
Contributing tab is selected. The Calculate indicator for SMP on the Non 
Contributing tab is also selected.

9. Change the FAT parameter value for cream on the Contributing tab from 20 to 25. 
In the Product Parameters region, change the Optimize field for the FAT parameter 
to Value.

10. Click Calculate on the Optimizer. The optimization was completed successfully as 
follows:

• The new optimized quantity for ingredient CREAM is 3 KGM and displays on 
the Contributing tab.

• The new optimized quantity for ingredient SMP is 3 KGM and displays on the 
Non Contributing tab.

• The product parameter value for FAT remains 4.51.

• The product parameter value for SNF changes to 8.27.

In this example, we changed an ingredient property and the formula optimized 
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successfully while maintaining product yield. The ingredient property was the 
FAT parameter value of CREAM.

11. Click Apply on the Optimizer to apply the results to the simulation, or Cancel to 
discard optimization results and return to the Simulator window. Optimization 
results are not automatically applied to the simulation.

Recalculating Quantities and Physical Properties
Certain physical properties of products require target values for regulatory compliance 
or customer specifications. For example, Formulators can specify the percent solids that 
are required in a product, and the application can reformulate to meet this specification.
Volume, mass, and units can be updated to meet batch size specifications.

If ingredient quantities are fixed to achieve a specific impact on the batch yield, then 
lock these ingredients, specify the product targets, and allow the remaining ingredient 
quantities to recalculate to meet the target quantity and properties.

Recalculating Quantities and Physical Properties of Ingredients Based on Target 
Quantity and Properties of Products:

Examples of this include Batch Rebalancing, and Compensation and Refraction. Batch 
Rebalancing is a scenario where the potency of one ingredient determines the quantity 
used of that ingredient. If the inventory quantity of this ingredient changes and the 
product output must remain the same, then the quantity of another buffer ingredient 
increases or decreases to meet the expected output quantity.

Compensation and Refraction is a scenario where a formulation contains two similar 
and interchangeable ingredients that always sum to the same quantity. If the quantity of
one ingredient changes, then the quantity of the other ingredient increases or decrease 
to meet the desired total input quantity.

To optimize ingredient quantity after specifying product property values 
while keeping the yield constant:
1. Create a formula for STD MILK with the following items and values:

Item Parameter Value QTY

RCM FAT and SNF 4 and 8 94

SMP SNF 25 2

CREAM FAT and SNF 25 and 0 4

The product parameter values are:
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• FAT = 4.76

• SNF = 8.02

2. Load the formula to the Simulator.

3. Click Optimizer to open the Optimizer window. The Product Parameters region 
displays the following:

• Optimize fields default to None for FAT and SNF parameters.

• FAT has a default value of 4.76.

• SNF has a default value of 8.02.

• The Calculate indicator is not selected for any ingredients.

If the ingredient lines Buffer indicators on the Formula Details window are not 
selected, then the ingredients Calculate indicators on the Optimizer are not 
selected.

4. Click Workpad on the Optimizer window to open the Workpad window and select 
the ingredients RCM, SMP, and CREAM for calculation. If you select the 
ingredients for calculation on the Workpad, then the Calculate indicators on the 
Optimizer are selected.

5. On the Optimizer window, select the FAT row in the Product Parameters region. 
Change the Optimize field to Value, and change the parameter Value to 4.9. The 
Contributing tab displays the RCM and CREAM ingredients, and the Calculate 
indicators are selected. The Non Contributing tab displays the SMP ingredient, and 
the Calculate indicator is selected.

In this example, optimize quantities by modifying two product property values. 
Use a Value and Range combination while keeping the output yield.

6. Select the SNF row in the Product Parameters region.

7. Change the Optimization field to Range.

8. Enter the parameter Value as 7.

• The Contributing tab displays the RCM and CREAM ingredients, and the 
Calculate indicators are selected.

• The Non Contributing tab displays the SMP ingredient, and the Calculate 
indicator is selected.

9. Click Calculate.
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10. Select the FAT parameter in the Product Parameters region:

• FAT Value remains at 4.9.

• On the Contributing tab, the RCM quantity changes to 95.69 and the CREAM 
quantity changes to 4.29.

• On the Non Contributing tab, the SMP quantity changes to 0.02.

11. Select the SNF parameter in the Product Parameters region:

• SNF Value changes to 7.66.

• On the Contributing tab, the RCM quantity changes to 95.70 and the SMP 
quantity changes to 0.02.

• On the Non Contributing tab, the CREAM quantity changes to 4.29.

12. Click Apply on the Optimizer window to apply the results to the simulation, or 
click Cancel to discard optimization results and return to the Simulator window.

Optimizing Lot Quantities While Maintaining Output Yield
If product parameters are dependent on the lot attributes, then use lot values during the
formulation and optimization process. You can enter lots with a formula and use the 
output yield optimization functionality. Batches can also be entered into the Simulator 
to optimize batch material allocations. For example, the dairy industry production 
process requires milk standardization. The quality of milk and cream can vary from lot 
to lot, and needs adjustment to predefined nutritional requirements. Each batch of milk 
can be updated with changes made from the Optimizer.

To optimize a lot quantity after specifying product property values while 
maintaining yield:
1. Create a SMP inventory item. This item does not require any attributes.

2. Create a formula for STD MILK with the following items:

Ingredient Quantity

RCM 94 KGM

CREAM 3.5 KGM
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Ingredient Quantity

SMP 2.5 KGM

3. Verify that ingredients RCM and CREAM each have two lots that contain 
inventory. RCM has lots R1 and R2. CREAM has lots C1 and C2.

4. Create a recipe with this formula, and include a routing.

5. Create a validity rule that is local to the plant and set the status to Approved for 
General Use.

6. Create and release a batch from the recipe. During WIP, allocate a partial quantity 
of 0.1 KGM for ingredient RCM to lot R1. Do not allocate CREAM. It is not 
necessary to allocate SMP. Record the batch number.

7. Verify the following item parameter values for FAT:

Item or Item/Lot Fat Value SNF Value

RCM 4 8

Lot R1 of RCM 4.3 8.2

CREAM 20 25

Lot C1 of CREAM 20 35

8. Load the batch to the Simulator.

9. Verify the following ingredient values on the Simulator:

Item FAT SNF Batch Qty

RCM 4 8 94

CREAM 20 25 3.5

SMP Null Null 2.5
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10. Verify the following product values:

Item FAT Value SNF Value

STD MILK 4.46 8.4

11. Make a partial line allocation for CREAM in the Simulator. Select the CREAM row 
in the product parameters region.

12. Choose Select Available Inventory from the Actions menu.

13. On the Select Available Inventory window, enter a quantity of 0.1 as the Selected 
Reservation Qty of lot C2.

14. Click OK and return to the Simulator.

15. Choose Update Batch from the Actions menu to create the line allocation 
transaction. A decision window displays.

16. Click OK. A partial line allocation is made to lot C2 of ingredient CREAM, and the 
batch is updated.

17. Click Optimizer to open the Optimizer window.

18. Verify the following Product Parameters region values:

• The Optimize fields default to None for FAT and SNF parameters.

• FAT has a value of 4.46.

• SNF has a value of 8.4.

19. Select the FAT row in the product parameters region and verify the Contributing 
tab. Select the SNF row in the product parameters region and verify the 
Contributing tab as follows:

Items Batch Qty FAT SNF

RCM 94 4 8

CREAM 3.5 20 25

20. Verify the Non Contributing tab for FAT and SNF. Only ingredient SMP defaults to 
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the Non Contributing tab, and SMP has no parameter values.

21. Select the FAT row in the product parameters region and change the Optimize field 
to Value.

22. Select the Calculate indicator for items RCM and CREAM.

23. Select the RCM row in the ingredient lines region. Allocations is activated when the 
Optimizer displays batch values. Allocations is disabled for formula values.

24. Click Allocations and note the partial allocation of 0.1 KGM for lot R1. The FAT 
value for lot R1 must be 4.3.

25. Select the Calculate indicator for lot R1 on the Allocations window.

26. Click Close to return to the Optimizer window.

27. Select the CREAM row in the Ingredient Lines region and click Allocations. Note 
the partial allocation of 0.1 KGM for lot C2. The FAT value for lot C2 must be 20.

28. Select the Calculate indicator for lot C2 on the Allocations window, and verify the 
results.

29. Click Close to return to the Optimizer window.

30. Select the SNF row in the product parameters region and change the Optimize field 
to Value. The Calculate indicator is selected for items RCM and CREAM.

31. Click the Non Contributing tab and select the Calculate indicator for ingredient 
SMP. Be sure that the Optimize field in the Product Parameters region is set to 
Value for both FAT and SNF parameters.

32. Click Calculate on the Optimizer window, and verify the results.

33. Select the FAT row in the Product Parameters region. The following values display:

• FAT Value changes to 4.46.

• On the Contributing tab, RCM Quantity changs to 88.15, and CREAM Quantity 
changes to 3.35.

• On the Non Contributing tab, SMP Quantity changes to 8.50.

34. Click Allocations for RCM and CREAM:

• Allocations change from 0.1 KGM to 88.15 for lot R1 of RCM.

• Allocations change from 0.1 KGM to 3.35 for lot C2 of CREAM.
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35. Select the SNF row in the Product Parameters region. The following values display:

• SNF Value changes to 7.89

• On the Contributing tab, RCM Quantity changes to 88.15, and CREAM 
Quantity changes to 3.35

• On the Non Contributing tab, SMP Quantity changes to 8.50

36. Click Allocations for RCM and CREAM:

• Allocations change from 0.1 KGM to 88.15 for lot R1 of RCM

• Allocations change from 0.1 KGM to 3.35 for lot C2 of CREAM

37. Click Apply on the Optimizer to apply the results to the simulation, or Cancel to 
discard optimization results and return to the Simulator window.

Ingredient Distribution Rules Used in Optimization
Within the header region of the Optimizer window, choose to maintain the ratio 
between ingredients, or maintain the output yield after the calculation. If you choose to 
maintain ratios, then the optimization process distributes quantity changes evenly 
across the affected ingredients. This feature is important in cases where chemical 
interactions rely heavily on certain materials being balanced.

If you choose the Maintain Output Yield indicator, then the application maintains final 
output yield while calculating ingredient properties.

Using the Buffer Indicator
The Formula Details window has a Buffer indicator that specifies ingredients used to 
maintain target quantities while working with a formula or batch on the Simulator.

Ingredients such as water and starch solution are commonly used to modify the volume
in a batch without affecting the overall chemical composition. When optimizing a batch 
that uses a formula, the Simulator adjusts the quantities of these buffer ingredients to 
achieve the target quantities. There can be one or more buffer ingredients in a formula.

When you select the Buffer indicator for an ingredient listed in the Formula Details 
window, the Calculate indicator on the Optimizer window is the default. If an 
ingredient is added to a formula from the Optimizer window, then you can override the
Buffer indicator in the Optimizer window. 

Running the Indented Bill of Materials Report
The Indented Bill of Materials (IBOM) report displays ingredients and ingredient 
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quantities used to produce a product. You can specify the formula, item, or range of 
formulas for the report. Other parameters such as formula, status, recipe use, effective 
date, and UOM type can be used as selection criteria. The Organization field is available
for entry when you select the Single option for the Validity Organization. You can 
change it to organizations that you can access. Intermediates are exploded into their 
individual ingredient components. Circular references are allowed one level deep so 
that an item can be both an ingredient and a product in a formula. Circular references 
beyond one level, however, are identified with an error message.

The IBOM report completes successfully when a fixed ingredient is scaled down below 
a quantity that is achievable by the percent reduction. Formula scaling does not stop the
IBOM report generation under these circumstances. It displays all levels of contributing 
formulas regardless of scaling rules. Optionally, run the report without the scaling 
option or display of quantities. Explode by phantom ingredients only, or explode all 
ingredients. 

The Indented Bill of Materials Report window has two modes of operation:

• Interactive, where the application initially displays a list of all of the validity rules 
that meet the parameters entered. For example, if you enter an item and batch 
quantity and there are several valid formulas for making the specified quantity and 
effective date for the item, then the application lists each of those formulas. Select 
the appropriate formula and the IBOM report is generated for that formula.

• Noninteractive, where the application picks the validity rule to use based on the 
effective date preference. If two or more validity rules have the same preference 
level, then the application uses the most recent one.

If formula security is enabled, then you can submit requests for an IBOM report for any 
formula with view or update access. The formula must be assigned to a recipe with a 
valid validity rule. Explosion rules and selection of the validity rule are based on the 
Validity Organization type.

The IBOM report business rules consider item substitutions and their effective start and 
stop dates.

To run the IOB report:
1. Navigate to the Indented Bill of Materials Report window.

Selection Range
2. Determine how to explode formulas:

• Select Interactive to use the interactive mode. This enables you to select from a 
list of validity rules.

• Deselect Interactive to use the noninteractive mode. This uses the most recent 
validity rule.
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3. When you run an IBOM report for the first time, the report explodes a formula 
regardless of the selection indicated in this field. Decide whether to reexplode 
formulas that were exploded in previous reports:

• Select Re-Explode to rebuild formulas that appear in the report. The application
expands all product, coproduct, and byproduct components and stores the 
repeat explosion for future reference. If a formula was recently modified, then 
this selection ensures that the most recent changes are in the IBOM report.

• Deselect Re-Explode if you do not want to rebuild formulas that appear in the 
report. The application uses previously stored formula explosions.

4. Enter Formula status to limit the IBOM report to formulas with a specific status. 
See: Understanding the Status Approval Workflow, page 1-9.

5. Select one of the following:

• Single Formula to print the IBOM for a specific formula. Enter the Formula and 
Version. Required when selected.

• Single Item to print the IBOM for a specific product. Enter the Item code for the 
product. Enter the Batch Qty and UOM of this product to determine the validity
rule to use. The validity rule must be valid for this quantity for proper 
ingredient scaling.

 Required when selected

• Formula Range to print IBOMs for a range of formulas. If you are using the 
interactive mode, then you cannot enter a formula range. Enter the starting 
formula in the From field and ending formula in the To field. One concurrent 
process starts for each formula entered in the contiguous range specified. Each 
formula has its own separate report. Required when selected.

Request Options
6. Language displays the language used for the IBOM report. To change this entry, 

click Languagesto display a list of available languages, select the appropriate 
language required and click OK.

Other Options
7. Select one of the following for Explode:

• All Ingredients to explode all ingredients.

• Phantom Ingredients Only to explode only phantom ingredients.

8. Enter the number of Levels to print on the report. The default is All.
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9. Select a Recipe Use to use as the basis of the report. You can select production, 
planning, costing, or technical. Required.

10. Select one of the following for Validity Organization:

• Single to base the formula explosion on the validity rules defined for the 
organization specified or a set of global validity rules when the organization is 
not specified.

• User Access to base the formula explosion on the validity rules defined for 
organizations you can access or a set of global validity rules when the 
organization is not specified.

• All to base the formula explosion on any effective validity rule.

Required.

11. Enter the Effective Date and time for the formula. Only formulas that are effective 
on this date and time are used as the basis for the report. Required.

12. Organization is the formula owner organization based on the validity organization 
selection.

13. Select the UOM Type as:

• Formula to use the formula unit of measure type.

• Inventory to use the inventory unit of measure type.

Required.

14. Enter Scale By as the scaling percent for the formula. A scale percent of zero 
indicates that a formula is not scaled and is the sample as the scale percent of 100.

15. Select Scale Intermediate to scale intermediates, or deselect this indicator to avoid 
scaling intermediates.

16. Select Display Qty to display quantities of each ingredient, or deselect this indicator
to suppress display of quantities.

Print Options
17. Enter the number of report Copies to print. If you selected a range of formulas, then

each IBOM is printed this number of times. Required.

18. Enter the code for the Printer to use. Style displays the print setup orientation, such 
as Portrait or Landscape.

19. Click OK.
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20. The Submission History window displays:

• Name is Indented Bill of Materials Report.

• Parameters is the number of parameters.

• Request ID is the request number.

21. Record the Request ID.

22. Click OK.

To display the output of the IBOM report:
1. Run the Indented Bill of Materials Report.

2. Choose Requests from the View menu.

3. Select All My Requests.

4. Click Find.

5. Choose the indicator next to the requested Indented Bill of Materials Report to 
display. Ensure that the report phase is complete without errors.

6. Click View Output. The report displays.

To interpret the IBOM report:
1. Run the Indented Bill of Materials Report.

2. The following fields are display only:

• Report Date is the date the report was run.

• Page is the report page number. The total pages included in the report appear 
after the slash mark (/).

• Formula is the code for the formula used for the IBOM report. A colon appears 
before the formula version number. A description of the formula and the 
version displays.

• Recipe Use indicates whether the formula is used for production, planning, 
costing, or technical purposes.

• Effective Date is the date the formula was first used as an approved formula.

• Validity Rule Organization displays:
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• Single when the formula explosion is based on the validity rules defined for
the organization specified, or for a set of global validity rules when the 
organization is not specified.

• User Access when the formula explosion is based on the validity rules 
defined for organizations you can access or a set of global validity rules 
when the organization is not specified.

• All when the formula explosion is based on any effective validity rule.

• Explode indicates whether all ingredients or phantom ingredients only were 
exploded in the report.

• Scale Intermediate displays Yes if the report scales intermediate formula 
components. It displays No if the report does not scale intermediates.

• Status indicates the status of the formula, if one is specified. All indicates that 
all statuses are considered.

• Scale Percent indicates the scaling percent for the formula. A scale percent of 
zero indicates that a formula is not scaled and is the same as the scale percent of
100.

• Max Explode Levels indicates the maximum number of levels to explode 
formulas.

• Exploded Date is the date the formula was exploded.

• Products are those products produced by the first level formula. Coproducts 
display before products in the body of the report. The product item code 
displays with its description. To the right of each product item code, two 
numbers appear in parentheses. Each number is separated by a slash mark. The 
first number displays the batch quantity of the product. This number is either 
the product quantity multiplied by the scale or the batch quantity entered in the
Batch Quantity field. The second number is the product quantity from the 
formula. The unit of measure for the batch quantity and formula quantity 
follows in parentheses.

• Ingredient -- Description is the item code for each ingredient in the exploded 
formula followed by the ingredient description. Byproducts, coproducts, and 
ingredients in the formula that produces the intermediate are indented 
separately from the ingredients in the main formula. Once the indentation ends,
the items that begin at the left margin of the report are ingredients in the main 
formula listed at the top of the report page.

• Levels of indentation display for item lines from the main formula listed at the 
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top of the report page. The highest level is level one identified by a 1. 
Intermediates are at level two identified by 2. The indentation progresses for 
each of the defined levels. The maximum number of levels is 25.

• Batch Quantity is the amount of ingredient necessary to produce the batch 
quantity of the product. For byproduct or coproduct lines, this is the quantity of
the byproduct or coproduct that is produced when the batch quantity of the 
main product is produced. This does not display when the Scale Intermediate is
set to No.

• Formula Quantity is the amount of ingredients, byproducts, and coproducts in 
the formula. This does not display if the Scale Intermediate is set to No.

• Standard Quantity of product is the amount of material used to produce 
intermediates in its primary UOM. If the quantity of an intermediate needed in 
the main formula is different from this standard quantity, then the intermediate
formula is scaled automatically. The scaled product quantity and scaled 
ingredient quantities display in the Batch Quantity column. This does not 
display if Display Qty is set to No.

Using Formula Inquiry
The Formula Inquiry Selection window is the starting point for Formula Inquiry 
queries. Using a selection range to narrow the search of formula information, you can 
display a summary list of formulas that fit the parameters you specify. The inquiry 
delivers a Formula Inquiry Summary View window where you display parent level and
intermediate level formula information.

To perform a formula inquiry:
1. Navigate to the Formula Inquiry Selection window.

2. Select the Formula Status or make no selection to query all active and inactive 
formulas.

3. Select one of the following for the Validity Rules field:

• Defined to query components with defined validity rules.

• Undefined for components with undefined validity rule.

• Both to query all components.

Recipe Used In
4. Select one, all or any combination of the following uses: 
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• Production for use in production.

• Planning for use in planning.

• Costing for use in cost management.

• Regulatory for use in regulatory management.

• Technical for use in formula analysis. Technical Class is a category used to 
identify and group ingredients where the overall contribution of specific 
technical characteristics of the ingredients is significant.

Selection Range
5. To select a specific selection range entity, enter it in both the From and To fields. To 

select a range of entities, enter the starting one in the From field and the ending one 
in the To field. To select all entities, leave the fields blank. Selection range entities 
are:

• Formula

• Formula Version

• Routing

• Routing Version

• Organization

• Effective Date

• Customer

6. Enter the Product code to display formulas for a specific product.

7. Enter the Effective Qty of the item produced by the formula. This field becomes 
available if you indicate a specific formula and version or a specific item produced. 
The unit of measure displays.

8. Enter the Ingredient used to display formulas that contain it.

9. Click OK. The Formula Inquiry Summary View window displays.

See: Interpreting a Formula Inquiry, page 3-82.

Interpreting a Formula Inquiry
The Formula Inquiry Summary View displays after you make entries in the Formula 
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Inquiry window. It lists formulas that meet the parameters entered. Get additional 
information for any formula you have privileges to access. The Formula Inquiry 
Summary consists of two window areas. You can scroll in the top area which lists the 
organization, formula number and version, routing, and minimum and maximum 
quantity the formula produces. The bottom area of the window is synchronized with 
the line that is selected in the top area. It lists the start and end date that the formula is 
effective, formula status, standard quantity, and formula use.

To interpret the Formula Inquiry Summary:
1. Navigate to the Formula Inquiry Summary View window.

2. Effective Date for Ingredient Replacement displays the default date that is effective 
for ingredient replacements. Select a specific date to display ingredient 
replacements effective on that date.

3. The following fields are display only:

• Organization where the formula is effective. You can only display formulas 
effective to organizations linked to your user code. A # sign indicates you 
cannot display the formula.

• Formula code for each formula.

• Version number for each Formula.

• Routing number for each Formula Version.

• Version number for each Routing.

• Minimum Qty as the minimum quantity where the Formula is valid.

• Maximum Qty as the maximum quantity where the Formula is valid.

• UOM listed for each Formula.

4. The following fields display data that is specific to the formula selected:

• Effective Dates lists the dates that formulas and versions are valid.

• Formula Status indicates the current formula status.

• Standard Qty is the typical quantity that is produced by each formula.

• Recipe Use displays the intended use for the formula in production, planning, 
costing, or technical investigation.

5. Drill down on a specific formula to display the Formula View.



3-84    Oracle Process Manufacturing Product Development User's Guide

Displaying Details from a Formula Inquiry
Use the Formula View window to display the parent formula or highest level formula. 
Use the Actions menu to display intermediates from this window.

To display details from a formula inquiry:
1. Select the appropriate Formula from the Formula View Inquiry window.

Important:  Verify that the desired Effective Date for Ingredient 
Replacement is displayed.

2. Choose Formula View from the Actions menu. The Formula View window 
displays.

3. The following fields are display only:

• Formula displays the unique identifying code for the formula selected.

• Status indicates the status of the formula.

• Version displays the version of the formula.

• Description displays the detailed descriptive information about the formula.

• Comments displays comments that you added at the header level.

• Formula Class displays how the formula is classified at the header level.

• Scaling Allowed is selected if formula scaling is permitted. Scaling is not 
allowed when this indicator is deselected. See: Scaling Formulas, page 3-12.

Details
4. The following fields are display only:

• Type indicates whether the item is a product, byproduct, or ingredient in the 
formula. The drill-down indicator to the left of the Type field lets you drill 
down to a subcomponent.

• Item displays the item code of the product, byproduct, or ingredient of the 
formula.

• Substitute indicates that the ingredient was substituted.

• Description displays a brief description of the item.
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• Quantity displays the quantity of the item used in the formula.

• UOM displays the unit of measure of the item.

5. The following fields display data that is specific to the component selected:

• Phantom Type indicates whether the material is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom.

• Scrap Factor indicates the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the Scrap Factor is 10 
percent, then an additional 10 percent of material is added to accommodate for 
this loss. Required.

• Scale Type displays whether the scaling is Fixed, Proportional, or Integer. See: 
Scaling Formulas, page 3-12.

• Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

6. Release Type indicates the type of yield for products and byproducts, or 
Consumption Type for ingredients.

To display formula text:
1. Choose View Text from the Actions menu.

2. The Text Editor window for the formula displays. If the cursor is on the:

• Formula header area, then the header text displays.

• Unexpanded detail line, then the text associated with the ingredient displays.

• Expanded detail line, then the product text displays.

Displaying an Intermediate Formula
The intermediate formula only displays if the row is preceded by a + sign.

To display an intermediate formula:
1. Select a row on the Formula View window that is preceded by a + sign.

2. Choose Lower Level from the Actions menu. The intermediate formula of the 
selected item or product displays on the Intermediate Formula Inquiry Summary 
View window.
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3. The following fields are display only:

• Organization displays the organization that owns the intermediate formula.

• Formula displays the intermediate formula name.

• Version displays the formula version number.

• Routing displays the routing associated to the formula.

• Version displays the routing version number.

• Minimum Qty displays the minimum quantity of the displayed formula 
produced by the routing.

• Maximum Qty displays the maximum quantity of the displayed formula 
produced by the routing.

• UOM is the unit of measure for the Minimum Qty and Maximum Qty.

• Effective Dates displays the dates that formulas and versions are valid.

• Standard Qty displays the typical quantity that is produced by the formula.

• Active Formula indicates that the formula is active.

• Recipe Use displays how the recipe is used. For example, in production, 
planning, costing, or technical investigation.

To condense an intermediate formula:

The cursor must be on a line preceded by a - sign. When you choose Condense from
the Actions menu, the window contracts the display of all lower level formulas. All 
expanded formulas that follow that line are already condensed.

Analyzing a Formula
Formula analysis helps to determine the contribution of formula components in a 
product by weight or by volume. View the quantities and percentages of ingredients 
classified by a Technical Class and a Technical Subclass. For example, a Technical Class 
could include all volatile organic solvents in a formula. Technical Subclasses of volatile 
organic solvents could include mineral spirits or alcohols.

Use the Formula Analysis Parameters window to analyze a formula for Technical Class 
and Technical Subclass composition. Display the results of the analysis in the Formula 
Ingredient Contribution Analysis window.

Formula analysis is performed in the concurrent program manager so that results are 
queried at your convenience. Each time this process is repeated for a specific formula in 
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a specific organization, any previously calculated data is replaced for that formula in 
that organization. The log file provides status messages issued during the formula 
analysis calculations. Use this file to identify any errors that occur.

To analyze formulas:

• Set up technical parameters and appropriate sequences.

• Enter item technical data for the density of ingredients in formulas to analyze. This 
is not required for intermediate items, but is required for their component 
materials.

• Set up technical classes and technical subclasses for ingredients included in a 
formula analysis. This is not required for intermediate items, but is required for 
their component materials.

• Enter and save formulas. Identify the correct formula to use for any intermediates 
in the parent formula. Do this either by setting the Item Technical Data Selection or 
by using a Recipe with Validity Rules.

To analyze a formula:
1. Navigate to the Formula Analysis Parameters window.

2. Specify the rule to use during the explosion of formula intermediates:

• Select Use Production Formulas to explode intermediates using a formula that 
is Approved for General Use. Name indicates the name of the organization 
entered.

• Select Use Laboratory Formulas to explode all intermediates using a formula 
that is Approved for Laboratory Use.

Required.

3. Enter the code for the formula owning Organization. The organization entered 
retrieves and uses appropriate recipe validity rules when it explodes an 
intermediate. If validity rules are not available for the organization entered, then 
global validity rules are applied. Required.

4. Lab displays the current context laboratory organization.

5. Enter the Formula to use in the analysis. Required.

6. Enter the Version of the formula to use in the analysis. Required.

7. The following fields are display only:

• Description of formula entered.
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• Status of the formula entered.

8. Enter the Analysis Quantity as the total formula output required for this analysis. 
Enter a value greater than zero. Required.

9. Enter the UOM for the analysis quantity. The unit of measure entered here must be 
defined in the parameters for Mass UOM type or Volume UOM type. Required.

10. Click Analyze.

11. Note the Request ID number.

12. From the View menu, choose Requests to display the status of the request in the 
concurrent program manager.

13. When the Request ID completes with a Status of Normal, the results of the analysis 
display. See: Displaying Formula Analysis Results, page 3-88.

14. Select View Log on the Requests window to view the explosions performed on 
intermediates using the rule that you specified in step 2. If problems were 
encountered in the explosion, then they are listed in the log file.

Displaying Formula Analysis Results
The Formula Ingredient Contribution Analysis window displays the details of the 
analysis of a particular formula in a specified organization. The window consists of two 
separate views that display Technical Class and Technical Subclass analysis results by 
weight or by volume.

Interpreting a Formula Ingredient Contribution Analysis:

The following example illustrates a simple formula analysis of Formula F1. Use it in the 
interpretation of results that display on the Formula Ingredient Contribution Analysis 
window.

Formula F1 makes 100 pounds of Product 1. The Analysis Quantity of Formula F1 is 
200.00 pounds. Formula F1 contains an intermediate, INT1. The intermediate INT1 is 
produced by Formula F2.

Formula F1 is composed of:

• 40 pounds of ingredient 1

• Technical Class is Binder

• Technical Subclass is Acrylic

• 10 pounds of ingredient 2
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• Technical Class is Solvent

• Technical Subclass is Organic

• 50 pounds of intermediate 1

Intermediate INT1, Formula F2, is 50 pounds, and is composed of:

• 10 pounds of ingredient 1

• Technical Class is Binder

• Technical Subclass is Acrylic

• 25 pounds of ingredient 3

• Technical Class is Binder

• Technical Subclass is Acrylic

• 15 pounds of ingredient 4

• Technical Class is Solvent

• Technical Subclass is Alcohol

Formula Analysis of Formula F1 is:

• The application calculates the ingredient direct contributions at the formula level:

• ING1 is scaled to 80.00 pounds

• ING2 is scaled to 20.00 pounds

• INT1 is scaled to 100.00 pounds

• The application calculates the ingredient contributions at the exploded lower levels.
These calculations consist of exploding each intermediate found at each level of the 
formula. There is only one intermediate, INT1, in this example. The formula that 
produces this intermediate does not contain any additional intermediates. 
Therefore, the formula is exploded only one level. INT1 is exploded using Formula 
F2. Formula F2 is scaled by the quantity of INT1 consumed by F1 after scaling, or 
100 pounds.

Exploding F1 results in the following:

• 80.00 pounds of ING1 calculated from the direct contribution

• 20.00 pounds of ING1 calculated from the explosion of INT1
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• 20.00 pounds of ING2 calculated from the direct contribution

• 50.00 pounds of ING3 calculated from the explosion of INT1

• 30.00 pounds of ING4 calculated from the explosion of INT1

The Formula Ingredient Contribution Analysis for this example is:

Direct Weight:

Binder

• Acrylic

• ING1 is 80.00 pounds, representing 100% of the Direct Weight contribution

• Subclass Direct Weight is 80.00 pounds

• Class Direct Weight Total is 80.00 pounds

Binder Class Total is 80.00 pounds

Solvent

• Organic

• ING2 is 20.00 pounds, representing 100% of the Direct Weight contribution

• Subclass Direct Weight is 20.00 pounds

Solvent Class Total is 20.00 pounds

Indirect Weight:

Binder

• Acrylic

• ING1 is 20.00, representing 28.60% of the Indirect Weight contribution

• ING3 is 50.00, representing 71.40% of the Indirect Weight contribution

• Subclass Indirect Weight is 70.00 pounds

Binder Class Total is 70.00 pounds

Solvent

• Alcohol

• ING 4 is 30.00 pounds, representing 100% of the Indirect Weight contribution

Solvent Subclass Total is 30.00 pounds
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Total Weight:

Binder

• Acrylic

• ING1 is 100.00 pounds, representing 66.67% of the Class

• ING3 is 50.00 pounds, representing 33.33% of the Class

Binder Subclass Total is 150.00 pounds, representing 100.00% of the Class and 75.00% of
the formula weight

Solvent

• Organic

• ING2 is 20.00 pounds, representing 40.00% of the Subclass

Solvent Subclass Total is 20.00 pounds, representing 40.00% of the Subclass and 10.00% 
of the formula weight

• Alcohol

• ING4 is 30.00 pounds, representing 60.00% of the Subclass

Solvent Subclass Total is 30.00 pounds, representing 60.00% of the Subclass and 15.00% 
of the formula weight

Ingredient Contribution Summary:

Binder is 75.00% of the formula weight

Solvent is 25.00% of the formula weight, with 10% Organic Subclass and 15% Alcohol 
Subclass

To display the results of a formula analysis by weight:
1. Navigate to the Formula Ingredient Contribution Analysis window.

2. Query the analyzed formula.

3. Select View By Weight.

4. The following fields are display only:

• Organization displays the facility that owns the formula analyzed.

• Analysis Date displays the date of the analysis.

• Formula displays the formula used in the analysis.
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• Version displays the version of the formula used in the analysis.

• Status displays the approval status of the formula used in the analysis. For 
example, Approved for Laboratory Use indicates that the formula can be used 
in the laboratory.

• Product displays the main item in the formula analyzed.

• Description displays a description of the main item in the formula analyzed. 

• View By displays the current type of view displayed. When View By Weight is 
selected, Weight displays in this field.

• Explosion Rule displays the currently selected explosion rule used to explode 
intermediates.

• Technical Class displays the technical class used to group ingredient 
contributions.

• Direct Weight displays the actual weight of ingredients in the selected formula 
technical class.

• Direct (%) displays the direct weight of the formula technical class as a 
percentage of the total weight.

• Indirect Weight displays the weight of ingredients within exploded 
intermediate products in the selected formula technical class.

• Indirect (%) displays the indirect weight of the formula technical class as a 
percentage of the total weight.

• Total Weight displays the sum of the direct weight and indirect weight in the 
selected formula technical class.

• Total (%) displays total weight of the formula technical class as a percent of the 
entire formula weight.

Item Detail
5. The following fields are display only:

• Subclass displays the formula technical subclass.

• Item displays the selected ingredient item in the formula technical subclass.

• Direct Weight displays the actual weight of ingredients in the selected formula 
technical subclass.
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• Direct (%) displays the direct weight of the formula technical subclass as a 
percentage of the total weight.

• Indirect Weight displays the weight of ingredients within exploded 
intermediate products in the selected formula technical subclass.

• Indirect (%) displays the indirect weight of the formula technical subclass as a 
percentage of the total weight.

• Total Weight displays the sum of the direct weight and indirect weight in the 
selected formula technical subclass.

• Class (%) displays the percentage contribution of the selected formula technical 
subclass to the entire formula technical class.

• Formula (%) displays the percentage contribution of the selected formula 
technical subclass as a percentage of the total formula weight.

Subtotal
6. The following fields are display only:

• Subclass displays the formula technical subclass.

• Direct Weight displays the actual weight of ingredients in the selected formula 
technical subclass.

• Direct (%) displays the direct weight of the formula technical subclass as a 
percentage of the total weight.

• Indirect Weight displays the weight of ingredients within exploded 
intermediate products in the selected formula technical subclass.

• Indirect (%) displays the indirect weight of the formula technical subclass as a 
percentage of the total weight.

• Total Weight displays the sum of the direct weight and indirect weight in the 
selected formula technical subclass.

• Class (%) displays the percentage contribution of the selected formula technical 
subclass to the entire formula technical class.

• Formula (%) displays the percentage contribution of the selected formula 
technical subclass as a percentage of the total formula weight.
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To display results of a formula analysis by volume:
1. Navigate to the Formula Ingredient Contribution Analysis window.

2. Query the analyzed formula.

3. Select View By Volume. The fields that display are calculated in terms of volume 
rather than weight.

Finding a Formula Analysis
The Find Analysis window helps you find an existing Formula Ingredient Contribution 
Analysis.

See: Analyzing a Formula, page 3-86.

To find a formula analysis:
1. Navigate to the Find Analysis window.

2. Enter one or more of the following fields:

• Organization where the analysis was performed.

• Formula code.

• Version number of the formula.

• Product produced by the formula.

3. Click Find. The Formula Ingredient Contribution Analysis window displays the 
analysis found that meets your search parameters.

Overriding Default Explosion Rules
The Item Technical Data Selection window enables you to specify the formula sources 
for intermediate technical parameter values, thereby overriding automatic selection.

To override default explosion rules:

• Set up technical parameters.

• Set up technical parameter sequences.

• Enter item technical data for the density of every ingredient in formulas to analyze.

• Set up technical classes and technical subclasses for all ingredients included in a 
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formula analysis.

• Enter and save formulas.

To override default explosion rules:
1. Navigate to the Formula Details window.

2. Select the Ingredient for custom explosion rules.

3. Choose Item Technical Data Selection from the Actions menu. The Item Technical 
Data Selection window displays.

Simulation
4. This region is not used in this procedure.

Ingredient Contribution
5. Enter the Formula number and Version to use for the explosion of the intermediate 

during the formula ingredient contribution analysis calculation.

6. Click OK.
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4
Operations

This chapter discusses how to define and maintain operations, activities, and resources. 
It explains how you can find an operation and view summaries of operations and 
operation headers that provide overviews. The processes to enter operation activity 
details, activity-resource details and how to display activity lines and edit a summary of
resource lines are also explained.

This chapter covers the following topics:

• Requirements

• Understanding Operations

• Defining and Maintaining Operations

• Defining and Maintaining Activities

• Defining and Maintaining Resources

• Finding an Operation

• Displaying the Operations Summary

• Displaying the Operation Header Summary

• Entering Operation Activity Details

• Using the View Menu to Find an Operation

• Entering Activity-Resource Details

• Displaying Operation Activity Line Summary

• Displaying a Process Operation Resource Line

• Editing a Process Operation Resource Line

• Displaying Operation Resource Process Parameters

Requirements
Following are some requirements that customers have for operations in Product 
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Development.

Does the application maximize production capacity resource usage?
Yes. By using the Charge to calculate resource usage, the application captures the 
number of passes required to process a step based on the maximum capacity of that 
step. This is derived from specific resources used and can assist in maximizing usage of 
production capacity resources.

Charges Refine Processing Requirements for Better Planning and Cost Management

In many process manufacturing plants, the capacity of a step is determined by the 
equipment used. For example, a mixing tank has a maximum capacity of 1000 gallons. If
more than 1000 gallons of material is added to this tank, then it would overflow. This 
maximum capacity determines the number of charges or iterations required to process 
the ingredients required for a defined batch. The time it takes to mix any volume of 
material through this operation is a fixed value. For example, one charge can require 
one hour of mixing. The problem arises when a batch is greater than the step capacity, 
and the step must be repeated several times to make a full batch volume. Proportional 
scaling does not always reflect the processing requirements. For example, if a batch is 
planned for 4500 gallons and the routing step can have a tank capacity of 1000 gallons, 
then five charges, or mini-batches, are required to process the full 4500 gallons. 
Proportional scaling results in only 4.5 hours of process time, whereas the actual 
required process time is five hours. By refining the process requirements, the 
application delivers a better assessment of usage rates that affect planning and cost 
management.

Can the application simplify the repeated entry of the same data for the same activity?
Yes. Using an Activity Factor defines the number of iterations that a specific activity can
be performed during an operation. The Activity Factor is considered in planning and 
calculating resource usage.

Activity Factors Streamline Resource Definition

An Activity Factor defines the number of times an activity is performed. For example, if
a quality test must be performed at the beginning, middle, and end of a mixing time 
period, you must use an Activity Factor of three. Activity Factors are applied to 
resource usage when planning and calculating resource costs. They can be set to zero to 
exclude a particular activity or to select specific equipment or resources.

Can you enable version control at the Operation attributes level?
Yes. The Operation user interface supports version control for attributes, provided you 
create version control attribute sets at the Operation entity level to include attributes 
you could like to modify and drive version control and assign them to the organization.

Support for Version Controlled Attributes for Operation
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Use the Version Control Attributes user interface provided under Product Development
Security Manager to create version control attribute sets at the Operation entity level. 
Select and enable attributes you would like to modify and enable version control for at 
the Operation level. Ensure you assign the version control attribute set to the 
organization using the Assign Version Control Set page or the Product Development 
Parameters window. This will enable you to modify attributes for existing operations 
and create new versions of the operation. See: Setting Up Version Control Attribute 
Sets, page 2-39.

Understanding Operations
An operation is an ordered set of activities that have to be completed for a 
predetermined step in a production batch. Resource requirements that are needed to 
perform these activities are usually specified. You build operations from activities that 
require resources.

Operations are depicted hierarchically in the following diagram that shows the:

• Routing composed of a series of Operations organized in Steps.

• Operations composed of Activities containing Resources.

• Formula composed of Ingredient, Product, and possibly Byproduct.

• Recipe linking the Routing and Formula together with Processing Instructions.

Additional Information: Set up instruction sets as described in the 
Oracle Manufacturing Execution System for Process Manufacturing 
User's Guide.
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The assembly of several operations in a stepwise progression creates a Routing.

Defining and Maintaining Operations
Operations are composed of a sequence of activities and required resources. Enter and 
maintain the sequence of activities in the operation, and specify the resource, resource 
usage, and process quantity used for each activity. For example, a mixing activity can 
require one-half hour of use of a mixing system. Resource usage and cost analysis codes
associated with each activity are used to calculate activity-based product costing.

Creating a New Operation
Create new operations on the Process Operation Details Activities window. When you 
define an operation, specify a combination of activities performed in the production 
batch and assign the resources used to perform those activities. A resource can be any 
noninventory item is used in production, such as a blender or a heating device. 
Resource requirements needed to perform these activities must be specified. The 
operation header contains a creation organization and owning organization. Operations
are linked to organizations referenced in the routing header, but are not organization-
specific.

Maintaining Operations
Use the following windows to maintain operations:

• Operations Summary By to display a list of all defined operations with their 
individual version numbers and validity dates. These are summaries by Class or 
Status. Display the Process Operation Details Activities window from the 
Operations Summary By window.

• Operation Header Summary to display descriptive information on a specific 
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operation. Display the Process Operation Details Activities window from the 
Operation Header Summary window.

• Process Operation Details Activities to enter, view, and edit an operation. Display 
the following window from the Process Operation Details Activities window:

• Operation Activity Line

• Operation Details Activity Resources

The following graphic depicts the previously described operation navigation flow:

Creating Version Control Attribute Sets for Operation
You can set up version control at the Operation attribute level. You can create a version 
control attribute set for Operation and assign it to the organization. This ensures that 
when modifying attributes in the Process Operation Details Activities window that are 
included in the attribute set, you will be able to create a new version of the Operation 
with the same entity names but with a different version number. Should you not want 
to create a new version, you can select to cancel and continue with the existing 
operation.

To set up version controlling attribute sets at the Operation entity level, see: Setting Up 
Version Control Attribute Sets, page 2-39.

Defining and Maintaining Activities
Activities are the basic tasks performed at your plant such as setup, mixing, cleanup, or 
cooling. Combine activities with resources such as blender, oven, labor, or utilities to 
define operations. Basic plant activities are identified by activity codes. These codes are 
then combined to define the sequence of activities that can make up an operation. You 
can associate a cost analysis code with each activity. For example, by defining cost 
classes, you can categorize individual activities on whether or not they add value. 
Activity costs are the basic components of an activity-based accounting system. Begin 
by setting up activities.
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Attaching Activities to Operations
Attach activities created in setup to specific operations using the Process Operation 
Details Activities window.

Maintaining Activities
Use the following windows to maintain activities:

• Operation Activity Line Summary to view a summary of a specific activity line 
including its description, process parameter, and factor. Display the Operation 
Activity Line window from the Operation Activity Line Summary window.

• Operation Activity Line to view and edit pertinent information relevant to a specific
operation line selected.

Defining and Maintaining Resources
You can define and maintain resources using the Operation Activity window. 
Resources are the assets to produce batches, including production equipment, and 
employee labor. You can define each resource generally, for example, OVENS, or 
specifically OVEN 1, OVEN 2 . . . OVEN n. For each resource, assign a classification 
code for cost management purposes. You can group resources into resource 
classifications, for example, group OVENS and STOVES into COOKING UNITS.

Attaching Resources to Activities
Attach resources created in setup to activities using the Operation Activity window.

Maintaining Resources
Use the following windows to maintain resources:

• Operation Resource Line Summary to view a summary of resource lines. Display 
the Operation Resource Line window from the Operation Resource Line Summary 
window

• Operation Resource Line to view and edit specific resource lines.

Finding an Operation
Use the Find Process Operations window to find a specific operation you have entered 
and saved.
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To find an operation:
1. Navigate to the Find Operations window.

2. Enter as many parameters as needed to complete the search:

• Enter search parameters in the Standard region for: Operation, Version, 
Description, Class, Valid From date, Valid To date, Process Quantity, or Status.

• Enter search parameters in the Advanced region for a specific: Item, Condition, 
or Value.

3. Click Find.

4. Review the results of the search.

Displaying the Operations Summary
The Operations Summary By window displays a list of all defined operations with their 
individual version numbers and validity rules, by class, owner, or status. Display the 
Process Operation Details Activities window to view specific activities associated with 
each of the operations.

To display a list of all defined operations:
1. Navigate to the Operations Summary By window.

2. The following fields are display only:

• Operation is the name of the operation.

• Version is the version of the operation.

• Valid From is the date the operation is effective.

• Valid To is the date the operation is no longer effective.

• Description is a brief explanation of the operation.

• Class is the optional class of the operation.

• Minimum Transfer Quantity is the minimum amount of material that must be 
produced in a step at a specific production operation and resource before the 
next operation can begin. This reduces bottlenecks by letting processes transfer 
an interim quantity of completed material to the next step without the 
requirement to complete the entire step.
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• Process Quantity UOM is the unit of measure for the process quantity 
associated with the operation.

3. Optionally, click Details to display the Process Operation Details Activities 
window.

Displaying the Operation Header Summary
The Operation Header Summary window displays important descriptive information 
on a specific operation. Use the Process Operation Details Activities window to enter, 
view, and edit an operation.

To display a summary of the operation headers:
1. Navigate to the Operation Header Summary window.

2. Select the appropriate Operation.

3. The following fields are display only:

• Status is the status of the Operation. Statuses are entered on the Process 
Operation Details Activities window.

• Operation is the name of the Operation.

• Version is the version of the Operation.

• Description is a brief explanation of the Operation.

• Class is the optional class assigned to the Operation.

• Class Description is a brief description of the Class.

• Valid From is the date the Operation is effective.

• Valid To is the date the Operation is no longer effective.

• Min Transfer Qty is the minimum amount of material that must be produced in 
a step at a specific production operation and resource before the next operation 
can begin.

• Process Qty UOM is the unit of measure for the process quantity associated 
with this Operation.

4. Optionally, click Details to display the Process Operation Details Activities 
window.
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Entering Operation Activity Details
Operations are a combination of activities performed in a production batch and the 
resources used to perform those activities. The Process Operation Details Activities 
window links operations to activities. Use the Activity Factor and activity-resource 
association to enter an activity several times within an operation. Activity Factor 
simplifies data entry of the same activity several times by defining the specific number 
of times an activity is performed during an operation. Activity factor is taken into 
consideration for planning and resource calculation purposes. Display the Operation 
Activity window to link resources to a single activity. Go to the Operation Activity Line 
Edit window to edit individual activity lines.

Save an operation that contains activities with no associated resources if the operation 
status is New. Status cannot be changed to Approved for Laboratory Use or to 
Approved for General Use until all activities have resources associated to them.

You can also create a version control attribute set at the Operation entity level and 
assign it to the organization. This will enable you to modify the selected operation 
attributes included in the set and create new versions of the operation. See: Setting Up 
Version Control Attribute Sets, page 2-39.

Sequence Dependent Operations

Sequence dependency indicates there is additional setup time required when products 
are processed through each operation in a specific sequence.

E-record and E-signature Approvals

There may be an e-signature event associated with this window. See: Appendix D 
Oracle E-Records Events in Product Development, page D-1.

To enter operation activity details:

• Enter and save activities.

• Enter and save resources.

• Optionally, enter and save operation classes.

To enter operation details:
1. Navigate to the Process Operation Details Activities window.

2. Enter the Operation name. Required.

3. Return to this window to change status by selecting Change Status from the Actions
menu after entering all relevant information and saving the process operation with 
the default Status of New. Depending on whether workflow is enabled, a different 
set of statuses is available. See: Appendix C Oracle Process Manufacturing Product 
Development Status Codes, page C-1.
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4. Enter the Version number for this operation. The combination of operation and 
version must be unique. Required.

5. Enter a brief Description for the version entered. Required.

6. Enter a Class for this operation to identify how it is categorized. The Class 
Description assigned to the class displays.

7. Enter a Valid From date as a validity rule for this operation. The default date is the 
current system date. Required.

8. Enter a To date as a validity date for the expiration of this operation. If there is no 
expiration date for this operation, leave the field blank.

9. Enter the Owner Organization for this Operation. A Description of the Owner 
Organization displays.

10. Minimum Transfer Qty displays the minimum amount of material that must be 
produced in a step at a specific production operation and resource before the next 
operation can begin. It is used by planning to reduce bottlenecks by letting 
processes transfer an interim quantity of completed material to the next step 
without the requirement to complete the entire step.

11. Enter a Process Qty UOM for this operation. Required.

12. Enter the operation level planned Yield %. This is not a mandatory field and cannot 
be more than 100%. You cannot edit the yield % after the status is changed to 
Approved for General Use. The yield % value also appears in the E-Record 
generated for the Operation Status Change Approval event. See the Yield 
Measurement in Process Manufacturing topic in the Oracle Process Manufacturing 
Process Execution User's Guide for detailed information about yield calculation.

Activities
13. Enter an Activity required for this operation. A Description of this activity displays.

14. Enter the Activity Factor to specify the number of times the activity is performed in 
this operation. Required.

For example, if a quality test must be performed at the beginning, middle, and end 
of a mixing time period, rather than defining the activity and associated resources 
three times, use an activity factor as the multiplier that indicates the number of 
iterations for the same activity.

To indicate that the activity must be performed at the beginning, middle, and end of
the mixing time period, enter a factor of 3. Factors are applied to usage of a resource
when planning and calculating cost. Set the activity factor to zero to exclude a 
particular activity. You can also use this to select equipment used for a production 
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run within this specific plant.

15. Sequence Dependency is selected when the activity has a sequence dependent 
setup. It is cleared when there is no sequence dependency.

16. Enter the Offset Interval as the time delay from the start of the activity to the point 
where the resource is actually required. Required.

17. Breakable indicates whether the activity can be broken.

18. Max Break indicates the maximum duration of the break if the activity is breakable.

19. Material Scheduled is used in conjunction with the planning and scheduling 
application to show the activity consumes material.

20. Repeat steps 13 through 18 for each activity in the specified operation, and save 
your work.

Note: If you create and assign a version control attribute set for the 
Operation entity and if you modify any of the attributes included in
that set, you will be prompted to create a new version of the 
operation when you save your work. See: Setting Up Version 
Control Attribute Sets, page 2-39.

To mark the operation for deletion:
1. Choose Mark for Purge from the Actions menu. The record is marked for deletion.

2. Save your work.

To edit operation text:
1. Choose Edit Text from the Actions menu.

2. Make the appropriate edits to operation text.

3. Save your work.

To display the Specifications window:
1. Choose Specifications from the Actions menu.

2. Evaluate specifications.
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To display the Samples Summary window:
1. Choose Samples from the Actions menu.

2. Evaluate the samples.

To view alternate resources for the operation:
1. Choose Operation Alternate Resources from the Actions menu. The window 

displays the alternate resources available for the resource displayed in the 
operation.

To change the operation status:
1. Choose Change Status from the Actions menu.

2. Change the Current Status displayed by selecting a different Status from the 
Change Status To list.

3. Click OK. The Process Operation Details Activities window displays the revised 
Status for the Operation.

To duplicate a record:
1. Query the Process Operation Details Activity record to duplicate.

2. Choose New from the File menu.

3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Operation name and Version number.

5. Click OK.

6. Save your work.

To display the E-record Details window:
1. Choose E-record Details from the Actions menu. The E-record Generic Query 

displays if this option is implemented in your application. 

See: Appendix D Oracle E-Records Events in Product Development, page D-1.

To enter processing instructions:
1. Choose Processing Instructions from the Actions menu. The Instruction Set window

displays.
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2. Enter information as described in the Oracle Manufacturing Execution System for 
Process Manufacturing User's Guide.

Using the View Menu to Find an Operation
Use the Find option in the View menu to find an operation.

To find an operation from the View menu:
1. Choose Find from the View menu.

2. Enter one or more of these search parameters:

• Status

• Operation

• Version

• Description

• Operation Class

• Activity

• Resource

• Mark for Deletion

3. Click Find.

Entering Activity-Resource Details
The Operation Activity window assigns resources to each activity, and lets you edit a 
resource line once activities are associated with an operation. Access this window when 
you click Resources on the Process Operation Details Activities window.

Charge calculates resource usage by capturing the number of passes required to process
a step. This is based on the maximum capacity of the step as derived from specific 
resources used.

To assign resources to an activity:
1. Navigate to the Operation Activity window.

2. Enter the Operation to associate activities. The Status assigned to the operation 



4-14    Oracle Process Manufacturing Product Development User's Guide

displays. The current Version number for the operation displays. Required.

3. Select the Activity to assign a resource.

4. Click Resources. The Resource and its Description display.

Throughput
Process units of measure and usage units of measure are derived from the plant 
resource if one is defined. You can override these values using this window. A process 
quantity is converted to an operation process quantity unit of measure if needed.

5. Enter the planned Process Quantity for the resource. The UOM entered on the 
header displays. This is the unit of measure for the planned process quantity. 
Required.

This value combined with the Usage quantity define the usage rate. For example, if 
a resource can mix 200 gallons per hour, enter 200 as the process quantity, 1 as the 
usage, and the unit of measure for hours.

6. Enter the planned resource Usage. This is typically expressed in hours. Required.

7. Enter the UOM as the unit of measure for the resource. Required.

Cost Information
8. Enter the Component Class code. The component class is set up in the Oracle 

Process Manufacturing Cost Management application and defaults from the 
Resource. Required.

9. The following fields are display only:

• Resource, its Description and the Component Class Description for the 
resource.

•  Cost Analysis Code and Cost Analysis Description for the activity. The code 
and description default from the activity.

Scheduling Information
10. Select a Plan Type for the displayed Resource and Description:

• Select Auxiliary for resources that work as companions with the primary 
resources to perform an activity in the operation. Auxiliary resources are not 
treated differently from primary resources in calculating step and batch 
duration. The calculation of batch duration is the duration of the longer 
resource, that is either the primary or auxiliary resource. Auxiliary resources 
affect the rate if the duration of the auxiliary resource is longer than the 
primary resource. 



Operations    4-15

• Select Primary to indicate the rate determining resource. It limits or determines 
throughput. It is also referred to as the bottleneck or critical resource. There can 
only be one primary resource.

• Select Secondary for resources that work as companions with the primary 
resource. Secondary resources are not treated differently from primary 
resources in calculating step and batch duration. The calculation of batch 
duration is the duration of the longer resource, that is either the primary or 
secondary resource. Secondary resources affect the rate if the duration of the 
secondary resource is longer than the primary resource. 

Resources are assigned a Plan Type indicating primary (1), auxiliary (2), or 
secondary (0) on the Process Operations window. In ASCP, you can set a 
secondary and auxiliary resource as to the value of Do Not Plan to prevent that 
resource from being planned. However, this has no affect within OPM Process 
Execution.

11. Enter the Count as the number of resources needed for the activity entered. For 
example, if two blenders are used for mixing, enter a 2 in the count. Required.

12. Enter the Offset Interval as the time delay from the start of the activity to the point 
where the resource is actually required.

13. Select the Scale Type. Designate whether scaling is used to determine resource 
quantity. Scaling is defined as the proportional increase or decrease of resources. 
For example, setup and cleanup activities are usually not scaled, while 
manufacturing activities are scaled:

• Select Proportional Scaling if the resources change in a ratio to the quantity of 
material being processed.

• Select Fixed if the resources do not change, regardless of the quantity of 
material being processed.

• Select Fixed By Charge if the resources change as a result of the number of 
charges specified.

To edit a resource line:
1. Select the appropriate Resource line.

2. Click Edit Resource Line to display the Operation Resource Line Edit window.

3. Make the appropriate changes to the line.

4. Save your work.
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To display the Operation Resource Process Parameters window:
1. Click Parameters. The Operation Resource-Process Parameter window displays. 

Displaying Operation Activity Line Summary
Use the Operation Activity Line Summary window to view information relevant to a 
specific operation line selected. Use this window to edit the selected activity line. To 
edit this information, click Details to display the Operation-Activity Line Edit window. 
See: Oracle Process Manufacturing Capacity Planning User's Guide to set up process 
parameters details.

Sequence Dependent Operations

In many cases, setup times depend on the setup type of a previous activity processed by
a given resource. Evaluation of these activities generates a firmed sequence in which to 
perform them in order to minimize the sum of changeover times for the entire cycle. 
After you define and create activity sequences in the Oracle Advanced Planning and 
Scheduling application, they are returned to the source Process Manufacturing instance.
When you create these sequences, you can firm the resource to ensure that the 
scheduling engine does not move the resource usage.

To display information about an operation activity line:
1. Navigate to the Operation Activity Line Summary window.

2. The following fields are display only:

• Activity indicates the activity selected for this Operation.

• Description is a brief explanation of the activity.

• Factor is the process factor entered for the activity.

• Offset Interval is the time required before the activity begins. In process 
operations, this is usually the number of hours from the batch step start to the 
start time of this activity.

3. Optionally, click Details to display the Operation Activity Line window.

To edit an operation activity line:
1. Navigate to the Operation Activity Line window.

2. The following fields are display only:

• Activity displays the activity selected for the Operation. 
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• Description is a brief explanation of the activity.

3. Enter the Factor as the process factor for the activity. Required.

4. Enter the Offset Interval as the time delay from the start of the activity to when the 
resource is actually required.

5. Sequence Dependency is selected when the activity has a sequence dependent 
setup.

Displaying a Process Operation Resource Line
The Process Operation Resource Line window displays a process operation resource 
and its associated process parameters. To display process operation resource lines:

• Enter and save operations.

• Enter and save activities. 

To display a process operation resource line:
1. Navigate to the Process Operation Resource Line window.

2. The following fields are display only:

• Resource displays the resource associated to the activity and its Description.

• Quantity is the process amount for the resource with Quantity UOM as its unit 
of measure.

• Usage is actual usage of the resource for the line with its UOM.

• Component Class code is set up in the Oracle Process Manufacturing Cost 
Management application and defaults from the resource. The component Class 
Description displays.

• Cost Analysis Code is the resource cost code and its Description.

• Plan Type is:

• Auxiliary to indicate the resources that work as companions with the 
primary resources to perform an activity in the operation.

• Primary to indicate the rate determining resource. There can only be one 
primary per resource.
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• Secondary to indicate the resource that replaces the primary if it were not 
available. This resource performs the same task as the primary, but can 
have a different usage.

• Count is the planned number of resources for the activity. Count indicates the 
number or quantity of the resource used in the specified Plant where you define
production costs and usage availability.

• Offset as the time delay from the start of the activity to the point where the 
resource is actually required.

• Scale Type is the type of scaling used to determine resource quantity:

• Proportional Scaling indicates the resources change in a ratio that is 
proportional to the quantity of material being processed.

• Fixed scale type indicates the resources do not change, regardless of the 
quantity of material being processed.

• By Charge indicates resources change as a result of number of charges 
specified.

Process Parameters
3. The following fields default from the process parameter set up in the planning 

application:

• Seq is the sequence of the resource process parameter.

• Parameter is the process parameter name. For example, Bath Temperature.

• Target indicates the target value for the process parameter.

• Minimum is the lowest acceptable value for a numeric range type of process 
parameter.

• Maximum is the highest acceptable value for a numeric range type of process 
parameter.

• Units is the unit of measure for the process parameter.

4. Click Reset Values to remove overrides set up for a process parameter. See: 
Displaying Operation Resource Process Parameters, page 4-21.
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Editing a Process Operation Resource Line
Use the Process Operation Resource Line window to edit process operation resource 
lines.

To edit a process operation resource line:
1. Navigate to the Process Operation Resource Line window.

2. Click Details. Resource and its Description indicate the resource you are editing.

Resource
3. Enter the appropriate process Quantity. The Quantity UOM displays for the process

quantity entered. Required.

4. Enter Usage as the rate of use for the resource. This value is usually expressed in 
hours or partial hours. For example, one hour and 15 minutes is entered as 1.25. 
Required.

Resource Usage = Count multiplied by Usage multiplied by Charges

5. Enter the Usage UOM as the unit of measure the resource is measured in the 
specified plant. This is usually specified in hours. Required.

6. Enter the Component Class. The Class Description assigned to the component class 
displays. Required.

7. Enter the appropriate Cost Analysis Code for the resource. The Cost Analysis 
Descriptor associated with the cost analysis code displays. Required.

8. Plan Type is display only and indicates whether this resource is an auxiliary, 
primary, or secondary resource:

• Auxiliary indicates resources that work as companions with the primary 
resources to perform an activity in the operation. These resources do not affect 
the rate of the operation. For example, a primary resource in a mixing activity is
a mixer with a throughput rate of 100 gallons per hour. An auxiliary resource is 
the worker who operates the mixer. No matter how fast or slow the worker is, 
the mixer rate remains at a constant 100 gallons per hour.

• Primary indicates this is the rate determining resource. It limits or determines 
throughput. It is also referred to as the bottleneck or critical resource. It is 
recommended that the RUN-TIME activity's resource be assigned this way.

• Secondary indicates the resource that replaces the primary resource when it is 
not available. This resource performs the same task as the primary resource. It 
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is unconstrained, and it has usage. The Advanced Planning and Scheduling 
application does not schedule the secondary resource.

9. Enter the appropriate Count. This is the number or quantity of the resource used in 
the specified plant where you are defining production costs and usage availability. 
The number you enter depends on how broad a resource categorization you are 
defining. For example, if you define the resource as Blender 1, then enter 1. If you 
use three blenders in the production line, and you define the resource as Blenders 
rather than defining each individually, then enter 3. Required.

10. Enter the appropriate Scale Type. You can designate whether scaling is used to 
determine resource quantity. Scaling is defined as the proportional increase or 
decrease of resources. For example, setup and cleanup activities are usually not 
scaled, while manufacturing activities are scaled. This field defaults to linear 
scaling.

• Select Proportional if the resources change in a ratio proportional to the 
quantity of material being processed.

• Select Fixed if the resources do not change, regardless of the quantity of 
material being processed.

• Select Scale by Charge if the resources are scaled by charges.

11. Enter the appropriate Offset as the time delay from the start of the activity to the 
point where the resource is actually required.

Process Parameters
12. The following fields default from the process parameter set up in the planning 

application:

• Seq is the sequence of the resource process parameter.

• Parameter is the process parameter name. For example, Bath Temperature.

• Target is the target value for the process parameter.

• Minimum is the lowest acceptable value for a numeric range type of process 
parameter.

• Maximum is the highest acceptable value for a numeric range type of process 
parameter.

• Units is the unit of measure for the process parameter.

13. Click Reset Values to remove overrides set up for a process parameter.
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14. Save your work.

Displaying Operation Resource Process Parameters
Process parameters are a component of the process instructions necessary to run 
resources during the batch process. They are usually machines or instruments and are 
the standard for executing a task. They can be generic or specific. Each industry and 
company uses different machines and instruments, and there are different requirements
for recording process parameters.

A process parameter details information such as temperature, pressure, or time 
pertinent to the product, but does not fall into the classification of input or output. You 
can use process parameters as set points, comparison values, or in conditional logic.

To display the Operation-Resource Process Parameters window:
1. Navigate to the Operation-Resource Process Parameters window.

2. The following fields are display only:

• Operation displays the operation with its Version and Description.

• Activity displays the activity related to the step and its Description.

• Resources displays the resource attached to the activity and its Description.

Parameter Values
3. The following fields default from the process parameter set up in the planning 

application:

• Seq is the sequence of the resource process parameter.

• Parameter is the process parameter name. For example, Bath Temperature.

• Minimum is the lowest acceptable value for a numeric range type of process 
parameter.

• Maximum is the highest acceptable value for a numeric range type of process 
parameter.

• Units is the unit of measure for the process parameter.

To reset values based on the hierarchy:
1. You can override certain process parameters at the operation and recipe levels. 

Click Reset Values to remove overrides set up for a process parameter. The 
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following illustrates how the process parameter is reset.

The hierarchy is:

• Recipe

• Operation

• Default value from the planning application

For example, if the default for a process parameter from the planning application is 
set to 10, you can override it at the operation level and at the recipe level. The 
following values are used for illustration:

• Recipe = 20

• Operation = 15

• Default value from the planning application = 10

If you click Reset Values for the process parameter on the:

• Recipe Details window, then the process parameter value changes from 20 to 
15, the next step down in the hierarchy.

• Operation Activity Details window, then the process parameter value changes 
from 15 to 10.

If no override exists at the operation level, and you click Reset Values at the recipe 
level, then the process parameter value changes to 10, which is the original default 
value from the planning application.
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5
Routings

This chapter describes how to define and maintain routings. It explains how to find a 
routing and view summaries of routings and routing headers that provide overviews of
available routings. The processes of entering routing details and displaying the routing 
step line summary are discussed. Steps to edit routing step lines, and enter routing step 
dependencies as well as procedures for displaying and editing theoretical process loss 
are provided.

This chapter covers the following topics:

• Requirements

• Understanding Routings

• Defining and Maintaining Routings

• Finding a Process Routing

• Displaying the Routings Summary

• Displaying the Routing Header Summary

• Using the View Menu to Find a Routing

• Entering Process Routing Details

• Displaying the Routing Step Line Summary

• Editing Routing Step Lines

• Entering Routing Step Dependencies

• Displaying Fixed Process Loss

• Displaying Theoretical Process Loss

• Editing Theoretical Process Loss

• Understanding the Routing Designer

• Using the Routing Designer

• Actions Menu Options
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• Using the Routing Properties Window

• Using the Step Properties Window

• Generating Step Dependencies

• Using the Activity Properties Window

• Using the Resource Properties Window

• Using the Step Dependency Properties Window

• Accessing Quality Control Windows

• Adding Operation Steps

• Removing Operation Steps

• Editing User Preferences

Requirements

Can process loss be captured as a cost?
Yes. Use Theoretical Process Loss to reflect a planned percentage of material lost for a 
specific routing. Calculate the actual ingredient usage from a production perspective, 
which accommodates for that loss in standard costing.

Process Loss Factors Enable Better Material Planning

Due to factors such as evaporation or changeovers, materials can be lost or 
unrecoverable in a production step. These lost materials need to be planned for to 
achieve the targeted process quantity for a step. The loss can vary depending on the 
material being processed, therefore a production loss factor must be defined at a 
product operation level, and reflected in production and planning for ingredients 
associated to the step. Product Development allows entry of a process loss factor to 
enable better material planning.

Does the application support automatic calculation of step quantities based on material 
input and output?

Yes. The application automatically calculates step quantities based on the amount of 
materials input and output for each step.

Step Quantity Calculations Deliver Accurate Total Quantity Usage

All step quantities are calculated based on the routing step definitions and ingredient 
usage per step. Quantities are cumulative in that ingredients in step one are added to 
ingredients in step two. When byproducts or coproducts are yielded at the step, they 
decrease the total step quantity. Product Development accounts for this yield to deliver 
an accurate total step usage.
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Can manufacturing activities and routings be managed on the manufacturing floor?
Yes. The Process Engineer workbench manages routings, operations, and recipes at the 
shop floor level.

Seamless Integration of Product Development Responsibilities

In addition to the default Recipe Data Organizer, the Process Engineer can manage all 
routings, operations, and recipes as part of a seamless integration of all pertinent job 
functions on the shop floor.

Is it possible to model when ingredients are relieved from inventory?
Yes. The application provides four separate release methods to update inventory: 
automatic, automatic by step, manual, and incremental.

Select the Appropriate Ingredient Release Method

Choose the release method that fits your requirements to relieve ingredients from 
inventory. Automatic release of ingredients releases all ingredients when the batch is 
released. Automatic by step releases ingredients after each step is completed, on a step 
by step basis. Use manual release for full hands-on control of ingredient release. Or, use
an incremental release to keep inventory quantities current by backflushing materials as
they are used.

Can you enable version control at the Routing attributes level?
Yes. The Routing user interface supports version control for attributes, provided you 
create version control attribute sets at the Routing entity level to include attributes you 
could like to modify and drive version control and assign them to the organization.

Support for Version Controlled Attributes for Routing

Use the Version Control Attributes user interface provided under Product Development
Security Manager to create version control attribute sets at the Routing entity level. 
Select and enable attributes you would like to modify and enable version control for at 
the Routing level. Ensure you assign the version control attribute set to the organization
using the Assign Version Control Set page or the Product Development Parameters 
window. This will enable you to modify attributes for an existing routing and create 
new versions of the routing. See: Setting Up Version Control Attribute Sets, page 2-39

Understanding Routings
A routing is a sequenced set of operations performed to complete a production batch. 
The operations are presented in a series of steps that organize these operations into an 
orderly set of activities that have individual resources associated to them.

Routings are depicted hierarchically in the following diagram which shows the:
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• Routing composed of a series of Operations organized in Steps.

• Operations composed of Activities containing Resources.

• Formula composed of Ingredient, Product, and possibly Byproduct.

• Recipe linking the Routing and Formula together with Processing Instructions.

Additional Information: Set up instruction sets as described in the 
Oracle Manufacturing Execution System for Process Manufacturing 
User's Guide.

Defining and Maintaining Routings
Routings are defined in terms of operations. Enter and maintain the sequence of 
operations and step quantities used in a routing. Define multiple versions for a routing 
that makes the same product to accommodate several production lines with differing 
characteristics. Routings and operations are modeled into the structure of a new recipe. 
Several attributes are defined at the recipe level, including planned process loss, step 
quantity, capacity, and activity factor. A single product can be associated with several 
routings on the manufacturing floor.

Creating a New Routing
Create and define new routings in the Process Routing Details window. A routing 
represents the sequence of operations or steps used during the manufacturing process. 
Specify each of the operations in sequence, with their respective step quantities, and 
total routing quantities. Display the following windows from the Process Routing 
Details window:

• Process Operation Details Activities
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• Routing Step Dependencies

• Routing Step Line

Maintaining Routings
Use the following windows to maintain routings:

• Routings Summary By to display a list of defined routings with their individual 
version numbers and descriptions. View routings by Class, Status, or Owner. 
Display the Process Routing Details window from the Routings Summary By 
window.

• Routing Header Summary to display important descriptive information on a 
specific routing. Display the following windows from the Routing Header 
Summary window:

• Process Routing Details

• Theoretical Process Loss

• Routing Step Line Summary to determine the step number, operation, step 
quantity, and unit of measure for the step in a specific routing. Display the Routing 
Step Line window from the Routing Step Line Summary window:

• Routing Step Dependencies to create and modify the interrelationships between 
routing steps. Step dependencies are those relationships between steps that 
establish whether a specific step can or cannot start until another step is completed.

• Theoretical Process Loss to enter the theoretical percent loss expected for a range of 
material processed during a specified routing.

• Routing Step Line to edit individual routing step lines.

The following graphic depicts the previously described routing navigation flow:

Creating Version Control Attribute Sets for Routing
You can set up version control at the Routing attribute level. You can create a version 
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control attribute set for Routing and assign it to the organization. This ensures that 
when modifying attributes in the Process Routing Details window that are included in 
the attribute set, you will be able to create a new version of the routing with the same 
entity names but with a different version number. Should you not want to create a new 
version, you can select to cancel and continue with the existing routing.

To set up version controlling attribute sets at the Routing entity level, see: Setting Up 
Version Control Attribute Sets, page 2-39.

Finding a Process Routing
Use the Find Process Routings window lets you find a specific routing you have entered
and saved.

To find a process routing:
1. Navigate to the Find Process Routings window.

2. Enter as many parameters as needed to complete the search:

• Enter search parameters in the Standard region for Routing, Version, 
Description, routing Class, Valid From, Valid To, Process Quantity, or Status.

• Enter search parameters in the Advanced region to enter a specific Item, 
Condition, or Value.

3. Click Find.

Displaying the Routings Summary
The Routing Summary window displays a list of all defined routings with their 
individual version numbers and descriptions. View these by Class, Status, or Owner. 
Display the Process Routing Details window from this window to view specific steps 
and operations associated with each of the routings displayed.

To display a list of all defined routings:
1. Navigate to the Routings Summary By window.

2. The following fields are display only:

• Routing displays the name of the routing.

• Version displays the version number of the routing.

• Quantity displays the product quantity associated with this routing. This is the 
total quantity from which individual step requirements are scaled.
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• UOM displays the unit of measure for the quantity. This unit of measure 
defaults from the process quantity unit of measure entered on the Process 
Operation Details Activities window.

• Class displays the optional class entered for the routing.

• Valid From displays the date on which the routing is effective.

• Valid To displays the date on which the routing is no longer effective.

• Status displays the current status of the routing.

Displaying the Routing Header Summary
The Routing Header Summary window displays important descriptive information on 
a specific routing.

To display a summary of routing headers:
1. Navigate to the Routing Header Summary window.

2. Select the desired Routing.

3. The following fields are display only:

• Status is the approval status of the routing.

• Routing is the code assigned to the routing.

• Version is the version number of the routing.

• Description is a brief explanation of the routing.

• Valid From is the date on which the routing is effective.

• Valid To is the date on which the routing is no longer effective.

• Class is the optional class assigned to the routing.

• Class Description is the optional class description assigned to the routing.

• Organization is the routing context organization.

• Theoretical Loss is the theoretical quantity of material lost in the routing.

• Planned Loss is loss of material planned for in the routing.
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• Quantity is the amount of material assigned to the displayed routing.

• UOM is the primary unit of measure for the quantity of material.

• Owner is the entity responsible for the routing.

• Enforce Step Dependency indicates that step interdependencies are in force. 
Routing steps must be released and completed manually.

• Contiguous indicates that the routing must be run in one contiguous block of 
time. The batch that uses this routing cannot stop and start, even if it runs into 
downtime on the shop calendar.

Using the View Menu to Find a Routing
Use the Find selection from the View menu to find a routing when the Process Routing 
Details window is displayed.

To find a routing from the View menu:
1. Choose Find from the View menu.

Note: This window does not allow entry of a context organization. 
Use the Process Routing Details window to change the context 
organization.

2. Enter one or more of these search parameters:

• Status of the Routing and its Owner Organization.

• Routing Number code assigned to the routing.

• Routing Version number assigned to the routing.

• Description of the routing.

• Routing Class assigned for classification of the routing.

• Valid From date the routing is effective.

• To date that the routing is no longer effective.

• Owner or initiator of the routing.

• Routing Quantity as the amount of material assigned to the routing in the 
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displayed unit of measure.

• UOM as the unit of measure for the routing quantity.

• Process Loss as the planned loss of material for the routing.

• Enforce Step Dependency as Yes to find routings that enforce step 
dependencies. If a recipe uses this routing, then batches created from the recipe 
have the indicator selected on the Batch window.

• Marked for Deletion as Yes to find routings marked for purge, or select No to 
find routings not marked for purge.

• Contiguous as Yes, to find routings that must be run in one contiguous block of 
time.

3. Click Find.

Entering Process Routing Details
Use the Process Routing Details window to enter details for a specific process routing.

Enforce Step Dependency Indicator

When Enforce Step Dependency is selected, several business rules are applied: 

• The Release Type field is set to Manual to indicate that the step must be released 
and completed manually.

• You cannot change the step dependency and step release type at the step level.

• All steps must be completed before you can complete a batch using this routing.

• All steps must be closed before you can close a batch using this routing.

• Business rules validate step start and completion dates and time for appropriate 
batch step rescheduling.

You can also create a version control attribute set at the Routing entity level and assign 
it to the organization. This will enable you to modify the selected routing attributes 
included in the set and create new versions of the routing. See: Setting Up Version 
Control Attribute Sets, page 2-39.

To enter process routing details:
1. Navigate to the Process Routing Details window.
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Note: Enter the context Organization if it is requested.

2. Enter the code for the Routing. Required.

3. Enter a Routing Version of the routing. Required.

4. Return to this window to change status by selecting Change Status from the Actions
menu after entering all relevant information and saving the process routing with 
the default Status of New. Depending on whether workflow is enabled, a different 
set of statuses is available.

See: Appendix C Product Development Status Codes, page C-1.

5. Enter a Routing Description that briefly describes the routing. Required.

6. Enter a Class for the routing to identify how it is categorized. The Class Description 
assigned to the class displays.

7. Enter the Valid From date for this routing. The default date is the current system 
date. Required.

8. Enter a To date for the expiration of this routing. If there is no expiration date for 
this routing, then leave the field blank.

9. Enter the process Quantity for this routing. This is the total quantity of material for 
the routing, and is used to scale individual step requirements. Required.

10. Enter the process quantity UOM associated with this routing. The process quantity 
UOM must interconvert with the UOM defined for theoretical process loss based on
the primary product UOM conversion in the routing. Required.

11. Enter a Planned Loss for this routing. This value is expressed as a percent. For 
example, a loss of 1.304% is entered as 1.304.

12. Optionally enter a Fixed Process Loss for this routing. This value is expressed as a 
number. For example, a loss of 10 kg is entered as 10. Optional.

13. The Fixed Process Loss UOM associated with this routing appears. The fixed 
process loss UOM defaults to the Routing Class UOM.

14. The Theoretical Process Loss for this routing displays. This value is entered on the 
theoretical process loss window, and is based on the value assigned to the class 
associated with this routing.

15. Enter the Owner to indicate the individual responsible for initiating this routing. 
Required.
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16. Enter the Owner Organization to indicate the plant, laboratory, or other facility 
responsible for initiating this routing. Required.

17. Select Enforce Step Dependency to indicate the recipe using this routing enforces 
step dependencies. When you select this indicator, routing steps must be released 
and completed manually.

18. Select Contiguous to indicate the routing must be run in one uninterrupted block of 
time. The batch that uses this routing cannot stop and start, even if it runs into 
downtime on the shop calendar.

Routing Steps
19. Enter the Step number to associate with an operation in this routing. It is 

recommended that the first number in this sequence be 10, the second 20, and so 
forth. You can add intermediate steps between 10 and 20 at a later time. Required.

Note: If the manufacturing operation is an outside processing step, 
then there can be only one resource defined for one outside 
processing step, and only one outside processing step defined per 
routing.

20. Enter the code for the Operation performed in this routing. Required.

21. Enter a Version number for the routing. The Description displays. Required.

22. Enter the operation Step Quantity as the quantity of material associated with this 
step. The UOM for the step quantity displays.

23. Enter the planned yield as Yield % for this step. This value is derived from the yield
that you defined in the operation definition and can be edited. You cannot edit 
yield % after the status of Routing or Operation is changed to Approved for General
Use. The yield % value also appears for each step in the E-Record generated for the 
Routing status change approval event. See the Yield Measurement in Process 
Manufacturing section in the Oracle Process Manufacturing Process Execution User's 
Guide for detailed information about yield calculation.

24. Min Transfer Qty is the minimum amount of material that must be produced in a 
step at a specific production operation and resource before the next operation can 
begin.

25. Select Release Type as Automatic if the step is automatically released or completed 
when subsequent steps are released or completed, or Manual if the step must be 
released and completed manually. All steps are completed if the batch is completed,
regardless of the step release type. Required.
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26. Save your work.

Note: If you create and assign a version control attribute set for the 
Routing entity and if you modify any of the routing attributes 
included in that set, you will be prompted to create a new version 
of the routing when you save your work. See: Setting Up Version 
Control Attribute Sets, page 2-39

27. Optionally, click Step Dependencies to display the Routing Step Dependencies 
window.

28. Optionally, click Edit Operation to display the Process Operation Details Activities 
window.

29. Optionally, click Edit Step Line to display Routing Step Line window.

To mark the routing for deletion:
1. Choose Mark for Purge from the Actions menu.

2. The record is marked for deletion.

3. Save your work.

To edit the routing text:
1. Choose Edit Text from the Actions menu.

2. Make the appropriate edits to routing text.

3. Save your work.

To display the Specifications window:
1. Choose Specifications from the Actions menu.

2. Evaluate specifications.

To display the Samples Summary window:
1. Choose Samples from the Actions menu.

2. Evaluate the samples.
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To change the routing status:
1. Choose Change Status from the Actions menu.

2. Change the Current Status displayed by selecting a different Status from the 
Change Status To list.

3. Click OK.

To generate step dependencies:
1. Position the cursor in the routing header.

2. Choose Generate Step Dependencies from the Actions menu.

3. Click OK.

4. Select the dependent Step.

5. Click Routing Step Dependencies.

6. Enter data. See: Entering Routing Step Dependencies, page 5-15.

To duplicate a record:
1. Query the Process Routing Details record to duplicate.

2. Choose New from the File menu.

3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Routing name and Version number.

5. Save your work.

To display the E-Record Details window:
1. Choose E-Record Details from the Actions menu. The E-Record Generic Query 

displays if this option is implemented in your application.

See: Appendix D Oracle E-Records Events in Product Development, page D-1.

To enter processing instructions:
1. Choose Processing Instructions from the Actions menu.

2. Enter information as described in the Oracle Manufacturing Execution System for 
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Process Manufacturing User's Guide.

Displaying the Routing Step Line Summary
The Routing Step Line Summary window enables you to determine the step number, 
operation, step quantity, and unit of measure for the step in a specific routing. Go to the
Routing Step Line window to edit individual lines.

To display the routing step summary:
1. Navigate to the Routing Step Line Summary window.

2. The following fields are display only:

• Step Number displays the unique number for the step.

• Operation displays the name of the operation associated with the Step Number.

• Operation Version displays the version number of the Operation.

• Operation Description displays a description of the Operation.

• Step Quantity displays the quantity of material being processed by this step.

• UOM displays the unit of measure associated with the Step Quantity.

• Minimum Transfer Qty is the minimum amount of material that must be 
produced in a step at a specific production operation and resource before the 
next operation can begin.

• Release Type is Automatic if the step is automatically released or completed 
when subsequent steps are released or completed, or Manual if the step must be
released and completed manually. All steps are completed if the batch is 
completed, regardless of the step release type.

3. Optionally, click Edit Line to display the Routing Step Line window to edit 
individual steps.

Editing Routing Step Lines
Use the Routing Step Line window to edit individual step lines. To edit routing step 
lines:

• Enter and save routings.

• Optionally, enter and save routing classes.
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To edit routing steps:
1. Navigate to the Routing Step Line window.

2. Enter the desired Step Number. This number must be unique.

3. Enter the desired Operation to associate to the step number displayed. Required.

4. Enter the desired Operation Version. Required.

5. The Operation Description displays.

6. Enter the desired Step Quantity. The UOM displays. Required.

7. Minimum Transfer Qty is the minimum amount of material that must be produced 
in a step at a specific production operation and resource before the next operation 
can begin.

8. Select Release Type as Automatic if the step is automatically released or completed 
when subsequent steps are released or completed, or Manual if the step must be 
released and completed manually. All steps are completed if the batch is completed,
regardless of the step release type. Required.

Entering Routing Step Dependencies
Use the Routing Step Dependencies window to create and modify routing step 
interrelationships. Step dependencies are those relationships between routing steps that
establish whether a specific step can or cannot start until another step is completed. 
Routing step dependencies reduce the routing development time by establishing a 
default sequence for operation steps during a production run. Step dependencies are 
implemented at the routing maintenance level to enable automatic step quantity 
calculation in recipes.

You can define new dependencies or delete the unneeded ones. For example, if step 10 
is BAKING and step 20 is the COOLING step, then step 10 must be completed before 
step 20 can begin. By this definition, step 20 is dependent on the completion of step 10. 
Step dependencies are used to calculate planned start times however, they can be 
overridden. Avoid defining circular references, for example Step 10 is less than Step 20 
is less than Step 10.

Understanding Routing Step Dependency Selections

Step Dependencies are definable as:

• Finish-to-start with no offset, to indicate a process step begins immediately after the
completion of its preceding step. For example, a consecutive addition of ingredients
is required without interruption.
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• Finish-to-start with positive offset, to indicate a process step begins a specified 
period of time after the completion of its preceding step. For example, time is 
required to rest material before the addition of another ingredient. 

• Finish-to-start with negative offset, to indicate a process step begins a specified 
period of time before the completion of its preceding step. For example, a 
production device needs to be activated before the addition of the next ingredient.

• Start-to-start with no offset, to indicate a process step begins at the same time as the 
step it depends on. For example, there is a need for simultaneous addition of 
ingredients without interruption.

• Start-to-start with positive offset, to indicate a process step begins a specified time 
after the beginning of its preceding step. This is similar to finish-to-start with 
negative offset, but by specifying that the dependency is start-to-start, you can 
ensure the positive offset is maintained if the previous dependent step finishes 
early.

The offset is defined in the Standard Delay field as a positive or negative number. The 
application uses step dependencies when individual steps are rescheduled.

To enter routing step dependencies:
1. Navigate to the Routing Step Dependencies window.

2. Query the desired routing.

3. The following fields are display only:

• Routing displays the routing to use for setting up step dependencies.

• Routing Version number displays the version of the routing.

• Routing Description displays a brief explanation of the routing.

• Routing Step displays the step number you selected for step dependency setup.

• Operation displays the operation associated with the routing.

• Operation Version displays the version number of the operation.

• Operation Description describes the operation associated with the routing.

Dependencies
4. Enter the Previous Step that the currently selected step is dependent on. The 

dependent step must immediately follow the routing step entered in this field. The 
Operation and Version associated with the routing step displays. Required.
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5. Select Dependency Type as:

• Start-to-start if the dependent step starts at the same time as the step on which 
it is dependent.

• Finish-to-start if the dependent step starts after the previous step ends. For 
example, when step 2 is dependent on step 1 and there is no specified offset, 
step 2 is scheduled to start when Step 1 finishes. If an offset of one hour is 
specified, step 2 is scheduled to start one hour after step 1 ends. You create 
overlapping steps by defining a finish-to-start dependency with a negative 
offset so that step 2 starts before step 1.

Required.

6. Enter Standard Delay as the standard number of hours from the end of the 
preceding step to the start of the current step. You can also enter standard delay as 
the start of the preceding step to the start of the current step, depending on the 
dependency type entered. This field is used to calculate step start times. If you enter
a value equal to zero, then the step following the current step begins immediately 
after the step ends or starts. You can enter a negative standard delay if the 
dependency type is finish-to-start in order to create overlapping steps. Required.

7. Enter Transfer Percent as the percentage of material that goes to the dependent step 
from the yielded quantity of the current step after all products and byproducts are 
yielded. The yielded quantity of the current step is the step quantity * yield %. This 
percentage is used to calculate the quantity of the dependent step if automatic step 
quantity calculations are on. Required.

The sum of transfer percentages from the current step to its dependent step should 
be equal to 100.

For example:

• If 40 percent of the material from the previous step comes into the current batch
step as a result of 60 percent of the material going to another step, then enter 
transfer percent as 40.

• If 90 percent of the material from the previous step comes into the current batch
step as the result of 10 percent being lost to evaporation or being retained by 
processing equipment, then enter the yield percentage as 90 and the transfer 
percent as 100.

Note: When the Routing with the step dependencies is 
included in a recipe, the system validates that the sum of 
transfer percentages from the current step to its dependent step
should be equal to 100. If the sum of transfer percentage is 
more or less than 100, an error message is displayed.
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Displaying Fixed Process Loss
During the production process, there are a number of reasons for losses. For example, 
losses might be attributed to the loss of ingredients or to a lesser yield of products. In 
some cases, the loss is a constant number or quantity irrespective of the quantity of 
product produced or the ingredient consumed. This type of loss cannot be defined as a 
percentage. It is primarily represented as a fixed quantity.

In a typical production process, several ingredients are combined in a mixer. The 
material is transported to the production equipment from the supply tanks through a 
series of pipelines. At the end of the production cycle or before a change over to a 
completely different product, some residual material might remain in the pipeline. This 
residual material must be flushed before the next production process can begin. This 
residual material represents the constant amount irrespective of the amount of material 
that has passed through the pipe.

The fixed process loss amount is dependent on the parameters of the pipelines, such as 
the pipeline diameter, length, and other dimensions. For example, if a mixer is having 
three different pipelines routed to it and material is pumped through these pipelines.

Similarly, there will be a residual loss during cleanup from the mixer to the blender. 
This loss is attributed to the intermediate stage of the production process. Otherwise, 
the loss is attributed to the ingredients proportionately based on the loss at the output 
level.

The following process loss occurs at the different stages of the production process, such 
as:

• Evaporation losses during the process

• Operation losses during the production process

• Residual losses during changeover

Oracle Process Manufacturing (OPM) Product Development enables you to calculate 
the process loss using the following methods:

• Theoretical process loss

• Planned process loss

Both these losses are entered as a percentage and are calculated as variable losses.

Some production processes have a fixed process loss, which will be used as the basis for
calculation of loss for all ingredients.

Displaying Theoretical Process Loss
Theoretical Process Loss can vary depending on the routing or the individual quantity 
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being processed by a routing. This loss is defined at the routing level and is based on a 
minimum and maximum range of quantities.

The Theoretical Process Loss window enables you to enter the hypothetical percent loss 
expected for a range of material processed during a specified routing. For example, if 
you mix a quantity of material up to 100 pounds, then the predicted loss might be 1.50 
percent, or up to 1.5 pounds. However, if you mixed a quantity between 100 and 500 
pounds, then you might predict a loss of 1.75 percent theoretical process loss, or up to 
8.75 pounds lost. The loss could be attributed to equipment, evaporation, or any other 
aspect of the routing that detracts from the delivery of the full quantity of material 
added.

To display process loss:

• Enter and save routings.

• Enter and save routing classes.

• Optionally, enter and save routing step dependencies.

To display process loss:
1. Navigate to the Process Loss window.

2. The following fields are display only:

• Routing Class displays the optional class assigned to the Routing.

• Description displays a brief description of the Routing Class.

• Fixed Process Loss displays the fixed process loss assigned to the routing.

• Fixed Process Loss UOM displays the Routing Class units of measure assigned 
to the routing. You cannot override this value.

Theoretical Process Loss
3. The following fields are display only:

• Min Quantity displays the lower limit for which the displayed Theoretical 
Process Loss percent applies.

• Max Quantity displays the upper limit for which the displayed Theoretical 
Process Loss percent applies.

• UOM displays the unit of measure for the minimum and maximum quantities.

• Process Loss displays the loss of process material for a range between the Min 
Quantity lower limit and Max Quantity upper limit.
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Editing Theoretical Process Loss
Use the Theoretical Process Loss Edit window to edit theoretical process loss.

To edit theoretical process loss:
1. Navigate to the Theoretical Process Loss window.

2. Query the desired routing Class.

3. Enter Min Quantity as the lower limit for the percent theoretical process loss. 
Required.

4. Enter Max Quantity as the upper limit for the percent theoretical process loss. 
Required.

5. Enter the percent Theoretical Process Loss. For example, enter 1.32 for a theoretical 
process loss of 1.32 percent.

6. Save your work.

Understanding the Routing Designer
Use the Routing Designer to define routing step dependencies using a visual network of
operations, steps, and activities. All the functions that the Routing Designer performs 
are accessible using the Process Routing Details window, including the validation of the
process routing owning organization. The Routing Designer provides an alternate, and 
more intuitive option that can reduce routing development time.

Additional Information: Set up instruction sets as described in the 
Oracle Manufacturing Execution System for Process Manufacturing User's 
Guide.

The Routing Designer is one component of the Recipe Designer. It displays routing 
steps in a hierarchical navigator structure. The Routing Designer is used alone or in 
conjunction with the Recipe Designer to provide a view of routing steps in three 
navigator style display formats:

• Interleaved style, which positions operations, activities, and resources in a left-to-
right orientation for each routing with spatial adjustment for each component.

• Organization chart style, which positions operations, activities, and resources in a 
top-to-bottom orientation for each routing with spatial adjustment for each 
component as in an organization chart.
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• Vertical style, which positions operations, activities, and resources in a left-to-right 
orientation for each routing with no spatial adjustment for each component.

Use the drag-and-drop operation vto organize the step network to get a better view of 
the sequence in which steps are run.

Understanding Step Dependency Type Connections

Use the Connect button to connect routing steps to develop a routing step network. The 
shape and color of the line that connects two steps determine the relationship between 
the two steps. Step dependency types are:

• Finish-to-start, represented by a black, single segment, line connection. The line 
originates at the end of an upstream step and points to the start of the downstream 
step. The finish-to-start connection indicates the serial property of the connected 
steps, since one step must complete before the step following it can start.

• Start-to-start, represented by a blue, multisegment connection line. The line 
originates at the start of the upstream step and points to the start of the downstream
step. The start-to-start connection indicates the parallel property of the connected 
steps, since both steps start simultaneously.

The step dependency capability available on the Process Routing Details window 
establishes the sequences in which routing steps occur throughout a production run. By 
establishing step dependency sequences, routing step quantities in the recipe are 
calculated automatically after the material and step associations are defined.

Using the Routing Designer
Use the Routing Designer to view or update a routing depending on the privileges 
assigned to you. It consists of these panes:

• A navigator view of the routing. Display or hide routing descriptions on the 
navigator. Expand components on the navigator by clicking the + sign, or collapse 
components on the navigator by clicking the - sign. Routing components include 
operations arranged in steps, activities, and resources.

• A routing graph view of the routing step dependencies. Each routing displayed in 
the pane is composed of a routing icon, step number, and routing code.

To view routing information in the Routing Designer:

• Enter and save operations.

• Enter and save activities.

To display a routing in the routing designer:
1. Navigate to the Routing Designer.
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2. Find the context Organization.

3. Click the Standard or the Advanced tab.

Standard
4. Enter any of the following to narrow your search:

• Routing is the name of the process routing.

• Version is the version of the process routing.

• Description is a brief description of the process routing.

• Class is the class assigned to the routing.

• Marked for Deletion as Yes to find process routings marked for deletion.

• Valid From is the first date and time the routing is valid.

• Valid To is the last date and time the routing is valid.

• Process Quantity is the planned quantity of material to process by the resource. 
This value combined with the usage defines the usage rate.

• Status is the status of the routing.

Advanced
5. In an advanced search of routings, select any of the following conditions for Items 

entered:

• Equals finds targets equal to the Value entered.

• Greater than finds targets greater than the Value entered.

• Less than finds targets less than the Value entered.

• Greater than or equal to finds targets greater than or equal to the Value entered.

• Less than or equal to finds targets less than or equal to the Value entered.

• Like finds targets similar to the information specified using the wildcard %.

For example, if you specify the Item as Routing, select the Condition Like, and 
enter FORM%, then you find each target Routing that contains entries with the 
letters FORM.

6. Click Find.
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7. Click the desired Routing and Version combination to display in the Routing 
Designer window.

To display the Routing Designer from other windows:
1. Navigate to one of the following windows:

• Routing Summary

• Routing Header Summary

• Process Routing Details

2. Query the appropriate routing.

3. Click Designer.

Identifying Buttons on the Routing Designer:
1. The following steps identify and explain each of tools displayed on the Routing 

Designer tool palette as displayed in the graphic:

1 is the Vertical Style button. Click it to display the vertical navigator style. 
Operations, activities, and resources are positioned in a left-to-right orientation for 
each routing. There is no spatial adjustment for each component.

2. 2 is the Interleaved Style button. Click it to display the interleaved navigator style. 
Operations, activities, and resources are positioned in a left-to-right orientation for 
each routing with spatial adjustment for each component.

3. 3 is the Org-Chart Style button. Click it to display the organization chart navigator 
style. Operations, activities, and resources are positioned in a top-to-bottom 
orientation for each routing with spatial adjustment for each component.

4. 4 is the Show/Hide Description button. Click it to display a description of the 
components shown in the navigator. Click it again to hide the description.

5. 5 is the Save button. Click it to save the changes made on the Routing Designer. 
This option is not available if the Routing Designer is in the view mode.

6. 6 is the Refresh button. Click it to refresh the routing graph pane with data 
retrieved from the database.
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7. 7 is the Exit button. Click it to exit from the Routing Designer workbench.

8. 8 is the Drag Mode button. Click it to move steps around the graph pane using the 
drag-and-drop operation. This option is not available if the Routing Designer is in 
view mode.

9. 9 is the Connect Mode button. Click it to build dependencies between steps using 
the drag-and-drop operation. This option is not available if the Routing Designer is 
in view mode.

10. 10 is the Help button. Click it to display online help for the current window.

To show or hide a routing description using the View menu:
1. Choose Show Description from the View menu to display routing information.

2. Choose Show Description from the View menu again to hide routing information.

To create a new dependency connecting two routing steps:
1. Click Connect to begin building dependencies between two steps. This option is not

available if the Routing Designer is in view mode.

2. Click the source or starting step in the routing graph pane.

3. Drag the dependency line to the target step, and drop it.

4. Override the default step dependency attributes by reentering them on the Routing 
Step Dependency Properties window.

5. Click OK. The application checks the desired connection:

• If a circular reference is detected, then the application displays:

A Circular reference has been detected.

The step dependency is not created.

• If a step dependency already exists, then the application displays:

Step dependency already exists.

The step dependency is not created.

6. Save your work.

To remove a step dependency between two routing steps:
1. Right-click the line connecting two routing steps.
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2. Choose Delete. The line connecting the two routing steps is removed.

3. Save your work.

Actions Menu Options
Use options from the Actions menu for the following:

Mark For Purge
Use this option to delete the current routing. This is available if the routing is not 
already marked for deletion.

Generate Step Dependencies
Use this option to generate sequential step dependencies. Specify the type of 
dependency and distribute steps through the Generate Step Dependencies window. 
Enter data as described in the "Entering Routing Step Dependencies" topic.

Distribute Steps
When opening a routing created in the Routing Details window, the steps display on 
top of one another in the upper left corner of the graph. Use this option to distribute 
steps and make them visible in the routing step dependency graph.

When selecting Distribute Steps, the following menu options are available:

• Left To Right: Images representing steps in the graph are drawn to create an equal 
distance between them. Steps are positioned from the left to the right and there is a 
maximum of three steps per line.

• Top To Bottom: Steps are positioned from the top to bottom. There is a maximum of
seven steps per column.

Edit Text
Use this option to display the Edit Process Instruction Step window.

Important:  If Oracle Manufacturing Execution System for Process 
Manufacturing is installed, then use the Process Instructions menu 
option.

Properties
Use this option to display the properties of a routing, routing step, activity, or resource 
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after selecting it.

QC Specification
Use this option to access the Specifications window. Refer to the Oracle Process 
Manufacturing Quality Management User's Guide for additional information.

Change Status
Use this option to change the status of the selected routing. If changes are made to the 
routing, then the application prompts you to save the changes.

E-record Details
Use this option to display the E-Record Generic Query window if it is implemented in 
your application.

Process Instructions
Use this option to create and maintain processing instructions for a specific step using 
the default Edit Text functionality.

If the Oracle Manufacturing Execution System for Process Manufacturing application is 
enabled, then create instructions as described in the Oracle Manufacturing Execution 
System for Process Manufacturing User's Guide.

Preferences
Use this option to define user preferences using the Routing Designer Profiles or 
Preferences windows. 

Using the Routing Properties Window
The Routing Properties window displays information about the routing, including its 
status, version, description, and its valid dates of use. The planned loss and routing 
quantity display. Use this window to:

• Edit routing header properties

• Create new routings

• Load an existing routing

To display the Routing Properties window:
1. There are two methods to display the Routing Properties window:
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• In the navigator, right-click the routing to display the menu, then choose 
Properties.

• In the navigator, click the routing, then choose Properties from the Actions 
menu.

2. The following fields are display only:

• Status displays the current status of the Routing.

• Routing displays the name of the routing.

• Version displays the version number of the routing.

• Class displays the class assigned to the routing.

• Description displays a brief description of the routing.

• Valid From displays the first date and time that the routing is valid.

• Valid To displays the last date and time the routing is valid.

• Quantity displays the quantity of material associated to the routing with its 
UOM. 

• Planned Loss displays the planned loss. It defaults to the theoretical process 
loss unless otherwise specified.

• Theoretical Process Loss displays the theoretical process loss for the routing.

• Owner displays the initiator of the routing.

• Owner Organization displays the plant, laboratory, or other facility responsible 
for initiating the routing.

• Enforce Step Dependency indicates whether the routing enforces step 
dependencies.

• Contiguous Indicator is selected when the routing must be run in one 
uninterrupted block of time. The batch that uses this routing cannot stop and 
start, even if it runs into downtime on the shop calendar.

Using the Step Properties Window
Use the Step Properties window to view a summary of a step and its dependencies, and 
edit step information. Use the Step Summary tab to view the main attributes of a 
specific step. The Step Dependencies tab displays upstream and downstream steps and 
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their individual attributes.

To display the Step Properties window:
1. There are three methods to display the Step Properties window:

• In the navigator, right-click the routing step, then choose Properties.

• In the navigator, click the routing step, then choose Properties from the View 
menu.

• In the routing graph pane, double-click the routing step.

Step Summary
2. The Step Properties window displays the following fields:

• Step displays the number of the selected routing step.

• Operation displays the operation code for the selected routing step.

• Version displays the version of the operation for the selected routing step.

• Description displays a description of the operation for the selected routing step.

• Status displays the status of the operation.

• Valid From displays the status start date.

• Valid To displays the status end date. If this field is blank, then there is no 
assigned end date.

• Quantity displays the quantity of the selected routing step in the routing and its
UOM.

• Release Type of the step defaults to Manual. Possible values are Manual or 
Automatic

Step Dependencies
3. Select one of the following from the list:

• Incoming Steps to display incoming dependencies of routing steps that are 
upstream to the currently selected routing step.

• Outgoing Steps to display outgoing dependencies of routing steps that are 
downstream to the currently selected routing step.

4. The following fields are display only and depend on the selection you make in step 
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3:

• Step displays the routing step number of the upstream or downstream routing 
step.

• Operation displays the operation code of the upstream or downstream routing 
step.

• Version displays the operation version of the upstream or downstream routing 
step.

• Description displays a description of the operation.

• Status displays the status assigned to the operation.

• Quantity displays the quantity of the upstream or downstream routing step and
its UOM.

• Transfer % displays one of the following:

• If Incoming Steps is selected, then it is the percentage of the routing step 
quantity that transfers from the routing step displayed in the list to the 
selected routing step.

• If Outgoing Steps is selected, then it is the percentage of the routing step 
quantity that transfers from the selected routing step to the routing step 
displayed in the list.

• Transfer Quantity displays one of the following:

• If Incoming Steps is selected, then it is the routing step quantity that 
transfers from the routing step displayed in the list to the selected routing 
step.

• If Outgoing Steps is selected, then it is the routing step quantity that 
transfers from the selected routing step to the routing step displayed in the 
list.

Generating Step Dependencies
Use this option from the Actions menu to generate sequential step dependencies. Enter 
data as you would to enter routing step dependencies.

See: Entering Routing Step Dependencies, page 5-15.
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Using the Activity Properties Window
The Activity Properties window displays the properties of the selected activity 
including a brief description, the activity factor, and the optional offset interval.

To display the Activity Properties window:
1. There are two methods to display the Activity Properties window:

• In the navigator, right-click the activity, then choose Properties.

• In the navigator, click the activity, then choose Properties from the View menu.

2. The following fields are display only:

• Activity displays the activity code.

• Description displays a description of the activity.

• Factor displays the activity factor.

• Offset Interval displays the activity offset interval.

Using the Resource Properties Window
The Resource Properties window has two tabs:

• Resource Summary displays the main attributes of a specific resource.

• Process Parameters displays the process parameters defined for the selected 
resource.

To display the Resource Properties window:
1. There are two methods to display the Resource Properties window:

• In the navigator, right-click the resource, then choose Properties.

• In the navigator, click the resource, then choose Properties from the View 
menu.

Resource Properties
2. The following fields are display only:

• Resource displays the resource code.
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• Description displays a description of the resource.

• Quantity displays the resource quantity and its UOM.

• Usage displays the resource usage and its UOM.

• Class displays the resource class.

• Description displays the resource class description.

• Plan Type displays:

• Auxiliary for a resource that works with the primary resource to perform 
an activity.

• Primary for a rate determining resource that limits or determines 
throughput. It is also referred to as the bottleneck or critical resource.

• Secondary for a resource that replaces the primary resource when it is not 
available. This resource performs the same task as the primary resource, 
but can have a different usage.

• Count displays the number of resource instances used.

• Offset displays the value entered for Standard Delay.

• Scale Type displays the scale type used.

Process Parameters
3. The following fields are display only:

• Process Parameter is the process parameter name and its Description. For 
example, BATHTEMP Bath Temperature.

• Target indicates the target value for the process parameter.

• Minimum is the lowest acceptable value for a numeric range type of process 
parameter.

• Maximum is the highest acceptable value for a numeric range type of process 
parameter.

• Units is the unit of expression for the process parameter minimum and 
maximum values. For example, DEGF for degrees Fahrenheit.



5-32    Oracle Process Manufacturing Product Development User's Guide

Using the Step Dependency Properties Window
The Step Dependency Properties window displays the source and destination step 
dependency properties. It also displays the dependency type, standard delay, transfer 
percent, and transfer quantity. Step Dependency properties include a dependency type 
and an offset defined by the value entered for Standard Delay. The offset is defined in 
the Standard Delay field as a positive or negative number. The application uses step 
dependencies when individual steps are rescheduled. Dependency type and standard 
delay offsets are: 

• Finish-to-start with no offset, to indicate a process step begins immediately after the
completion of its preceding step. For example, a consecutive addition of ingredients
is required without interruption.

• Finish-to-start with positive offset, to indicate a process step begins a specified 
period of time after the completion of its preceding step. For example, time is 
required to rest material before the addition of another ingredient. 

• Finish-to-start with negative offset, to indicate a process step begins a specified 
period of time before the completion of its preceding step. For example, activate a 
production device before the addition of the next ingredient.

• Start-to-start with no offset, to indicate a process step begins at the same time as the 
step it depends on. For example, there is a need for simultaneous addition of 
ingredients without interruption.

• Start-to-start with positive offset, to indicate a process step begins a specified time 
after the beginning of its preceding step. This is similar to finish-to-start with 
negative offset, but by specifying that the dependency is start-to-start, you can 
ensure the positive offset is maintained if the previous dependent step finishes 
early.

Operation Charge Step Dependencies

The application calculates how much material to process by each step, taking into 
account the step dependencies, and the input and output of material associated with the
individual step. This information is used to calculate the number of charges required to 
satisfy the demand based on the maximum capacity of the selected process element. 
The process element can be a resource, an activity, or the step itself.

When you change the planned quantity of a material, the application recalculates all 
dependent quantities in the recipe. You can indicate whether step quantities are 
manually maintained or automatically calculated at the routing level. The prerequisites 
of the step quantity calculation are the creation of step dependencies and the association
of material to each appropriate step. Apply the defined dependency to each charge to 
enhance the scheduling of charges. The principle is to apply the dependency to the first 
charge. If the run rate of the downstream process is not equivalent, then the 
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dependency is applied to the first and last charge. This functionality applies to users of 
the Oracle Advanced Supply Chain Planning application.

For example, step 10 yields a charge in 100 pound increments. Step 20 consumes that 
material by charge in the same increment. The yield at the end of the charge determines 
the timing for the material. Define a finish-to-start relationship and select the 
Chargeable indicator. Step 20 starts its first charge at the end of the first charge for step 
10.

To display the Step Dependency Properties window:
1. There are three methods to display the Step Dependency Properties window:

• In the right pane, click the starting routing step and hold down the left mouse 
button as you draw a connection line to the target routing step. Release the left 
mouse button. This prompts you to validate or override the default values 
displayed for the routing step dependency attributes.

• In the right pane, double-click the line connecting two routing steps.

• In the right pane, right-click the line connecting two routing steps, then choose 
Properties.

Source
2. The following fields are display only:

• Step displays the routing step number of the source routing.

• Operation displays the operation code of the source operation.

• Version displays the version of the source operation.

• Description displays a description of the source operation.

• Quantity displays the source routing step quantity and its unit of measure.

Destination
3. The following fields are display only:

• Step displays the routing step number of the destination operation.

• Operation displays the operation code of the destination operation.

• Version displays the version of the destination operation.

• Description displays a description of the destination operation.
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• Quantity displays the destination routing step quantity and its unit of measure.

Dependency Type
4. Select one of the following:

• Finish-to-start for operations that begin immediately after the completion of the
previous routing step, or with a specified standard delay. This is the default 
that you can override.

• Start-to-start for operations that begin at the same time, or with a specified 
standard delay.

5. Standard Delay displays the positive or negative time offset between routing steps. 
It is the number of hours from the end of the source routing step to the start of the 
destination routing step. The default is zero.

6. Transfer % displays the default percentage of material that goes to the dependent 
routing step after all products and byproducts are yielded. This percentage is used 
to calculate the quantity of the dependent routing step if automatic routing step 
quantity calculations are on.

7. Transfer Quantity displays the quantity transferred from the source routing step to 
the destination routing step and its UOM. It is calculated as:

Transfer Quantity = Routing Step Quantity * Transfer %

To display a full description of a routing step:
1. Position the cursor over a routing step in the graph to display a full description of 

the routing step.

To display the transfer percentage of a routing step:
1. Position the cursor over a routing step dependency line to display the transfer 

percentage of material.

Accessing Quality Control Windows
Use the Actions menu to access the Specifications window. See: Oracle Process 
Manufacturing Quality Management User's Guide for more information on specifications.

1. Select Routing in the navigator pane.

2. Choose QC Specifications from the Actions menu.
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Adding Operation Steps
The operation list is the source for adding operations to the routing. This list is not 
available if the routing is in view mode. When adding a step to the routing, the 
application validates the operation and displays the Operation Step Properties window.

To add a new operation step:
1. Click Show/Hide Operation Master if the operation list does not display below the 

navigator.

2. Select an operation from the list and associate it to the routing in the navigator or in 
the Routing Dependency Graph pane.

3. Save your work.

Removing Operation Steps
When removing an operation step, all incoming and outgoing dependencies are also 
removed. Changes are displayed in the Routing Graph pane and in the Process 
Instruction Sheet pane simultaneously.

To remove a step in the routing:
1. Use one of these methods to remove a step in the routing:

• Select the step in the navigator, and choose Cut from the Edit menu.

• Select the step in the Routing Dependency graph pane, and choose Delete from 
the right-click menu.

2. Save your work.

Editing User Preferences
The Preferences window contains the following tabs:

• Routing tab to customize the behavior of the application when adding a new step to
a routing and creating a dependency between two steps.

• Step Dependency Graph tab to customize the routing step dependency graph.

• Process Instructions tab to specify the language for displaying and maintaining 
process instructions.



5-36    Oracle Process Manufacturing Product Development User's Guide

To edit preferences:
1. Select Preferences from the Actions menu.

2. Click each tab to enter user preference details.

3. Click OK to save.
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6
Recipes

This chapter describes how to define and maintain recipes. It shows you how to find 
recipes and display summaries of recipes and recipe headers. Procedures of how to 
enter recipe details, recipe organization details, and edit validity rules are explained to 
demonstrate the process flows for recipe development. Also discussed are processes to 
display and interpret recipe validity rules, recipe step and material association.

This chapter covers the following topics:

• Requirements

• Understanding Recipes

• Defining and Maintaining Recipes

• Finding a Recipe

• Displaying the Recipes Summary

• Displaying the Recipe Header Summary

• Understanding Step Quantity Calculations

• Entering Recipe Details

• Using the View Menu to Find a Recipe

• Entering Recipe Organization Details

• Using the Find Recipe Organization Details Window

• Displaying Recipe Organization Details-Process Parameters

• Entering Multi-Record Recipe Validity Rules

• Editing Recipe Validity Rules

• Displaying Validity Rules By Product

• Displaying Validity Rules By Recipe

• Generating a Recipe and Validity Rule Automatically

• Displaying the Recipe Step/Material Association
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• Defining Descriptive Flex Fields for Step Materials

• Understanding the Recipe Designer

• Using the Recipe Designer

• Using the Recipe Tab

• Using the Recipe Properties Window

• Finding a Recipe in the Recipe Designer

• Creating a Recipe in the Recipe Designer

• Copying a Recipe and Its Components

• Using the Formula Tab

• Using Formula Menu Options

• Creating a Formula in the Recipe Designer

• Changing Formula Status

• Editing the Formula Header

• Editing Formulas in the Recipe Designer

• Using the Routing Tab

• Using the Process Instruction Sheet

• Expanding and Collapsing Nodes

• Editing User Preferences

Requirements

Does the application support effectivities already developed for in-house formulas?
Yes. Migrate Effectivities to Recipe Validity Rules with special scripts provided by 
Oracle.

Migrate Effectivities with Scripts

Oracle provides a customized series of scripts that migrate existing formula information
into the Product Development application.

Is there one place in the application that shows exactly how to make a product?
Yes. Use the Recipe Details window. After evaluating the information on the Recipe 
Details window, display Organization Details, Validity Rules, and the Recipe Step and 
Material Association needed to determine exactly how to make a product.

Use the Recipe Details Window to Determine All Product Manufacturing 
Requirements
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The Recipe Details window displays all product manufacturing requirements. In each 
step of building a new product, components are created that appear on the Recipe 
Details or the Organization Details windows.

Does a Product Development recipe support Cost Management and Production 
Execution requirements?

Yes. By linking input and output of materials to individual operation steps and 
providing an automatic step quantity and charge calculation, the application supports 
the requirements for accurate cost rollup and flexible production execution.

Use Recipes as the Foundation for Cost Management and Production Execution

Where routings are used to specify process related requirements such as equipment, 
labor, and energy, the recipe defines the input and output of each operation step. This is
achieved by linking formula materials and quantities to appropriate routing steps, and 
is a prerequisite to enabling automatic step calculation.

Can an item be made differently depending on the manufacturing plant or the time of 
year?

Yes. Recipes enable rule-based execution. By applying this approach to formula 
selection, plant-specific and seasonal formulations are possible. Item substitution can 
also be used to time seasonal replacements of selected items in the recipe.

Enhance Product Consistency with Rule-Based Execution

If not managed appropriately, manufacturing variability can lead to product 
inconsistency and complexity. Rule-Based Execution enhances product consistency and 
manufacturing simplicity by letting planners, quality control specialists, and cost 
accountants specify the conditions under that recipe components must be applied. 
When a recipe is needed for production, planning, or costing purposes, the application 
selects the appropriate version to support the activity. This capability improves 
consistency by applying rule-based logic to formula selection for use in specific 
environments and under specific conditions based on status.

Product Development uses Validity Rules that are based on several key factors 
including date, production site, plant, customer, and required quantities. Some recipes 
are seasonal and based on ingredient availability. Other recipes are determined by 
whether they are small, medium, or large production runs. Different plants can use 
different versions of a target recipe, so the choice of recipe depends on the plant that is 
producing the batch. By using validity rules an organization can set the standard 
quantity and effective dates of a recipe to specify what, where, when, and how 
formulas, recipes, routings, and operations must be applied.

With rule-based execution, production gains a tighter control over the business and is 
able to select an optimized recipe. When several recipes have overlapping validity 
dates, business logic selects the optimum valid recipe.
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Note: See: Managing Item Substitutions in Formulas, page 7-9 for 
additional information on using this feature to control seasonal 
replacements of selected items in the recipe.

Does the application support SP88 terms for batch manufacturing?
Yes. The application offers enhanced standards for master recipe definition.

Offer Enhanced Industry Standards for Recipe Definition

The concept of effective date is refined into a recipe structure that complies with 
industry standards for recipe definition. A master recipe combines a formula and a 
routing at a global level to streamline the overall approval process. The master recipe 
serves as the basis for subsequent planning, manufacturing, and costing calculations.

Can you enable version control at the Recipe attributes level?
Yes. The Recipe user interface supports version control for attributes, provided you 
create version control attribute sets at the Recipe entity level to include attributes you 
could like to modify and drive version control and assign them to the organization.

Support for Version Controlled Attributes for Recipe

Use the Version Control Attributes user interface provided under Product Development
Security Manager to create version control attribute sets at the Recipe entity level. Select
and enable attributes you would like to modify and enable version control for at the 
Recipe level. Ensure you assign the version control attribute set to the organization 
using the Assign Version Control Set page or the Product Development Parameters 
window. This will enable you to modify attributes for an existing recipe and create new 
versions of the recipe. See: Setting Up Version Control Attribute Sets, page 2-39.

Understanding Recipes
Recipes standardize the structure of all information that describes production of one or 
more products. Recipes have:

• Formulas that define the relationship of material resources, including products, 
ingredients, and byproducts.

• Routings that define the relationships of nonmaterial resources, including labor and
equipment operations with activities and their associated resource. Routings are 
optional.

• Processing instructions that encompass the work instructions needed to produce 
the products.

To provide the greatest flexibility to process manufacturers, formulas and routings are 
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built independently. They are linked using a Recipe that has validity rules. Different 
formulas can use the same routing, or one formula can be associated to several different
routings.

Recipes are depicted hierarchically in the following diagram that shows the:

• Routing composed of a series of Operations organized in Steps.

• Operations composed of Activities containing Resources.

• Formula composed of Ingredient, Product, and possibly Byproduct.

• Recipe linking the Routing and Formula together with Processing Instructions.

Additional Information: If the Oracle Manufacturing Execution 
System for Process Manufacturing application is installed, then set 
up instruction sets. Refer to the Oracle Manufacturing Execution 
System for Process Manufacturing User's Guide for detailed 
information on enhanced processing instructions.

Defining and Maintaining Recipes
Recipes standardize the structure of all information that describes production of one or 
more products. Recipes contain the minimum set of information that uniquely defines 
the manufacturing requirements for a specific products. To provide the greatest 
flexibility to process manufacturers, formulas and routings are built independently. 
They are linked using a recipe and its validity rules.

Compliance with S88.01 Standard for Recipe Management
Recipes are compliant with the S88.01 standard for Recipe Management. Control recipes
at a global level to maintain a corporate standard, and allow different sites or plants 
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within your organizational hierarchy to maintain their own version of the recipe to 
meet their local requirements. A recipe can be created in one inventory organization 
and then copied, modified and maintained by another inventory organization.

Creating a New Recipe
Create and define new recipes on the Recipe Details window. Recipe access is based on 
your access to the recipe owning organization. To create a new recipe, specify product 
code and quantity, or formula number and version. If you enter product code and 
quantity, then you get a list of all valid or effective formulas. Select the one you want to 
use to create the recipe. You can also specify a routing in the recipe. You can override 
routing attributes such as capacity, activity factor, charges, and resource usage for each 
recipe defined. If a recipe is set up for automatic step quantity calculation, then ensure 
that formula material is properly associated to each appropriate routing step. Display 
the following windows from the Recipe Details window:

• Recipe Organization Details

• Recipe Validity Rules

• Recipe Step/Material Association

Maintaining Recipes
Use the following windows to maintain recipes:

• Recipes Summary By to display a list of defined recipes with their individual 
version numbers and descriptions. These can be viewed by Status or Owner. 
Display the Recipe Details window from the Recipes Summary By window.

• Recipe Header Summary to display important descriptive information regarding a 
particular recipe. Display the following windows from the Recipe Header Summary
window:

• Recipe Validity Rules

• Recipe Details

• Recipe Organization Details to display and, if necessary, override information 
defined for specific operations and routings at the Organization level. Display the 
Recipe Validity Rules window from the Recipe Organization Details window.

• Recipe Validity Rules is a multi-record window to enter or edit a complete list of 
Validity Rules for Organizations you can access.

• Recipe Validity Rules lets you edit validity rules for a specific recipe.
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• Recipe Step/Material Association to display all items from the recipe's formula and 
associate them with specific routing steps.

The following graphic depicts the previously described recipe navigation flow:

Creating Version Control Attribute Sets for Recipe
You can set up version control at the Recipe attribute level. You can create a version 
control attribute set for Recipe and assign it to the organization. This ensures that when 
modifying attributes in the Recipe Details window that are included in the attribute set, 
you will be able to create a new version of the recipe with the same entity names but 
with a different version number. Should you not want to create a new version, you can 
select to cancel and continue with the existing recipe.

To set up version controlling attribute sets at the Recipe entity level, see: Setting Up 
Version Control Attribute Sets, page 2-39.

Finding a Recipe
Use the Find Recipes window to find a specific recipe you have entered and saved. At 
least one search parameter needs to be entered.

To find a recipe:
1. Navigate to the Find Recipes window.

2. Enter as many parameters as needed to complete the search:

• Enter search parameters in the Standard region for Recipe, Description, 
Formula, Routing, or Product with appropriate Version for recipe, formula, or 
routing. You can also enter Organization, Status, and Recipe Use.

• Enter search parameters in the Advanced region for a specific Item, Condition, 
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or Value.

3. Click Find.

Displaying the Recipes Summary
The Recipes Summary window displays a list of all defined recipes with their 
individual version numbers and descriptions. Display these by Status or Owner. 
Multilingual support is provided for the Recipe Description.

To display a list of all defined recipes:
1. Navigate to the Recipes Summary By window.

2. The following fields are display only:

• Recipe is the recipe code.

• Version is the version of the recipe.

• Description is a brief explanation of the recipe.

• Status is the current status for the recipe.

• Product is the code for the primary product produced by the recipe.

• Revision is the revision of the primary product produced by the recipe.

• Owner Organization is the default organization for the owner of the recipe.

3. The following fields display for each selected recipe:

• Formula is the formula for the currently selected recipe.

• Formula Version is the version of the formula for the currently selected recipe.

• Routing is the routing for the currently selected recipe.

• Routing Version displays the version of the routing for the currently selected 
recipe.

4. Optionally, click Details to display the Recipe Details window.

Displaying the Recipe Header Summary
Use the Recipe Header Summary window to display important descriptive information 
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regarding a particular recipe.

To display recipe header information:
1. Navigate to the Recipe Header Summary window.

Summary
2. The following fields are display only:

• Status is the current status of the recipe.

• Recipe is the name of the recipe.

• Version is the version of the recipe.

• Description is a brief explanation of the recipe.

• Recipe Type indicates if the recipe is a Site, General, or Master Recipe.

See: Setting Up Parameters, page 2-3.

• Formula is the formula number used in the recipe.

• Version is the version of the formula with its Description.

• Main Product is the end item in the formula with its Revision.

• Total Output Qty is the total output of material in the formula UOM.

• Routing is the routing number.

• Version is the routing version with its Description.

• Contiguous indicates that the routing associated to this recipe must be run in 
one contiguous block of time. The batch that uses this routing cannot stop and 
start, even if it runs into downtime on the shop calendar.

• Enhanced Process Instructions indicates that process instructions used in this 
recipe are created and managed in the Oracle Manufacturing Execution System 
for Process Manufacturing application. See: Oracle Manufacturing Execution 
System for Process Manufacturing User's Guide for additional information.

3. Click Products to display the Formula Product Summary window.

4. Click Details to display the Recipe Details window.

5. Click Designer to display the Recipe Designer.
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Validity Rules
6. The following fields are display only:

• Organization displays the plant or laboratory organization code.

• Product displays the formula product of the formula and its Revision.

• Recipe Use displays if the recipe is used in Production, Planning, Costing, or 
Technical class and subclass determination.

• Status displays the status of the validity rules listed.

7. Click Details to display the Recipe Validity Rules window.

Customers
8. The following fields are display only:

• Customer displays the customer number.

• Name displays the customer name.

Understanding Step Quantity Calculations
The quantity of material required in a specific step is dependent on the weight of 
material that passes into and out of that step. Input material consists of ingredients that 
are injected directly into steps or material that is transferred from preceding steps.

If you use automatic step quantity calculations, then the step quantities are calculated 
from the quantities of the items in the formula, after you tie the routing and formula 
together in a recipe, and specify the item-step associations and routing step 
dependencies. Step quantities are calculated from the quantity of ingredients being 
added to each step, and the quantity that comes from previous steps based on step 
dependencies. This is where the transfer percent affects as it is used to specify how 
much of the quantity yielded from a step flows on to a subsequent step, after 
subtracting out any product or byproduct yielded by the step.

If you are not using automatic step quantity calculation, then you enter step quantities. 
The total output quantity is compared to the routing quantity to determine a scale 
factor. The scale factor is applied to the routing step quantities to scale them up or 
down for the step quantities in the recipe.

The following example shows how material can be input, transferred, and output from 
a series of production steps.

Step 1: Add 50 pounds of Ingredient 1 to 50 pounds of Ingredient 2. The step quantity 
at step1 is 100 pounds. Planned yield is 95%. So the total output is resulted as 95% of 
100 pounds, 95 pounds. 
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The total output is comprised of 5 pounds of Byproduct 1 and 90 pounds of 
Intermediate 1. The Transfer of Intermediate 1 is as follows:

• 25% or 22.5 pounds to Product 1

• 35% or 31.5 pounds to Step 2 

• 40% or 36 pounds to Step 3

Step 2: The Step quantity is 31.5 pounds. The planned yield is 90%. So the output is 
resulted as 90% of 31.5 pounds as 28.35 pounds. Transfer of 28.35 pounds of 
Intermediate 2 is as follows:

• 25% or 7.0875 pounds to Step 3

• 75% or 21.2625 pounds to Product 1

Step 3: Add 20 pounds of Ingredient 3 to the mixture of Intermediate 1(36 pounds) and 
Intermediate 2 (7.0875 pounds). This makes the step quantity as 63.0875 pounds. 
Planned yield is 100%. So the output is resulted as 100% of 63.0875 as 63.0875 pounds.

The output consists of 3 pounds of by product2 and 60.0875 pounds of Intermediate 3.

The final yield of Product 1 consists of:

• 22.5 pounds from Step 1

• 21.2625 pounds from Step 2

• 60.0875 pounds from Step 3

Total Product 1 produced is 103.85 pounds.

Total Byproduct produced is 8 pounds, and is comprised of:

• 5 pounds of Byproduct 1

• 3 pounds of Byproduct 2

In this example, yield is the ratio of the total output to the total input which is 111.85
/120 which is 93.21%

The following depicts the previously described example. LB is equal to pounds.
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Entering Recipe Details
Use the Recipe Details window to enter the details for a specific recipe. A Plant or a 
Laboratory can be associated with all the materials and resources required to make a 
product at the recipe level. One or more customers can be associated to the recipe for 
informational purposes.

You can also create a version control attribute set at the Recipe entity level and assign it 
to the organization. This will enable you to modify the selected recipe attributes 
included in the set and create new versions of the recipe. See: Setting Up Version 
Control Attribute Sets, page 2-39.

Step Quantity Calculations

When you select the Calculate Step Qty indicator on the Recipe Details window, the 
application checks to determine if there are proper step quantity material associations. 
You must use a routing. Step and material associations must be made. If any of these 
associations are defective, then you receive an error message. When you use the 
Automatic Step Quantity Calculation, it checks quantities in each step to verify that 
material is available to pass into and out of each step. The quantity of material for a 
particular step is dependent on the quantity of material that passes into or out of it. The 
input material can be either the ingredient that is injected directly into the step, or it can 
be the output of preceding steps. Output is represented typically by coproducts or 
byproducts.
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To enter recipe details:
1. Navigate to the Recipe Details window.

2. Enter the code for the Recipe to be entered. Required.

3. Enter a Version of the recipe. Required.

4. Enter a Description for the recipe. Required.

5. Return to this window to change status by selecting Change Status from the Actions
menu after entering all relevant information and saving the recipe with the default 
Status of New. Depending on whether workflow is enabled, a different set of 
statuses is available. See: Appendix C Product Development Status Codes, page C-
1.

6. Enter the main Product for the formula associated with this recipe. If you enter a 
new recipe, then enter the formula to fill this field automatically.

7. The output Quantity displays the sum of the product quantities entered in the 
formula. UOM is the unit of measure for the formula associated with this recipe.

8. Enter the Formula number for the recipe. The formula Version displays. Required.

Note: This field cannot be edited after you save this recipe. You 
cannot use an inactive formula in a recipe.

9. Creation Organization displays the default context organization code.

10. Enter a Routing number for the recipe. A routing can be added to an existing recipe.
The Version for the routing entered displays.

11. Enter the Owner Organization. This field is the default organization for the owner 
of the recipe. In order for you to enter or edit information for the recipe, you must 
have an association with this organization and permission to access and change this
field. Required.

12. Enter the Owner of the recipe. The owner name must be a valid user name. This 
field defaults to the current user. Required.

Note: Enter all information on this window before you select the 
Calculate Step Qty indicator.

13. Theoretical Process Loss displays the hypothetical loss of process material 
associated to a routing as a percentage. If a routing is not associated to a recipe, or if
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a routing class is not associated to a given routing, and process loss is not defined 
for that routing, this field is blank.

14. Enter Recipe Type as:

• Master to indicate that the default recipe type is process cell specific. Master 
recipes define exactly how a product is made in a specific process 
manufacturing cell.

• Site to indicate that the default recipe type is at the site level. There is one site 
recipe for each place that makes the product, or some portion of it. A site recipe 
has the same structure as a general recipe, but can be modified for the local 
language and unit of measure. It can be modified to account for local material 
availability. It can also define a part of the general recipe that is actually 
performed on the site.

• General to indicate that the default recipe type is one general recipe for each 
specific product variation made by a company. It defines, in an equipment 
independent manner, the material and process dependencies required to make 
a product. The general recipe is usually created during or after the pilot plant 
scaleup of a research and development recipe.

15. Select Contiguous if routings in this recipe must be run in one contiguous block of 
time. The batch that uses this routing cannot stop and start, even if it runs into 
downtime on the shop calendar.

16. Select Enhanced Process Instructions to indicate that process instructions used in 
this recipe are created and managed in the Oracle Manufacturing Execution System 
for Process Manufacturing application. Refer to the Oracle Manufacturing Execution 
System for Process Manufacturing User's Guide for additional information.

17. Enter the Planned Process Loss as the loss of process material observed during 
production of a batch using the recipe. If a value is not entered in this field, then it 
defaults to the value entered for Theoretical Process Loss.

18. Enter the Fixed Process Loss. The fixed process loss field is defaulted to the routing 
fixed process loss in case a routing is assigned to the recipe. Optional

19. The Fixed Process Loss UOM displays. The fixed process loss UOM is defaulted to 
the Routing Class UOM. You cannot override the UOM value.

20. Total Output Qty displays with its UOM.

21. Select the Calculate Step Qty indicator to let the application calculate step quantities
automatically. Quantities are based on the amount of materials that go into and out 
of each supported step. Fields related to step quantities cannot be entered after you 
select the indicator. Associate all items that contribute to step quantity to specific 
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steps on the Recipe Step/Material Association window.

22. The Yield% field displays the yield calculated as the ratio of the total output to the 
total input.

Plant/Laboratory
23. The following fields are display only:

• Organization displays the Organization code that the process loss is being 
defined for. This must be a plant or a laboratory. Required.

• Organization Name displays a description of the plant or laboratory.

• Type indicates whether this is a plant or a laboratory.

• Process Loss displays the material that is lost through the process. This field is 
blank if you did not enter a routing. You can override the default process loss.

• Contiguous is selected if routings in this recipe must be run in one contiguous 
block of time.

Customer
24. Enter the Customer number. Required.

25. Name indicates the name of the customer associated with the customer number 
entered.

26. Operating Unit is the parent organization associated to the customer entered.

27. Ship To Locator is the customer postal address.

Step Quantity

Note: If a routing was not entered, then this region is not available. If 
you calculate step quantities in the Automatic Step Quantity 
Calculation, then Step Material Associations are entered.

28. Step indicates the step number associated with the listed operation in the displayed 
routing. Steps cannot be added or deleted here. However, if a step is deleted in the 
base routing used for this recipe, and the Step field is overwritten, then choose 
Delete from the Edit menu to delete the orphaned Step. Charges are calculated for 
each step displayed.

29. Operation displays the operation associated with the step. The operation Version 
and Description display.
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30. Step Quantity indicates the default quantity of material associated with the step. 
The UOM for the step quantity displays. You can enter a new value in the step 
quantity field if you do not use the Automatic Step Quantity Calculation. If 
Automatic Step Quantity Calculation is used, then this field is not enterable. 
Required if the Step is associated to a material, and you are not using Automatic 
Step Quantity Calculation

31. Enter planned yield percentage for the operation. The yield percentage should be 
the ratio of planned output to the planned input of the step. Planned output is 
calculated after removing the process losses and any by-products which are not of 
type yield. Planned output should be the expected yield from the operation and it 
should not include the byproducts of type, waste, sample or rework. See the topic 
Understanding Step Quantity Calculations, page 6-10, for detailed information 
about step quantities calculation based on planned yield percentage.

32. Charges displays the total calculated charges for the step. Charges are the number 
of times the operation must be performed to complete the step for the specified step
quantity. For example, a mixer that holds 50 kilograms (kg) requires two charges to 
process 100 kg of material. Charges are calculated from the smallest minimum 
capacity for all resources in the step. Calculation of charges is based on the 
resources defined at the more granular level. If a resource is defined at plant 
resource level, then the maximum capacity defined at the plant is used rather than 
the maximum capacity defined at the generic resource level.

33. Save your work.

Note: If you create and assign a version control attribute set for the 
Recipe entity and if you modify any of the attributes included in 
that set, you will be prompted to create a new version of the recipe 
when you save your work. See: Setting Up Version Control 
Attribute Sets, page 2-39

To create instructions for a recipe or operation:
You have the option to create an instruction set with instructions for a recipe and 
operations from the Recipe Details window by selecting Process Instructions from the 
Actions menu. 

Instructions created at the recipe header level must have an instruction type of 
Clearance. Use clearance instructions for clearance checklist items, such as dispensing 
or production area cleanliness, calibrations, and ambient conditions, that occur before 
release of the batch.

An instruction set with instructions created for a particular operation in a recipe can 
have an instruction type of Clearance or Process. You can create one instruction set of 
each type per operation. Use the Clearance type if the instructions must be completed 
before the operation's release. Use the Process type for instructions to complete after the
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operation's release.

For step-by-step instructions, see: Adding Instructions to an Operation or Recipe, Oracle
Manufacturing Execution System for Process Manufacturing User's Guide.

To display regulatory item information:
1. Choose Regulatory Item Information from the Actions menu to display the General 

Item Information window.

To edit text:
1. Choose Edit Text from the Actions menu.

2. Enter appropriate text.

3. Save your work.

Duplicating a Recipe:
You can duplicate a recipe, routing, and validity rules from an existing record. If you 
change the routing end date prior to saving the record, then the application checks the 
routing end date against the validity rule end date. If the validity rule end date is 
greater than the routing end date, or blank, then the application assigns the value of the 
routing end date to the validity rule end date.

To duplicate a recipe:
1. Query the Recipe Details record to duplicate.

2. Choose New from the File menu.

3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Recipe name and Version number.

5. Save your work.

To display the Formula Details window:
1. Choose Formula from the Actions menu to display the Formula Details window.

To display the Routing Details window:
1. Choose Routing from the Actions menu to display the Process Routing Details 

window.
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To display the E-Record Details window:
1. Choose E-Record Details from the Actions menu to display the E-Record Generic 

Query if this option is implemented in your application. 

See: Appendix D Oracle E-Records Events in Product Development, page D-1.

To display the Specifications window:
1. Choose Specifications from the Actions menu. The Specifications window displays.

2. Evaluate specifications.

To display the Samples Summary window:
1. Choose Samples Summary from the Actions menu. The Samples window displays.

2. Evaluate the samples.

To view the master batch record:
1. Choose View Master Batch Record from the Actions menu. The View Master Batch 

Record window displays.

2. Evaluate the record.

3. Save or print the optional attachment.

See: Oracle Manufacturing Execution System for Process Manufacturing User's Guide for 
a complete discussion of the master batch record.

Using the View Menu to Find a Recipe
Use thee Find selection from the View menu to find a recipe. At least one search 
parameter needs to be entered.

To find a recipe from the View menu:
1. Navigate to the Recipe Details window.

2. Choose Find from the View menu.

3. Enter search parameters for: Status, Recipe, Version, Description, Product, 
Description, Formula, Version, Routing, Version, Owner, Recipe Type, Contiguous 
indicator, Enhanced Process Instructions, Owner Organization, , Owner Laboratory,
Creation Organization or Marked for Deletion.
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4. Click Find.

5. View the recipes found.

Entering Recipe Organization Details
Use the Recipe Organization Details window to display and, if necessary, override 
information defined for specific operations and routings at the plant or laboratory level.

To enter recipe organization details:
1. Navigate to the Recipe Organization Details window. The Find Recipe Organization

Details window displays.

Important: The first time you enter recipe organization details, click
New. Otherwise, enter the required information in the Find Recipe 
Organization Details window.

2. Enter the Organization where you want to override information that is defined for 
specific operations and routings. Required.

3. Click Find.

4. The following fields are display only:

• Organization indicates the code for the plant or laboratory that owns the recipe.

• Type displays Plant if the organization is a plant, or a Laboratory if the 
organization is a laboratory.

• Organization Name displays the description assigned to the organization. This 
field defaults to the entry from the Recipe Details window. Required.

• Planned Process Loss displays the loss of process material observed during 
production of a batch using the recipe as a percentage. You can enter and save a
different planned process loss value for the recipe used in the organization 
displayed. This value defaults to the theoretical process loss when no entry is 
made on the Recipe Details window.

• Theoretical Process Loss displays the hypothetical loss of process material 
associated to a routing. If no routing is associated to the recipe, this field is 
blank.

Validity Rules
5. Enter a Product for the formula used in the recipe. Revision indicates the product 
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item revision. You can only enter this field if the product is defined with a revision.

6. Recipe Use displays if the recipe is used in Production, Planning, Costing, 
Regulatory, or Technical when it is used to define technical classes and subclasses.

7. Enter the From Date as the date the validity rule becomes effective. The date must 
be within the effective date for any routing associated to the recipe. Required.

8. Enter To Date as the date to stop using the validity rule. This is an optional field 
and must be left blank if an expiration date is not defined for the validity rule.

9. Status displays the status of the validity rule entered on the Recipe Validity Rules 
window.

10. Enter Std Qty as the usual quantity of product produced by the validity rule. 
Required. 

Note: If the Automatic Step Quantity Calculation is not used, then 
the step quantities are based on the routing, and are scaled to this 
quantity. If the Automatic Step Quantity Calculation is used, then 
step quantities are based on the formula that is scaled to this 
quantity. 

11. Enter the UOM as unit of measure for the standard quantity. Required.

12. Enter the Min Qty as the minimum quantity of material allowable by the validity 
rule. Required.

13. Enter the Max Qty as the maximum quantity of material allowable by the validity 
rule. Required.

14. Enter the Preference number for the validity rule. When more than one formula can 
be used to produce the same product, the Preference field is used to show the 
validity rule that must be used first, second, third, and so forth. Preference defaults 
to 1. Required.

15. Enter the Theoretical Process Loss based on the standard quantity produced by this 
validity rule.

16. Enter the Planned Process Loss for the product. This entry overrides the process 
loss defined at the routing or recipe level. Once you save the current window, you 
can override the Planned Process Loss field on the Validity Rules window by 
reentering it and saving your work.

Note: Batches created for a different quantity using this validity 
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rule calculate the actual process loss by dividing the planned 
process loss by the theoretical process loss for the standard 
quantity to compute a factor. The theoretical process loss for the 
batch quantity is then multiplied by this factor to compute the 
actual process loss for the batch.

Activities
17. The following fields are display only:

• Step indicates the step number associated with the listed operation. Steps 
cannot be added or deleted here.

• Operation displays the operation associated with the step. The operation 
Version and Description display.

• Activity displays the activity associated with the operation. The activity 
Description displays.

18. Enter Factor as the number of times the activity is performed in the displayed 
operation. This value can change when resources that are specific to the 
organization are associated with ingredients. Required.

Capacity
19. The following fields are display only:

• Step indicates the step number associated with the listed operation. Steps 
cannot be added or deleted here.

• Operation displays the operation associated with the step. The operation 
Version displays.

• Activity displays the activity associated with the operation. Activities cannot be
added or deleted here.

• Resources displays the resource associated to each displayed activity.

20. The following fields display and can be edited:

• Min Capacity displays the minimum throughput amount per capacity unit as 
defined on the Resources window.

• Max Capacity displays the maximum throughput amount per capacity unit as 
defined on the Resources window.

21. UOM displays the unit of measure for both Min Capacity and Max Capacity entries.
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Throughput
22. The following fields are display only:

• Step indicates the step number associated with the listed operation. Steps 
cannot be added or deleted here.

• Operation displays the operation associated with the step. The operation 
Version displays.

• Activity displays the activity associated with the operation. Activities cannot be
added or deleted here.

• Resources displays the resource associated to each displayed activity.

23. Process Qty displays the total quantity of material for the step with its UOM. You 
can enter and save a different value. Required.

24. Usage displays the unit of the resource used to perform the activity on the 
displayed step. The usage UOM displays. You can enter and save a new usage 
quantity. Required.

25. Optionally, click Parameters to display the Recipe Organization Details-Process 
Parameters window.

Using the Find Recipe Organization Details Window
The Find Recipe Organization Details window displays when you navigate to the 
Recipe Organization Details window.

To find the recipe organization:
1. Enter the Organization that owns the recipe. The Name of the Organization 

displays. Required.

2. Click Find.

To display the E-Record Details window:
1. Choose E-Record Details from the Actions menu to display the E-Record Generic 

Query if this option is implemented in your application.

See: Appendix D Oracle E-Records Events in Product Developmen, page D-1t.

Displaying Recipe Organization Details-Process Parameters
The Recipe Organization Details-Process Parameters window displays organization-
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specific process parameters for recipes. Process parameters are a component of the 
process instructions necessary to run resources during the batch process. They are 
usually machines or instruments and are the standard for processing a task. They can be
generic or specific. Each industry and company uses different machines and 
instruments, and there are different requirements for recording process parameters.

A process parameter details information such as temperature, pressure, or time 
pertinent to the product, but does not fall into the classification of input or output. You 
can use process parameters as set points, comparison values, or in conditional logic.

Several process parameter fields can be overridden once associated with resources, 
operations, and recipes. For example, if the parameter type is:

• Numeric Range, then you can define the Target field at the generic resource level. 
You can override Target, Min, and Max fields at the recipe resource level.

• List of Values, then you cannot enter overrides. The List of Values can only be 
defined on the Process Parameter window. Min and Max fields are not available.

• Text, then you can define the Target value at the generic resource level. It can be 
overridden at the recipe resource level. The Min and Max fields are not available.

If the process parameter is added directly to a batch, then you can enter the Target field.
If the process parameter is numeric, then enter the Min and Max fields.

Important: When a batch is created from a recipe, only the actual values
can be entered.

To display the Recipe Organization Details-Process Parameters window:
1. Navigate to the Recipe Organization Details-Process Parameters window.

2. The following fields are display only:

• Recipe displays the recipe with its Version and Description.

• Organization displays the recipe organization and its Description.

• Resources displays the resource attached to the activity and its Description.

Parameter Values
3. The following fields default from the process parameter set up in the planning 

application:

• Seq is the sequence of the resource process parameter.

• Parameter is the process parameter name. For example, Bath Temperature.
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• Target is the target value for the process parameter.

• Minimum is the lowest acceptable value for a numeric range type of process 
parameter.

• Maximum is the highest acceptable value for a numeric range type of process 
parameter.

• Units is the unit of measure for the process parameter.

4. Click OK to close the window.

Entering Multi-Record Recipe Validity Rules
Use the Recipe Validity Rules Multi-Record window to enter or edit a complete list of 
validity rules for organizations you can access. Validity rules provide a combination of 
a quantity of material and an effective date used by production, planning, costing, or 
technical operations in one or more specified organizations. Validity rules marked for 
deletion cannot be updated. Validity dates are ordered by organization, product, 
recipes, and start date.

To view multi-record recipe validity rules:
1. Navigate to the Recipe Validity Rules window.

2. The following fields are display only:

• Formula displays the formula used in the recipe with its Version and 
Description.

• Routing displays the routing used in the recipe with the routing Version and 
Description.

3. Organization displays the organization that owns this validity rule to produce 
products. This can be a plant or laboratory. When left blank, the validity rule is 
global.

Note: If there is an outside processing resource in the routing, it 
must be associated with the outside processing item at the plant 
resource level. When you create a recipe validity rule for a specific 
plant, then you must define the OSP resource in that plant and 
associate the OSP item to that resource.

4. Enter a Product for the validity rule. Revision indicates the product revision level. 
The Product Description field displays. Required.
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Recipe Use
5. Select Recipe Use as:

• Production for use in production of products.

• Planning for use in planning material consumption.

• Costing for use in establishing costs.

• Regulatory for use in a regulated product.

• Technical for use in establishing technical classes and subclasses.

Required.

6. Enter the Preference number for the validity rule. When more than one formula is 
used to produce the same product, preference indicates the validity rule that must 
be used first, second, third, and so forth. Required.

7. Enter the From Date as the date the validity rule becomes effective. The date must 
be within the effective date for any routing associated to the recipe. Required.

8. Enter To Date as the date to stop using the validity rule. If an expiration date is not 
defined for the validity rule, then this is an optional field and must be left blank.

9. Enter the Standard quantity of product made with this recipe and its UOM. This 
quantity is only used to determine costs. It does not restrict quantities produced by 
the formula displayed. The standard quantity must be in the specified range 
defined by the minimum and maximum quantities. Required.

10. Enter the Minimum as the minimum quantity of product that can be made using 
the formula. Required.

11. Enter the Maximumas the maximum quantity of product that can be made using 
the formula. Required.

12. Theoretical displays the theoretical process loss based on the validity rule standard 
quantity.

13. Enter the Planned process loss. This overrides planned process loss entered at the 
routing level.

Step Quantity
14. The following fields are display only:

• Step is the routing step number.
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• Operation is the operation associated to the routing step and the operation 
Version.

• Description is the operation description.

• Step Qty is the quantity of material consumed by the step in its primary UOM.

• Charges is the number of charges entered for the step.

To view the master batch record:
1. Choose View Master Batch Record from the Actions menu.

2. Evaluate the record.

3. Save or print the optional attachment.

See: Oracle Manufacturing Execution System for Process Manufacturing User's Guide for 
a complete discussion of the master batch record.

Editing Recipe Validity Rules
Use the Recipe Validity Rule Details window to edit validity rules for a specific recipe 
you have entered and saved. Use this window to apply global or specific organization 
rules to batches, cost management, planning, or technical data when producing the 
same product. Validity rules can be added, updated, or marked for deletion.

Overriding Process Loss Entered at the Routing Level

Process loss is based on the standard quantity entered at the validity rule level. Process 
loss that is entered at that level overrides the process loss entered at the routing level. 
Theoretical Process Loss, Planned Process Loss, Step Quantity, and Charges fields 
display at the validity rule level.

Theoretical Process Loss calculations are also based on the Validity Rule Standard 
Quantity. If Planned Process Loss is entered on a validity rule, then its value overrides 
process loss defined at any other level in the routing or the recipe. If a batch is created 
for a different quantity, then the same rule is applied to calculate the actual Process 
Loss. Planned Process Loss is compared to the Theoretical Process Loss for the Standard
Quantity field on a validity rule to derive a factor. The factor is multiplied by the 
routing class process loss for the quantity range in which the batch quantity falls to give
the actual process loss for the batch.

Following are the modifications for the Automatic Step Quantity Calculation, or ASQC:

• If ASQC is not used, then the step quantities displayed initially are based on the 
routing, as scaled to the Validity Rule Standard Quantity. If step quantities are 
overridden at the recipe level, then the recipe step quantities are scaled to the 
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Validity Rule Standard Quantity.

• If ASQC is used, then the Step Quantities displayed are based on the formula scaled
to the Validity Rule Standard Quantity. 

Charges displayed at the validity rule level are based on the step quantities indicated 
there. Process Execution, Cost Management, and Financials applications use process 
loss overrides at the validity rule level.

E-Record and E-Signature Approvals

There may be an e-signature event associated to this window. See: Appendix D Oracle 
E-Records Events in Product Development, page D-1.

To edit recipe validity rules:
1. Navigate to the Recipe Validity Rule Details window.

2. The following fields are display only:

• Formula displays the formula used in the recipe with its Version and 
Description.

• Routing displays the routing used in the recipe with the routing Version and 
Description.

3. Return to this window to change status by selecting Change Status from the Actions
menu after entering all relevant information and saving the validity rule with the 
default Status of New. Depending on whether workflow is enabled, a different set 
of statuses is available. See: Appendix C Oracle Process Manufacturing Product 
Development Status Codes, page C-1

Important: This field cannot have a status that is higher than its 
associated recipe. For example, a validity rule cannot be approved 
for general use until its associated recipe is approved for general 
use. You can change the status of recipes or validity rules to on-
hold or obsolete even if they are used in batches as long as all the 
batches are closed or canceled.

4. Organization displays the organization that owns this validity rule, and the 
Organization Description. This is usually a plant or laboratory.

Validity Rule
5. Select Recipe Use as:

• Production for use in production of products.
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• Planning for use in planning material consumption.

• Costing for use in establishing costs. 

• Regulatory for use with hazardous or controlled materials.

• Technical for use in establishing technical classes and subclasses.

Required.

6. Enter a Product in the formula for the validity rule. Product Revision displays for 
revised product items. The product Description field displays. Required.

7. Enter the Preference number for the validity rule. When more than one formula can 
be used to produce the same product, this field indicates the validity rule that must 
be used first, second, third, and so forth. Preference defaults to 1. For example, one 
formula can be used to produce between 10 and 150 gallons of a product. Another 
formula can be used to produce between 100 and 1000 gallons of the same product. 
Either formula can be used to produce 100 to 150 gallons of material. Preference 
indicates the suggested order of use. Lower numbers indicate a higher preference. 
The number 1 indicates the highest preference.

Required.

8. Enter the Standard Quantity of product made with the formula. This quantity is 
only used for product costing. It does not restrict quantities that can be produced 
with the formula. Required.

9. UOM is the unit of measure for the standard quantity. You can enter and save a 
different unit of measure. Required.

10. Enter the Minimum quantity of product that can be made using the Formula. 
Minimum defaults to 1. Required.

11. Enter the Maximum quantity of product that can be made using the formula. 
Required.

12. Theoretical displays the theoretical process loss based on the Validity Rule Standard
Quantity.

13. Enter the Planned process loss. This overrides planned process loss entered at the 
routing level.

14. Enter the Fixed Process Loss. This value is defaulted to the value you entered in the 
Recipe Details window. You can override this value if required. Optional.

15. The Fixed Process Loss UOM displays. The fixed process loss UOM is defaulted to 
the Routing Class UOM. You cannot override the UOM value.
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16. Enter the From date as the date the validity rule becomes effective. The date must 
be within the effective date for any routing associated to the recipe. Required.

17. Enter the To date as the date to stop using the validity rule. If an expiration date is 
not defined for the validity rule, then this is an optional field and must be left blank.

Step Quantity
18. The following fields are display only:

• Step displays the step number associated with the operation displayed.

• Operation indicates the operation associated to the step. The operation Version 
displays.

• Description indicates a description of the operation.

• Step Quantity and its UOM indicates the quantity processed by the routing step
and the unit of measure of the step quantity.

• Charges indicates the total calculated charges for the step. Charges are 
calculated from the smallest minimum capacity for all resources in the Step. 
Calculation of charges is based on the resources defined at the more granular 
level. If a resource is defined at plant resource level, then the maximum 
capacity defined at the plant is used rather than the maximum capacity defined 
at the generic resource level

To view the master batch record:
1. Choose View Master Batch Record from the Actions menu.

2. Evaluate the record.

3. Save or print the optional attachment.

See: Oracle Manufacturing Execution System for Process Manufacturing User's Guide for 
a complete discussion of the master batch record.

Displaying Validity Rules By Product
Use the Validity Rules Summary by Product window to specify under which 
circumstances a recipe can be used. Validity rules provide a combination of material 
quantities and a range of effective dates used by production and planning in one or 
more specified organizations. This window only displays validity rules that have not 
expired. To display validity rules by product:

• Enter and save recipes.
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• Enter and save validity rules.

To select a validity rule by product:
1. Navigate to the Validity Rules Summary By Product window. The Find Validity 

Rules By Product window displays.

2. Enter the desired product item in the Find field.

3. Click Find. The window displays all recipes found for the item.

4. The following fields are display only:

• Recipe displays the recipe that is the basis of the validity rule.

• Version displays the Recipe version.

• Recipe Description is a brief description of the recipe.

• Organization displays the organization for which the validity rule can be used. 
This field is blank if any organization can use the validity rule.

• Formula displays the formula associated with the Recipe.

• Formula Version displays the version of the Formula.

• Routing displays the routing associated with the Recipe.

• Routing Version displays the version of the Routing.

• Routing Description displays a brief description of the Routing.

• Product displays the product code for the primary product used in the Recipe.

• Revision is the product item revision.

• Product Description displays a description of the primary product.

• Recipe Use displays the intended use for the recipe. Firm Planned Orders use 
Production or Planning validity rules.

• Preference displays the preference number for the validity rule. When more 
than one formula can be used to produce the same product, the Preference field 
is used to show the order of preference for a validity rule. Lower numbers are 
preferred. For example, a preference of 2 is higher than a preference of 5.

• Start Date displays the first date the validity rule can be used.
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• End Date displays the last date the validity rule can be used. When this field is 
blank, there is no specified end date. 

• Standard Quantity displays the standard quantity of material used for costing 
the formula. It does not restrict quantities that can be produced by the formula.

• UOM displays the unit of measure for the Quantity fields.

• Min Quantity is the minimum quantity of product that can be made using the 
recipe.

• Max Quantity is the maximum quantity of product that can be made using the 
recipe.

• Theoretical Process Loss is the theoretical process loss.

• Planned Process Loss is the process loss planned for.

• Validity Rules Status is the current status assigned to the validity rule.

5. Select the validity rule to display.

6. Click OK.

To edit a validity rule:
1. Click Edit to edit a validity rule.

Displaying Validity Rules By Recipe
Use the Validity Rules Summary by Recipe window to specify under which 
circumstances a recipe can be used. Validity rules provide a combination of material 
quantities and a range of effective dates used by production and planning in one or 
more specified organizations.

This window only displays validity rules that have not expired.

To select a validity rule by recipe:
1. Navigate to the Validity Rules Summary By Recipe window. The Find Validity 

Rules By Recipe window displays.

2. Enter the desired recipe in the Find field.

3. Click Find. The window displays all recipes found for the item.

4. The following fields are display only:
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• Recipe displays the recipe that is the basis of the validity rule.

• Version displays the Recipe version.

• Recipe Description displays a brief description of the Recipe.

• Organization displays the organization for which the validity rule can be used. 
This field is blank if any organization can use the validity rule.

• Formula displays the formula associated with the Recipe.

• Formula Version displays the version of the Formula.

• Formula Description displays a brief description of the Formula.

• Routing displays the routing associated with the Recipe.

• Routing Version displays the version of the Routing.

• Routing Description displays a brief description of the Routing.

• Product displays the product code for the primary product used in the Recipe.

• Revision is the product item revision.

• Product Description displays a description of the primary product.

• Recipe Use displays the intended use for the recipe. Firm Planned Orders can 
use Production or Planning validity rules.

• Preference displays the preference number for the Validity Rule. When more 
than one formula can be used to produce the same product, the Preference field 
is used to show the order of preference for a validity rule. Lower numbers are 
preferred. For example, a preference of 2 is higher than a preference of 5.

• Start Date displays the first date the validity rule can be used.

• End Date displays the last date the validity rule can be used. When this field is 
blank, there is no specified end date. 

• Standard Quantity displays the standard quantity of material used for costing 
the formula. It does not restrict quantities that can be produced by the formula.

• UOM displays the unit of measure for the Quantity fields.

• Min Quantity is the minimum quantity of product that can be made using the 
recipe.
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• Max Quantity is the maximum quantity of product that can be made using the 
recipe.

• Theoretical Process Loss is the theoretical process loss.

• Planned Process Loss is the process loss planned for.

• Validity Rules Status is the current status assigned to the validity rule.

5. Select the validity rule to display.

6. Click OK.

To edit a validity rule:
1. Click Edit to edit a validity rule.

Generating a Recipe and Validity Rule Automatically
The Recipe Generation window configures rules for the creation of a recipe and validity
rule automatically when a formula is created. Select how the recipe is used, its start 
date, end date, creation type, naming convention, and how to manage validity rules 
created for the recipe.

When you save the formula, the application determines if a recipe generation 
configuration is set up for the formula owning organization. If an owning organization 
is not specified, then a recipe with a global validity rule is generated. The application 
checks for default status rules to determine if the recipe must be set to a default status.

If an approval workflow is configured, then it starts when the formula or recipe is set to 
a default status other than New. If a recipe generation e-signature event was 
configured, then its approval process begins. When an approval workflow or e-
signature workflow is not started, then the recipe and its associated validity rule are 
created for the formula.

To associate E-record and E-signature approvals:
E-signature events can be associated to this window. The GMD ERES Recipe Generation
event works in conjunction with automatic recipe generation. The event displays the 
formula, recipe, and validity rule on a single e-record. When the event is approved, 
then all records are approved. Approval of this e-record bypasses the requirement to 
start the individual status change e-signature events associated to formulas, recipes, 
and validity rules.

1. Creation Type is Automatic or Optional

If the Creation Type field selection on this window is set to Automatic or Optional, 
then use the GMD ERES Recipe Generation event. The e-record event is triggered 
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online when the formula is saved, unless you choose to defer it. If the event is 
deferred, then the formula status changes to Pending and its approval can be 
managed manually. The recipe and validity rule are not created until the event is 
approved.

2. Creation Type is User-Initiated

If the Creation Type is User-Initiated, then the GMD ERES Recipe Generation event 
cannot be used. Use individual e-record status change events for approvals. After 
the formula is saved, the Formula Status Change event is triggered online. The 
recipe event is triggered in a deferred mode after you approve the formula event. 
The validity rules event is triggered in a deferred mode after you approve the 
recipe event.

3. Impact of the GMD ERES Recipe Generation Event on Status Approval Events

If you do not use the GMD ERES Recipe Generation event with automatic recipe 
generation feature and you do use the current status approval events for formulas, 
recipes and validity rules, then the formula changes to an approved status. The 
Formula Status Change event is not triggered. The Recipe Status Change event is 
triggered in a deferred mode after the formula is approved. Similarly, the Validity 
Rules event is triggered in a deferred mode after you approve the Recipe Approval 
event.

Workflows are deferred. The notifications are not triggered online. The approval of 
the formula workflow notification triggers the recipe workflow if it is enabled. If the
recipe workflow is not enabled, then the recipe is automatically created after the 
formula workflow is approved. Likewise, the validity rules workflow is triggered 
after the recipe workflow notification is approved. If the validity rules workflow is 
not enabled, then the validity rules are created automatically after the recipe 
workflow is approved.

To generate a recipe and validity rule automatically:
1. Navigate to the Recipe Generation window.

2. Enter the Organization to use for validity rule creation. If you leave this field blank, 
then the application creates a global configuration rule. The global configuration 
rule produces a global validity rule that can be used by any organization that does 
not have a configuration. The formula owner organization is used to determine the 
recipe generation rule to use.

3. Organization Description displays the organization entered. This field is blank if an 
organization is not entered.

Recipe Use
4. This selection determines how validity rules are configured for use. Select one or 
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more of the following recipe use types to define how to create the recipe validity 
rules:

• Production to create a validity rule for manufacturing.

• Costing to create a validity rule to use in establishing costs.

• Planning to create a validity rule to use for planning material consumption.

• Regulatory to create a validity rule for regulatory purposes.

• Technical to create a validity rule for use in establishing technical classes and 
subclasses.

The application creates a validity rule for each type of recipe use you select.

Start Date
5. Specify the start date using one of these methods:

• Select Formula Date to use the formula creation date as the start date for the 
validity rule.

• Select Specific Date and enter the start date for the validity rule.

End Date
6. Specify the end date using one of these methods:

• Enter End Date as the last date to use the validity rule. When this field is blank, 
there is no specified end date.

• Enter Number of Days to indicate the number of days from the start date that 
you want the validity rule to end. If you enter an end date, then you cannot use 
this field.

• Enter Cost Calendar for a costing type validity rule to end on the period end 
date.

7. Select Creation Type to indicate how recipes and validity rules are created when a 
formula is saved:

• Automatic to indicate that the recipe and validity rule are saved automatically 
when you save the formula. This is the default.

• User-Initiated to choose whether to create a recipe and validity rule when you 
save a formula.

• Optional to respond to the message: Do you wish to create the recipe?
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• If you click Yes, then the recipe and validity rules are created automatically 
when you save the formula.

• If you click No, then only the formula is created.

8. Select one of the following for Recipe Naming Convention:

• Formula to name the recipe with the number of the formula.

• Product to name the recipe with the number of the product.

9. Select Managing Validity Rules as the method to handle preexisting validity rule 
and formula versions. This selection also prevents you from saving duplicate 
validity rules:

• Preference when more than one formula can be used to produce the same 
product. This indicates the order of choice for a validity rule. Lower numbers 
are preferred. For example, a preference of 2 is higher than a preference of 5. If 
you select this to manage validity rules, then preexisting, overlapping validity 
rules increase their preference by one and the validity rules you create are set to
the default preference of 1. The preference is used in background processes 
such as material requirements planning and standard cost calculation rollups.

• End Date to set preexisting, overlapping validity rules to end on the date and 
time you create the new one. This option sets the Preference field for the new 
validity rule to 1.

• Next Preference to create a preference for the newly created validity rule as one 
higher than the highest value of any preexisting overlapping validity rules. For 
example, if the highest preexisting validity rule preference is 4, then an 
overlapping validity rule is assigned a preference of 5; one higher than the 
highest preexisting value.

To delete configurations created by this window:
You cannot use Mark for Purge functionality with this window. If you want to undo a 
configuration, then delete it physically.

Displaying the Recipe Step/Material Association
Use the Recipe Step/Material Association window to display all items from the recipe 
formula and associate these items with specific routing steps. 

Minimum Transfer Quantity (MTQ) has a restriction on the gap between the time that 
the MTQ is yielded for the item, and the start of the next routing that involves that item.
The gap is defined with a minimum and maximum value based in the TIME unit of 
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measure for hour. When calculating the gap, the minimum value creates the gap, and 
the maximum value limits the duration of the gap between the routing and the MTQ 
yield point. This MTQ calculation can be added for all products of a recipe.

Minimum and maximum values are optional, and blank values represent an infinite 
gap between the manufacturing processes:

• If you enter the minimum value only, then a specific gap must exist between the 
MTQ timepoint and the next routing for the item. However, the end of the gap is 
infinite.

• If you enter both minimum and maximum values, then the gap is fixed and requires
the next routing to start in the defined period after the MTQ timepoint.

Minimum delay and maximum delay represent this gap. The values for these can never 
be negative, and the minimum must always be less than or equal to the maximum 
value. The entry of an MTQ for any of the products is not required. Blank value for 
MTQ implies the full quantity must be yielded before the next routing can start.

Note: Data that displays on this window is entered and saved in the 
Recipe Details window.

Item substitutions are marked with the Substitution indicator. The Effective Date for 
Ingredient Replacement field displays the starting date when the item substitution is 
effective.

To display recipe step/material associations:
1. Navigate to the Recipe Step/Material Association window.

2. The following fields are display only:

• Formula displays the formula used in a recipe with the Version and Formula 
Description.

• Routing displays the routing used in a recipe with the Version and Routing 
Description.

• Effective Date for Ingredient Replacement indicates the effective date for any of 
the substitute items associated to the recipe and steps listed. The Substitute 
indicator marks these items. This field defaults to the current date and time.

Associations
3. Step displays the step number associated with the listed operation in the displayed 

routing. You cannot add a step to a routing on this window. Add a step to a routing
on the Process Routing Details window. Required.
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4. The following fields are display only:

• Item is the code associated with each product, byproduct, or ingredient listed.

• Substitute indicates the ingredient is a substitute item. These items have an 
effective date for ingredient replacement that displays in the window header.

• Type is the type of line associated in the step as a product, byproduct, or 
ingredient.

• Item Qty is the quantity of product, byproduct, or ingredient yielded by the 
listed formula.

• Line is the routing line number.

• UOM is the unit of measure for the item quantity.

• Operation displays the operation associated with the step. The operation 
Version displays.

• Step Qty displays the default quantity of material associated with the step. The 
UOM for the step quantity displays.

To edit the associations of materials and steps:
1. Enter the Step from the LOV. Required.

Note: By entering a new line number for a step, you change the 
step and material association.

2. The following fields are display only:

• Operation displays the operation associated with the Step. The operation 
Version displays.

• Step Qty displays the default quantity of material associated with the Step. The 
UOM for the Step Quantity displays.

• Effective Date for Ingredient Replacement indicates the effective date for any of 
the substitute items associated to the recipe and steps listed. The Substitute 
indicator marks these items. This field defaults to the current date and time.

3. Enter the Line from the LOV. Required.

4. The following fields are display only:
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• Item displays the code associated with each product, byproduct, or ingredient 
listed.

• Type displays the type of Line associated in the Step as a product, byproduct, or
ingredient.

• Item Qty displays the Quantity of product, byproduct, or ingredient yielded by 
the listed Formula.

• Line UOM displays the unit of measure for the Item Quantity.

5. Save your work.

Defining Descriptive Flex Fields for Step Materials
Oracle Process Manufacturing (OPM) enables you to define the recipe step material 
associations using the routing with the specific steps. To establish step material 
associations, you use the Step Material Association window of the recipe. This 
information is also available in OPM Process Execution. Step materials descriptive 
flexfields follow the standard Oracle Application procedure for extending applications 
with descriptive flexfields (DFFs).

A descriptive flexfield is a field that is comprised of segments. A flex field appears in a 
pop up window when you click on the flex field icon. Each segment has a name and a 
set of valid values. Using Descriptive flex fields you can store additional information 
about each step.

A Recipe provides a relationship between the material in a formula and the steps in the 
routing through material association. The material may be product, coproduct, by-
product or ingredient. This association indicates the time, or place of yield or 
consumption of the corresponding material

You can view the DFF added to the recipe in the Step Material Associations window. 
You can use these flex fields to provide more information related to the respective step.

Descriptive Flex Field for step materials provide additional information such as the 
registration of the sequence in which the ingredients need to be consumed. 

To define DFF for Step Materials Associations:
1. Navigate to Step Materials Association window.

2. Enter the following details:

• Formula as the formula used in a recipe with the Version and Formula 
Description.

• Routing as the routing used in a recipe with the Version and Routing 
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Description.

• Effective Date for Ingredient Replacement as the effective date for any of the 
substitute items associated to the recipe and steps listed. The Substitute 
indicator marks these items. This field defaults to the current date and time.

Associations
3. Step as the step number associated with the listed operation in the displayed 

routing. You cannot add a step to a routing on this window. Add a step to a routing
on the Process Routing Details window. Required.

4. Enter the following fields details:

• Operation as the operation associated with the step. The operation Version 
appears.

• Step Qty as the default quantity of material associated with the step. The UOM 
for the step quantity appears.

• Substitute as the substitute item. These items have an effective date for 
ingredient replacement that appear in the window header.

• Item as the code associated with each product, byproduct, or ingredient listed.

• Type as the type of line associated in the step as a product, byproduct, or 
ingredient.

• Item Qty as the quantity of product, byproduct, or ingredient yielded by the 
listed formula.

• Line as the routing line number.

• UOM as the unit of measure for the item quantity.

5. Click Descriptive Flex Field [ ] icon. The Descriptive Flex Field window appears 
based on your DFF setup.

Note: The Descriptive Flex Field window displays the flex field 
segments based on the Recipe Step Material associations flex field 
defined in the Applications Developer responsibility.

Understanding the Recipe Designer
The Recipe Designer provides all functions that are accessible using the Routing, 
Formula, and Recipe Details windows. The Recipe Designer is used to create, copy, and 
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edit a complete recipe that includes formulas, routings, validity rules, and process 
instructions.

Recipe Designer Components
The Recipe Designer window has three major components:

• A navigator located in the top left pane displays a:

• Recipe tab which displays a broad view of the product including material and 
process requirements.

• Formula tab which displays a material oriented view of the product.

• Routing tab which displays a process oriented view of the product.

• The following navigator style formats are available:

• Interleaved style that positions recipe components in a left-to-right orientation 
for each recipe with spatial adjustment for each component.

• Organization chart style that positions recipe components in a top-to-bottom 
orientation for each recipe with spatial adjustment for each component as in an 
organization chart.

• Vertical style that positions recipe components in a left-to-right orientation for 
each recipe with no spatial adjustment for each component.

• A display of formula items in the bottom left pane has tabs that let you select all
items, or filter out only products, byproducts, or ingredients. For each type of 
item, you can display those that are associated to steps, or those that are not 
associated to steps. You can also display a combination of those that are 
associated to steps and those that are not associated to steps.

• A right pane displays the following views selected from tabs located at the bottom 
of the pane:

• Process Instruction Sheet view that combines routing information. This view 
includes process requirements and formula details, including input and output 
requirements.

• Step Dependency Graph view that depicts the step dependencies within the 
routing associated to the recipe. All of the steps in the routing display are 
represented as a graphic image. Below each image is a step number, operation 
code, and operation version. When you position the cursor over a step, text 
displays the complete description of that step. When you position the cursor 
over a line dependency that links two routing steps, text displays the transfer 
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percentage between the routing steps.

The graphics that appear as nodes on the navigator are also used to identify the Recipe 
Designer components. See: Using the Recipe Designer, page 6-44.

Understanding the Tab Pane
The Tab pane contains a Recipe tab, Formula tab, and Routing tab. 

• The Recipe tab displays a Formula Items view or Item Master view. The Formula 
Items view displays a list of items in the present formula, and you can associate 
formula items to steps. The Formula Items view has several tabs that let you display
a list of items by product, byproduct, or ingredient. Within each tab, view all items, 
items that are associated to routing steps, or items that are not associated to routing 
steps. The Item Master view displays items from the Item Master table, and you can
add new items to the formula while assigning them to steps. The Process 
Instruction Sheet tab displays steps and associated items. It also displays formula, 
routing, and recipe level process instructions.

• The Formula tab lists all items in a formula. You can create and maintain material 
requirements of a recipe. You can also maintain standard item level processing 
instructions. The Process Instruction Sheet tab displays formula details and 
standard item process instructions.

• The Routing tab enables you to create and edit routings. You can also maintain 
standard routing step level processing instructions. The Process Instruction Sheet 
tab displays routing step details and standard routing step process instructions.

Associating an Item to a Routing Step
If production and consumption of materials are controlled at the step level, then the 
specification of material input and output for each step in a recipe is required. The 
Formula Item view under the Recipe tab lets you select one or more items and assign 
them to a routing step in the navigator or on the routing step dependency graph using 
the drag-and-drop operation. This function is available when the View Unassigned 
Items option is selected on the Formula Item list. You can also use the Item Master 
option. The Item Master view displays items from the item master table, and you can 
add new items to the formula.

Redistributing a Formula
When you select the Formula tab, all items associated to a step display by expanding 
the related node in the navigator. Move items from one routing step to another by using
the drag-and-drop operation or a cut and paste operation. The Process Instruction Sheet
tab on the right pane reflects all changes you make.
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Using Automatic Step and Number of Charges Calculation
The routing step quantities and the number of charges are calculated and updated on 
the Process Instruction Sheet pane when you change an item and step association. The 
calculation is performed when you select the Calculate Step Quantities indicator on the 
toolbar.

Understanding the Process Instruction Sheet Pane
Use the Process Instruction Sheet pane to display, develop, and maintain material and 
routing step associations as well as the process instructions for a specific recipe. 
Standard process instructions can be maintained at the formula item level and the 
routing step level, while clearance instructions can be maintained at the recipe and the 
operation/routing step level. It provides navigator views of routing steps in interleaved,
organization chart, or vertical display styles. It also presents multiple views of items in 
the formula.

You can use the Process Instruction Sheet to:

• Assign formula items to routing steps using the drag-and-drop operation.

• Perform automatic step quantity and number of charge calculations.

• Redistribute formula items from one step to another step using the drag-and-drop 
operation.

• Display process instructions defined at the formula item level and at the routing 
step level.

• Create, maintain, and view process instructions at the routing step, and at the item 
and step association level.

• Combine process requirement inputs and production execution outputs within a 
single set of process instructions.

• View the properties of recipes, routings, routing steps, operations, activities, 
resources, and items at the product, ingredient, and byproduct levels.

Editing Process Instruction Text
Access the Process Instruction Text Editor from the right-mouse menu or the Tools 
menu. Process instructions are created and maintained for a specific operation item or 
step association row, or for a particular step in the recipe. Standard process instructions 
defined in the formula at the item level, or in the routing at the step level cannot be 
edited at the recipe level. Process instructions are stored in the standard text table 
against the paragraph code defined in the GMD: Process Instruction Paragraph profile 
option.
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Differentiating Standard from Specific Process Instructions
Standard process instructions common to all recipes are defined in the formula or 
routing. Text displays in the Recipe Process Instruction Sheet. You cannot edit this text 
in the pane. Use the Edit Text functionality.

Note: If the Oracle Manufacturing Execution System for Process 
Manufacturing application is available, then use this application to 
build process instructions.

Standard process instructions maintained at the step level in the routing display under 
the routing step line. Display or hide process instructions by expanding or collapsing 
the corresponding routing step line. Process instructions defined at the step level for 
this particular recipe display.

Using the Recipe Designer
The Recipe Designer contains the following components:

• A navigator view of the recipe in the top left pane. Display or hide descriptions on 
the navigator. Expand components on the navigator by clicking the + sign, or 
collapse components on the navigator by clicking the - sign. The navigator has a 
Material View and a Resource View that selectively displays materials such as 
products, byproducts, and ingredients, or routings composed of operations 
arranged in steps, activities, and resources.

• A Formula Item view of the recipe in the bottom left pane.

• A Process Instruction Sheet or a Step Dependency Graph in the right pane, 
depending on the tab selected.

Depending on the status of the recipe, the Recipe Designer is in update or view mode. 
You have the same update or view privileges for the Recipe Designer as you have for 
the Recipe Details window.

Before you use the Recipe Designer:

• Define a paragraph code for process instructions using the GMD: Process 
Instruction Paragraph profile option. By default, the Recipe Designer uses PI as the 
default paragraph code.

To display the Recipe Designer from Product Development windows:
Find an existing recipe or create a new recipe within the Recipe Designer:

1. To display the Recipe Designer from Product Development windowavigate to one 
of the following windows:
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• Recipe Details

• Recipe Summary By

• Recipe Header Summary

2. Query the appropriate recipe.

3. Click Designer to display the Recipe Designer window.

To use the buttons on the Recipe Designer:
The following discussion and graphic identify and explain each of the tools displayed 
on the Recipe Designer tool palette:

• 1 is the Vertical Style button. Click it to display the vertical navigator style. Recipe 
components are positioned in a left-to-right orientation. There is no spatial 
adjustment for each component.

• 2 is the Interleaved Style button. Click it to display the interleaved navigator style. 
Recipe components are positioned in a left-to-right orientation with spatial 
adjustment for each component.

• 3 is the Org-Chart Style button. Click it to display the organization chart navigator 
style. Recipe components are positioned in a top-to-bottom orientation with spatial 
adjustment for each component.

• 4 is the Find button. Click it when the Edit Process Instructions window displays 
the Find Text Token window. Text tokens are codes or short descriptions that 
represent longer descriptions or messages.

• 5 is the Show/Hide Description button. Click it to display a description of the 
components shown in the navigator. Select it again to hide the description.

• 6 is the Save button. Click it to save the changes made on the Recipe Designer. This 
option is not available if the Recipe Designer is in View mode.

• 7 is the Refresh button. Click it to refresh the panes with data retrieved from the 
database.

• 8 is the Exit button. Click it to exit from the Recipe Designer workbench.
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• 9 is the Show/Hide Operation Master button. Click it to display the Routing 
Operation Pane. Select it again to hide the Routing Operation Pane.

• 10 is the Show/Hide Formula Items button. Click it to display the Formula Item 
Pane. Select it again to hide the Formula Item Pane.

• 11 is the Drag Mode button. Click it to move steps around the graph pane using the 
drag-and-drop operation. This option is not available if the Recipe Designer is in 
View mode, or if the Process Instruction Sheet tab is selected.

• 12 is the Connect Mode button. Click it to build dependencies between steps using 
the drag-and-drop operation. This option is not available if the Recipe Designer is 
in view mode.

• 13 is the Help button. Click it to display online help for the current window.

• 14 is the Calculate Step Quantities indicator. Click it to calculate step quantities. 
Clear the box to indicate that steps are not calculated.

To set up the GMD: Process Instruction Paragraph Profile Option
You can use many windows in Oracle Process Manufacturing applications to associate 
text with a record of the edited document. For example you can attach text to a specific 
ingredient line in a formula. In this application, paragraphs are structures that are used 
to store and categorize text. The standard application has the General Text paragraph as
the one default paragraph stored for each database table.

To provide the Recipe Designer with a means to distinguish between Process 
Instructions and other text types, your system administrator needs to define a 
paragraph code for process instructions. Text displayed in the Process Instruction Sheet 
in the Recipe Designer is the text defined for the paragraph code specified by the GMD: 
Process Instruction Paragraph profile option.

Using the Recipe Tab
The Recipe tab includes the following options:

Formula Items
If Formula Items is selected, then the list below the navigator displays the list of items 
in the formula and you can associate formula items to steps.

Item Master
When Item Master is selected, then the list below the navigator displays items from the 
Item Master table and you can add new items to the formula while assigning them to 
steps.
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Mark For Purge
Select this option to delete a recipe. If the recipe is not marked for purge, then this 
function is available.

Edit Process Instructions
Select this option to create and maintain clearance and processing instructions for a 
recipe, recipe step, or step-item association. This option is enabled if a node 
representing a step or an item is selected.

Edit Properties
Select this option to view or edit properties of the selected node. You can edit recipe 
header, recipe step, and recipe step material properties.

Change Status
Select this option to change the recipe, formula, or routing status. If changes are made to
the components, then the application displays a warning message prompting you to 
save the changes. If the save option is selected, then the standard Change Status 
window displays.

Organization Details
Select this option to view or edit organization specific attributes of the current recipe. If 
changes are made to the recipe, then the application displays a warning message 
prompting you to save the changes. If the save option is selected, then the standard 
Validity Rules window displays.

Validity Rules
Select this option to view or edit validity rules for the current recipe. If changes are 
made to the recipe, then the application displays a warning message prompting you to 
save the changes. If save is selected, then the standard Validity Rules window displays.

Undelete
Select this option to undelete a recipe. If the recipe is marked for purge, then this option 
is available.

Using the Recipe Properties Window
The Recipe Properties window displays information about the selected recipe. You can 
edit some fields on this window to edit the recipe. To use the Recipe Properties 
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window:

• Enter and save operations.

• Enter and save routings.

• Enter and save formulas.

• Enter and save recipes.

To display the Recipe Properties window:
1. Navigate to the Recipe Properties window:

• In the navigator, right-click the Recipe node, then choose Properties.

• In the navigator, click the recipe, then choose Properties from the Actions 
menu.

Recipe
2. The following fields are display only:

• Status displays the recipe status.

• Recipe displays the recipe and its Version.

3. Description displays the recipe description. You can edit this field.

4. Owner displays the recipe owner. You can edit this field.

5. Owner Organization displays the owner organization for the recipe. You can edit 
this field.

6. Creation Organization displays the organization that created the recipe.

7. Recipe Type displays:

• Master to indicate that the default recipe type is process cell specific. Master 
recipes define exactly how a product is made in a specific process 
manufacturing cell.

• Site to indicate that the default recipe type is at the site level. There is one site 
recipe for each site that makes the product, or some portion of the product. A 
site recipe has the same structure as a general recipe, but may be modified for 
the local language and unit of measure. It can also be modified to take into 
account local material availability, or it may only define a part of the general 
recipe that is actually performed on the site.
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• General to indicate that the default recipe type is one general recipe for each 
specific product variation made by a company. It defines, in an equipment 
independent manner, the material and process dependencies required to make 
a product. The general recipe is usually created during or after the pilot plant 
scaleup of a research and development recipe.

8. The Enhanced Process Instructions indicator is selected for a recipe that has 
processing instructions that are created and managed in the Oracle Manufacturing 
Execution System for Process Manufacturing application. Refer to the Oracle 
Manufacturing Execution System for Process Manufacturing User's Guide for additional 
information.

9. The Contiguous Indicator is selected for the recipe that has a routing associated to it
that must be run in one contiguous block of time. The batch that uses this routing 
cannot stop and start, even if it runs into downtime on the shop calendar.

Formula
10. The following fields are display only:

• Status displays the formula status.

• Formula displays the formula used in the recipe and its Version.

• Description displays a description of the formula.

• Total Output Quantity displays the total material yielded by the formula.

• Main Product displays the primary product for the formula associated with the 
recipe.

• Main Product Qty displays the quantity and UOM of the first product the 
formula produces.

Routing
11. Status displays the status of the routing used in the recipe.

12. Routing displays the routing used in the formula and its Version.

13. Description displays the routing description.

14. Planned Loss displays the planned material loss for the routing.

15. Theoretical Process Loss displays the theoretical process loss associated with the 
routing.

16. Click OK to close the window. If you edited recipe properties, then your changes 
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are validated and saved.

To display, edit, or delete the list of customers:
1. Click the Recipe tab on the Recipe Properties window.

2. Click Customers. The Customers property sheet displays.

3. Click Add to add a customer. Enter the customer and customer Name.

4. Click Delete to delete a customer.

5. Click OK to save your work.

To enter or edit process loss:
1. Click the Recipe tab on the Recipe Properties window.

2. Click Plant/Laboratory. The Process Loss property sheet displays.

• Enter the Organization. The Name displays the name of the organization.

• Type indicates whether this organization is a plant or a laboratory.

• Enter the Process Loss for the Organization entered.

• Click OK to save your work.

3. Click Add to add process loss for a specific organization.

4. Click Organization Details to display the Recipe Organization Details window.

5. Click Validity Rules to display validity rules to display the Recipe Validity Rules 
window.

6. Click Delete to delete process loss for a selected organization.

Finding a Recipe in the Recipe Designer
The Find Recipes window displays when you select the Recipe Designer option from 
the navigator. It also displays when you choose Open from the File menu. To use the 
Find Recipes window:

• Optionally, enter and save operations.

• Optionally, enter and save routings.
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• Enter and save formulas.

To find a recipe in the Recipe Designer:
1. Navigate to the Recipe Designer Find Recipes window.

2. Enter the appropriate search criteria to find the desired recipe.

3. Click Find. The lower region of the window displays recipes matching the entered 
criteria.

4. Select the appropriate recipe. The Recipe Designer displays with the selected recipe.

Creating a Recipe in the Recipe Designer
Click New on the Recipe Designer Find Recipes window, or select the New file option 
to create a new recipe. The Recipe Designer displays in the create mode. Navigate to the
Recipe Properties window to enter additional recipe details.

Using the Recipe Properties window, specify a formula and a routing marked for purge 
or with a status of On-hold or Obsolete. However, they cannot be modified and the 
recipe cannot be created with these components. Use the Save As option to create a new
formula and routing for the recipe. Refer to the "Copying a Recipe And Its 
Components" topic for additional information.

If the formula and routing specified in the Recipe Properties window do not exist, then 
the application assumes that you intend to create these components in the Recipe 
Designer.

Formula is a required component of a recipe. However, you can create a recipe without 
a routing.

To create recipes using the Recipe Designer:

• Enter and save operations.

• Enter and save routings.

• Enter and save formulas.

To create a recipe:
1. Select Recipe Designer from the navigator. The Find Recipes window displays.

2. Click New. The Recipe Designer displays with New as the root node.

To change recipe status:
The Change Status window displays when you choose one of these options from the 
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Actions menu:

• Change Recipe Status

• Change Routing Status

• Change Formula Status

1. Click the desired Recipe.

2. Choose Change Status from the Actions menu.

3. Enter the desired status for the recipe.

4. Click OK.

To view and edit recipe header information:
1. Click the desired Recipe.

2. Choose Properties from the Actions menu. You can also right-click the Recipe node 
and select Properties from the right-click menu. The Recipe Properties window 
displays.

3. Enter or edit the recipe header Description. When creating a new recipe, this 
defaults to the formula description. Required.

4. Owner defaults to the current user. This is validated against the user master table. 
Required.

5. Enter the Owner Organization. This defaults to the current user organization and is 
validated against the user organization table. Required.

Copying a Recipe and Its Components
When developing a new product, consider identifying an existing recipe with similar 
characteristics. Use this recipe as a template, and modify it to meet the specific new 
product requirements. Save the modified recipe.

To improve new product development efficiency and speed time to market, locate and 
load existing recipes as templates for promoting reuse of existing product definitions. 
The recipe and its material and process components that include formulas and routings,
can be modified to meet new product requirements and saved as new entities.

Choose Save As from the File menu and the Save As window displays. Specify the 
name, version, and description of the new recipe, routing, and formula. Once saved, the
new recipe, routing, and formula are current. Note that the primary purpose of this 
function is to copy the current recipe. This window can also be used to replace the 
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formula or routing in the current recipe.

To copy a recipe and its components:
When copying a recipe, formula, or routing, the status of the new record is set to New 
or to the predefined default status. If the recipe is not copied, but one of its component 
is, then the current recipe status is also set to New, because one of its components is 
copied and has a status of New.

1. Choose Save As from the File menu.

2. Select the copy indicators for the recipe, formula, and routing you are copying.

3. Click OK.

Using the Formula Tab
The Formula tab in the Recipe Designer displays information about the formula items:

• Item number

• Item description

• Item unit of measure

The Formula tab has three item properties windows:

• Ingredient Properties

• Product Properties

• Byproduct Properties

Using Formula Menu Options
The following options are available when you click the Formula tab:

Edit Process Instructions:
Choose this option to create and maintain processing instructions for a formula item. 
This option is enabled when an item node is selected in the navigator.

Edit Properties:
Choose this option to view or edit properties of the selected node in the navigator. You 
can edit formula header and formula item properties.
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QC Specifications:
Choose this option to view or edit production specifications for the formula. If changes 
are made to the formula, then the application displays a warning message prompting 
you to save the changes. If the save option is selected, then the standard Production 
Specifications window displays.

Change Formula Status:
Choose this option to change the status of the current formula. If changes are made to 
the recipe, then the application displays a warning message prompting you to save 
changes. If the save option is selected, then the standard Change Status window 
displays.

Ingredient Technical Parameter:
Choose this option to display the Technical Parameters window for the selected 
ingredient. If changes have been made to the formula, then the application displays a 
warning message prompting you to save the changes. If the save option is selected, then
the standard Ingredient Technical Parameters window displays.

Product Technical Parameters:
Choose this option to display the Technical Parameters window for the selected 
product. If changes are made to the formula, then the application displays a warning 
message prompting you to save the changes. If the save option is selected, then the 
standard Product Technical Parameters window displays.

List Engineering Items:
Choose this option to display the List Engineering Items window for the formula. If 
changes have been made to the formula, then the application displays a warning 
message prompting you to save changes. If the save option is selected, then the 
standard List Engineering Items window displays.

Technical Data Selection:
Choose this option to specify the formula number and version from where to get the 
intermediate's technical parameter values, or to specify the formula number and version
to use for the explosion of this intermediate during the formula ingredient contribution 
analysis calculation.

Scale Formula:
Choose this option to scale formulas up or down by input or output.

Calculate Theoretical Yield:
Choose this option to calculate theoretical yield.
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Calculate Product Quantity:
Choose this option to calculate formula product quantity automatically.

Assign Access:
Choose this option to assign formula security access.

E-Record Details:
Choose this option to view electronic signature details.

Creating a Formula in the Recipe Designer
When creating a new recipe, you can build a new formula within the Recipe Designer. If
the formula entered in the Recipe Properties window exists, then you can edit the 
formula in the Recipe Designer and choose Save As in the File menu to generate a new 
formula. You can also use an existing formula to serve as a template for the new 
formula.

If the formula entered in the Recipe Properties window does not exist, then there are 
several ways to create a formula in the designer.

• Click the Formula tab to access the Formula navigator. The Item Master list 
displays. You can build the formula by associating items using the drag-and-drop 
operation.

• Click the Recipe tab and choose the Item Master option to display the list of items. 
Choose the Step Dependency Graph tab. You can build the formula by associating 
items to the steps in the routing step dependency graph using the drag-and-drop 
operation.

• Click the Recipe tab to access the Recipe navigator. Select the Item Master view. 
You can build the formula by associating items to the steps in the Recipe navigator 
using the drag-and-drop operation.

Using the New Item window:
The Item Properties window displays when adding an item to the formula using one of 
the methods described above, provided the Display New Item Window user preference 
option is selected. See: Editing User Preferences, page 6-65.

You can enter basic item attributes in this window.

1. Click Edit Line to access the Ingredient, Product, or By Product Properties 
windows, depending on the type of item selected.

See the following topics:
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• Changing Formula Status, page 6-56

• Editing the Formula Header, page 6-56

• Editing Formulas in the Recipe Designer, page 6-57

• Using the Routing Tab, page 6-63

Changing Formula Status
The Change Status window displays when you choose one of the following from the 
Actions menu:

• Change Recipe Status

• Change Routing Status

• Change Formula Status

To change formula status:
1. Navigate to the Recipe Designer.

2. Click the Formula tab in the navigator.

3. Choose Change Status from the Actions menu.

4. Enter a new status.

5. Click OK.

Editing the Formula Header
Edit formula details in the Formula Properties window.

To edit the formula header:
1. Navigate to the Recipe Designer.

2. Select the formula node in the navigator.

3. Click Properties from the Actions menu, or right-click and choose Properties from 
the menu.

4. Select the Formula tab.
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5. Enter the Formula name.

6. Enter the formula Version.

7. Right-click the Formula node, and select Properties. The Formula Properties 
window displays.

8. Ensure that the Calculate Product Quantity checkbox is selected.

Note: When you select the Calculate Product Quantity checkbox 
the Percentage field is enabled for the products with a Proportional 
scale type. If scaling is not allowed on the formula, then the 
products are defaulted to the Fixed scale type, and their quantity is 
entered manually.

9. Click OK to save, or Cancel to close the window without saving.

Editing Formulas in the Recipe Designer
Click the Formula tab to edit formula specific data. The Formula navigator displays and
the following functions are available:

• Create and edit processing instructions at the formula item level

• Add and remove items

• Edit item properties

• Edit formula header properties

To view formula process instructions:
Process instructions defined at the formula item level establish the standard procedure 
to follow when processing a particular material. Instructions are usually process 
independent, but are not required to be. Process related instructions can be defined at 
the routing step level, the recipe step level, or the routing item level. Formula item 
process instructions display in the Formula Process Instruction Sheet tab, and also in 
the Recipe Process Instruction Sheet tab.

Access the current Process Instruction editor by selecting an item in the Formula 
navigator and choosing Edit Process Instructions from the Tools menu.

1. Navigate to the Recipe Designer.

2. Click the Formula tab in the navigator.

3. Click the Process Instruction Sheet tab in the right pane of the Recipe Designer.
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The Process Instruction Sheet tab displays item details in a hierarchical grid. If 
processing instructions are defined for an item, then you can expand the 
corresponding item to view the text.

All changes made to the formula in the designer are immediately displayed in the 
Formula Process Instruction Sheet.

To add an item to the formula:
The Item Master list is a component below the recipe and Formula navigator. It displays
items from the Item Master table and serves as the source for adding items to the 
formula. If the formula is in view mode, then the Item Master list is not available. Sort 
the list by item, description, UOM, and category by clicking the appropriate column 
heading in the item list.

1. Navigate to the Recipe Designer.

2. Display the Item Master list by clicking Show/Hide Formula Items on the toolbar, or
choose the Show Item List indicator from the View menu.

3. Choose Item Master in the lower region.

4. If the Item Code indicator is selected, then enter an item code, or part of an item 
code in the Find field. If the Category indicator is selected, then enter a Category 
Code, or part of a category code in the Find field.

5. Select the desired item in the list and associate it to the formula in the recipe, 
formula, or to a step in the routing dependency graph pane using the drag-and-
drop operation.

6. Drag and drop Items onto the Ingredients node in the formula tab. The New Item 
window displays for item entered onto the node.

7. Enter the Quantity for each ingredient and byproduct.

8. Click OK.

9. Drag and drop Items onto the Products node in the formula tab. The New Item 
window displays for item entered onto the node.

10. Enter the product details with a Percentage in which the product quantity is 
distributed between single and multiple products.

 The default is 100 percent for the first product. You can edit the percentage.

Note: When you add an item in the ingredients or products node 
the formula product quantity is calculated automatically.
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11. Click OK. The formula product quantity is calculated and updated on the Product 
node.

To remove an item from a formula:
If the item being removed is a product, then the application checks for validity rules 
associated to the product. If at least one valid validity rule exists, then an error message 
displays and the product cannot be deleted.

1. Navigate to the Recipe Designer.

2. Click the Formula tab in the navigator.

3. Expand the recipe to display the item to cut. Following are two methods for 
removing items:

• In the navigator, right-click the item node, then choose Cut.

• In the navigator, click the item node, then choose Cut from the Edit menu.

4. Save your work.

To display assigned and unassigned item components:
1. Navigate to the Recipe Designer.

2. Click the Recipe tab in the navigator.

3. Click Formula Items. A pane displays all items in the formula below the navigator.

4. Select one of the following to display assigned, unassigned, or both assigned and 
unassigned items:

• View Assigned to display only those items that are assigned to a routing step.

• View Unassigned to display only those items that are not yet assigned to a 
routing step.

• View Assigned/Unassigned to display all items that are assigned or not yet 
unassigned to a routing step.

To activate or disable automatic step calculation:
1. Navigate to the Recipe Designer.

2. Select the Calculate Step Quantities indicator on the toolbar. The following message
displays:
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Do you want to delete the current calculated step quantities? Y/N

• Click Yes to delete recipe step quantities from the database and Process 
Instruction Sheet. The sheet is updated with the default step quantities in the 
routing.

• Click No to retain the current calculated step quantities.

3. Clear the Calculate Step Quantities indicator to disable automatic step calculation.

To define material input and output for a step:
Note: Select Calculate Step Quantities to calculate quantities and 
number of charges for each step.

1. Navigate to the Recipe Designer.

2. Click the Recipe tab in the navigator.

3. Click Show/Hide Formula Items if the Formula Item pane does not display.

4. Select View Unassigned Items. The list of all items that are not assigned to a 
particular step displays.

5. Associate one or more items to a particular step by dragging the items in the 
Formula Item pane and dropping them onto a particular step either in the Step 
Dependency Graph or the navigator.

To redistribute formula items:
1. Navigate to the Recipe Designer.

2. Click the Recipe tab in the navigator.

3. Use one of the following techniques to redistribute an item:

• Drag the item in the navigator, and drop it onto a target routing step in the 
navigator, or in the Step Dependency graph.

• Click the item to redistribute. From the Edit menu, choose Cut. Then, select the 
target routing step in the navigator, or in the Step Dependency Graph. From the
Edit menu, choose Paste.

4. Optionally, select the Calculate Step Quantities indicator to calculate and display 
the step quantities and the number of charges on the Process Instruction Sheet pane.
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5. Save your work.

To edit ingredient properties:
You can access the Ingredient Properties window from the Formula tab. You can also 
display ingredient properties from the New Item window that displays when adding a 
new ingredient to the formula.

1. Navigate to the Recipe Designer.

2. Select the Ingredient node in the navigator.

Note: You can edit the quantity of any ingredient, and byproduct 
or change the percentage value of the product using the properties 
window to recalculate the formula product quantity. 

3. Choose Properties from the Actions menu to display the Ingredient Properties 
window, or right-click an ingredient node in the recipe Formula navigator, and 
choose Properties from the right-click menu.

4. Edit the Quantity of the desired ingredient or byproduct in the formula.

5. Click OK to recalculate formula product quantity, or Cancel to close the window 
without saving.

Important: Refer to the discussion of ingredients on the Recipe 
Details window for details.

To edit product properties:
You can access the Product Properties window from the Recipe navigator or from the 
Formula navigator. You can also display product properties from the New Item 
window that displays when adding a new product to the formula.

1. Navigate to the Recipe Designer.

2. Select the Product node in the navigator.

3. Choose Properties from the Actions menu to display the Product Properties 
window, or right-click an ingredient node in the Recipe navigator or in the Formula
navigator, and choose Properties from the right-click menu.

4. Change the Percentage of the desired product in the formula.

5. Click OK to recalculate formula product quantity, or Cancel to close the window 
without saving.
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Important: Refer to the discussion of products on the Recipe Details
window for details.

To edit byproduct properties:
The By Product Properties window is accessible from the Recipe navigator or from the 
Formula navigator. You can also display byproduct properties from the New Item 
window that displays when adding a new byproduct to the formula.

1. Navigate to the Recipe Designer.

2. Select the By Product node in the navigator.

3. Choose Properties from the Actions menu to display the By Product Properties 
window, or right-click an ingredient node in the Recipe navigator or in the Formula
navigator, and choose Properties from the right-click menu.

4. Edit the By Product Properties fields and click OK to save, or Cancel to close the 
window without saving.

To enter formulas for item technical dataa:
Specify the formula to use in the item technical data calculation, and in formula 
analysis. 

1. Navigate to the Recipe Designer.

2. Click the Formula tab and select the appropriate intermediate ingredient in the 
Formula navigator.

3. Choose Technical Data Selection from the Actions menu. Prior to displaying this 
window, the application verifies that the selected ingredient is an intermediate.

4. Click the Ingredient Contribution tab.

5. Enter the Technical Formula. This is the formula used by the laboratory spreadsheet
to derive technical values.

6. Enter the formula Version.

7. Click the Technical tab.

8. Enter the Contribution Formula. This is the formula used by formula analysis to 
derive indirect ingredient contribution.

9. Enter the formula Version.
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10. Click OK to save your work.

Using the Routing Tab
Click the Recipe Designer Routing tab to view routing components.

To create or edit routing properties:
While creating a new recipe within the Recipe Designer, you can build a new routing. 
An existing routing can also be used as a template for a new routing.

Click the Routing tab to edit and create routings. The Routing navigator displays and 
the following functions are available:

• Create and edit processing instructions at the routing step level.

• Add and remove steps.

• Edit step properties.

• Edit routing header properties.

1. Navigate to the Recipe Designer.

2. Select the Routing node in the navigator.

3. Choose Properties from the Tools menu to display the Routing Properties window.

4. Enter routing header information and click OK to save.

To add a new operation step:
The Operation List displays all operations. It serves as the source for adding new 
operations to a routing. This list is not available when the routing is in view mode.

1. Click Show/Hide Operation Master to display the operation list.

2. Select an operation from the list and associate it to the routing in the navigator or in 
the Routing Dependency Graph pane. When adding a step to the routing, the 
application validates the operation and displays the Operation Step Properties 
window. Review or override the default values in this window.

3. Save your work.

Using the Process Instruction Sheet
The Process Instruction Sheet pane is a view only user interface that displays on the 
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right side of the Recipe Designer. It is a hierarchical grid that combines the details of the
three main components of the recipe: routing steps, the formula items associated to the 
steps, and the process instructions. The Process Instruction Sheet updates automatically,
and instantaneously reflects any changes that you make.

Standard process instructions are defined at the routing step level and at the formula 
item level. These instructions are generic and apply to any recipes that use the routing 
and the formula. These standard instructions are shown in the Process Instruction 
Sheet, but cannot be amended in the recipe.

The standard process instructions maintained at item level in the formula display under
the item line. Show or hide process instructions by expanding or collapsing the 
corresponding item line. The process instructions defined at the step and item 
association level for the selected recipe are displayed. The process instructions defined 
at the recipe level appear with a yellow background to distinguish between standard 
instructions defined at the formula level, and the specific instructions defined at the 
recipe level.

To define process instructions that are specific to a particular recipe, use the Edit 
Process Instruction window.

Process instructions are defined at two separate levels within a recipe:

• At the routing step level with instructions that need to be considered at a specific 
stage in the process.

• At the routing step and item level with instructions that are specific to the 
processing of a specific item at a particular stage in the process.

To create or edit process instructions:
1. Use one of these methods to display the Edit Process Instructions window:

• In the navigator, right-click the appropriate item line for a product, ingredient, 
byproduct, or routing step, then choose Edit Text.

• In the navigator, click the appropriate item line for a product, ingredient, 
byproduct, or routing step, then choose Edit Text from the Tools menu.

2. Enter or edit text.

3. Click OK.

4. Save your work.

To add text tokens to process instructions:
1. Use one of these methods to display the Edit Process Instructions window:
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• In the navigator, right-click the appropriate item line for a product, ingredient, 
byproduct, or routing step, then choose Edit Text.

• In the navigator, click the appropriate item line for a product, ingredient, 
byproduct, or routing step, then choose Edit Text from the Tools menu.

2. Click Find.

3. Select the appropriate text tokens.

4. Click OK. The full text for the text token displays in the Process Instructions 
window.

5. Save your work.

Expanding and Collapsing Nodes
You can expand all nodes to view the entire recipe structure in the navigator. This 
feature is also available in the Routing and Formula navigators. The following options 
can be selected from the Tools menu to expand or collapse a selected node or the entire 
navigator with just one click.

Right-click a node in the navigator and choose one of the following options from the 
right-click menu:

• Expand to expand the selected node and subnodes.

• Collapse to collapse the selected node and subnodes.

• Expand All to expand the entire navigator.

• Collapse All to collapse the entire navigator.

Editing User Preferences
Use the Preferences window to maintain preferences related to the formula. Formula 
preferences are used to customize the behavior of the application when the following 
actions are performed:

• Add a new item to the formula

• Search an item in the Item Master list

To edit preferences:
1. Navigate to the Recipe Designer.
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2. Choose Preferences from the Actions menu.

Formula
3. Select the Display New Item Window to display the New Item window when 

adding a new item. This prompts you to review and override the default item 
attributes. Clear this box to review and edit default values later using the Item 
Properties window.

4. Enter a Category Set to display on the Item Master list, otherwise leave this field 
blank.

Routing
5. Select one of the following:

• Display Step Properties Window to display the Step Properties window when 
you add a new step.

• Generate Step Number Automatically to generate a step number automatically 
when you add a new step.

6. Select one of the following:

• Display Step Properties Window to display the Step Properties window when 
you create a new step dependency.

• Generate Default Attributes to generate the default step attributes when 
creating a step dependency. Select the Dependency Type as Finish-to-start or 
Start-to-start.

Step Dependency Graph
7. Select Display Step Quantity to display the quantity of each step. Clear this box to 

hide step quantities.

8. Select Display Transfer Percentage to display the transfer percentages between 
steps. Clear this box to hide transfer percentages between steps.

Process Instructions
9. Language displays the default language. You can edit this field. Description 

displays a description of the Language code.

10. Click OK.



Tools    7-1

7
Tools

This chapter covers the following topics:

• Search and Replace Features

• Understanding Mass Search and Replace

• Performing a Mass Search and Replace

• Managing Item Substitutions in Formulas

• Creating and Approving Item Substitution Lists

• Finding Formulas for Item Substitutions

• Finding Item Substitution Lists

• Finding Formula Substitution Lists

• Item Substitution Status Change Approval Workflow

Search and Replace Features
• Mass Search and Replace

Process Manufacturing Product Development enables you to perform a mass search
and replace for ingredients in formulas. The Mass Search and Replace window 
enables the identification and replacement of key components in formulas, routings,
operations, recipes, and validity rules for single or multiple organizations. This 
permits the query for fundamental components such as the name, version, 
description, owner, and status. Advanced search and replace features facilitate the 
search and replacement of components using conditions and specific values in 
formulas, routings, operations, recipes, and validity rules.

• Change Management Control

Mass Search and Replace supports change management control by enabling status 
and version updates. As part of change management control, mass search and 
replace enables rapid component substitution while supporting status and version 
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control updates for each formula, recipe, routing, operation, or validity rule affected
by the substitution.

• Formula Ingredient Substitution

Formula ingredient substitution is a critical business need for process industries to 
meet stringent product specifications during batch production. The tool enables 
rapid identification and replacement of approved ingredient substitutions

Ingredients are replaced for various business reasons such as obsolescence, 
customizations, pricing, or regulatory compliance. Mass search and replace takes 
into account the affected formula and status in order to recalculate step quantities, 
technical parameters, and formula contribution by class and subclass. As part of 
change management control, this tool assists in the management of status and 
version for each changed component.

• Item Substitutions by Date

Date-driven item substitutions are supported. Create a date-specific list of 
replacement items for raw materials, intermediate items, or packaging components. 
A common reason for use of item substitution is use of a new or updated packaging
component or informational insert.

• Item Substitution Status Change Approval Workflow

Formulators define item substitutions to a prescribed list of alternative item 
replacements. Use the Item Substitution Status Change Approval Workflow to 
approve a list of substitute items with specified start and substitution effective 
dates. Associate formulas to the list to manage this date-specific list of replacement 
items. The new or updated packaging component or insert is substituted during the
effective date range.

Understanding Mass Search and Replace
Use the Mass Search and Replace window to search for and replace records in:

• Operations

• Routings

• Formulas

• Recipes

• Validity Rules

The Find list enables you to select the target for the search, such as an operation or a 
routing. You can only search for one target at a time. The Basic and Advanced search 
regions let you specify conditions to narrow the search. Once you have selected a target,
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and initiated a search, clear the window before searching for a new target.

Using the Basic Search Region
Use the Basic search region to specify any combination of Name, Version, Description, 
Organization, Owner, or Status. Enter specific search data, or use the wildcard % for 
search string matching.

For example, if you search for:

Owner JDOE (as User ID)

Name A%

The results contain all entries where the Owner is JDOE and that start with the letter A.

Using the Advanced Search Region
Use the Advanced search region to specify conditions to narrow the search for one or 
more Item field entries. Specify different conditions for each search target.

Specifying the Item Field in an Advanced Search
• For Operations you can specify search conditions for:

• Activity

• End Date

• Operation Class

• Operation

• Operation Version

• Resource

• Start Date

• Status

• For Routings you can specify search conditions for:

• End Date

• Operation

• Owner

• Routing Class
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• Routing

• Routing Version

• Start Date

• Status

• For Formulas you can specify search conditions for:

• Byproduct

• Formula Class

• Formula

• Formula Version

• Ingredient

• Owner

• Product

• Status

• For Recipes you can specify search conditions for:

• Formula

• Owner

• Owner Organization

• Recipe

• Recipe Version

• Routing

• Status

• For Validity Rules you can specify search conditions for:

• Validity Rule Status

• Validity Rule Orgn
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• Maximum Qty

• Minimum Qty

• Planned Process Loss

• Preference

• Product

• Recipe Use

• Start Date

• End Date

• Status

• Standard Qty

Specifying the Condition Field in an Advanced Search
In an advanced search of operations, routings, formulas, recipes, or validity rules, select
any of the following conditions for items entered:

• Equal To finds targets equal to the specified Value entered.

• Greater Than finds targets greater than the specified Value entered.

• Less Than finds targets less than the specified Value entered.

• Greater Than or Equal To finds targets greater than or equal to the specified Value 
entered.

• Less Than or Equal To finds targets less than or equal to the specified Value 
entered.

• In finds targets that contain the information specified.

For example, if you specify the Item as Owner, select the Condition In, and enter 
JDOE as the Value, the application finds all targets whose owners are JDOE. 
Separate each Value entry with a comma.

For example, if you specify the Item as Product, select the Condition In, and enter 
FORMULA 101,ROUTING 100 the application finds each target product that 
contains the entries specified.

• Not In finds targets that do not contain the information specified.
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For example, if you specify the Item as Owner, select the Condition Not In, and 
enter JDOE as the Value, you find all targets whose owners are not JDOE. Separate 
each Value entry with a comma.

For example, if you specify the Item as Product, select the Condition Not In, and 
enter FORMULA 101,ROUTING 100 the application finds each target product that 
does not contain entries specified.

• Like finds targets similar to the information specified using the wildcard %.

For example, if you specify the Item as Product, select the Condition Like, and enter
FORM% the application finds each target Product that contains entries with the 
letters FORM.

Mass Search and Replace Security
Your System Administrator sets up the Mass Search and Replace function security. 
When functions are registered for the appropriate responsibility, two parameters are 
passed with the following settings:

• Enable_status=No disables the ability to make a change of status using Mass Search 
and Replace. If you cannot change status, then contact your System Administrator. 
The default is Yes.

• Enable_replace=No disables the replace capability. If you cannot use the replace 
capability, then contact your System Administrator. The default is Yes.

Default Status Rules Applied to New Versions
When new versions of operations, routings, formulas, recipes, and validity rules are 
created during the Mass Search and Replace process, the default status is assigned 
according to the status set up for default configuration rules. If a new formula is 
created, then a new recipe is also created if the recipe configuration rules are set up for 
the formula owner organization.

Performing a Mass Search and Replace
Use the Mass Search and Replace window to search for and replace components in 
recipes, formulas, operations, routings, and validity rules.

You cannot replace components in recipes, formulas, operations, routings, or validity 
rules that have a status of obsolete/archived, approved for general use, or on hold. If 
you attempt to replace any components in these entities, then a message displays 
indicating that you can only change the status. You can search for recipes, formulas, 
operations, routings, or validity rules that are obsolete/archived or on hold. The Update 
indicator is cleared for these entities. If you attempt to select the Update indicator, then 
a message displays that indicates you can only update the status. Click the Replace tab, 
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choose Status, and select the Update indicator.

You cannot replace components in recipes, formulas, operations, routings, or validity 
rules with a status of pending. If workflow, e-records, and e-signatures are enabled, and
a status is changed through mass search and replace, then the entity changes to a 
pending status. You cannot update an entity with a pending status until it is approved. 
Go to the advanced worklist to approve a pending status through Oracle Workflow or 
Oracle E-Records, and respond to the notification. If you attempt to replace any 
components for such entities, then you receive a message.

To perform a mass search and replace:

• Determine if your responsibility can use the Mass Search and Replace function.

• See: Understanding Mass Search and Replace, page 7-2.

Note: To replace the specification and validity rules for specs using the 
Mass Search and Replace functionality, select the Quality Manager 
responsibility.

Important: Upon entering the Mass Search and Replace window, the 
context organization is used to filter for process-enabled items. You can
also search across organizations by leaving the Organization field 
blank.

To search for and replace components:
1. Navigate to the Mass Search and Replace window.

2. Select Formulas, Operations, Recipes, Routings, or Validity Rules from the Find list 
to specify the type of records to search for and replace.

Additional Information: If you select Formulas, then you can enter 
Validity Rule Criteria for Start Date, End Date, Recipe Use, and 
Status. You can also search for global validity rules.

Additional Information: If you select Validity Rules, then you can 
enter the Effective Dates for the validity rule. You can also enter the
Standard quantity and the Minimum and Maximum quantities that
the validity rule covers.

Note: Use the Basic and Advanced regions to specify the search 
criteria.
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3. Enter one or more of the search parameters. It is not necessary to enter them all. 
You can use string search matching by entering % as wildcard.

Basic
4. Enter the Name of the record type to search and replace.

5. Enter the Version number of the record type to search and replace.

6. Enter the Description of the record type to search and replace.

7. Enter the Organization of the record type to search and replace. Search across 
organizations by leaving this field blank.

8. Enter the Owner of the record type to search and replace.

9. Select a Status of the record type to search and replace.

10. Click Find to search for all records that match the Basic search criteria. If you do 
this, then proceed to step 12, or click the Advanced region to enter additional search
criteria. If you do this, then proceed to step 11.

Advanced
11. Enter an Item, Condition, and Value to specify a condition for the search. For 

example, to search for all formulas with a version of 1, select Formula Version as the
Item, Equal To as the Condition, and enter a Value of 1.

12. Click Find to search for all records that match Basic and Advanced search criteria. 
The Results of the search display. If results are not found, then you cannot use 
GoTo or Replace. To review the details for each record found perform one of the 
following:

• Double-click the drill down indicator next to the appropriate Name.

• Select the appropriate Name and click Go To.

Return to the Product Development Search and Replace window to continue.

Additional Information: You cannot use the Replace capability 
unless you have proper authorization. Contact your system 
Administrator if you have questions regarding this authorization.

Replace
13. Click the Replace region.

14. Select the component to replace from the Replace list. Enter the Old component 
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Name and, if required, its Version.

15. Enter the New component Name to replace in selected Results. Enter a new Version
if required. If the component being replaced is a formula, then enter an appropriate 
Scale Factor. You can replace ingredients using a scale factor greater than zero. 
However, you cannot replace ingredients using a negative scale factor.

16. Select the Update indicator next to each Name to replace with the entry made in the
new Name field. To update the entire list, choose Select All from the Actions menu. 
To clear all selections, choose Deselect All from the Actions menu.

17. Click Replace to perform the specified changes. The message "Are you sure you 
want to replace this?" displays:

• Click Yes to proceed with replacement of the selected records with the New 
Name field.

• Click No to cancel replacement of the selected records with the New Name 
field.

If automatic version control is active, then the message "Create new version?" 
displays.

18. Enter Yes to indicate that you want to create a new version, or enter No to keep the 
same version. If records are not found that meet the replace criteria, then the 
message "No records were found that meet the replace criteria." displays.

19. Note the Request ID number.

20. Choose View from the menu.

21. Choose Requests to view the status of your request in the concurrent program 
manager.

22. Select View Log to determine if there were any problems after your Request ID 
completes normally. The log displays all successful and failed updates, and it 
indicates if no records were found for the replacement operation.

Managing Item Substitutions in Formulas
Availability or date-driven item substitutions are often required in the manufacturing 
process. Formulators define item substitutions in a prescribed list of alternative item 
replacements with usage managed either by defined start and stop dates or by a lack of 
original item availability. The item substitution list is approved through the Item 
Substitution Status Change Approval Workflow with separate version and status 
control. Following summarizes the process to create and approve the item substitution 
list: 
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1. Create an item substitution list to specify an original formula item and its 
substitute, with the substitution based either on substitution validity dates or on the
original formula item's availability.

2. Associate one or more formulas to this item substitution list.

3. Optionally, use the Find Formula feature to select the list of formulas to associate to 
the item substitution list.

4. Associate any formula you have privileges to access except those with a status of 
Obsolete/Archived.

5. Apply for a change of status for this item substitution list to start the approval 
workflow that obtains e-signature approvals. Acquisition of the e-signature 
finalizes the item substitution list setup. When the list is approved, the item 
substitution becomes effective in the Oracle Process Manufacturing (OPM) 
Planning, Costing and Process Execution applications where the substituted item is 
referenced. The item substitution list cannot be used by a formula unless it has an 
Approved for General Use status.

Understanding Item Substitutions
Companies use item substitutions to manage an availability or date-specific list of 
replacement items. This includes raw materials, intermediate items, or packaging 
components. For example, a product formulator can create a standard formula and 
include a label as one of the packaging ingredients. As special promotions expire, the 
labels need to change. Rather than changing the formula each time a label change is 
required, item substitution lists are created with start dates and end dates so a specific 
label is assigned to a specific date range. Alternatively, define an availability-based 
substitute label for use only when original label supplies are exhausted. Planning and 
production have visibility to the item substitution list.

Associating Formulas to the Item Substitution List
After setting up and approving an item substitution list, associate formulas to each list 
created. Click Associate Formulas on the Item Substitution List window, and select each
formula to use from the LOV or click Find Formula.

Approving Item Substitution Lists
Use Change Status to approve, audit, and manage changes made to an item substitution
list. The default status is set to New. Other available statuses are:

• Approved for General Use

• Obsolete/Archived
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If you decide to select Approved for General Use and the e-signature workflow is 
activated, then the electronic record described in "Item Substitution Status Change 
Approval Workflow" displays. The list status is set to Pending for Approved General 
Use until all e-signature approvals are collected. When the approval of the item 
substitution list is complete, the associate list of formulas and the original formula item 
line substitution effective date are set. The item substitution list cannot be used by a 
formula unless it is approved for general use.

Understanding the Replacement UOM Source
For example, substitution of SACCHARIN with ASPARTAME requires an analysis to 
determine use of the original or replacement UOM. Select the appropriate Replacement 
UOM Source on the Item Substitution List window. Select Original Item to maintain the
original UOM, or select Replacement Item to use the UOM of the substitution item.

Calculating the Replacement Quantity
The Replacement Qty field represents the quantity relationship of the replacement item 
to its original item. For example, one pound of original item SACCHARIN has a 
primary UOM of kg. It can be replaced by 0.6 kg of ASPARTAME. Therefore, enter 0.6 
as the Replacement Qty.

Example Calculation of Replacement Quantity 

When you substitute an item, the substitute quantity is based on the original unit 
quantity expressed in its primary UOM as displayed on the Item Substitution List 
window.

Here is an example:
1 unit quantity of master item = 0.6 units replacement item quantity

If the quantity of master item is 100 kg, then

Replacement Qty = 0.6 * 100 kg

                = 60 kg ASPARTAME

Use 60 kg ASPARTAME as a substitution for 100 kg SACCHARIN.

Versioning Item Substitution Lists
Set the Version Control parameter to Yes, No, or Optional. When this parameter is set 
to:

• Yes, and an approved item substitution list is updated, then a new version of the list
is generated each time a change is made.

• No, and an approved item substitution list is updated, then a version change is not 
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made.

• Optional, and an approved item substitution list is updated, then you can change 
the version. Change the existing version prior to saving the item substitution list.

Accessing Formula Substitution Lists from the Formula Details Window
Access the Formula Substitution List window from the Actions menu on the Formula 
Details window. Substituted items display in the Substitution Effective Date field on 
that window.

Understanding the Effective Item in Other Applications
Once an item substitution becomes part of a formula, the OPM Planning, Costing, and 
Process Execution applications access the substitution as the active, effective item, either
while the original item is unavailable or for the defined date range, depending upon 
whether the item substitution is availability or date-based. If an item substitution affects
the quality specifications required for a batch, then there are utilities to change the 
specification association for a sample during sample creation or specification 
comparison in the OPM Quality Management application.

Creating and Approving Item Substitution Lists
Use the Item Substitution List window to create a list of formulas that you set up for 
availability-based or date-based item substitutions. For date-based item substitutions, 
the substitutions occur based on dates you enter to start and stop the item substitution. 

To create item substitution lists:

• Create and approve formulas.

• Optionally, set up the Item Substitution Status Change Approval Workflow.

To create an item substitution list:
1. Enter the Name of the item substitution list. Required.

2. Enter the Version number of the item substitution list. The default is 1. Required.

3. Enter a Description of the item substitution list. Required.

4. Status is restricted to:

• New for a new list that requires approval. Default.

• Approved for General Use for an approved list name and version.
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• Obsolete/Archived for a list no longer approved for general use.

5. Choose Change Status from the Actions menu to initiate the Item Substitution 
Status Change Approval Workflow after entering all required fields.

6. Enter Original Item as the original item to substitute using this list.

7. Description is the description for the item entered on the Item Master.

8. Enter Qty as the quantity of the original item to use when compared to the 
Replacement Qty in a formula.

9. Item UOM is the original item's primary UOM entered on the Item Master.

10. Owner Organization is the default organization code. Required.

11. Enter Preference as the desirability assigned to this list. A value of 1 is the most 
desirable list, followed by 2, 3, 4 and so on. If substitution lists have overlapping 
effective date periods, then the list with the lowest number in this field is used. The 
Preference field is always unique within a given date range. Required.

12. Enter Replacement UOM Source as:

• Original to maintain the original item UOM (Default).

• Replacement to use the substitution item UOM.

13. Select the Substitution Type:

• Date Based Substitution (default), to substitute the item based on the date range
entered.

• Availability Based Substitution, to substitute the item if the quantity needed for 
the original item exceeds the quantity available.

To enter valid dates if the Date Based Substitution Type is selected
These date fields only appear when a Substitution Type of Date Based Substitution 
is selected.

1. Enter Valid From Date as the approved starting date and time for the item 
substitution list. This is the beginning of the period for which the item 
substitution is effective, and defaults to the system date. Required.

2. Enter Valid To Date as the approved ending date and time for the item 
substitution list. If a date is not entered, then this is an open-ended item 
substitution list. If the system date is greater than the last entry for this field, 
then the original item in the formula is used for subsequent batches.
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14. Enter Item as the replacement item. The Description defaults from the Item Master.

15. Enter Replacement Qty as the quantity relationship of the replacement item to its 
original item. See: Calculating the Replacement Quantity in Managing Item 
Substitutions in Formulas, page 7-9.

16. UOM defaults to the primary unit of measure for the replacement item. If a UOM 
conversion exists on the Item Master between the new UOM entered and the 
primary UOM for the replacement item, then change this field.

17. Enter Formula as the formula to associate to this item substitution list, or use the 
Find Formula window to enter formulas as described in the task that follows this 
procedure.

18. Enter Version as the formula version to associate to this item substitution list.

19. Description is a brief description of the formula as entered on the Formula Details 
window.

20. Status is the status of the formula association. The status displays New until the 
status of the completed list is obtained.

21. Item Substitution Effective Date is the date on which the first substitution becomes 
effective in the associate formula. This date is derived by the application.

To find formulas for item substitution lists:
See: Finding Formulas for Item Substitutions, page 7-14.

To change the status of the item substitution list:
1. Choose Change Status from the Actions menu.

2. Choose one of the following:

• Approved for General Use to approve the item substitution list for general use.

• Obsolete/Archived to obsolete an existing item substitution list.

3. Click OK.

See: Managing Item Substitutions in Formulas, page 7-9.

Finding Formulas for Item Substitutions
Use the Find Formulas window to select formulas you have entered and saved, for item 
substitutions.



Tools    7-15

To find formulas for an item substitution:
1. Navigate to the Item Substitution List window.

2. Enter all required fields. See: Creating and Approving Item Substitution Lists, page 
7-12.

3. Click Associate Formulas.

4. Click Find Formula to navigate to the Find Formula window.

5. Enter as many parameters as needed to filter formula search results:

• Enter search parameters in the Basic region for Formula Name, Version, 
Description, Class, Product, or Item.

• Enter Start Date, End Date, Recipe Use, Organization, and Validity Status.

• Enter search parameters in the Advanced region to enter a specific Item, 
Condition, or Value.

6. Click Find.

7. Review the results of the search.

8. Select the formulas for use with this item substitution list.

9. Click OK to display the Associate Formulas window.

Finding Item Substitution Lists
The Find Item Substitution List window retrieves substitution lists you have entered 
and saved based on a set of criteria you enter. Narrow the search based on a variety of 
factors, such as list status, original and replacement item, and substitution type.

To find an item substitution list:
1. Navigate to the Find Item Substitution Lists window.

2. Enter any of the following criteria to narrow your search:

• Status is restricted to New for a new list that still requires approval, Approved 
for General Use for an approved list name and version, and Obsolete/Archived 
for a list no longer approved for general use.

• Original Ingredient is the original item to substitute using this list.
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• Replacement Item is the item that replaces the original item.

• Name is the name of the item substitution list.

• Version is the version of the item substitution list.

• Description is a description of the item substitution list.

• Substitution Type is either Availability Based Substitution or Date Based 
Substitution.

• Valid From Date is the approved starting date and time for the item 
substitution list. This is the beginning of the period for which the item 
substitution is effective, and defaults to the system date.

• Valid End Date is the approved ending date and time for the item substitution 
list. If a date is not entered, then this is an open-ended item substitution list.

• Preference is the desirability assigned to this list. A value of 1 is the most 
desirable, followed by 2, 3, 4 and so on. If substitution lists have overlapping 
effective date periods, then the list with the lowest number in this field is used. 
The Preference field is always unique within a given date range.

3. Click Find.

To clear the Find Item Substitution List window:
Click Clear to clear the item substitution list. The Original Ingredient continues to 
display.

Finding Formula Substitution Lists
The Formula Substitution Lists window displays all substitution lists you have created, 
approved and associated to a formula item in the Formula Details window. The 
substitution list details are display only, and cannot be modified, overridden, or deleted
on this window.

To display formula substitutions from the Formula Details window:
1. Navigate to the Formula Details window.

2. Select an ingredient line with effective date for item substitution.

3. Choose Substitution Lists from the Tools menu.

4. The following fields are display only on the Formula Substitution Lists window:
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• Ingredient is the original item to substitute using this list.

• Description is a description of the original item as entered on the Item Master.

• Name is the name of the item substitution list.

• Version is the version of the item substitution list.

• Description is the description of the substitution list.

• Status is status of the item substitution list.

• Preference is the desirability assigned to this list. A value of 1 is the most 
desirable, followed by 2, 3, 4 and so on. If substitution lists have overlapping 
effective date periods, then the list with the lowest number in this field is used. 
The Preference field is always unique within a given date range.

• Organization is the default organization code.

• Original Qty the quantity of the original item to use when compared to the 
Replacement Qty in a formula.

• Replacement Uom Type is either Original (the original item's UOM) or 
Replacement (the replacement item's UOM).

• Valid From is the approved starting date and time for the item substitution list. 
This is the beginning of the period for which the item substitution is effective, 
and defaults to the system date.

• Valid To is the approved ending date and time for the item substitution list. If a 
date is not entered, then this is an open-ended item substitution list.

• Replacement Item is the replacement item for the original item.

• Description is the description of the replacement item.

• Unit Qty is the quantity relationship of the replacement item to its original item.
See: Calculating the Replacement Quantity in Managing Item Substitutions in 
Formulas, page 7-9.

• Uom is the primary UOM for the replacement item.

To display an item substitution list:
1. Click the desired Name of the item substitution list.

2. Click Details.
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Item Substitution Status Change Approval Workflow
The Oracle Process Manufacturing (OPM) Product Development Item Substitution 
Status Change Approval Workflow notifies the workflow recipient that an item 
substitution list was created and requires approval for general use or approval to make 
obsolete or archived. The item substitution list cannot be used with its associate 
formulas unless it has a status of Approved for General Use.

Refer to the Oracle E-Records Implementation Guide to set up the following:

• Set up approvals in the Approvals Management Application Administrator 
responsibility.

• Set up the business event in Workflow Administrator Web Applications.

• Optionally, set up the ERES Administrator configuration variables to require e-
record and e-signature.

Setting up GMD ERES Item Substitution Status Change Approval Event
When you request a status change to Approved for General Use or Obsolete/Archived, 
this business event is triggered for an item substitution.

Following summarizes the subscription for the oracle.apps.gmd.itemsub.sts business 
event:

Field Value

Event Name oracle.apps.gmd.itemsub.sts

Display Name GMD ERES Item Substitution Status Change 
Approval

Owner Name Product Development

Owner Tag GMD

Description Item Substitution Status Change Approval

E-record for Item Substitution Lists
The workflow sends a notification to the contact person to approve the item 
substitution list. The e-record event can be set to run ON-LINE or in DEFERRED mode.
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• Changes to substitution status on the Item Substitution Lists window usually run in
the ON-LINE mode. After approval, control returns to the original setup window 
with the status set to Approved for General Use.

• Use the Change Status API to approve the e-record in the DEFERRED mode.

The body of the notification for the Item Substitution Status Change Approval 
transaction follows:
Substitution Name: Substitution 455-1234

Version: 2

Description: Substitution for Item 455-1234

Original Item: 455-1234

Description: Original Item Used

Original Item Qty: 1.0000

Original Item UOM: KG

Substitution Type: Date Based Substitution

Valid From Date: 11-Feb-2005

Valid To Date:   28-FEB-2005

Preference: 1

New Status: Approved for General Use

Item Substitution Descriptions:

================================================================

Language     Description

================================================================

US           Item 455-1234 - English

F            Item 455-1234 - French

ESP          Item 455-1234 - Spanish

Replacement Item

================================================================

Item          Description      Unit Quantity     UOM

================================================================

421-999E      Ing. 421-999      2                LB
================================================================

Associated Formulas

================================================================

Formula       Version         Description

================================================================

Formula 1     190.0           Formula 1 Description

Formula 2     290.0           Formula 2 Description

=================================================================
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8
Least Cost Formulation

This chapter provides a basic understanding of least cost formulation. It includes 
information on using the formulation specification workbench, entering a new 
formulation specification, and a new requirement. Material, compositional, and 
technical requirements are discussed, and use of the formulation specification summary
is presented. You are shown how to generate and optimize a formula.

This chapter covers the following topics:

• Requirements

• Understanding Least Cost Formulation

• Using the Formulation Specification Workbench

• Entering a New Formulation Specification

• Entering a New Requirement

• Entering Material Requirements

• Entering Compositional Requirements

• Entering Technical Requirements

• Displaying the Formulation Specification Summary

• Generating and Optimizing a Formulation

• Creating a Least Cost Formula or Batch in the Simulator

• Using Least Cost Formulation

Requirements
Following are some requirements that customers have for least cost formulation in 
Product Development:
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Can the application formulate to a product specification?
Yes. A formulator can enter a complete product specification that represents target 
properties of a product that must be met as part of the least cost formulation. Individual
ingredient requirements are listed that define the specific requirements such as 
minimum and maximum ingredient quantities allowable.

Use the New Formulation Specification Window to Define the Product Specification

The New Formulation Specification window lets you define targets for each product, 
including technical parameters, formulation specifications, and the minimum and 
maximum physical quantities of an item or item group. You can define the effective 
dates for this specification.

Can formulas generated for least cost maintain the product formulation requirements?
Yes. The application processes the minimum and maximum ingredient requirements to 
deliver a formulation that meets product specifications while targeting the lowest 
possible cost.

View Material, Compositional, and Technical Requirements to Evaluate a Proposed 
Least Cost Formulation

The application generates least cost formulas that meet the requirements defined within
the product specification. You can display the material, compositional, and technical 
requirements for the proposed formulation.

Is there a method to generate least cost batches from a formula with the lowest cost?
Yes. Generate a least cost batch that meets the product specification from a formulation 
with the lowest cost.

Generate Least Cost Batches

Validity rule windows display the least cost validity rule at the beginning of lists. You 
can create batches using one of these validity rules.

Can a batch be created without a formula?
Yes. Generate a batch without predefined formulas. The application models the percent 
composition of ingredients from the set of predefined parameters entered. Use this 
model formulation to create a batch without prior creation and approval of a formula.

Generate a Batch Directly from the Generate/Optimize Formulation Window

Use the Material View of the Generate/Optimize Formulation window to display least 
cost formulation results. Then click OK to navigate to the Simulator where you can 
create the batch.
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Can the application retrieve standard, actual, and lot costs as part of the optimized 
formulation?

Yes. You can specify which costs to use in the optimization equation. You can recall the 
standard, actual, and lot costs for the optimized formulation. You can compare costs of 
the standard formula to the proposed least cost formula, and import external costs.

Select the Cost Method to Use for Evaluating the Optimized Formulation

Cost methods and external costs are considered as part of the optimization process. You
can compare the actual cost of the input materials to the standard cost of the materials 
specified for a batch prior to its release.

Understanding Least Cost Formulation
Least cost formulation is a cost saving optimization method that responds to the 
demands of food, beverage, and metals formulation industries to satisfy several of their 
key business processes:

• Formulas and recipes are developed and optimized based on targets and 
constraints.

• Formulation targets can include properties such as fat, moisture content, nutrient 
requirements, or other parameters that are unique to each industry. Specific 
formulation constraints can require identification of the maximum contribution of a 
single ingredient type.

• Substitute ingredients can be used to optimize formulations for cost, or to meet 
product weight and volume requirements.

Least cost formulation is frequently used to generate formulations that are not reused. 
By yielding products that meet the predefined product specification at the lowest 
possible cost, this tool maximizes profits, minimizes waste, and reduces the time and 
complexity involved in new formula creation. Least cost formulation eliminates many 
of the manual processes previously required to find proper materials to produce a 
batch.

Set Up for Least Cost Formulation
Prior to running a least cost formulation, you must set up the following:

• Create a new laboratory organization, define inventory items in that laboratory and 
assign these items to the laboratory organization. Enter accounting and inventory 
information for this organization.

Refer to the Oracle Inventory User's Guide for the procedures to set up items.

• Set up the key flexfield structure for the least cost formulation item category. Create
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new least cost formulation item categories and category sets. Assign the items to the
category sets.

Refer to the Oracle Inventory User's Guide for the procedures to set up item 
categories and category sets.

• Create technical parameters under the laboratory organizations to use. Enter 
technical parameter sequences to associate the technical parameters to items. Enter 
item technical data for each item created. Verify that the proper mass to volume 
conversions are entered.

• Create a Derived Cost Technical parameter by selecting the cost source and 
designating the default cost parameter. Add the cost parameter to the item technical
data for each ingredient in order to calculate costs appropriately when you generate
the least cost formulation.

• Set up standard, actual, or lot costs for least cost formulation items.

Define a Formulation Specification
Create a new formulation specification using the Formulation Specification Workbench 
with material, compositional, and optional technical components.

Change the Status of Formulation Specification
Use the Change Status window to change the formulation specification status to 
Approved for Laboratory Use.

Generate a Least Cost Formulation
Use the Formulation Specification Workbench to query the approved formulation 
specification. Review the effective date, minimize or maximize objective, and 
optimization parameter. You can also review the material, compositional, and technical 
views prior to generating a least cost formulation. From the Actions menu click 
Formulate to open the Generate/Optimize Formulation window. Click Generate. The 
least cost formulation engine generates the material and compositional views based on 
the formula. Review each of the tabs. Final output of ingredient quantities appears on 
the Material tab. Click OK to display the formula in the Simulator where you can adjust 
formula quantities to meet your needs.

Using the Formulation Specification Workbench
Use the Formulation Specification Workbench to display formulation specifications by 
specification name, product, laboratory, or status.
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To display the Formulation Specification Workbench:
1. Navigate to the Formulation Specification Workbench.

2. Select View By as:

• Specification to view by formulation specification name.

• Product to view by the product that is associated to each formulation 
specification.

• Laboratory to view by the formulation specification owner laboratory.

• Status to view by formulation specification approval status.

3. Expand nodes to display material, compositional, and technical requirements 
entered for individual formulation specifications.

See:

• Understanding Navigation, page 1-5

• Understanding Workbenches, page 1-8

4. Click individual nodes to display each of the compositional, material, or technical 
requirements

See: 

• Entering Material Requirements, page 8-7

• Entering Compositional Requirements, page 8-8

• Entering Technical Requirements, page 8-9

Additional Information: Choose Find from the View menu to 
display the Find Formulation Specification window. Enter 
appropriate fields to narrow your search, and click Find.

Entering a New Formulation Specification
Use the New Formulation Specification window to enter a new set of requirements to 
run a least cost formulation. You must enter and use process enabled items in Oracle 
Inventory. To enter new formulation specifications:

• Select the organization to serve as the owner laboratory.
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• Identify the parameter to optimize.

To enter a new formulation specification:
1. Navigate to the New Formulation Specification window.

2. Enter Name as new formulation specification name and its Version. Required.

3. Enter Owner Laboratory as the name of the laboratory that owns this formulation 
specification. Required.

4. Enter Product as the name of the product that is associated to this formulation 
specification. Required.

5. Enter Std Qty and UOM. Required.

6. Enter Start Date Active as the date to start the new formulation specification. This 
field defaults to the system date. Required.

7. Enter End Date Active as the date to end the new formulation specification. Leave 
this field blank if there is no end date.

8. Enter Min Ingredients as the minimum number of ingredients to use in the 
optimization of the formulation.

9. Enter Max Ingredients as the maximum number of ingredients to use in the 
optimization of the formulation.

10. Select one of the following for Ingredient Selection:

• Compositional Requirement to base the formulation optimization on a group of
items. Use this selection to minimize or maximize the compositional 
percentages of ingredients within the same category sets.

• Material Requirement to base the formulation optimization on a set of required 
ingredients with a defined range of quantities. If the materials are set up with a 
specified range of materials, then the application attempts to meet the 
requirements while generating the least cost formula.

11. Optionally, enter the process Routing and its Version associated to this formulation 
specification. The routing can be used in creating a formula or batch in the 
Simulator based on the least cost formulation and in creating a recipe if the 
automatic recipe generation rules are enabled.

12. Select the Objective and its coordinating technical Parameter for the formulation 
specification when it is used in least cost formulation. The objective entered can be 
Minimize or Maximize, depending on the technical parameter entered.
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13. Click OK to save the new formulation specification.

Note: You must redisplay the Formulation Specification 
Workbench to view a newly saved formulation specification.

14. After entering all relevant information and saving the formulation specification 
with the default status of New, return to this window if you need to change the 
formula specification status by choosing Change Status from the Actions menu. 
Depending on whether workflow is enabled, a different set of statuses is available.

Entering a New Requirement
Use the New Requirement window to create a new requirement for a formulation 
specification you have entered. You can add technical compositional or material 
requirements that were not previously entered in the New Formulation Specification 
window.

To enter a new requirement:
1. Navigate to the New Requirement window.

2. Enter the new Requirement as:

• Material to enter a material requirement.

• Compositional to enter a compositional requirement.

• Technical to enter a technical requirement.

Note:  The list of requirements you can enter is limited to those not 
previously entered.

The Product, Std Qty, and UOM fields default based on the formulation 
specification. Tabs are enabled based on the requirement entered.

3. Save your work.

Entering Material Requirements
Use the Material Requirements window to enter a list of ingredients for the formulation 
specification. If the range type selected is Percentage, then minimum and maximum 
values displayed are percentages of the total product standard quantity. If the range 
type selected is Quantity, then the minimum and maximum values displayed are 
quantities in the UOM displayed. To enter material requirement, determine minimum 



8-8    Oracle Process Manufacturing Product Development User's Guide

and maximum ranges of ingredients to enter.

To enter material requirements:
1. Navigate to the Material Requirement window.

2. The following fields are display only:

• Product is the with its description.

• Std Qty is the quantity of material produced for the product with its UOM.

3. Item lists each ingredient item in the product with the item Description. You can 
edit the Item field.

4. Range Type indicates whether the minimum and maximum range type listed is a 
Percentage or by Quantity. If a quantity range type is selected, then the UOM 
displays.

5. If you edit the item or minimum and maximum ranges, then save your work before 
exiting.

Entering Compositional Requirements
Use the Compositional Requirements window to display and modify requirements for a
group of ingredients on the formulation specification. The group is called a category set.
For example, you can create a DAIRY category set. Individual categories are added to 
the category set. For example, in the DAIRY category set you can have PROTEIN, FAT, 
and VITAMIN categories. To enter compositional requirements, determine minimum 
and maximum percents of each ingredient category set and category.

To enter compositional requirements:
1. Navigate to the Compositional Requirement window.

2. The following fields are display only:

• Product is the with its description.

• Std Qty is the quantity of material produced for the product with its UOM.

3. Order determines the rank of the percentage of the Category (or Category Set) that 
is present in the final product composition. For example, an order of 1 represents a 
higher percentage of a category in the product than an order of 2. You can edit these
fields.

4. Min% and Max% are the minimum and maximum percentages that are allowable 
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for each category. The application constrains the composition to the range entered.

5. If you edit the order, category set, category, or minimum and maximum ranges, 
then save your work before exiting.

Entering Technical Requirements
Use the Technical Requirements window to enter minimum and maximum technical 
parameters to be used in constraining the least cost formulation The parameter 
composition includes each technical parameter requirement, the parameter description 
and a minimum and maximum value to guide the least cost formulation. To enter 
technical requirement, determine minimum and maximum ranges of parameters to 
enter.

To enter technical requirements:
1. Navigate to the Technical Requirement window.

2. The following fields are display only:

• Product is the with its description.

• Std Qty is the quantity of material produced for the product with its UOM.

3. Enter Parameter as a technical parameter to use for the least cost formulation. The 
technical parameter Description displays. Required.

4. Enter Min Value as the minimum value to use for constraint of the listed parameter 
in least cost formulation.

5. Enter Max Value as the maximum value to use for constraint of the listed parameter
in the least cost formulation.

6. Save your work.

Displaying the Formulation Specification Summary
The Formulation Specification Summary window displays a summary of the 
formulation specification selected from the Formulation Specification Workbench. This 
window displays the information entered and saved on the New Formulation 
Specification window.

1. Navigate to the Formulation Specification Summary window.

2. The following fields are display only:
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• Specification is the name of the formulation specification and its Version.

• Status is the status of the formulation specification.

• Product is the name of the product that is associated to this formulation 
specification.

• Owner Lab is the name of the laboratory that owns this formulation 
specification.

• Std Qty is the standard quantity of material produced by this formulation 
specification.

• Start Date is the date the formulation specification was started.

• End Date is the date to end the formulation specification. If this field is empty, 
then there is no assigned end date.

• Min Ingredients is the minimum number of ingredients to use in the 
optimization of the formulation on the Generate/Optimize Formulation 
window.

• Max Ingredients is the maximum number of ingredients to use in the 
optimization of the formulation on the Generate/Optimize Formulation 
window.

• Ingredient Selection is the basis for selecting ingredients and displays:

• Compositional Requirement when you entered a compositional 
requirement as a constraint for the formulation.

• Material Requirement when you entered a material requirement as a 
constraint for the formulation.

• Routing and its Version are optional associations to this formulation 
specification. The routing can be used in creating a formula or batch in the 
Simulator based on the least cost formulation and in creating a recipe if the 
automatic recipe generation rules are enabled.

• Objective is the optimization objective for the target Parameter displayed.

Generating and Optimizing a Formulation
The Generate/Optimize Formulation window generates a formula that meets a defined 
formulation specification based on ingredients entered with their requisite item 
technical data. The formulation specification name and version default when this 



Least Cost Formulation    8-11

window is displayed from the Formulation Specification Workbench. The formula 
number and version, or batch number display on the window title when this window is
called from the Simulator for an existing formulation or batch.

The Generate button starts the formulation routine. After a formula is generated, the 
results display on the Material View and Compositional View tabs. Technical 
parameters defined in the technical requirements and other defined requirements are 
displayed in the Material View. Category sets and category values defined under the 
compositional requirements are displayed in the compositional view. The minimum 
and maximum values displayed are based on data set up in each technical requirement.

The formulation routine generates the same results each time you run it unless you 
change the formulation specification. After displaying results that meet the formulation 
specification criteria, you can fine tune components on the Simulator or Optimizer 
windows.

To generate a formulation:
1. Query the desired Formulation Specification on the Formulation Specification 

Workbench.

2. From the Actions menu, choose Formulate to display the Generate/Optimize 
Formulation window.

3. Enter the Cost Effective Date for the formulation specification.

Note: The Cost Effective Date defaults to the system date and is 
used to retrieve the current costs of ingredients as listed in the 
material requirements.

4. The following fields are display only:

• Formulation Specification is the name and Version of the formulation 
specification entered for the desired product.

• Objective is the goal for the optimization parameter entered on the New 
Formulation Specification window to minimize or maximize the parameter 
displayed.

5. Click Generate.

Material View
6. Following fields are display only:

• Ingredient displays each ingredient with its Qty and, UOM and Description.

• Each technical Parameter associated with the ingredients and product are listed 
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next to the item.

Compositional View
7. Following fields are display only:

• Ingredient displays the ingredient Description, Qty and UOM. 

• The Category Set type for each ingredient appears as a selected indicator to the 
right of the ingredient line for each of the category set column names. A single 
ingredient can be assigned to more than one category set type.

8. Product Details displays the product Description, Product Qty, and UOM with the 
achieved quantities and percentages listed directly above each of the Min and Max 
target values.

9. Click OK to navigate to the Simulator window. The new formulation displays. You 
can save this formulation as a new formula or create a new batch from it.

Note:  When a batch is created, the formula used to create the batch
is not saved in the formula tables. The only record of the 
formulation is the batch itself.

Important: When costs are retrieved to generate a formula, the cost 
is based on the effective date of the formulation specification. When
the generated formula is loaded into the Simulator, then the current
system date is used to retrieve the costs. The effective date for the 
formulation specification should be less than or equal to the current
system date, or costs displayed can be different. For example, if the 
Cost Effective Date for the formulation specification is in the future,
then costs displayed for the least-cost formulation can differ from 
the cost displayed in the Simulator.

Creating a Least Cost Formula or Batch in the Simulator
Use the Simulator window to save a simulation, create a formula, or create a batch 
based on the least cost formulation generated by the formulation specification. You can 
also associate a routing and enhanced processing instructions to the new formula, or a 
new batch, if automatic recipe generation is set for the organization. This association 
enables you to view the enhanced processing instructions for the batch steps in the 
Operator Workbench of the MES for Process Manufacturing application. 

When you generate a least cost formulation, costs are based on the effective date of the 
formulation specification. Once the generated formulation is loaded into the Simulator 
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window, the current system date is used to retrieve the costs. In general, the effective 
date for the formulation specification should be less than or equal to the current system 
date, otherwise the costs displayed in the Simulator will be different in the generated 
formulation.

To generate a formulation:
1. Navigate to the Formulation Specification Workbench. 

2. Query formulation specifications. In the View By Specification mode, you can query
and view by formulation specification name.

3. Expand nodes, and select one of the nodes. The Formulation Specification Summary
window appears. You can view summary data. 

4. Change any applicable Quantity, Dates, and Ingredient Selection values. This 
enables you to display and enter data on the Material Requirement, Technical 
Requirement, and Compositional Requirement windows for formulation 
specifications.

5. In the Actions menu, select Formulate.

The Generate/Optimize Formulation window appears.

6. Select Generate to generate a formulation specification based on ingredients and 
associated item technical data.

You can view the formulation for the product in the Material View or 
Compositional View tabs. Both of these views display values in the Ingredient, 
Quantity, Unit of Measure, and Description fields.

7. Select OK to navigate to the Simulator window. 

The Simulator window enables you to save a simulation, and create a formula or 
batch based on the least cost formulation generated by the Formulation 
Specification Workbench. The window displays each ingredient, product, and by-
product in a formula with the quantity and technical parameter values for each.

8. In the Actions menu on the Simulator, select either Create Formula or Create Batch.

9. If creating a formula, enter values in the Create Formula window for the fields:

• Formula name

• Version

• Description

• Organization
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• Routing and Version to associate to the recipe created.

• Enhanced Processing Instructions to associate the existing processing 
instructions from the routing to the recipe created.

Note: If automatic recipe generation is set for the organization, then
the routing and enhanced processing instructions selected are 
associated to the recipe created.

10. If creating a batch, enter values in the Create Batch window for the fields: 

• Organization

• Document Number

• Description

• Laboratory Batch

• Update Inventory to create inventory transactions for the batch.

• Routing and Version

• Enhanced Process Instructions to associate the existing processing instructions 
from the routing to the batch.

• Planned Start Date

• Planned Completion Date

11. Click OK to create the formula or batch.

For batches, the batch is created without a formula or recipe. The only record of the 
formulation is the batch itself.

Using Least Cost Formulation
Important: See Entering a New Formulation Specification, page 8-5 and 
topics that follow it for the procedures used in this example.

Following is an example that illustrates the use of least cost formulation. In this 
example, a manufacturer must create a fruit juice blend that consists of several 
inventoried fruit juices and water. Liquid sugar is added as needed to give the juice a 
consistent sweet-sour taste balance.
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The manufacturer creates a new formulation specification for Fruit Juice.:

Field Enter

Product Fruit Juice

Version 1

Ingredients Based On Compositional Requirements or Material 
Requirements

Standard Quantity 1000 gallons (GL)

Minimize Cost

Compositional requirements are:

Category Enter

JUICES Minimum: 80%

Maximum: 90%

WATER Minimum 10%

Maximum 20%

Material requirements are:

• Apple Juice

• Apricot Juice

• Grape Juice

• Grapefruit Juice

• Orange Juice

• Peach Juice

• Pear Juice

• Pineapple Juice
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• Water

Juices can range in quantity between one and 500 gallons.

Water can range in quantity between one and 200 gallons.

Technical requirements are:

Parameter Enter

SWEET

(Measure of sweetness)

Minimum: 50% (of volume)

Maximum: 60% (of volume)

MOISTURE Minimum: 70% (of volume)

Maximum: 80% (of volume)

BRIX

Note:  BRIX is a measurement used by 
the food and beverage industry to 
indicate the mass ratio of dissolved 
sucrose to water in a liquid.

Minimum: 20% (of volume)

Maximum: 30% (of volume)

Technical parameters are entered as volume or weight percent. The Derived Cost 
technical parameter is linked to either standard or actual cost as maintained in the 
Oracle Process Manufacturing Cost Management application. This cost is used to 
optimize the formula based on the lowest cost.

Change the Status of the New Formulation Specification to Approved for General Use. 
Choose Formulate from the Actions menu. When the Generate/Optimize Formula 
window displays, click Generate.

Based on the technical parameters entered for each juice ingredient and water, the 
generated formula is:

Ingredient Qty (GL) Moisture BRIX Sweetness Cost

Apple Juice 30 70 28 30 8

Apricot Juice 10 70 28 30 10

Grape Juice 10 70 28 30 8
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Ingredient Qty (GL) Moisture BRIX Sweetness Cost

Grapefruit Juice 10 70 28 30 8

Orange Juice 10 70 28 30 8

Peach Juice 10 70 29 50 10

Pear Juice 10 70 28.5 60 8

Pineapple Juice 710 71 27 80 6.6

Water 200 100 0 0 1

The resulting FRUIT JUICE formula is:

Formula Qty (GL) Moisture BRIX Sweetness Cost

Fruit Juice 1000 76.71 21.71 60 5.646

This formula contains water and all of the juices included in the JUICE item category. It 
meets the technical requirements listed in the Formulation Specification, and 
simultaneously optimizes the ingredients for the least cost.

You can modify this formula using the Simulator or Optimizer tools, and then save the 
resulting formula. You can also modify the formulation specification, and generate 
other formulas.

For example, if the list of required juice ingredients changes to Apple Juice, Grape Juice,
and Pear Juice, then you can enter only those ingredients as Material Requirements. The
Material Requirements are modified to list only the required ingredients:

• Apple Juice

• Grape Juice

• Pear Juice

• Sugar (Liquid)

• Water

Sugar is added to adjust for some properties, so it is added to the Compositional 
Requirements. Other Compositional Requirements are adjusted as indicated:
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Parameter Enter

JUICES Minimum: 70%

Maximum: 80%

WATER Minimum 10%

Maximum 25%

SUGAR Minimum: 5%

Maximum: 10%

Technical Requirements are adjusted to:

Parameter Enter

SWEET Minimum: 40% (of volume)

Maximum: 50% (of volume)

MOISTURE Minimum 70% (of volume)

Maximum 80% (of volume)

BRIX Minimum: 20% (of volume)

Maximum 30% (of volume)

The resulting formula is:

Ingredient Qty (GL) Moisture BRIX Sweetness Cost

Apple Juice 10 70 28 30 8

Grape Juice 10 70 28 30 8

Liquid Sugar 50 67 33 67 100

Pear Juice 680 70 28.5 60 8

Water 250 100 0 0 1
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The new FRUIT JUICE formula generated has these characteristics.

Formula Qty (GL) Moisture BRIX Sweetness Cost

Fruit Juice 1000 77 22 45 10.85
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A
Navigator Paths

Oracle Process Manufacturing Product Development Navigator Paths
The following table displays the navigation paths in Process Manufacturing Product 
Development.

Window Path

Activities Process Engineer > Setup > Activities

Activity Properties Process Engineer > Routing Designer 
Navigator > Activity > Properties

Process Engineer > Routing Designer 
Navigator > Activity > Properties

Add Lot Formulator > Simulator > load simulation > 
Add Lot

Allocations Formulator > Simulator > Load Simulator > 
Optimizer > Allocations

Alternate Resources Process Engineer > Setup > Alternate 
Resources
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Window Path

By-Product Properties Formulator > Recipe Designer > Find Recipes >
Recipe or Formula tab > By-product node > 
Properties

Recipe Designer Material View navigator > 
right-click the by-product node > Properties

Recipe Designer Material View navigator > 
by-product node > Properties from the View 
menu

Calculate Theoretical Yield Formulator > Recipe Designer > Find Recipes >
Formula tab > Calculate Theoretical Yield 
from the Actions menu

Change Status Formulator > Recipe Designer > Find Recipes >
select recipe > Actions > Change Status

Compositional Requirement Formulator > Formulation Specification 
Workbench > expand the Formulation 
Specification node > select the desired 
Formulation Specification > Compositional 
Requirements

Customers Formulator > Recipe Designer > Find Recipes >
Customers from the Actions menu

Display Calculation Errors Formulator > Simulator > Actions > 
Calculation Errors

Find Activities Process Engineer > Activities > View > Find

Find Analysis Formulator > Formula Analysis > Analysis > 
Formula Ingredient Contribution Analysis > 
View > Find

Find Formula Classes Formulator > Formula Classes > View > Find

Find Formulas from the Product Development
Workbench

Formulator > Formulator Workbench > 
Formula tab > View > Find

Find Formulas from the View Menu Formulator > Formulas > Formula Details > 
View > Find
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Window Path

Find Formulation Specification Formulator > Formulation Specification 
Workbench > View > Find

Find Item Substitution Lists Formulator > Setup > Item Substitution List 
Setup > Item Substitution List > View > Find

Find Item Technical Data Formulator > Technical Data > Item Technical 
Data > View > Find

Find Operation Classes Process Engineer > Process Operation Classes 
> View > Find

Find Process Operations from the Product 
Development Workbench

Process Engineer > Engineering Workbench > 
Operation tab > View > Find

Find Process Operations from the View Menu Process Engineer > Process Operations > 
Process Operation Details Activities > View > 
Find

Find Product Development Parameters Product Development Security Manager > 
Organization Parameters > View > Find

Find Recipe Organization Details Formulator > Recipes > Recipe Details > 
Organization Details

Find Recipes from the Product Development 
Workbench

Formulator > Formulator Workbench > Recipe
tab > View > Find

Find Recipes from the Recipe Designer Formulator > Recipe Designer

Formulator > Recipe Designer > Find Recipes >
File > Open

Find Recipes from the Process Engineer Process Engineer > Recipe Designer

Find Recipes from the View Menu Process Engineer > Recipes > Recipe Details > 
View > Find

Find Routings from the Product Development 
Workbench

Process Engineer > Engineering Workbench > 
Routing tab > View > Find
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Window Path

Find Routings from the Routing Designer Process Engineer > Routing Designer 
Navigator

Process Engineer > Routing Designer 
Navigator > File > Open

Find Routings from the View Menu Process Engineer > Routings > Routing Details
> View > Find

Find Status Codes Formulator > Setup > Status Codes > View > 
Find

Find Technical Parameters Formulator > Technical Data > Technical 
Parameters > View > Find

Find Technical Parameter Sequences Formulator > Technical Data > Technical 
Parameter Sequences > View > Find

Formula Analysis Parameters Formulator > Formula Analysis > Parameters

Formula By-Product Line Edit Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula > select By-Products > Formula By-
Product Summary > select a Line > Edit Line

(also available from Formula By-Product Line 
Summary, Formula By-Product Lines, and 
Formula Details)

Formula By-Product Line Summary Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula node > expand By-Products > select a 
by-product node

Formula By-Product Lines Formulator > Formulator Workbench > 
Formula tab > expand Formulas > select a 
formula > Formula Header Summary > By-
Products

(also available from Formula By-Product 
Summary and Formula Details)
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Window Path

Formula By-Product Summary Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula > select By-Products

Formula Classes Formulator > Setup > Formula Class

Formula Details Formulator > Formulas

(also available from Formulas Summary By 
and Formula Header Summary)

Formula Header Summary Formulator > Formulator Workbench > 
Formula tab > expand Formulas > select a 
formula node label

Formula Ingredient Contribution Analysis Formulator > Formula Analysis > Analysis

Formula Ingredient Line Edit Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula node > select Ingredients > Formula 
Ingredient Summary > select a Line > Edit 
Line

(also available from Formula Ingredient Line 
Summary, Formula Ingredient Lines, and 
Formula Details)

Formula Ingredient Line Summary Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula node > expand Ingredients > select an 
ingredient node

Formula Ingredient Lines Formulator > Formulator Workbench > 
Formula tab > expand Formulas > select a 
formula > Formula Header Summary > 
Ingredients

(also available from Formula Ingredient 
Summary and Formula Details)

Formula Ingredient Summary Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula node > select Ingredients
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Window Path

Formula Inquiry Selection Formulator > Formula Inquiry

Formula Inquiry Summary View Formulator > Formula Inquiry > Formula 
Inquiry Selection

Formula Product Line Edit Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula node > select Products > Formula 
Product Summary > select a Line > Edit Line

(also available from Formula Product Line 
Summary, Formula Product Lines, and 
Formula Details)

Formula Product Line Summary Formulator > Formulator Workbench > 
Formula tab > expand Formulas > expand a 
formula node > expand Products > select a 
product node

Formula Product Lines Formulator > Formulator Workbench > 
Formula tab > expand Formulas > select a 
formula node > Formula Header Summary > 
Products

(also available from Formula Product 
Summary)

Formula Product Summary Formulator > Formulator Workbench > 
expand Formulas > expand a formula node > 
select Products

Formula Properties Formulator > Recipe Designer > Find Recipes >
Formula tab > select a formula node > Actions 
> Properties

Formula Substitution Lists Formulator > Setup > Item Substitution List 
Setup > Item Substitution List > Find Formula

Formula Summary By Formulator > Formulator Workbench > 
Formula tab > View By > select Class, Status, 
Owner, Laboratory, Product, or Plant > 
expand Formulas By > select an unexpanded 
node
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Window Path

Formula View Formulator > Formula Inquiry > Formula 
Inquiry Summary View > Actions > Formula 
View

Formulation Specification Summary Formulator > Formulation Specification 
Workbench > expand Formulation 
Specification node > click the desired 
Formulation Specification

Formulation Specification Workbench Formulator > Formulation Specification 
Workbench

Generate/Optimize Formulation Formulator > Formulation Specification 
Workbench > expand the Formulation 
Specification node > select the desired 
Formulation Specification > Actions >

Indented Bill of Materials Report Formulator > Indented Bill of Materials

Ingredient Properties Formulator > Recipe Designer > Find Recipes >
Recipe or Formula tab > right-click the 
ingredient node > Properties

Recipe Designer Material View navigator > 
right-click the ingredient node > Properties

Recipe Designer Material View navigator > 
click the ingredient > Properties from the View
menu

Item Substitution List Formulator > Setup > Item Substitution List 
Setup

Item Technical Data Formulator > Technical Data > Item Technical 
Data

Item Technical Data Selection Formulator > Recipe Designer > Find Recipes >
Formula tab > select intermediate ingredient > 
Technical Data Selection from the Actions 
menu

Formulator > Formulas > Formula Details > 
Technical Data Selection from the Actions 
menu
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Window Path

Items Formulator > Inventory Items

Load Simulator Formulator > Simulator > View > Find

Mass Search and Replace Formulator > Mass Search And Replace

Material Requirement Formulator > Formulation Specification 
Workbench > expand the Formulation 
Specification node > select the desired 
Formulation Specification > Material 
Requirements

New Formulation Specification Formulator > Formulation Specification 
Workbench > Formulation Specification node 
> Actions > New Specification

New Item Formulator > Recipe Designer > Find Recipes >
Recipe tab > associate items to the formula in 
the navigator (window displays only when 
the Display New Item Window is selected)

New Requirement Formulator > Formulation Specification 
Workbench > expand Formulation 
Specification node > click the desired 
Formulation Specification > Formulation 
Specification Summary > Actions > New 
Requirement

Operation Header Summary Process Engineer > Engineering Workbench > 
Operation tab > View By Operation > expand 
Operations > select an operation node label

Operations Summary By Process Engineer > Engineering Workbench > 
Operation tab > View By Class or Status > 
expand Operations By > select unexpanded 
operation node

Optimizer Formulator > Simulator > Optimizer

Plant/Laboratory Information Formulator > Recipe Designer > Find Recipes >
Recipe tab > the desired recipe > Actions > 
Plant/Laboratory
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Window Path

Preferences Formulator > Recipe Designer > Find Recipes >
Preferences from the Actions menu

Process Operation Activity Process Engineer > Process Operations > 
Process Operation Details Activities > select an
activity > Resources

Process Operation Activity Line Process Engineer > Engineering Workbench > 
Operation tab > chose View By Operations > 
expand Operations > select an operation node 
> Operation Header Summary > Details > 
Operation Details Activities > select an activity

(also available from Process Operation 
Activity Line Summary)

Process Operation Activity Line Summary Process Engineer > Engineering Workbench > 
Operation tab > View By Operation > expand 
Operations, expand an operation node > select
an activity

Process Operation Activity Resource Line Process Engineer > Engineering Workbench > 
Operation tab > chose View By Operations > 
expand Operations > select an operation node 
> Operation Header Summary > Details > 
Operation Details Activities > select an activity

Process Operation Classes Process Engineer > Setup > Operation Classes

Process Operation Details Activities Process Engineer > Process Operations

(also available from Operation Summary By, 
Operation Header Summary, and Routing 
Details) 

Process Operation Resource Line Process Engineer > Engineering Workbench > 
Operation tab > View By Operation > expand 
Operations > select an operation > Operation 
Header Summary > Details

Process Operation Resource Process 
Parameters

Process Engineer > Process Operations > 
Process Operation Details Activities > select 
the desired Activity > Resources > Parameters
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Window Path

Process Parameter Sets Process Engineer > Process Parameters > 
Parameter Sets

Process Routing Classes Process Engineer > Setup > Process Routing 
Classes

Process Routing Details Process Engineer > Process Routings

(also available from Routings Summary By 
and Routing Header Summary)

Process Routing Step Dependencies Process Engineer > Process Routings > Process
Routing Details > query a routing > select a 
Step > Step Dependencies

Process Routing Step Line Process Engineer > Process Routings > Process
Routing Details > query a routing > select a 
Step

(also available from Routing Step Line 
Summary)

Product Development Parameters Product Development Security Manager > 
Organization Parameters

Product Development Workbench Process Engineer > Engineering Workbench

Product Properties Formulator > Recipe Designer > Find Recipes >
Recipe or Formula tab > right-click the 
product node > Properties

Recipe Designer Formulator > Recipe Designer

Process Engineer > Recipe Designer

Formulator > Recipes > query the desired 
recipe > Designer

(also available from Recipe Summary and 
Recipe Header Summary)
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Window Path

Recipe Details Process Engineer > Recipes

Formulator > Recipes

(also available from Recipe Header Summary 
and Recipes Summary By)

Recipe Generation Formulator > Setup > Recipe Generation

Recipe Header Summary Formulator > Formulator Workbench > Recipe
tab > View By Recipe > expand Recipes > 
select a recipe node label

Recipe Organization Details Formulator > Find Recipes > Recipe Details > 
Organization Details

Recipe Properties Formulator > Recipe Designer > right-click the 
recipe node > Properties

Formulator > Recipe Designer > recipe > 
Properties from the View menu

Recipe Step/Material Association Formulator > Formulator Workbench > Recipe
tab > View By Recipe > select a recipe > Recipe
Header Summary > Details > Recipe Details > 
Step/Material Association

(also available from Process Engineer)

Recipe Validity Rule Details Formulator > Recipes > query a recipe on the 
Recipe Details window > Validity Rules

Formulator > Formulator Workbench > Recipe
tab > View By Recipe > expand Recipes > 
select a recipe node > Recipe Header 
Summary > Validity Rules tab > select desired 
validity rule > Details

(also available from Recipe Header Summary)

Recipes Summary By Formulator > Formulator Workbench > Recipe
tab > View By Status or Owner > expand 
Recipes By > select unexpanded node

Resource Information Process Engineer > Setup > Plant Resources
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Window Path

Resource Parameters Process Engineer > process Resource 
Parameters > Plant Resource Parameters

Resource Properties Process Engineer > Routing Designer 
Navigator > right-click resource > Properties

Process Engineer > Routing Designer 
Navigator > resource > Properties from the 
View menu

Resources Process Engineer > Setup > Generic Resources

Routing Designer Process Engineer > Routing Designer

Process Engineer > Process Routings > query 
the desired routing > Designer (also available 
from Routing Summary and Routing Header 
Summary)

Routing Header Summary Process Engineer > Engineering Workbench > 
Routing tab > View By Routing > expand 
Routings > select a routing node label

Routing Properties Process Engineer > Routing Designer 
Navigator > right-click the routing > 
Properties

Process Engineer > Routing Designer 
Navigator > click the routing > Properties 
from the View menu.

Routing Step Dependency Properties Routing Designer > displays automatically 
after drawing connection between two steps

Routing Designer > double-click the line 
connecting two steps

Routing Designer right pane > right-click the 
line connecting two steps > Properties

Routing Step Line Summary Process Engineer > Engineering Workbench > 
Routing tab > select View By Routing > 
expand Routings > expand a routing node > 
select an operation node
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Window Path

Routings Summary By Formulator > Formulator Workbench > 
Routing tab > View By Class, Status, or Owner
> expand Routings By > select an unexpanded 
node

Save As (Recipe) Formulator > Recipe Designer > Find Recipes >
File > Save As

Process Engineer > Recipe Designer > Find 
Recipes > File > Save As

Save As (Routing) Process Engineer > Routing Designer > File > 
Save As

Save Simulation Formulator > Simulator > Save Simulation 
from the Actions menu

Scale Formula Formulator > Recipe Designer > Find Recipes >
Formula tab > Scale from the Actions menu

Simulator Formulator > Simulator

Status Codes Formulator > Setup > Status Codes

Process Engineer > Setup > Status Codes

Status Details Formulator > Setup > Status Codes > Details

Step Properties Process Engineer > Routing Designer 
Navigator > right-click the routing step > 
Properties

Process Engineer > Routing Designer 
Navigator > routing step > Properties from the
View menu

Routing Designer routing graph pane > 
double-click the routing step

Technical Parameter Sequences Formulator > Technical Data > Technical 
Parameter Sequences
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Window Path

Technical Parameters Formulator > Technical Data > Technical 
Parameters

Formulator > Formulas > Formula Details > 
query the formula > select Ingredients region >
select Line containing technical parameters > 
Ingredient Technical Parameters from the 
Actions menu

Technical Requirement Formulator > Formulation Specification 
Workbench > expand the Formulation 
Specification node > select the desired 
Formulation Specification > Technical 
Requirements

Theoretical Process Loss Process Engineer > Engineering Workbench > 
Routing tab > expand Routings > click a 
Routing > Routing Header Summary > 
Theoretical Process Loss

Validity Rule Summary By Product Formulator > Validity Rules - Product

Validity Rule Summary By Recipe Formulator > Validity Rules - Recipe

Workpad Formulator > Simulator > Optimizer > 
Workpad
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B
 Oracle Process Manufacturing Product 

Development Responsibilities and Menu 
Access

Oracle Process Manufacturing (OPM) Product Development 
Responsibilities and Menu Access

Set up Workbench Responsibilities for each user. The following are menu and submenu 
selections available to each listed Workbench Responsibility:

• Formulator

• Formulator Workbench

• Formulas

• Recipes

• Mass Search and Replace

• Simulator

• Formulation Specification Workbench

• Inventory Items

• Indented Bill of Materials

• Formula Inquiry

• Validity Rules - Product

• Validity Rules - Recipe
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• Technical Data: Technical Parameters

• Technical Data: Technical Parameter Sequences

• Technical Data: Item Technical Data

• Formula Analysis: Parameters

• Formula Analysis: Analysis

• Setup: Formula Class

• Setup: Status Codes

• Setup: Recipe Generation

• Setup: Item Substitution List Setup

• Setup: Process Engineering Items

• Master Items

• Organization Items

• Others

• Profile Options

• Lookups

• Change Organization

• Workflow

• Advanced Worklist

• Self Service Workflow

• Home

• Status Monitor

• Notifications

• Recipe Designer

• Process Engineer
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• Engineering Workbench

• Process Routings

• Process Operations

• Recipes

• Mass Search and Replace

• Setup: Routing Classes

• Setup: Operation Classes

• Setup: Activities

• Setup: Generic Resources

• Setup: Plant Resources

• Setup: Alternate Resources

• Setup: Status Codes

• Setup: Process Parameters

• Define Parameters

• Parameter Sets

• Generic Resource Parameters

• Plant Resource Parameters

• Others

• Profile Options

• Lookups

• Change Organization

• Workflow

• Advanced Worklist

• Self Service Workflow
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• Home

• Status Monitor

• Notifications

• Recipe Designer

• Routing Designer

• Product Development Security Manager

• Product Development Security Profile Manager
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C
 Oracle Process Manufacturing Product 

Development Status Codes

Oracle Process Manufacturing (OPM) Product Development Status Codes
This appendix outlines how status codes change when workflow is and is not running.

Workflow Running and Approval Required for the Current Data
A status of New changes to a status of:

• Pending Approval for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

• Pending Approval for General Use when the Requester selects Approve for General
Use.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Pending Approval for Laboratory Use changes to a status of:

• Approved for Laboratory Use when the Approver approves the request.

• Revise for Laboratory Use when the Approver rejects the request.

A status of Revise for Laboratory Use changes to a status of:

• Pending Approval for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

A status of Approved for Laboratory Use changes to a status of:

• Pending Approval for General Use when the Requester selects Approve for General
Use.
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• On hold when the Requester selects On Hold.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Pending Approval for General Use changes to a status of:

• Approved for General Use when the Approver approves the request. 

• Revise for General Use when the Approver rejects the request.

A status of Revise for General Use changes to a status of:

• Pending Approval for General Use when the Requester selects Approve for General
Use.

A status of Approved for General Use changes to a status of:

• On hold when the Requester selects On Hold.

• Frozen when the Requester selects Frozen.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of On Hold changes to a status of:

• Pending Approval for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

• Revise for Laboratory Use when the Requester selects Revise for Laboratory Use.

• Revise for General Use when the Requester selects Revise for General Use.

• Pending Approval for General Use when the Requester selects Approve for General
Use.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Frozen changes to a status of:

• On hold when the Requester selects On Hold.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Obsolete or Archived changes to a status of:

• Revise for Laboratory Use when the Requester selects Revise for Laboratory Use.

• Revise for General Use when the Requester selects Revise for General Use.
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Workflow Not Running
A status of New changes to a status of:

• Approve for Laboratory Use when the Requester selects Approve for Laboratory 
Use.

• Approve for General Use when the Requester selects Approve for General Use.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Approved for Laboratory Use changes to a status of:

• Approve for General Use when the Requester selects Approve for General Use.

• On hold when the Requester selects On Hold.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Approved for General Use changes to a status of:

• On hold when the Requester selects On Hold.

• Frozen when the Requester selects Frozen.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of On Hold changes to a status of:

• Approve for Laboratory Use when the Requester selects Approve for Laboratory 
Use.

• Approve for General Use when the Requester selects Approve for General Use.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Frozen changes to a status of:

• On hold when the Requester selects On Hold.

• Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Obsolete or Archived changes to a status of:

• Approve for Laboratory Use when the Requester selects Approve for Laboratory 
Use.

• Approve for General Use when the Requester selects Approve for General Use.
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D
 Oracle E-Records Events in Oracle Process 

Manufacturing Product Development

Oracle E-Records Events in Oracle Process Manufacturing (OPM) Product 
Development

OPM Product Development supports the acquisition of electronic signatures on 
electronic records. Electronic documentation replaces paper with a seamless interface of
business activities that improves manufacturing throughput and enhances the overall 
quality of operations in the enterprise. The following provides information for online 
and deferred events that are e-record and e-signature enabled in the OPM Product 
Development application. A brief discussion of each event is provided. Refer to the 
Oracle E-Records Implementation Guide for details on setting up the events and approvals.

Events
The following table lists the events that are e-record and e-signature enabled for OPM 
Product Development:

Event Online or Deferred

Operation Status Change Approval Deferred

Routing Status Change Approval Deferred

Formula Status Change Approval Deferred

Recipe Status Change Approval Deferred
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Event Online or Deferred

Validity Rule Status Change Approval Deferred

Formulation Specification Status Change 
Approval

Deferred

Item Substitution Status Change Approval Deferred

Operation Status Change Approval
When the status of an operation is changed, the e-signatures can be captured at multiple
points in the process. When the status change is requested, required signatures can be 
captured online, while the event is happening in the window. Any users responsible for
additional required signatures receive workflow notifications informing them their e-
signature must be entered before the status of the operation is changed to the requested 
status.

The Change Status window in Product Development starts the signature capturing 
process whenever an operation status change is requested. This replaces the existing 
operation approval workflow.

Routing Status Change Approval
When the status of a routing is changed the e-signatures can be captured at multiple 
points in the process. When the status change is requested, required signatures can be 
captured online, while the event is happening in the window. Any users responsible for
additional required signatures receive workflow notifications informing them their e-
signature must be entered before the status of the routing is changed to the requested 
status.

Formula Status Change Approval
When the status of a formula is changed the e-signatures can be captured at multiple 
points in the process. When the status change is requested, required signatures can be 
captured online, while the event is happening in the window. Any users responsible for
additional required signatures receive workflow notifications informing them their e-
signature must be entered before the status of the formula is changed to the requested 
status.

Recipe Status Change Approval
When the status of a recipe is changed the e-signatures can be captured at multiple 
points in the process. When the status change is requested, required signatures can be 
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captured online, while the event is happening in the window. Any users responsible for
additional required signatures receive workflow notifications informing them their e-
signature must be entered before the status of the recipe is changed to the requested 
status.

Validity Rule Status Change Approval
When the status of a validity rule is changed the e-signatures can be captured at 
multiple points in the process. When the status change is requested, required signatures
can be captured online, while the event is happening in the window. Any users 
responsible for additional required signatures receive workflow notifications informing 
them their e-signature must be entered before the status of the validity rule is changed 
to the requested status.

Formulation Specification Status Change Approval
When the status of a formulation specification is changed the e-signatures can be 
captured at multiple points in the process. When the status change is requested, 
required signatures can be captured online, while the event is happening in the 
window. Any users responsible for additional required signatures receive workflow 
notifications informing them their e-signature must be entered before the status of the 
formulation specification is changed to the requested status.

Item Substitution Status Change Approval
When the status of an item substitution is changed the e-signatures can be captured at 
multiple points in the process. When the status change is requested, required signatures
can be captured online, while the event is happening in the window. Any users 
responsible for additional required signatures receive workflow notifications informing 
them their e-signature must be entered before the status of the item substitution is 
changed to the requested status.

Finding Additional E-record Information
Find the following information in the Oracle E-Records Implementation Guide:

• Events

• Event Key

• Subscriptions

From the XML Gateway, using the existing Event and Event Key, derive the XML Map, 
Subscription Data, and Metadata.
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Statuses Available for E-records
Set up the capturing of e-signatures and e-records for the following seeded statuses and
any other customized statuses:

• Approved for Laboratory Use

• Approved for General Use

• On Hold

• Frozen

• Obsolete/Archived

OPM Product Development Events

Events

Name Display 
Name

Description Status Owner Name Owner Tag

oracle.apps.
gmd.
operation.sts

GMD ERES 
Operation 
Status 
Change 
Approval

This event is 
raised when 
the status of 
an operation 
is being 
changed.

Enabled Product 
Development

GMD

oracle.apps.
gmd.routing.
sts

GMD ERES 
Routing 
Status 
Change 
Approval

This event is 
raised when 
the status of a
routing is 
being 
changed.

Enabled Product 
Development

GMD

oracle.apps.
gmd.formula.
sts

GMD ERES 
Formula 
Status 
Change 
Approval

This event is 
raised when 
the status of a
formula is 
being 
changed.

Enabled Product 
Development

GMD
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Name Display 
Name

Description Status Owner Name Owner Tag

oracle.apps.
gmd.recipe.
sts

GMD ERES 
Recipe Status 
Change 
Approval

This event is 
raised when 
the status of a
recipe is 
being 
changed.

Enabled Product 
Development

GMD

oracle.apps.
gmd.validity.
sts

GMD ERES 
Recipe 
Validity Rule 
Status 
Change 
Approval

This event is 
raised when 
the status of a
validity rule 
is being 
changed.

Enabled Product 
Development

GMD

oracle.apps.
gmd.auto.
recipe

GMD ERES 
Recipe 
Generation

This event is 
raised when a
recipe is 
generated.

Enabled Product 
Development

GMD

oracle.apps.
gmd.
formspec.sts

GMD ERES 
Formulation 
Specification 
Status 
Change 
Approval

This event is 
raised when 
the status of a
formulation 
specification 
is being 
changed.

Enabled Product 
Development

GMD

oracle.apps.
gmd.itemsub.
sts

GMD ERES 
Item 
Substitution 
Status 
Change 
Approval

This event is 
raised when 
the status of 
an item 
substitution 
is being 
changed.

Enabled Product 
Development

GMD

Event Key
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Event Name Event Key User Event Key

oracle.apps.gmd.operation.sts Oprn_id Gmd_operations_vl.oprn_no -
Gmd_operations_vl.
oprn_vers

oracle.apps.gmd.routing.sts Routing_id Fm_rout_dtl.Routing_no - 
fm_rout_dtl.routing_vers

oracle.apps.gmd.formula.sts Formula_id Fm_form_mst.formula_no, - 
fm_form_mst.formuls_vers

oracle.apps.gmd.recipe.sts Recipe_id Gmd_eres_recipes_vw.
recipe_no - 
gmd_eres_recipes_vw.
recipe_version

oracle.apps.gmd.validity.sts Recipe_validity_rule_id Gmd_recipe_validity_rules.
recipe_id - 
Gmd_recipe_validity_rules.
recipe_use - 
Gmd_recipe_validity_rules.
orgn_code - 
Gmd_recipe_validity_rules.
item_id

oracle.apps.gmd.auto.recipe Formula_id fm_form_mst_b.formula_no - 
fm_form_mst_b.formula_vers

oracle.apps.gmd.formspec.sts N/A N/A

oracle.apps.gmd.itemsub.sts N/A N/A

Subscriptions
The system is HM001 for all subscriptions.

Subscriptions
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Source 
Type

Event 
Filter

Phas
e

Status Rule 
Data

Rule 
Function

Parameter
s

Priority

Local oracle.
apps.gmd.
operation.
sts

0 Disable
d

Key EDR_RUL
E.
ESIGN_R
ULE

EDR_XML
_MAP_CO
DE = 
'oracle.
apps.gmd.
operation_
sts'; 
EDR_AME
_TRANSA
CTION_T
YPE = 
'oracle.
apps.gmd.
operation_
sts';

Normal

Local oracle.
apps.gmd.
routing.sts

0 Disable
d

Key EDR_RUL
E.
ESIGN_R
ULE

EDR_XML
_MAP_CO
DE = 
'oracle.
apps.gmd.
routing_st
s'; 
EDR_AME
_TRANSA
CTION_T
YPE = 
'oracle.
apps.gmd.
routing_st
s';

Normal
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Source 
Type

Event 
Filter

Phas
e

Status Rule 
Data

Rule 
Function

Parameter
s

Priority

Local oracle.
apps.gmd.
formula.sts

0 Disable
d

Key EDR_RUL
E.
ESIGN_R
ULE

EDR_XML
_MAP_CO
DE = 
'oracle.
apps.gmd.
formula_st
s'; 
EDR_AME
_TRANSA
CTION_T
YPE = 
'oracle.
apps.gmd.
formula_st
s';

Normal

Local oracle.
apps.gmd.
recipe.sts

0 Disable
d

Key EDR_RUL
E.
ESIGN_R
ULE

EDR_XML
_MAP_CO
DE = 
'oracle.
apps.gmd.
recipe_sts';
EDR_AME
_TRANSA
CTION_T
YPE = 
'oracle.
apps.gmd.
recipe_sts';

Normal

Local oracle.
apps.gmd.
validity.sts

0 Disable
d

Key EDR_RUL
E.
ESIGN_R
ULE

EDR_XML
_MAP_CO
DE = 
'oracle.
apps.gmd.
validity_st
s'; 
EDR_AME
_TRANSA
CTION_T
YPE = 
'oracle.
apps.gmd.
validity_st
s';

Normal
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Source 
Type

Event 
Filter

Phas
e

Status Rule 
Data

Rule 
Function

Parameter
s

Priority

Local oracle.
apps.gmd.
auto.recipe

0 Enabled Key EDR_RUL
E.
ESIGN_R
ULE

EDR_XML
_MAP_CO
DE = 
'oracle.
apps.gmd.
auto.
recipe'; 
EDR_AME
_TRANSA
CTION_T
YPE = 
'oracle.
apps.gmd.
auto.
recipe';

Normal

Local oracle.
apps.gmd.
formspec.
sts

0 Enabled Key EDR_PSIG
_RULE.
PSIG_RUL
E

N/A Normal

Local oracle.
apps.gmd.
itemsub.sts

0 Enabled Key EDR_PSIG
_RULE.
PSIG_RUL
E

N/A Normal

Approval Matrix

Transaction Type

Oracle Application Transaction Type ID Transaction Type 
Description

Line Item Id Query 
String

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
operation.sts

GMD ERES 
Operation Status 
Change Approval

N/A
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Oracle Application Transaction Type ID Transaction Type 
Description

Line Item Id Query 
String

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
routing.sts

GMD ERES Routing 
Status Change 
Approval

N/A

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
formula.sts

GMD ERES Formula 
Status Change 
Approval

N/A

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
recipe.sts

GMD ERES Recipe 
Status Change 
Approval

N/A

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
validity.sts

GMD ERES Recipe 
Validity Rule Status 
Change Approval

N/A

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
recipe.generation

GMD ERES Recipe 
Generation

N/A

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
formspec.sts

GMD ERES 
Formulation 
Specification Status 
Change Approval

N/A

Oracle Process 
Manufacturing 
Product Development

oracle.apps.gmd.
itemsub.sts

GMD ERES Item 
Substitution Status 
Change Approval

N/A

Define Rules/Associate Approvers/Associate E-record Output XSL
The rules basing the status on Approved For Laboratory Use and Approved For 
General Use are seeded.

As part of the implementation, complete these activities. The following mandatory and 
nonmandatory attributes must be added for all transaction types. Substitute the values 
shown with appropriate transaction specific values or data:

Mandatory Attributes
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Name Attribute Type Description Static Usage Usage

ALLOW_DELET
ING_RULE_GE
NERATED_APP
ROVERS

boolean Whether to let 
the calling 
application (or 
its end users) 
delete approvers
generated by the 
rules.

Yes False

ALLOW_REQU
ESTOR_APPRO
VAL

boolean Whether to 
allow requestors 
to approve their 
own transactions
(when the rules 
do so).

Yes False

AT_LEAST_ON
E_RULE_MUST_
APPLY

boolean Whether to 
require that at 
least one rule 
apply to each 
transaction.

Yes False

EFFECTIVE_RU
LE_DATE

date The date that 
determines 
which rules are 
active.

Yes (blank)

TRANSACTION
_DATE

date Date transaction 
occurred.

No Select ame_util.
versionDateToSt
ring
(CREATION_D
ATE) 

from 
gme_batch_head
er 

where batch_id=:
transactionId

TRANSACTION
_GROUP_ID

number Business-group 
ID in which 
transaction 
occurred.

Yes (blank)
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Name Attribute Type Description Static Usage Usage

TRANSACTION
_ORG_ID

number Org ID in which 
transaction 
occurred. 

Yes (blank)

TRANSACTION
_REQUESTOR_P
ERSON_ID

number Person ID of 
person initiating 
transaction.

Yes (blank)

TRANSACTION
_REQUESTOR_
USER_ID

number User ID of 
person initiating 
transaction.

No Select 
Last_updated_b
y 

from 
gme_batch_head
er 

where batch_id=:
transactionId

TRANSACTION
_SET_OF_BOOK
S_ID

number Set of books ID 
in which 
transaction 
occurred.

No (blank)

USE_RESTRICTI
VE_LINE_ITEM
_EVALUATION

boolean Whether to 
require that the 
same line item 
satisfy all line-
item conditions 
in a given rule.

Yes False

WORKFLOW_IT
EM_KEY

string The transaction's
workflow item 
key.

No (blank)

WORKFLOW_IT
EM_TYPE

string The transaction's
Workflow item 
type.

No (blank)
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Name Attribute Type Description Static Usage Usage

ALLOW_DELET
ING_RULE_GE
NERATED_APP
ROVERS

boolean Whether to let 
the calling 
application (or 
its end users) 
delete approvers
generated by the 
rules.

Yes False





Glossary-1

Glossary

Activity

Action performed during the manufacturing process, such as mixing or heating.

Activity Factor

The number of times an activity is performed. For example, a quality test must be 
performed at the beginning, middle, and end of a mixing time period. Rather than 
defining the activity and associated resources three times, use a factor or multiplier to 
indicate several iterations of the same activity. In example of performing a test at the 
beginning, middle, and end of a mixing time period, you would define a factor of 3. 
Factors are applied to resource usage when planning and calculating resource costs. 
Factors can be set to zero to exclude a particular activity. This is also a means to select 
the equipment (resources) that are used for this production run within this specific 
plant.

Boolean

A logical combinatorial system that represents the symbolic relationships between 
entities. Typical logical operators are: AND, OR, and NOT. In Boolean searching, the 
AND operator between two words indicates a search for both words. For example "pear
AND apple" searches for information containing both words.

Byproduct

An item produced by a formula in addition to the product. Byproducts differ from 
products in that you do not plan your production to make byproducts. Byproducts can 
have monetary value, but generally have less monetary value than products. In some 
instances there can be a cost associated with disposing of a byproduct.

Category

Code used to group items with similar characteristics, such as plastics, paints, inks, or 
foods.

Category Set

Grouping scheme consisting of categories. Typical category sets include purchasing, 
materials, costing, and planning.
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Charges

Often in a process manufacturing plant the capacity of a step is determined by the 
equipment used. For example, a mixing tank that has a maximum capacity of 1000 
gallons overflows if more is added. A charge is defined as one full load that can be 
accommodated in a single pass through equipment. The maximum capacity determines 
the total number of charges that are required to process the ingredients required for a 
batch. In the previous example, a batch size of 5000 gallons requires five charges at 1000
gallons each.

Component Class

A way of classifying item costs. Examples of component classes are labor or overhead.

Coproduct

One of several products produced by a formula. The term coproduct is sometimes used 
when a formula produces more than one product. OPM does not distinguish between 
products and coproducts. Compare with byproduct.

Cost Analysis Code

A code that generally specifies whether an activity is value-added.

Density

The quantity of a material per unit volume. In general, density is mass divided by 
volume.

Electronic Record

Also e-record. Any combination of text, graphics, data, audio, pictorial, or other 
information representation in digital form that is created, modified, maintained, 
archived, retrieved, or distributed by a computer system.

Electronic Signature 

Also e-signature. A computer data compilation of any symbol or series of symbols 
executed, adopted, or authorized by an individual to be the legally binding equivalent 
of the individual's handwritten signature.

Event

An occurrence in an Internet or intranet application or program that is significant to 
other objects in a system or to external agents.

Exponentiation

The act or process of raising a quantity to a power.



Glossary-3

Formula

A statement of ingredient requirements. A formula can also include processing 
instructions and ingredient sequencing directions. The formula can also specify the 
quantities of each item.

Gravimetric

Of or relating to measurement by weight.

Ingredient

An item that is used in a formula to produce a product.

Operation

A combination of one or more activities and the resources used to perform those 
activities. For example, the combination of mixing (activity) and the mixer (resource) 
defines the mixing operation.

Process Parameter

A processing instruction. Processing parameters are used to provide operators with 
information needed for managing equipment that is used during the preparation of a 
product or to drive a production decision, such as the type of filter to use, or the 
quantity of product required to fill a container. There is no direct linkage between a 
process parameter and the equipment it describes.

Product

An item that is produced by a formula. See also coproduct.

Project

In the context of product development, this represents an endeavor undertaken to 
develop a new product or to perform changes to an existing product. A project gathers 
information about the project manager, participants and objectives to be met such as 
start dates, end dates, unit cost, and quality specifications.

Recipe

An entity that contains the minimum set of information that uniquely defines the 
manufacturing requirements for a specific product. Recipes provide a way to describe 
products and how those products are produced.

Resource

Any noninventory item used in production, like a mixer or oven.

Routing

A sequenced set of operations that need to be performed in order to complete a 
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production batch.

Routing Process Loss

The capability to account for material lost during the production process at the routing 
level. This loss can vary depending on the routing and quantity being processed by the 
routing. A loss factor is defined at the routing level based on a range of quantities.

Scaling

The proportional increase or decrease of product, byproduct, and ingredient quantities 
in a formula or batch.

Specific Gravity

The ratio of the density of a substance to the density of some other substance, usually 
pure water, taken as a standard when both densities are obtained by weighing in air at 
standard temperature and pressure.

Specification

Identify the target or ideal result of a quality control assay test performed on an item or 
lot. Assay codes and item attributes are combined to devise test specifications for 
specific items and lots.

Technical Class

An item category that is used to identify and group ingredients. It is used to analyze 
ingredients within a formula by contribution of the class. This can assist in both 
development and maintenance of a formula, wherein the overall contribution of specific
technical characteristics of ingredients is significant.

Technical Subclass

An item category that is used to identify and group ingredients within a technical class. 
The technical subclass refines the analysis of ingredients within a formula a level 
beyond the technical class. For example, if a technical class is RESIN, a technical 
subclass could be EPOXY.

Theoretical Process Loss

The capability to account for the material lost during the production process at the 
routing level. This loss can vary depending on the routing or the individual quantity 
being processed by the routing. This loss is defined at the routing level and is based on 
a minimum and maximum range of quantities.

Theoretical Yield Calculation

A calculation that calculates product quantities yielded by a formula given a specified 
yield percentage.
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Validity Rule

Formerly effectivity. The combination of a quantity of material and an effective date 
that is used by production, planning, costing, or MSDS in one or more specified 
organizations.

Version

A number identifying a variant of a formula, operation, routing, or recipe.
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Copy Formula Text profile option, 3-9
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Formula Menu

options, 6-53
Formula Product Line Summary window, 3-41
Formula Product Lines window, 3-42
Formula Product Summary window, 3-38
Formula Properties window

editing formula headers, 6-56
Formula Responsibility, 2-19
Formulas

adding and removing items to a formula, 6-57
analysis 

technical class and subclass, 3-88
analyzing, 3-86
calculating formula product quantities, 3-20
changing formula status, 6-56
Copy Formula window, 3-35
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creating, 3-20
creating , 6-55
creating packaging formulas, 3-20
editing formula header, 6-56
Find Formulas window, 3-24
fixed scale

without yield contribution, 3-12
with yield contribution, 3-12

fixed scaling, 3-12
Formula Analysis Parameters window, 3-86
Formula By-Product Summary window, 3-39
formula details, 3-27
Formula Ingredient Contribution Analysis 
window, 3-86
Formula Ingredient Summary window, 3-40
Formula Inquiry Selection window, 3-81
Formula Inquiry Summary View, 3-82
Formula Inquiry Summary window, 3-82
Formula Product Line Summary window, 3-41
Formula Product Lines window, 3-42
Formula Product Summary window, 3-38
Formula Properties window, 6-56
Formula Summary window, 3-25
Formula View window, 3-84
inquiry, 3-81
integer scale

complex, 3-12
simple, 3-12

integer scaling, 3-12
Intermediate Formula Inquiry Summary View
window, 3-85
item substitution

formula substitution lists, 7-16
status change approval, 7-18

item substitution lists
finding, 7-15

item substitutions, 7-9
finding formulas, 7-14

maintaining
at header level, 3-20
at line level, 3-20

optimization methods, 3-61
proportional scale

mixed type, 3-12
single type, 3-12

proportional scaling, 3-12
Recipe Designer

editing formulas, 6-57
scale type rules, 3-12
scaling

input ingredients, 3-12
outputs, 3-12

user preferences, 6-65
Formulas 

Formula Header Summary window, 3-26
Formula Substitution List, 7-9
Formula Tab

Formula menu options, 6-53
formulation specification approval, D-1
Formulation Specifications

changing status, 8-3
defining, 8-3
new requirements, 8-7

Formulation Specification Summary window, 8-9
, 8-12
Formulation Specification Workbench

generating formulations, 8-12
Formulation Specification Workbench 

using, 8-4
Formulator, 1-3, B-1
Formulator Responsibility, 1-17
formula weight, 2-25

G
Generate/Optimize Formulation window, 8-10
GMD

Process Instruction Paragraph, 6-44
UOM Mass Type, 3-86
UOM Volume Type, 3-51, 3-86

H
Hierarchical Display, 1-5
hierarchy, technical parameters, 2-23

I
Indented Bill of Materials Report (IOBM)

displaying, 3-75
interpreting, 3-75
running, 3-75

Ingredient Properties window
editing ingredient properties, 6-57

ingredient usage, 1-3
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ingredient usage, at step level, 5-2
ISO 9000, 3-3
Item Substitution

e-records, 7-18
e-signature, 7-9
formulas

finding, 7-14
Formula Substitution List, 7-9
formula substitution lists, 7-16
item substitution lists

changing status, 7-12
creating and approving, 7-12
finding, 7-15
finding formulas, 7-12

Item Substitution List window, 7-9
status change, 7-18
Status Change Approval Workflow, 7-9, 7-18
workflow, 7-18

item substitution approval, D-1
Item Substitution List window

using, 7-9
Item Substitutions

formulas, 7-9

L
Laboratory Organizations

setting up, 2-21
Least Cost Formulation

generating, 8-3
set up prerequisites, 8-3
understanding, 8-3
using, 8-14

life cycle, product, 1-3
Load Simulator window, 3-52

M
Maintain Resources, 4-6
Material Requirements window, 8-7
Material View tab, 8-10
mathematical operators, in expressions, 2-25
Menu, 1-5
Migration scripts, 3-3
Minimum Transfer Quantity, 4-7
Multilingual Support, 3-3

N
Navigation in Product Development, A-1
Navigator, 6-40
New Formulation Specification window, 8-5
Node

activity, 1-5
by-product, 1-5
class, 1-5
formula, 1-5
ingredient, 1-5
operation, 1-5
owner, 1-5
product, 1-5
recipe, 1-5
resource, 1-5
routing, 1-5
status, 1-5

Notification Summary window, 1-9

O
Operation Activity Details

Process Operation Details Activities window, 
4-9

Operation Activity Line Summary window, 4-5
Operation Activity Line window, 4-5
operation approval, D-1
Operation Classes

Process Operation Classes window, 2-19
setting up, 2-19

Operation List, 6-63
displaying, 6-63

Operation Resource Line
Operation Resource Line Summary window, 
4-6
Operation Resource Line window, 4-6

Operation Resource Lines
Process Operation Resource Line window, 4-
19
Process Operation Resource Line window , 4-
17

Operations
activity-resource details, 4-13
Find, 4-13
finding, 4-6
Find Operations window, 4-6
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operation activity details, 4-9
Operation Activity Line Summary window, 4-
16
Operation Header Summary window, 4-8
operation resource lines

displaying, 4-17
editing, 4-19

Process Operation Details Activities window, 
4-4, 4-8
resource process parameters

displaying, 4-21
Sequence dependency , 4-9
version control attribute sets, 2-39

Operations Summary
Operations Summary By window, 4-7
Operations Summary window, 4-4
Process Operation Details Activities window, 
4-7

OPM Cost Management
cost analysis codes, 2-1
cost calendar, 2-1

OPM Process Planning
 plant resources, 2-1
resources, 2-1

OPM Product Development Events, D-4
Optimization Methods

FDA, 3-61
Optimizer, 3-61

Optimizer
ingredient distribution rules, 3-75
lot quantity optimization, 3-63
optimization methods, 3-61
optimizing ingredient quantities, 3-66
optimizing lot quantities, 3-71
recalculating physical properties, 3-69
recalculating quantities, 3-69
using Workpad, 3-62

Oracle Inventory
prerequisites, 2-1

Overriding Process parameters, 4-21

P
Packaging formula, 3-3
Personal Folder, 1-5
Personal Shortcuts, 1-5
Phantoms

automatic generation, 3-11
Formula

using, 3-11
manual generation, 3-11
multibatch management, 3-11

Preferences window, 5-35
Prerequisite setup, 1-1
Process Engineer, 1-3, B-2
Process Engineer Workbench, B-3
Process Instruction Sheet

process instructions
adding text tokens, 6-63
editing, 6-63

Process Operation Details Activities window, 4-5
Process Parameters

overriding, 4-21
reset values, 4-21

Process Routing Classes window, 2-20
Product Development Parameters

Find Default Configuration Parameters 
window, 2-10
finding, 2-10
Product Development Security Manager 
responsibility, 2-3
setting up, 2-3

Product Development Parameters window, 1-17
Production Batch, 4-3
production loss factor, 5-2
Product Properties window

editing product prperties, 6-57
Product Requirements, 1-3
Profile Options

GMD: Density, 3-51
GMD: UOM Volume Type, 3-51
setting up, 2-11

Public Folder, 1-5

R
recipe

e-signature approval of, D-1
Recipe Designer

associating item to routing steps, 6-40
automatic step calculation

activate or disable, 6-57
changing status, 6-51
components, 6-40
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copy recipe, 6-52
creating formulas, 6-55
creating recipes, 6-51
editing formulas, 6-57
editing operation steps, 6-63
editing recipes, 6-51
editing routing properties, 6-63
finding a recipe, 6-50
formula tab, 6-53
Formula Tab

Formula menu options, 6-53
item technical data, 6-57
paragraph code

defining, 6-44
process instruction sheet pane, 6-40
Process Instruction Sheet pane, 6-63
Process Instruction Sheet tab, 6-57
Recipe tab, 6-46
Routing tab, 6-63
step number charges, 6-40
Tab pane, 6-40

Formula tab, 6-40
Recipe tab, 6-40
Routing tab, 6-40

using, 6-44
viewing recipes, 6-51

Recipe Details window, 6-12, 6-44
Recipe Header Summary window, 6-8, 6-44
Recipe Organization

finding, 6-22
Recipe Organization Details

entering, 6-19
Recipe Organization Details-Process Parameters 
window, 6-22
Recipe Organization Details window, 6-22
Recipe Properties window, 6-47
Recipes

copy recipe, 6-52
copy recipe components, 6-52
creating, 6-5
Find Recipes window, 6-7
maintaining, 6-5
recipe details

entering, 6-12
Recipe Details window, 6-12
 recipe header summary

displaying, 6-8

Recipe Header Summary window, 6-8
recipe management

compliance, 6-5
recipe organization

finding, 6-22
recipe organization 

entering, 6-19
Recipe Organization Details-Process 
Parameters, 6-22
Recipe Organization Details window, 6-19
Recipe Properties window, 6-47
Recipes Summary By window, 6-8
Recipes Summary window, 6-8
recipe step/material association, 6-5, 6-36
recipe validity rule details

editing, 6-26
recipe validity rules, 6-5, 6-24
step quantity calculations, 6-10
version control attribute sets, 2-39
view menu, 6-18

Recipes Summary window
multilingual support, 6-8

Recipe Step/Material Association window, 6-36
Recipe Summary By window, 6-44
Recipe Validity Rules Lines window, 6-26
Recipe Validity Rules Multi-Record window, 6-
24
Recipe Validity Rules window, 6-24
regulatory compliance, 1-3
Replace

formulas, 7-2
operations, 7-2
recipes, 7-2
routings, 7-2

Resource Maintenance, 4-6
Resource Properties window, 5-30
Resource Requirements, 4-3
Resource Usage, 4-4
Responsibilities, B-1
responsibility, workbench, B-1
Routing

step properties
editing, 5-27

Routing 
node, 1-5

routing approval, D-1
Routing Classes
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Process Routing Classes window, 2-20
setting up, 2-20

Routing Designer
drag-and-drop function, 5-20
using, 5-21

Routings
Activity Properties

using, 5-30
Activity Properties window, 5-30
creating, 5-4
Find Routings window, 5-6
fixed loss process, 5-18
maintaining, 5-4
operation steps, 5-35
Process Routing Details window, 5-4, 5-9
resource properties

displaying, 5-30
Resource Properties window, 5-30
Routing Designer, 5-21

routing step dependencies, 5-20
routing header summary, 5-7
Routing Header Summary window, 5-4, 5-7
Routing Properties window, 5-26
routing step dependencies

entering, 5-15
Routing Step Dependencies window, 5-4, 5-15
routing step lines, 5-14
Routing Step Line Summary window, 5-4, 5-14
Routing Step Line window, 5-14
Routing Summary window, 5-6
Step Dependency properties, 5-32
Step Properties window, 5-27
Theoretical Process Loss, 5-18

editing, 5-20
Theoretical Process Loss window, 5-4
version control attribute sets, 2-39

Routing tab
using, 6-63

S
Scaling Formulas

Scale Formula window , 3-36
using item quantity, 3-36
using percent, 3-36

Search and Replace
advanced search region, 7-2

basic search region, 7-2
Search and Replace window, 7-2
specifying conditions, 7-2
using wildcards, 7-2

Search and Replace features, 7-1
Security Profiles

setting up, 2-17
Sequence Dependent Operations, 4-9, 4-16
Sequencing Activities, 4-4
Setup

formulas, 3-7
prerequisites, 1-1

Simulator
adding lot information, 3-58
adding lot information to a batch, 3-58
blending batches, 3-57
displaying calculation errors, 3-59
displaying parameters, 3-59
finding simulations, 3-61
saving simulations, 3-60
updating batches, 3-56
updating formulas, 3-55
using, 3-54

Simulator window
creating a least cost formula or batch, 8-12
general description, 3-54

Status Approval Workflow, 3-3
adding status codes, 1-9
editing status codes, 1-9

Status Codes
adding and editing, 1-13
finding, 1-17
Find Status Codes window, 1-17

Status Codes window, 1-13
Status Details

entering, 1-16
Status Details window , 1-13, 1-16
Step Dependency properties window, 5-32
Step Materials

descriptive flexfields
defining, 6-39

Step Properties
editing, 5-27

Step Quantity Calculations
understanding, 6-10

Steps, 4-3
Subscriptions, D-6



Index-8

System Security Profile, 1-1

T
Tab

formula, 1-5
operation, 1-5
recipe, 1-5
routing, 1-5

Task Analysis, 1-3
Technical Characteristics, 3-3
Technical Class, 3-86, 3-88
Technical Class and Technical Subclass

assign category sets
process manufacturing class, 2-34

categories, 2-34
category sets, 2-34
key flexfields, 2-34
values, 2-34

Technical Classes, 3-94
technical parameters

formula rollups, 2-25
Technical Parameters, 3-3

data entry, 2-31
derived cost, 2-22
expressions, 2-22
fixed expressions, 2-22
Item Technical Data window, 2-31
sequence, 2-30
Technical Parameters window, 2-22

technical parameters, hierarchy, 2-23
Technical Parameter Sequences

computer-aided formulation, 3-51
setting up, 2-30
Technical Parameter Sequences window, 2-30

Technical Parameters window, 2-25, 2-25
Technical Subclass, 3-86, 3-88
test batches, 1-3
Theoretical Process Loss

displaying, 5-18
Editing, 5-20
Theoretical Process Loss Edit window, 5-20

Theoretical Process Loss window, 5-18
Toolbar, 1-5
Translations, 3-3

U

UOM conversions
errors in, 2-31

User Preferences, 5-35
editing, 6-65

V
validity rule approval, D-1
Validity Rules Summary by Product, 6-29
Validity Rules Summary by Recipe, 6-31
Version Control

parameters, 1-17
Product Development Parameters window, 1-
17
setting up

attributes level, 1-17
organizational level, 1-17
responsibility level, 1-17

version control attribute sets, 3-3
Version Control Attribute Sets

assigning to organization, 2-39
deleting, 2-39
setting up, 2-39
updating, 2-39
Version Control user interface, 2-39

View By
class, 1-5
owner, 1-5
status, 1-5

View Menu
Find, 4-13

W
wildcard, use in search and replace, 7-6
window

Formula By-Product Summary, 3-45
Item Properties window, 6-55

Window Security
setting up, 2-17

Windows Security
Product Development Security Manager, 2-17
recipe editing privileges , 2-17
System Administrator, 2-17

workbench, 1-3
Formulator, B-1

Workbench, 1-17
formulator, 1-8
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process engineer, 1-8
workbench responsibility, B-1
Work Breakdown Structure, 1-3
Workflow

activities, 1-9
Activity Approval Configuration Framework 
window, 1-9
Activity Configuration window, 1-9
API, 1-9
approver

setting up, 1-9
basics, 1-9
business processes, 1-9
decision trees, 1-9
electronic notifications, 1-9
notification, 1-9
Process Configuration Framework window, 1-
9
Process Configuration window, 1-9
setup, 1-9
status approval

enabling, 1-9
Status Approval

disabling, 1-9
triggers, 1-9

Workflow 
Process Activation window, 1-9

Workpad
Workpad window, 3-62
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